Spread for ASP.NET Developer’s Guide

Developer's Guide

This guide provides introductory conceptual material and how-to explanations for routine tasks for developers using
Spread for ASP.NET. It describes how an application developer would use the properties and methods in Spread to
create spreadsheets and grids on Web Forms, bind to databases, and customize the component for your application.

¢ Getting Started

¢ Understanding the Product

e Working with the Spread Designer
¢ Customizing the Appearance

e Customizing User Interaction

¢ Customizing with Cell Types

¢ Managing Data Binding

e Managing Data in the Component
e Managing Formulas

¢ Managing File Operations

¢ Using Sheet Models

e Maintaining State

e Working with the Chart Control

¢ Using Touch Support with the Component

For complete API reference information, refer to the Assembly Reference (on-line documentation).

For a complete list of documentation, refer to the Spread for ASP.NET Documentation (on-line
documentation).
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Getting Started

This topic describes how to get started with the component. It includes:

¢ Handling Installation

¢ Working with the Component

¢ Getting More Practice

¢ Understanding the Spread Wizard

e Tutorial: Creating a Checkbook Register

Handling Installation

Here are the tasks for installing the product for development and for redistribution.

¢ Installing the Product

¢ Licensing a Trial Project after Installation

e End-User License Agreement

¢ Creating a Build License

¢ Handling Redistribution

¢ Product Requirements

¢ Handling Variations in Windows Regional Settings

Installing the Product

Installation instructions and a list of installed files for Spread for ASP.NET is provided in the Read Me file that
accompanies this product. To view the Read Me file, do one of the following:

1. From the Start menu choose Programs -> GrapeCity -> Spread.NET 11 -> ASP.NET ->
SpreadASPReadMe. Select the Read Me under the GrapeCity name on the Start screen with Microsoft
Windows 8, 8.1, or 10.

2. If you performed a default installation, in Windows Explorer browse to \Program Files\GrapeCity\Spread.NET
11\Docs\ASP.NET and double-click the readme.chm file.

You can also access the Read Me on the web site.

Licensing a Trial Project after Installation

To license ASP.NET projects made with the trial version do the following;:

Ensure that Spread is licensed on the machine by following the installation steps in the Read Me.
Open the project in Microsoft Visual Studio.
Open the Visual Studio Build menu and select Rebuild Solution.

The web application is now licensed and no evaluation banners appear when you run it. You can distribute the
Web application to unlicensed machines and no evaluation banners appear.

Sl S

For licensing Web Site applications, open the Visual Studio Build menu and select Build Runtime Licenses to create
the App_ Licenses.dll file.

End-User License Agreement

The GrapeCity licensing information, including the GrapeCity end-user license agreements, frequently asked licensing
questions, and the GrapeCity licensing model, is available online at https://www.grapecity.com/en/licensing/spread
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and https://www.grapecity.com/en/legal/eula.

Creating a Build License

You can create a build license to use on a build machine.

Licenses are built using the license compiler tool (lc.exe) to produce a special resource file with the .licenses file
extension. Visual Studio VB.NET and C# projects automatically handle compiling the licenses.licx in the project to
produce the .licenses resource file, which is linked into the target executable. The components’ run-time license keys in
that licenses resource file are loaded and verified when the first instance of each component with the LicenseProvider
attribute is created in the application. You can remove the licenses.licx from your Visual Studio project and add the
Jicenses resource in its place using the following steps:

1. Build the project using the licensed components on a developer machine which is licensed for development with
all the components referenced in the project (this creates the .licenses resource).

2. Find the licenses.licx in the Solution Explorer window. You can use the Show All Files toolbar button to see it
or expand the Properties folder.

Right-click the licenses.licx in the Solution Explorer window, and then select Exclude From Project.
& Properties
P Assemblylnfo.cs
) licenses.licx
Open

Open With...

Scope to This

Mew Solution Explorer View

Show on Code Map

Exclude From Project

4. Use Windows Explorer (outside Visual Studio) to find the .licenses file in the obj\{configuration} folder
(obj\Debug or obj\Release). The file should have the name {target}.{ext}.licenses (for example:
projecti.exe.licenses).

5. Copy that file to the project folder and rename it to remove the target name (rename it from {target}.
{ext}.licenses to {ext}.licenses). For example: projecti.exe.licenses to exe.licenses.

6. In the Visual Studio Solution Explorer window, find the {ext}.licenses (you might need to refresh the window),
then right-click the file and select Include In Project.
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4 J My Project
VB Ap lion.myapp

VB Assemblyinfovb

Properties
[ Mew Solution Explorer View
exe.licen: ©
<% Show on Code Map

Include In Project

Properties
exe.licenses File Properties
B &
Build Action Content
Copy to OuNone

8. The project can now be built without requiring a developer license on the machine, since the license has already
been built and linked into the project.

Note the following restrictions:

e The licenses resource contains the name of the target module encoded in its contents, so that licenses resource
is specific to that particular project.

e The steps described above will not bypass any part of the design-time license enforcement. The developer
license is still required to open forms containing instances of the licensed controls.

o If the licensed components in the project change, then special care should be taken. The licenses.licx should be
added back to the project first, so that it does not get recreated (empty) by Visual Studio and cause type
references (and embedded licenses in the resource) to be lost. After the new licensed components are added or
changed in the licx, the above steps should be repeated.

e The above steps only apply for .NET managed code applications which use the standard .NET Framework
component licensing model (ActiveX control licensing in managed .NET applications does not use this
mechanism).

Handling Redistribution

Please review this information concerning redistribution of Spread for ASP.NET with your application.
Server Requirements

You must deploy to a Microsoft Internet Information server.
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Server Files

Place the assemblies that come with Spread for ASP.NET in either your server's global assembly cache (GAC) or in your application directory's \bin folder under the wwwroot directory on your server.
Place the following assemblies on your server:

FarPoint.Web.Spread.dll

FarPoint.CalcEngine.dll

FarPoint.Excel.dll

FarPoint.PDF.dIl

FarPoint.Web.Chart.dll (if you use the Chart control or Sparklines)
FarPoint.Web.Spread.Extender.dll (if you use the extender classes)
System.Web.Extensions.dll (if you use the FarPoint.Web.Spread.Extender.dll)
AjaxControlToolkit.dll (if you use the FarPoint.Web.Spread.Extender.dll)
FarPoint.Mvc.Web.Spread.dll (if you use Spread in an MVC3 project)

Place the fp_client folder (installed in Spread NET\ASP.NET\..\fp_client) and its subfolders provided with Spread for ASP.NET under your server's wwwroot directory, or, if you wish to put it elsewhere, set up a virtual directory in IIS Manager
to point to the location of that folder's contents.

The fp_client folder can also be placed in the web application directory. The following code would need to be added to the web config file. For example:
<?xml version="1.0"2>
<configuration>

<system.web>

</system.web>
<appSettings>
<add key="fp_client" value="fp_client" />
</appSettings>
</configuration>
Be aware that Spread for ASP.NET creates a Web server control that serves up HTML pages for clients and it also puts HTC files in a directory on the client machine for client-side scripting capability.

] Spread for ASP.NET uses jQuery 2.x. If the web page or web application uses jQuery 2.0 or higher, Spread uses that version of jQuery. If the web page uses jQuery 1.9 or earlier, Spread uses jQuery 2.x internally and does not conflict with the
web page version of jQuery.

Permission Requirements

If you use the Spread control on medium trust web sites, you need to add SerializationFormatter and Reflection permissions to the machine config file, web_mediumtrust.config. The SecurityPermission needs the UnmanagedCode and
SerializationFormatter flags. For example:

<IPermission class="SecurityPermission” version="1" Flags="Assertion, Execution, ControlThread, ControlPrincipal, RemotingConfiguration, UnmanagedCode, SerializationFormatter"/>

<IPermission class="ReflectionPermission" version="1" Unrestricted="true" Flags="ReflectionPermissionFlag.MemberAccess"/>

Product Requirements

For developing applications with the .NET 4.0 version of Spread for ASP.NET, you must have the following system
items:
Operating System
One of the following;:
e Microsoft Windows 2003 Server

e Microsoft Windows 2008 Server

e Microsoft Windows 2012 Server

e Microsoft Windows XP Professional
e Microsoft Windows Vista

e Microsoft Windows 7

e Microsoft Windows 8

e Microsoft Windows 8.1

e Microsoft Windows 10

Software
[ )

Release version of the Microsoft .NET 4.0 Framework.
e Microsoft Internet Information Services (IIS)

e SQL Server or the SQL Server desktop engine that ships with Visual Studio .NET installed on your machine to
be able to run some of the data binding samples

e The Spread extender requires the AJAX Control Toolkit
e The Spread Designer requires Microsoft Internet Explorer (IE) 7 or higher and the Microsoft.mshtml.dll.

Handling Variations in Windows Regional Settings

The Spread component reads the Windows regional settings or options, which are set by the user through the Control
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Panel, but due to variations in how Windows handles those settings, your user might experience unexpected results.

In general in Windows operating systems, the Spread component does not recognize changes made to the Windows
regional settings until you restart your development environment or your application or perform any operation that
unloads and reloads the current assembly and dependent assemblies. This is because handling the regional settings is
very processor intensive. To optimize performance these settings are not checked each time a simple operation is
performed.

In most Windows operating systems, the regional options are read from the system registry. In certain situations,
Windows does not clear previous regional options when reading changes from the system registry. Be aware of this when
working with regional settings.

Working with the Component

Here are the tasks involved with starting to work with the component.

¢ Adding a Component to a Web Site using Visual Studio 2015 or 2017
¢ Adding a Component to a Web Site using Visual Studio 2013
e Adding a Component to a Web Site using Visual Studio 2012
¢ Adding a Component to a Web Site using Visual Studio 2010
¢ Adding and Using JavaScript IntelliSense

¢ Understanding Browser Support

¢ Understanding Parts of the Component Interface

e Working with Collection Editors

e Working with Web Parts

¢ Working with Windows Azure

¢ Working with Microsoft ASP.NET MVC 5

e Working with Microsoft ASP.NET MVC 3

¢ Copying Shared Assemblies to Local Folder

¢ Working with Strongly Typed Data Controls

Adding a Component to a Web Site using Visual Studio 2015 or 2017

Use the following steps to add a Spread component to a Web Form in Visual Studio. You can either open an existing Web Site
or create a new one.

Z] Spread, as a child control of the page, is affected by the style settings on that page (similar to placing a table on a web
form, and setting a master CSS for everything inside the page). If you create a default web application with Visual Studio
2010 or higher, the default master page contains CSS style settings. Spread, once placed on this default page, can be
affected by the style settings and the layout may change. Avoid the following HTML tags to prevent the layout change:
TD, TH, TABLE, INPUT, and TEXTAREA.

Step 1. Start Visual Studio.
Step 2. Create a new Web site.

1. Select New Project or from the File menu, choose New, Web Site.
2. Under Templates, select Web under Visual Basic or Visual C#.
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4 Templates A project ternplate for creati

I Visual C2 applications. You can create

Faorms, MVC, or Web APl ap

4 Visual Basic add many other features in £

P Windows
m @ Application Insights
Cloud [] Add Application Insights
Extensibility Help you understand ant
LightSwitch your application,
Office/SharePoint
Sitverlight
Test
WCF
Workflow
Visual F#
b Visual C++
S0L Server
M bl -
I Online Click here to go online and find templates.
MName: WebApplication
Location: C:\Program Files (x86)\GrapeCity"SpreadSamples', -
Solution name: WebApplication Create directory for solution

[] Add to source control

3. Select ASP.NET Web Application.

4. Specify a location and name for the project.
5. Select OK.

6. Select a template such as Empty.
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Mew ASP.MET Project - WebApplication

Select a template:

Empty Web Forms MY C Web AP Single Page
Application
F'U'B
e
Azure Mobile
Service

Add folders and core references for:

[ WebFarms [ | MVC [ | Web API

[ Add unit tests

Test project name: | WebApplicationl.Tests

7. Select OK.

An empty project template for creating ASP.NET
applications. This template does not have any content in
it,

Learn more

Authentication: Mo Authentication

= Microsoft Azure
@ [] Host in the cloud

Web App <

0K | | Cancel

If your project does not display the Solution Explorer, from the View menu, choose Solution Explorer. If you used
an empty site, you may wish to add a web form to the project (choose Add, Web Form after right-clicking on the

project name in the Solution Explorer).

Specify the Item name. Select OK.

Specify Mame for [tem x

[term name: WebForm 1

| QK | | Cancel |

Step 3. Add the FpSpread component to the toolbox if the component is not displayed in the toolbox.

N =

Spread and placed the toolbox icon in a different category).

w

Choose Items.

N

. If the Toolbox is not displayed, from the View menu choose Toolbox.
. Once the Toolbox is displayed, look in the GrapeCity Spread category (or in other categories if you have installed

. If the FpSpread component is not in the Toolbox, right-click in the Toolbox, and from the pop-up menu choose

. In the Choose Toolbox Items dialog, click the .NET Framework Components tab.

5. In the .NET Framework Components tab, the FpSpread component should be displayed in the list of components.
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Select the FpSpread component check box and click OK.
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If the FpSpread component is not displayed in the list of components, click Browse and browse to the installation path
for the Spread component. Once there, select FarPoint.Web.Spread.dll and click Open. The FpSpread component is
now displayed in the list of components. Select it and click OK. Select FarPoint.Web.Chart.dll if you wish to add FpChart

at design time.

6. You can test that the component has been added by opening a project and inserting the component.

Step 4. Add the FpSpread component to the Web site.

1. With an open project, in the Toolbox under Web Forms, select the FpSpread component. Select FpChart if you wish

to add the chart at design time.

2. On your Web Forms page, draw an FpSpread component by dragging a rectangle the size that you would like the initial

component or simply double-click on the page.
3. The FpSpread component appears (as shown in this Visual Studio project).

';‘? Toolbox * =X
i't‘,_ll_, Search Toolbox - [|:|
E—, I Standard c D 2
e - Data
[ Validation
'f,._.,—'_ > Mavigaticn
= i Login .
I WebParts

B AJAK Extensions

k> Dynamic Data

- HTML

4 GrapeCity Spread
k. Pointer P
[ FpChart
EY FpSpreadTemplateReplacement
g8  SpreadDataSource

4 General

There are no usable controls in this
group. Drag an item onto this text to
add it to the toolbox.

EI <FarPoint:FpSpread#FpSpre..>

- |

I

Adding a Component to a Web Site using Visual Studio 2013

Adding an FpSpread component to a Web Form in Visual Studio 2013 involves the following steps of adding the component to

a Web Site. You can either open an existing Web Site or create a new one.

2 Spread, as a child control of the page, is affected by the style settings on that page (similar to placing a table on a web
form, and setting a master CSS for everything inside the page). If you create a default web application with Visual Studio
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2010 or higher, the default master page contains CSS style settings. Spread, once placed on this default page, can be
affected by the style settings and the layout may change. Avoid the following HTML tags to prevent the layout change:
TD, TH, TABLE, INPUT, and TEXTAREA.

Step 1. Start Visual Studio 2013.
Step 2. Create a new Web site.

1. Select New Project or from the File menu, choose New, Web Site.
2. Under Templates, select Web under Visual Basic or Visual C#.

I Recent NET Framework 4.5 - Sortby:lDe‘FauIt ii° [i=|| Search Installed Templ 2 -
4 |nstalled

pmve — . - Type: Visual Basic
N @J ASP.MET Web Application Visual Basic

4 Templates A project ternplate for creating ASP.NET

4 Visual Basic applications. You can create ASP.MET Web
Forms, MVC, or Web API applications and
add many other features in ASP.MET.

Windows Store
Windows
Web
Visual Studio 2012

Office/SharePoint
Cloud
LightSwitch
Reporting
Sitverlight
Test
WCF
Worlflow

4 Visual C#

Windows Store
LT T PR

b Online Click here te go online and find templates.

Mame: VBWS2013

Location: |C:\Spread ASPTisamplesh ~|

Solution name: VBV52013 Create directory for solution
[ Add to source control

3. Select ASP.NET Web Application.

4. Specify a location and name for the project.
5. Click OK.

6. Select a template such as Empty.
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Select a template:

An empty project template for creating ASP.NET

F“ F“ F“ F" applications. This template does not have any content in
el el el el it,
Empty Web Forms MVC Web API
Learn more
F'. F'H
e-l el
Single Page Facebook
Application

Add folders and core references for:

[ |WebFerms [ |MVC [ | Web AP

Change Authentication

Authentication: Mo Authentication
[] Add unit tests

Test project name: | VEV52013.Tests

0K H Cancel

7. Click OK.
If your project does not display the Solution Explorer, from the View menu, choose Solution Explorer. If you used
an empty site, you may wish to add a web form to the project (choose Add, Web Form after right-clicking on the
project name in the Solution Explorer).
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Solution Explorer 0 X
@ e-enam o F -
Search Solution Explorer (Ctrl+;) P~

fal Solution 'VBVS2013' (1 project)
4 VBVS2013

& My Project

¥.1 Web.config

gl WebForm1.aspx

LTSl Team Explorer  Class View

Specify the Item name. Select OK.

Specify Name for Item

[tem names; |Wel;:|Fu:|rm'| |

| QK | | Cancel |

Step 3. Add the FpSpread component to the toolbox. This only has to be done once.

1. If the Toolbox is not displayed, from the View menu choose Toolbox.

6.

. Once the Toolbox is displayed, look in the GrapeCity Spread category (or in other categories if you have installed

Spread and placed the toolbox icon in a different category).

. If the FpSpread component is not in the Toolbox, right-click in the Toolbox, and from the pop-up menu choose

Choose Items.

. In the Choose Toolbox Items dialog, click the .NET Framework Components tab.
. In the NET Framework Components tab, the FpSpread component should be displayed in the list of components.

Select the FpSpread component check box and click OK.

If the FpSpread component is not displayed in the list of components, click Browse and browse to the installation path
for the Spread component. Once there, select FarPoint.Web.Spread.dll and click Open. The FpSpread component is
now displayed in the list of components. Select it and click OK. Select FarPoint.Web.Chart.dll if you wish to add FpChart
at design time.

You can test that the component has been added by opening a project and inserting the component.

Step 4. Add the FpSpread component to the Web site.

1.

With an open project, in the Toolbox under Web Forms, select the FpSpread component. Select FpChart if you wish
to add the chart at design time.

. On your Web Forms page, draw an FpSpread component by dragging a rectangle the size that you would like the initial

component or simply double-click on the page.

. The FpSpread component appears (as shown in this Visual Studio 2013 project).
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Dd VBYS2013 - Microsoft Visual Studio (Administrator)
FILE EDIT VIEW  PROJECT  BUILD DEBUG  TEAM FORMAT  TOOLS TEST  ARCHITECTURE

G' |ﬁ‘__"|"" Hd‘| - '| }Ir1tv.=_rr1v.=_~tExr:llu:urvar1-(:i-v|J;I ;

S

Toolbox * b X
Search Toolbox Pl
[ Standard B C D
[: Data

I Validation
[: Mavigaticn

o) Jaui0)dxg s2am

og|o

I> Legin
[ WebParts
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k  Pointer
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0
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Adding a Component to a Web Site using Visual Studio 2012

Adding an FpSpread component to a Web Form in Visual Studio 2012 involves the following steps of adding the
component to a Web Site. You can either open an existing Web Site or create a new one.

["g Spread, as a child control of the page, is affected by the style settings on that page (similar to placing a table on a
web form, and setting a master CSS for everything inside the page). If you create a default web application with
Visual Studio 2010 or higher, the default master page contains CSS style settings. Spread, once placed on this
default page, can be affected by the style settings and the layout may change. Avoid the following HTML tags to
prevent the layout change: TD, TH, TABLE, INPUT, and TEXTAREA.

Step 1. Start Visual Studio 2012.
Step 2. Create a new Web site.

1. From the File menu, choose New, Web Site.

2. In the New Web Site dialog, select a template. For example, from the list of Templates, choose ASP.NET Web

Forms Site or ASP.NET Empty Web Site.

3. In the Web location area, select HTTP from the drop-down box, and type a location path, such as
http://localhost/SpWebTesto1. Alternatively, you could use the default location type as FileSystem, and then
specify the complete path, but this requires some additional setup of copying the fp_ client folder.

4. Click OK.

If your project does not display the Solution Explorer, from the View menu, choose Solution Explorer. If

you used an empty site, you may wish to add a web form to the project (choose Add New Item after right-
clicking on the project name in the Solution Explorer).

In the Solution Explorer, right-click on the form name, Default.aspx. You can rename it. Choose Rename
from the pop-up menu, then type the new form name.

Step 3. Add the FpSpread component to the toolbox. This only has to be done once.

1. If the Toolbox is not displayed, from the View menu choose Toolbox.
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2. Once the Toolbox is displayed, look in the GrapeCity Spread category (or in other categories if you have
installed Spread and placed the toolbox icon in a different category).

3. If the FpSpread component is not in the Toolbox, right-click in the Toolbox, and from the pop-up menu choose
Choose Items.

4. In the Choose Toolbox Items dialog, click the .NET Framework Components tab.

. In the .NET Framework Components tab, the FpSpread component should be displayed in the list of
components. Select the FpSpread component check box and click OK.
If the FpSpread component is not displayed in the list of components, click Browse and browse to the
installation path for the Spread component. Once there, select FarPoint.Web.Spread.dll and click Open. The
FpSpread component is now displayed in the list of components. Select it and click OK. Select
FarPoint.Web.Chart.dll if you wish to add FpChart at design time.

(93}

6. You can test that the component has been added by opening a project and inserting the component.
Step 4. Add the FpSpread component to the Web site.

1. With an open project, in the Toolbox under Web Forms, select the FpSpread component. Select FpChart if you
wish to add the chart at design time.

2. On your Web Forms page, draw an FpSpread component by dragging a rectangle the size that you would like the
initial component or simply double click on the page.

3. The FpSpread component appears (as shown in this Visual Studio 2012 project).

Dd SpWeb7Touch - Microsoft Visual Studio (Administrator)
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM SQL FORMAT TOOLS TEST AMALYZE  WINDOW

e - B - W P Internet Explorer - Debug - S -
E:_' Search Toolbox P- =
= 4 GrapeCity Spread -
E [ i P-:u?:;tv.: C D -[IEI
' [ FpChart
Ef FpSpreadTemplateReplace...
g8 SpreadDataSource o
4 Standard
k. Pointer
f#1 AdRotator
i=  BulletedList
Button :_D
& Calendar
CheckBox
B=  CheckBoxlist
= DropDownlist
4  FileUpload
@i HiddenField
A HyperLink .
E Image
E R [H-:htmI}”-:I::-Dd:,f>||-:fc:-rm#fc:-rm'l> <FarPoint:FpSpread#FpSpre..> IEI
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Step 5. Handle messages when running the Web site.

1. When you are ready to build and run the Web site, Visual Studio pops up an additional dialog to allow you to
choose between whether to enable debugging or not to enable it. An example of the dialog appears here. Click
OK, unless you want to select the other option to run without debugging before clicking OK.

Debugging Not Enabled ?

The page cannot be run in debug mode because debugging is not enabled in the Web.config file,
What would you like to do?

(®) Modify the Web.config file to enable debugging.

I Debugging should be disabled in the Web.config file before deploying the Web
. site to a production envircnment.

() Run without debugging. (Equivalent to Ctrl+F5)

QK Cancel

If you select the File System for the location, follow these additional instructions.

Place the fp_ client folder (installed in Spread. NET\ASP.NET\..\fp_ client) and its subfolders provided with Spread for
ASP.NET under the folder for the Web site. Add the following code to the web.config file. For example:

XML

<?xml version="1.0"?2>
<system.web>

</system.web>

<appSettings>

<add key="fp client" value="fp client" />
</appSettings>

</configuration>

If you add FpChart and you are using integrated managed pipeline mode, you may wish to set
validateIntegratedModeConfiguration to false in web.config. For example:

XML

<system.webServer>

<validation validateIntegratedModeConfiguration="false"/>
<handlers>

<add name="chart" path="FpChart.axd" verb="*"
type="FarPoint.Web.Chart.ChartImageHttpHandler" />
</handlers>

// If you are using integrated managed pipeline mode,
//set validatelIntegratedModeConfiguration to false.
<validation validateIntegratedModeConfiguration="false"/>

Adding a Component to a Web Site using Visual Studio 2010
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Adding an FpSpread component to a Web Form in Visual Studio 2010 involves the following steps of adding the
component to a Web Site. You can either open an existing Web Site or create a new one.

] Spread, as a child control of the page, is affected by the style settings on that page (similar to placing a table on a
web form, and setting a master CSS for everything inside the page). If you create a default web application with
Visual Studio 2010 or higher, the default master page contains CSS style settings. Spread, once placed on this
default page, can be affected by the style settings and the layout may change. Avoid the following HTML tags to
prevent the layout change: TD, TH, TABLE, INPUT, and TEXTAREA.

Step 1.
Step 2.

1.
2.

Step 3.

Start Visual Studio 2010.
Create a new Web site.

From the File menu, choose New, Web Site.

In the New Web Site dialog, select a template. For example, from the list of Templates, choose ASP.NET Web
Site or ASP.NET Empty Web Site.

In the Web location area, select HTTP from the drop-down box, and type a location path, such as
http://localhost/SpWebTesto1. Alternatively, you could use the default location type as FileSystem, and then
specify the complete path, but this requires some additional setup of copying the fp_ client folder.

Click OK.

If your project does not display the Solution Explorer, from the View menu, choose Solution Explorer. If
you used an empty site, you may wish to add a web page to the project (choose Add New Item after right-
clicking on the project name in the Solution Explorer).

In the Solution Explorer, right-click on the form name, Default.aspx. You can rename it. Choose Rename
from the pop-up menu, then type the new form name.

Add the FpSpread component to the toolbox. This only has to be done once.

1. If the Toolbox is not displayed, from the View menu choose Toolbox.

6.

Step 4.

1.
2.

3.

. Once the Toolbox is displayed, look in the GrapeCity Spread category (or in other categories if you have

installed Spread and placed the toolbox icon in a different category).

. If the FpSpread component is not in the Toolbox, right-click in the Toolbox, and from the pop-up menu choose

Customize Toolbox, Add/Remove Items, or Choose Items.

. In the Customize Toolbox dialog, click the .NET Framework Components tab.
. In the .NET Framework Components tab, the FpSpread component should be displayed in the list of

components. Select the FpSpread component check box and click OK.

If the FpSpread component is not displayed in the list of components, click Browse and browse to the
installation path for the Spread component. Once there, select SpreadWeb.dll and click Open. The FpSpread
component is now displayed in the list of components. Select it and click OK.

You can test that the component has been added by opening a project and inserting the component.
Add the FpSpread component to the Web site.

With an open project, in the Toolbox under Web Forms, select the FpSpread component.

On your Web Forms page, draw an FpSpread component by dragging a rectangle the size that you would like the
initial component or simply double click on the page.

The FpSpread component appears (as shown in this Visual Studio 2010 project).
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Step 5. Handle messages when running the Web site.

1. When you are ready to build and run the Web site, Visual Studio pops up an additional dialog to allow you to
choose between whether to enable debugging or not to enable it. An example of the dialog appears here. Click
OK, unless you want to select the other option to run without debugging before clicking OK.
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Debugging Not Enabled m

The page cannot be run in debug mode because debugging is not enabled in the Web.config
file. What would you like to do?

@ Modify the Web.config file to enable debugging.

_ﬂ, Debugging should be disabled in the Web.config file before deploying
the Web site to a production environment.

Run without debugging. (Equivalent to Ctrl+F3)

Ok ‘ ‘ Cancel

If you select the File System for the location, follow these additional instructions.

Place the fp_client folder (installed in Spread. NET\ASP.NET\..\fp_ client) and its subfolders provided with Spread for
ASP.NET under the folder for the Web site. Add the following code to the web.config file. For example:

XML

<?xml version="1.0"?2>
<system.web>

</system.web>

<appSettings>

<add key="fp client" value="fp client" />
</appSettings>

</configuration>

Adding and Using JavaScript IntelliSense

The Spread component can support client-side code IntelliSense. This requires a minimum of Visual Studio 2010. This
feature allows you to type the name of the control and get a list of available methods and properties. Some browsers may
not support certain properties and methods.

After support has been added, type the control name followed by a dot to see the list.
The following topics contain detailed information based on the version of Visual Studio:
e Adding JavaScript IntelliSense for Visual Studio 2012
¢ Adding JavaScript IntelliSense for Visual Studio 2010

Adding JavaScript IntelliSense for Visual Studio 2012

The Spread component can support client-side code IntelliSense in Visual Studio 2012. This feature allows you to type the
name of the control and get a list of available methods and properties. Some browsers may not support certain properties and
methods.
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After support has been added, type the control name followed by a dot to see the list.
This features requires the FpSpreadJsIntellisense.js file located in the fp_ client folder. Use the following steps:

1. Verify that the ~/Scripts/_references.js reference exists in your IntelliSense settings. Select the Options menu under
the Tools menu to see this dialog. Click OK.

Options "v-" - |

- Projects and Solutions Reference Group:
> Source Control [Implicit (Web) — I
4 Text Editor
General Included Files:
File Extension domWeb.js - L)
> All Languages CA\Program Files (x86)\Microsoft Visual Studio 11.0\JavaScript\Refe
» Basic I underscorefilter.js v
> C# CA\Program Files (x86)\Microsoft Visual Studio 11.0VJavaScript\Refe—
P /s showPlainComments.js x
| : SS =| | cAProgram Files (x86)\Microsoft Visual Studio 11.0\JavaScript\Refe
| . HTML ~/Scripts/_references.js 1
ath will be resolved relative to referencing file/project
| 4 JavaScript (p 1 g file/project)
General i -
Tabs < | m b
» Formatting
4 IntelliSense Add a reference to current group .
General Please input a full or relative file path, or URL
References
|| > Plain Text

[ OK ] | Cancel |

2. Add the FpSpreadJsIntellisense.js file to the same folder where the _references.js file is located. You may need to create
a Scripts folder in your project if the folder does not exist. You may also need to create the _references.js file under the
Scripts folder if the file does not already exist.

4 @l Scripts
LT _references,js
LT FpSpreadlsintellisense.js

3. Add the following line to _references.js:
/// <reference path="FpSpreadJsIntellisense.js" />

4. Open and close the FpSpreadJsIntellisense.js file.
5. Spread client-side methods and properties should now be displayed when you type the control name followed by a dot.
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<script type="text/javascript”>
var spreadl = FpSpread("Spreadl™)
spreadl.|

ActiveRow

Add
addEventListener
AddKeyMap
AddSelection
CallBack

Cancel

o000 a ¢ ¢

Cells -

Adding JavaScript IntelliSense for Visual Studio 2010

|ActiveCol | (member variable) ActiveCol
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The Spread component can support client-side code IntelliSense. This requires a minimum of Visual Studio 2010. This
feature allows you to type the name of the control and get a list of available methods and properties. Some browsers may

not support certain properties and methods.

After support has been added, type the control name followed by a dot to see the list.

Adding Support for IntelliSense

This features requires the FpSpreadJsIntellisense.js file located in the fp_ client folder. Use the following steps:

e Create a folder named ClientResources and put the folder in the project folder (or root path of the application

or web site).
e Put the FpSpreadJsIntelliSense.js file in the ClientResources folder.
o Add the following code (after the title) to the aspx page:

Code

<%$If (False) Then%>
<script type="text/javascript"

src="./ClientResources/FpSpreaddsIntellisense.js"></script>
<% End IfS%>
function SomeFunction () {

var spread = FpSpread("FpSpreadl");

// This variable declaration is necessary for the autocomplete.
// Type spread. here to see the autocomplete.

}

The final aspx page might appear as follows:

Code

<title>Untitled Page</title>

<%$If (False) Then%>

<script type="text/javascript"
src="./ClientResources/FpSpreaddsIntellisense.js"></script>

<% End If%$> <script language="javascript" type ="text/javascript"
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window.onload = function () {
var ss = document.getElementById ("<%=FpSpreadl.ClientID %>");
if (document.all) {

// 1IE

if (ss.addEventListener) {

// IE9

ss.addEventListener ("DataChanged", DataChanged, false);
} else {

// Other versions of IE and IE9 quirks mode (no doctype set)
ss.onDataChanged = DataChanged;

}

}

else {

// Firefox

ss.addEventListener ("DataChanged", DataChanged, false);

}

}

function DataChanged(event) {
var spread = FpSpread("FpSpreadl");
> // TYPE spread. here to see the auto-complete.

}
</SCRIPT>

The <% if %> block will evaluate to false at run time since this code is only used for code autocomplete.

Client-side autocomplete support can also be used in a stand-alone js file with the following code (this line must be
before any script):

Code

<reference name="FarPoint.Web.Spread.htc.FpSpreaddsIntellisense.js"
assembly="FarPoint.Web.Spread" />

Understanding Browser Support

The Spread component resides on the server and generates HTML pages when it is accessed by end users on the client
side. The appearance and amount of interactivity of the Web page depends on the browser used on the client side. The
view of the HTML pages generated by the Spread component depends on the browser being used to view the page. The
component also downloads some HTML component (HTC) files to the client side. This topic summarizes some browser-
specific behaviors of the product. These aspects of browser support, discussed below, include:

Browser Level

The appearance and amount of interactivity of the Web page depends on the level of browser. Broadly, an uplevel
browser is one that can support client-side JavaScript, HTML version 4.0, the Microsoft Document Object Model, and
cascading style sheets (CSS). A downlevel browser is one that does not. For a more detailed definition of uplevel and
downlevel browser and for a list of capabilities of those browsers, refer to the browser capability information in the
Microsoft .NET documentation.

Mozilla Firefox Support

While most features work in Mozilla Firefox, not all do. All features work in the latest version of Microsoft Internet
Explorer (IE). Here is a list of features that are not supported in Firefox.

e Scroll bar properties (see Customizing the Scroll Bar Colors)
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For other affects, see the discussion on the DOCTYPE Affect on Rendering.
Apple Safari Support

While most features work in Apple Safari, not all do. Here is a list of features that are not supported.

e Frozen rows and columns (FrozenRowCount ('FrozenRowCount Property' in the on-line
documentation) property and FrozenColumnCount ('"FrozenColumnCount Property' in the on-
line documentation) property)

e ImeMode for editable cell types
e UlVirtualization ('UIVirtualization Property' in the on-line documentation) property

Apple Safari Support with IPad

Here is a list of features that are not supported.

e Panning mode is not supported.
e Custom toolbar above the system keyboard is not supported.
e Scroll bars are not displayed.

Google Chrome

Here is a list of features that are not supported.

e ImeMode for editable cell types
e Scroll bar properties (see Customizing the Scroll Bar Colors)

Client-Side Scripting

For other browsers, besides Microsoft Internet Explorer (IE) and Mozilla Firefox, the Spread client-side scripting is not
supported.

In your scripting code, you will need to check the browser to see if it is Firefox or IE before calling this code, so you can
call it correctly based on the browser that is viewing the page. Client-side scripting for the Firefox browser is a little
different than it is for IE. You need to use Firefox's way to attach events. For example

Code

<HEAD>

<script language="javascript" type="text/javascript">
window.onload = function ()
{
var spreadl = document.getElementById ("<%=FpSpreadl.ClientID %>");
if (document.all) {

// 1IE
if (spreadl.addEventListener) {

// IE9

spreadl.addEventListener ("DataChanged", dataChanged, false);
} else {

// Other versions of IE and IE9 quirks mode (no doctype set)
spreadl.onDataChanged = dataChanged;
}
} else {
// Firefox
spreadl.addEventListener ("DataChanged", dataChanged, false);
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function dataChanged() {
alert ("The data has changed!");
}

</SCRIPT>
</HEAD>

Firefox does not support JavaScript properties as IE does; everything is accessed with methods. For example, to get the
active row and active column, you use the GetActiveRow (on-line documentation) method and the GetActiveCol
(on-line documentation) method respectively. In code,

Code

var row = ss.GetActiveRow () ;
alert (row) ;

For browser-level issues specific to certain members, refer to these:
e FpSpread.EnableClientScript ("EnableClientScript Property' in the on-line documentation)
Property
o SheetView.MessageRowStyle ('MessageRowStyle Property’ in the on-line documentation)
Property
e SheetSkin.SelectionForeColor ('SelectionForeColor Property' in the on-line documentation)
Property

and refer to Understanding Effects of Client-Side Validation.

AJAX Support

Spread for ASP.NET supports AJAX in Microsoft Internet Explorer (IE) and Mozilla Firefox browsers.
DOCTYPE Affect on Rendering

The DOCTYPE settings can affect the rendering of Spread. Consider the following:

¢ Column widths slightly differ from what you see in Spread Designer (IE and Firefox).

e Spread inside a DIV element does not scroll as expected (IE and Firefox)

e Row height expands to show the wrapping text (IE and Firefox)
The column widths may appear narrower in Firefox than in IE. This has to do with the document type (DOCTYPE) of the
HTML page. In IE, with compliant mode, you will see column widths with margins set to be larger that what you set

them to. If you change the DOCTYPE of the page to Transitional or remove the margins for the cells, you should see the
same column widths using either browser. For more information, refer to the IsStrictMode method.

%] Note: Spread requires that the XML name space be declared as follows:
<html xmlns="http://www.w3.0rg/1999/xhtml">

Spread uses HTML tables for the display on the client side. When you define a row span, it defines the span for the
HTML table in the page. The default behavior in Internet Explorer for a spanned row in an HTML table is to resize to fit
the text. In Spread, the row is resized to avoid layout issues. There is little documentation outlining this behavior, but
you can test this behavior in Firefox where you do not see the cell resize itself to display the full text. However, it does
not force the horizontal scroll bar to remain.

Understanding Parts of the Component Interface

The generated Spread component interface is made up of the tool bars (which can appear above and below the
spreadsheet) and the sheet that displays the data. The figure below shows the major parts of the component interface
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that can be customized.
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More information about the component is available in Customizing the Appearance of the Overall Component
and Customizing Interaction with the Overall Component.

The command bar, the optional page navigation bar, and the scroll bars are described in more detail in Customizing
the Tool Bars.

The row and column headers, considered part of the sheet, are described in more detail in Customizing the
Appearance of Headers.

For more information on the data area, including the sheet, the rows and columns, and the cells, refer to Customizing
the Appearance of the Sheet, Customizing the Appearance of Rows and Columns, and Customizing the
Appearance of a Cell.

Working with Collection Editors

Several properties that appear in the Properties window are associated with collections. To view and modify these
settings, click on the Browse button (...) and a separate Collection Editor window appears. This is the case for the
NamedStyles ('NamedStyles Property’' in the on-line documentation) property and the Sheets ('Sheets
Property' in the on-line documentation) property in the FpSpread component.

Browse button
(to open editor)

DataMernber

Datasource

Sheets {Collection} __I
Froperty name That it iz a collection

With these collection editors, you must click OK to see the results of a change to a setting. (The collection editors are
part of the Microsoft .NET framework and do not have an Apply button.)
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Working with Web Parts

You can allow Spread for ASP.NET work as a Web Part in a Microsoft SharePoint environment. To do so, follow these
steps:

1. Set the trust level to full. Set the TrustLevel in SharePoint web.config to Full.

2. Mark the Spread DLLs safe in web.config (FarPoint.CalcEngine.dll, FarPoint.Excel.dll and
FarPoint.Web.Spread.dll).

This assumes you are using the latest version of SharePoint (WSS or MOSS). For earlier versions of SharePoint you also
had the additional step of excluding the fp_ client folder from the SharePoint server. This is no longer necessary.

Spread can be used inside the Web Part you are developing.

In earlier versions of the product, the FpSpread.RenderWebPart method was used for the .NET Framework 1.x when you
created a Web Part based on Microsoft.SharePoint. WebPartPages.WebPart class. In .NET Framework 2.x, the Web Part
becomes part of the framework. If you use the framework WebPart class,
System.Web.UL.WebControls.WebParts.WebPart, the FpSpread.RenderWebPart method is no longer needed.

See a good introduction to Web Parts at:

e https://msdn.microsoft.com/en-us/library/ee231579.aspx

Working with Windows Azure

You can use Spread for ASP.NET in a Windows Azure project. Use the following steps:

1. Copy the fp_client folder to your WebRole project folder.
2. Include this fp_ client folder in your WebRole project and add the following setting to the web.config file.

Code

<appSettings>
<add key="fp client" value="fp client"/>
</appSettings>

You do not need to edit web.config if you use the development fabric in Visual Studio.

You can also use the Chart control in a Windows Azure project. You would need to add the ChartImageHttpHandler to
the web server section of the web.config file. If you are using integrated managed pipeline mode, set
validateIntegratedModeConfiguration to False. For example:

Code

<system.webServer>
<validation validateIntegratedModeConfiguration="false"/>
<handlers>

<add name="chart" path="FpChart.axd" verb="*"
type="FarPoint.Web.Chart.ChartImageHttpHandler" />

Working with Microsoft ASP.NET MVC 5

You can use Spread for ASP.NET in an MVC 5 project. MVC support in Spread for ASP.NET requires Microsoft ASP.NET
MVC 5, Microsoft Visual Studio 2013 with .NET 4.0 Framework, and the Microsoft ADO.NET Entity 4.1 Framework.

The Razor view generally uses @ in front of the name and the ASPX view generally uses <% %>around the name. Use
the following steps to create a project with Spread:
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1. Reference FarPoint.Mvc.Spread.dll and FarPoint.Web.Spread.dll in the project.
2. Add the Spread information to the Licenses.licx file:

Code

FarPoint.Web.Spread.FpSpread, FarPoint.Web.Spread, Version=10.40.20162.0,
Culture=neutral, PublicKeyToken=327c3516b1b18457
FarPoint.Mvc.Spread.FpSpread, FarPoint.Mvc.Spread, Version=10.40.20162.0,
Culture=neutral, PublicKeyToken=327c3516bl1b18457

3. Open Global.asax.cs, go to the Application_ Start function and add the following registration code:

& Ifyou use Spread MVC on .NET Framework 4.0 or above, remove
FarPoint.Mvc.Spread.MveSpreadVirtualPathProvider.ApplInitialize(); from Application_ Start().

C#

protected void Application Start ()

{

//FarPoint .Mvc.Spread.MvcSpreadVirtualPathProvider.AppInitialize();
AreaRegistration.RegisterAllAreas();

RegisterGlobalFilters (GlobalFilters.Filters);

RegisterRoutes (RouteTable.Routes) ;
//ModelBinders.Binders.DefaultBinder =

ModelBinders.Binders|[typeof (FarPoint.Mvc.Spread.FpSpread)];
//ModelBinders.Binders.Add (typeof (FarPoint.Mvc.Spread.FpSpread), new
FarPoint.Mvc.Spread.MvcSpreadModelBinder ()) ;

}

4. Declare Spread with the MVC Spread namespace:
Code

@using FarPoint.Mvc.Spread; or <%@ Import Namespace="Farpoint.Mvc.Spread"
%>

This allows you to have an MVC Spread with the following code:

Code
@Html.FpSpread ("FpSpreadl"); or <%=Html.FpSpread ("FpSpreadl") %>

FpSpreadz is the Spread ID. It should be unique.

5. Provide access to MVC Spread from the Controller. When the user posts back data to the server, the developer

can access the declared MVC Spread as an argument (the Spread has full ViewState and new postback data). For
example:

C#

public ActionResult

Index ([FarPoint.Mvc.Spread.MvcSpread]FarPoint.Mvc. Spread.FpSpread FpSpreadl)
{

ViewBag.Message = "Welcome to GrapeCity";

if (FpSpreadl != null)

{

var value = FpSpreadl.ActiveSheetView.Cells[0, 0].Value;

}

return View () ;

}
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If you do not want to use an attribute, open the Global.asax.cs and uncomment one of the lines in step 3.
Make sure the Spread ID is the same in the view code and in the controller action parameter.

6. Attach Spread events:

Spread supports attaching events from the Controller only. If there is an AJAX postback, the Spread events will
not be handled. MvcSpread allows attaching 3 main events: Init, Load, and PreRender. Events can be grouped or
ungrouped. Use one of the following methods to handle the event:

Create a function with a special name.

The special name indicates that “I want to bind this function to a Spread event”. For example, to attach to the
Load event of FpSpreadi, the function looks like the following:

C#

public void FpSpreadl Load(object sender, EventArgs e)

{

}

Use MvcSpreadEventAttribute.

In some cases, you may want to reserve a special name (like “FpSpreadl Load”).
This can only be done by using the second method: MvcSpreadEventAttribute. The
event handler can be shared globally or in a group.

This example handles the Init event for all FpSpreads with the ID of FpSpreadl in
any view, globally:

[FarPoint.Mvc. Spread.MvcSpreadEvent ("Init", "FpSpreadl")]

private void init (object sender, EventArgs e)

{

}

This solution also provides the ability to bind one function to many different Spreads. The following example
handles the Init event for all FpSpreads with the ID of FpSpread1 or FpSpread2 in any view, globally:

C#

[FarPoint.Mvc.Spread.MvcSpreadEvent ("Init", new string[] {"FpSpreadl",
"FpSpread2"}) ]

private void init (object sender, EventArgs e)
{
}

The second solution requires that you indicate implicitly that the function (with special name) should not be
attached automatically:

C#

[FarPoint.Mvc. Spread.NoMvcSpreadEvent]

private void FpSpreadl Init (object sender, EventArgs e)
{

}

By attaching to the Init or Load event, you can attach to other custom Spread events such as TopRowChange,
UpdateCommand, and so on.
Additional information about global, grouped, and ungrouped events:
Attaching events with a grouped MvcSpread:
If the MvcSpread is grouped, use a group name. For example:
C#

// groupName is "GroupName" -> grouped
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public ActionResult Index ([MvcSpread ("GroupName", false)] FpSpread FpSpreadl)
// no groupName specified -> not grouped

public ActionResult Index ([MvcSpread(false)] FpSpread FpSpreadl)

The following examples show how to handle group events:
C#

// method Func3() 1is used to handle the Load event for all FpSpreads with ID of
FpSpreadl in any view, inside the group called "GroupName"

[MvcSpreadEvent ("Load", "GroupName", "FpSpreadl")]

private void Func3 (object sender, EventArgs e)

{
}

// method Func4 () is used to handle the Load event for all FpSpreads with ID of
FpSpreadl, or FpSpread2 in any view, inside the group called "GroupName"
[MvcSpreadEvent ("Load", "GroupName", new string[] { "FpSpreadl", "FpSpread2" })]
private void Func4 (object sender, EventArgs e)

{

}

Any function named “[Spread ID]_[Event Name]” is treated as a global event handler. The event name is

indicated by [Event Name] and only an MvcSpread with an ID the same as [Spread ID] can handle this event
handler:

C#

// this is a global handler for all FpSpreadl Load events
public void FpSpreadl Load(object sender, EventArgs e)

{

}

You can exclude some groups (that contain FpSpread controls that are not handled by this method) from global
event handlers. These groups can be referenced by their names. For example:

C#

// method abc() is used to handle the Load event for all FpSpreadl controls,
excluding the ones that belong to GroupNamel or GroupName?2

[MvcSpreadEvent ("Load", "FpSpreadl")]

[MvcSpreadEventExclude ("GroupNamel", "GroupName2") ]

public void abc (object sender, EventArgs e)

{

}

// this method is used to handle the Load event for all FpSpreadl controls,
excluding the ones that belong to GroupNamel or GroupName?2
[MvcSpreadEventExclude ("GroupNamel", "GroupName2") ]

public void FpSpreadl Load(object sender, EventArgs e)

{
}
Developer does not declare MvcSpread inside controller:

The MvcSpread is ungrouped if the MvceSpread is declared inside the view. Using a group name with MvcSpread
in the view may cause issues since there is a case where the group name in the controller and the group name in
the view are different. If MvcSpread is not declared in the controller, the events are attached to global event

handlers only.
Developer declares MvcSpread inside controller:

If the event handlers are global (group name not declared in MveSpreadEventAttribute), they attach to all Spread
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controls whether grouped or not.

If the event handlers are private (group name explicitly declared in MveSpreadEventAttribute), they attach only
to Spread controls with the same group name.

Spread controls without a group name are attached by global event handlers.
If there are two event handlers for the same event, the first one is private and the second one is global.

The current Spread looks for the global event handler first when binding events. If found, binding for the current
event happens first. The private one with the same group name happens next.

Note: Using the create parameter to notify MvcSpreadModelBinder to create a new instance of MvcSpread the
first time does not affect attaching events.An event handler is attached to MvcSpread if the event ID list contains
the MvcSpread ID, regardless of whether the event handler is private or global.

7. Pass MVC Spread from Controller to View:
If an instance of FpSpread is created by a model, it is applied to the view automatically. The code that renders
FpSpread with the same ID, renders the current FpSpread to the client browser:

C#

public ActionResult Index ([MvcSpread(true)] FpSpread FpSpreadl)
{

FpSpreadl.ActiveSheetView.Rows.Count = 30;

return View () ;

}

In the parameter list Index() action the FpSpread1 is declared specifically as [MveSpread(true)] FpSpread
FpSpread1. When running this code, a new instance of FpSpread is created by our ModelBinder. The
ActiveSheetView.Rows.Count is set to 30, and then this instance is applied to the view automatically. The
FpSpread control with the ID of "FpSpread1" in the view receives these changes.

Working with Microsoft ASP.NET MVC 3

You can use Spread for ASP.NET in an MVC 3 project. MVC support in Spread for ASP.NET requires Microsoft ASP.NET
MVC3, Microsoft Visual Studio 2010 with .NET 4.0 Framework, and the Microsoft ADO.NET Entity 4.1 Framework.

The Razor view generally uses @ in front of the name and the ASPX view generally uses <% %>around the name. Use
the following steps to create a project with Spread:

1. Reference FarPoint.Mvc.Spread.dll and FarPoint.Web.Spread.dll in the project.
2. Add the Spread information to the Licenses.licx file:

Code

FarPoint.Web.Spread.FpSpread, FarPoint.Web.Spread, Version=8.40.20143.0,
Culture=neutral, PublicKeyToken=327c3516b1b18457
FarPoint.Mvc.Spread.FpSpread, FarPoint.Mvc.Spread, Version=8.40.20143.0,
Culture=neutral, PublicKeyToken=327c3516b1b18457

3. Open Global.asax.cs, go to the Application_ Start function and add the following registration code:
C#

protected void Application Start ()

{
FarPoint.Mvc.Spread.MvcSpreadVirtualPathProvider.AppInitialize();
AreaRegistration.RegisterAllAreas();

RegisterGlobalFilters (GlobalFilters.Filters);

RegisterRoutes (RouteTable.Routes) ;
//ModelBinders.Binders.DefaultBinder =
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ModelBinders.Binders[typeof (FarPoint.Mvc.Spread.FpSpread) ];
//ModelBinders.Binders.Add (typeof (FarPoint.Mvc.Spread.FpSpread), new
FarPoint.Mvc.Spread.MvcSpreadModelBinder ()) ;

}

4. Declare Spread with the MVC Spread namespace:
Code

@using FarPoint.Mvc.Spread; or <%@ Import Namespace="Farpoint.Mvc.Spread"
&>

This allows you to have an MVC Spread with the following code:
Code

@Html.FpSpread ("FpSpreadl™); or <%$=Html.FpSpread ("FpSpreadl") %>

FpSpread1 is the Spread ID. It should be unique.

5. Provide access to MVC Spread from the Controller. When the user posts back data to the server, the developer

can access the declared MVC Spread as an argument (the Spread has full ViewState and new postback data). For
example:

C#

public ActionResult

Index ([FarPoint.Mvc.Spread.MvcSpread] FarPoint.Mvc.Spread.FpSpread FpSpreadl)
{

ViewBag.Message = "Welcome to GrapeCity";

if (FpSpreadl != null)

{

var value = FpSpreadl.ActiveSheetView.Cells[0, 0].Value;

}

return View () ;

}

If you do not want to use an attribute, open the Global.asax.cs and uncomment one of the lines in step 3.
Make sure the Spread ID is the same in the view code and in the controller action parameter.

6. Attach Spread events:
Spread supports attaching events from the Controller only. If there is an AJAX postback, the Spread events will
not be handled. MvcSpread allows attaching 3 main events: Init, Load, and PreRender. Events can be grouped or
ungrouped. Use one of the following methods to handle the event:

Create a function with a special name.

The special name indicates that “I want to bind this function to a Spread event”. For example, to attach to the
Load event of FpSpreadi, the function looks like the following:

C#

public void FpSpreadl Load(object sender, EventArgs e)
{

}

Use MvcSpreadEventAttribute.

In some cases, you may want to reserve a special name (like “FpSpreadl Load”).
This can only be done by using the second method: MvcSpreadEventAttribute. The
event handler can be shared globally or in a group.

This example handles the Init event for all FpSpreads with the ID of FpSpreadl in
any view, globally:
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[FarPoint.Mvc. Spread.MvcSpreadEvent ("Init", "FpSpreadl")]
private void init (object sender, EventArgs e)

{

}

This solution also provides the ability to bind one function to many different Spreads. The following example
handles the Init event for all FpSpreads with the ID of FpSpread1 or FpSpread2 in any view, globally:

C#

[FarPoint.Mvc.Spread.MvcSpreadEvent ("Init", new string[] {"FpSpreadl",
"FpSpread2"}) ]

private void init(object sender, EventArgs e)
{
}

The second solution requires that you indicate implicitly that the function (with special name) should not be
attached automatically:

C#

[FarPoint.Mvc. Spread.NoMvcSpreadEvent]

private void FpSpreadl Init (object sender, EventArgs e)
{
}

By attaching to the Init or Load event, you can attach to other custom Spread events such as TopRowChange,
UpdateCommand, and so on.

Additional information about global, grouped, and ungrouped events:
Attaching events with a grouped MvcSpread:
If the MvcSpread is grouped, use a group name. For example:

C#

// groupName is "GroupName" -> grouped

public ActionResult Index ([MvcSpread ("GroupName", false)] FpSpread FpSpreadl)
// no groupName specified -> not grouped

public ActionResult Index ([MvcSpread(false)] FpSpread FpSpreadl)

The following examples show how to handle group events:
C#

// method Func3() is used to handle the Load event for all FpSpreads with ID of
FpSpreadl in any view, inside the group called "GroupName"

[MvcSpreadEvent ("Load", "GroupName", "FpSpreadl")]

private void Func3 (object sender, EventArgs e)

{

}

// method Func4 () is used to handle the Load event for all FpSpreads with ID of
FpSpreadl, or FpSpread? in any view, inside the group called "GroupName"
[MvcSpreadEvent ("Load", "GroupName", new string[] { "FpSpreadl", "FpSpread2" })]
private void Func4 (object sender, EventArgs e)

{

}

Any function named “[Spread ID]_[Event Name]” is treated as a global event handler. The event name is
indicated by [Event Name] and only an MvcSpread with an ID the same as [Spread ID] can handle this event
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handler:
C#

// this is a global handler for all FpSpreadl Load events
public void FpSpreadl Load(object sender, EventArgs e)

{

}

You can exclude some groups (that contain FpSpread controls that are not handled by this method) from global
event handlers. These groups can be referenced by their names. For example:

C#

// method abc() is used to handle the Load event for all FpSpreadl controls,
excluding the ones that belong to GroupNamel or GroupName?2

[MvcSpreadEvent ("Load", "FpSpreadl")]

[MvcSpreadEventExclude ("GroupNamel", "GroupName2") ]

public void abc (object sender, EventArgs e)

{

}

// this method is used to handle the Load event for all FpSpreadl controls,
excluding the ones that belong to GroupNamel or GroupName?2
[MvcSpreadEventExclude ("GroupNamel", "GroupName2") ]

public void FpSpreadl Load(object sender, EventArgs e)

{

}

Developer does not declare MvcSpread inside controller:

The MvcSpread is ungrouped if the MvceSpread is declared inside the view. Using a group name with MvcSpread
in the view may cause issues since there is a case where the group name in the controller and the group name in
the view are different. If MvcSpread is not declared in the controller, the events are attached to global event
handlers only.

Developer declares MvcSpread inside controller:

If the event handlers are global (group name not declared in MveSpreadEventAttribute), they attach to all Spread
controls whether grouped or not.

If the event handlers are private (group name explicitly declared in MveSpreadEventAttribute), they attach only
to Spread controls with the same group name.

Spread controls without a group name are attached by global event handlers.
If there are two event handlers for the same event, the first one is private and the second one is global.

The current Spread looks for the global event handler first when binding events. If found, binding for the current
event happens first. The private one with the same group name happens next.

Note: Using the create parameter to notify MvcSpreadModelBinder to create a new instance of MvcSpread the
first time does not affect attaching events.An event handler is attached to MvcSpread if the event ID list contains
the MvcSpread ID, regardless of whether the event handler is private or global.

7. Pass MVC Spread from Controller to View:

If an instance of FpSpread is created by a model, it is applied to the view automatically. The code that renders
FpSpread with the same ID, renders the current FpSpread to the client browser:

C#

public ActionResult Index ([MvcSpread(true)] FpSpread FpSpreadl)
{
FpSpreadl .ActiveSheetView.Rows.Count = 30;
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return View () ;

}

In the parameter list Index() action the FpSpread1 is declared specifically as [MvcSpread(true)] FpSpread
FpSpread1. When running this code, a new instance of FpSpread is created by our ModelBinder. The
ActiveSheetView.Rows.Count is set to 30, and then this instance is applied to the view automatically. The
FpSpread control with the ID of "FpSpread1" in the view receives these changes.

Copying Shared Assemblies to Local Folder

FarPoint.CalcEngine.dll, FarPoint.Excel.dll, and FarPoint.PDF.dll are installed to the GAC by default when installing
Spread for ASP.NET.

You can use the smart tag verb "Copy Shared Assemblies Local" to copy FarPoint.CalcEngine.dll, FarPoint.Excel.dll, and
FarPoint.PDF.dIl to the local bin folder on the web site when deploying.

The smart tag verb appears as follows:
El FpSpread Tasks
Choose Data Source: kNDnﬂ ¥
Edit Sheets...
Spread Designer...
Spread Cuick Start Wizard...
[ ] EditModeReplace
EnablefjaxCall
[] ClientAuteCalculation
[ ] Allow Deleting
[ ] Allow Inserting
Allow Paging
[ ] Allow Sorting
Allow User Formulas
Copy Shared Assemblies Local
Reset Spread Control
Operation Mode: Maormal W
Sheet Skins...
(1D FpSpreadi
Version: §_40 20141 0
Edit Templates

The following entry is added to the web.config file:
Code

<appSettings>
<add key="fp CopySharedAssembliesLocal" value="True" />
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</appSettings>

Working with Strongly Typed Data Controls

Strong-typed data controls support binding using a new syntax that is available in ASP.NET 4.5. This allows you to
directly reference properties on the data source object in the markup. For example, in order to bind data to
PreviewRowTemplate and RowEditTemplate before ASP.NET 4.5, code to bind to the FirstName property on your
data source item looked like this:

Code

<FarPoint:FpSpread ID="FpSpreadl">
<Sheets>
<FarPoint:SheetView SheetName="Sheetl">
<PreviewRowTemplate>
First Name is: <%$#DataBinder.Eval (Item, "FirstName") %>
</PreviewRowTemplate>
<RowEditTemplate>
First Name is: <%#DataBinder.Eval (Item, "FirstName") %>
</RowEditTemplate>
</FarPoint:SheetView>
</Sheets>
</FarPoint:FpSpread>

With ASP.NET 4.5 you can use code like the following:

Code

<FarPoint:FpSpread ID="FpSpreadl">
<Sheets>
<FarPoint:SheetView SheetName="Sheetl">
<PreviewRowTemplate>
First Name is: <%$#Item.FirstName %>
</PreviewRowTemplate>
<RowEditTemplate>
First Name is: <%$#Item.FirstName %>
</RowEditTemplate>
</FarPoint:SheetView>
</Sheets>
</FarPoint:FpSpread>

Using code in your markup this way allows you to get the added benefits of IntelliSense listing of your data source
object's properties and validation of the property name at design time.

Getting More Practice

Here are the tasks for getting more practice with the product.

¢ Understanding Procedures in the Documentation
¢ Getting Technical Support (on-line documentation)

Understanding Procedures in the Documentation

There are several different ways to accomplish the same result when creating a Windows Forms page with a Spread
component. In this documentation, the procedures often describe more than one way, including using the Properties
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window in Visual Studio .NET, writing code including using shortcut objects, and using the Spread Designer. The Spread
Designer sets properties and calls methods for the component, including properties not available at design time through
Visual Studio .NET, without producing any editable code.

Each of these has its advantages and disadvantages. Using shortcut objects is the shortest, quickest way of adding code
using dot notation and setting a property of a shortcut object. Using code without using shortcut objects generally means
declaring objects and setting properties for them. Typically, for either way of writing code, there is an example given.

Documentation Provided

The Spread for ASP.NET documentation provides introductory information about the product, conceptual information,
how-to topics, and a detailed assembly and formula function reference in a help file and in PDF files. Additional
information is provided in the Read me file.

Accessing the Help

You can access the help through F1 support provided in Visual Studio .NET. While the component or one of its members
has focus, press F1 to display the Spread for ASP.NET help.

You can also access the help file in a stand-alone window by choosing Start->Programs->GrapeCity->...->Product-
>Help.

Documentation Conventions

The format of the help is similar to the help provided for Visual Studio .NET. Reference material for members provides
multiple language reference for the member. You can change which language's syntax is displayed by clicking the
Languages button in the title of the topic.

List of How-To's

Here is a list of the commonly used procedures covered in the documentation:

¢ Adding a Note to a Cell

e Adding a Row or Column

e Adding a Sheet

e Applying a Skin to a Sheet

¢ Customizing the Dimensions of the Component
e Customizing the Number of Rows or Columns
¢ Creating a Custom Function

e Creating a Custom Name

¢ Creating a Skin for Sheets

¢ Creating Alternating Rows

¢ Customizing the Outline of the Component
¢ Customizing the Sheet Corner

¢ Displaying Grid Lines on the Sheet

¢ Displaying Scroll Bars

e Locking a Cell

¢ Nesting Functions in a Formula

¢ Opening Existing Files

¢ Placing a Formula in Cells

e Removing a Row or Column

e Removing a Sheet

e Saving Data to a File
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¢ Setting the Background Color of the Sheet

¢ Setting the Row Height or Column Width

¢ Specifying a Cell Reference Style in a Formula
¢ Using a Circular Reference in a Formula

e Working with Editable Cell Types

e Working with Graphical Cell Types

Getting Technical Support

If you have a technical question about this product, consult the following sources:

¢ Help and other documentation files installed with the product.
For instructions for accessing the help and other documentation files, see Understanding Procedures in
the Documentation.

e Product forum at https://www.grapecity.com/en/forums#spread

If you cannot find the answer using these sources, please contact Technical Support using one of these methods:

Web site: https://www.grapecity.com/en/forums
E-mail: spread.support@grapecity.com

Fax: (412) 681-4384

Phone: (412) 681-4738

Technical Support is available between the hours of 9:00 a.m. and 5:30 p.m. Eastern time, Monday through Friday.

Understanding the Spread Wizard

You can use the Spread Wizard to quickly and easily bind data, set up the column structure, and customize the
appearance of a spreadsheet. See the following topics for more information:

e Starting the Spread Wizard
e Using the Spread Wizard

Starting the Spread Wizard

You can launch the Spread Wizard from the Smart Tags on the FpSpread component on the Web Form in Visual Studio
as shown in this figure.
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FpSpread Tasks

Choose Data Source: | (Mone) ¥

Edit Sheets...

Spread Designer...

Spread Cuick Start Wizard...
[] EditModeReplace

EnahblefjaxCall

] ClientAutoCalculation

[] Allow Deleting

] Allow Inserting

Allow Paging

L] Allow Sorting

Allow User Formulas

[] Copy Shared Assemblies Local

Reset Spread Control

Operation Mode: Marrmal "
Sheet Skins...
(1o FpSpread?

Version: 10_40_20172_0
Edit Templates

Using the Spread Wizard

You can use the Spread Wizard to bind to a data source, set column properties, set the operation mode, specify titles,
select a sheet skin, and many others.

Select the menu option of the feature you wish to customize, located on the left side of the dialog. Select the various
options for that feature and then click Next to go to the next step. When you are finished, click Finish.
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Spread Quick Start Wizard

Data Binding

Select a Data Source: |{Nune} W ki
Column Settings
Select 3 Table (Data Member): | v
Cperation Mode
CommandBar, GroupBar
TitleBar
Ajax and LoadOnDemand
Sheet Skin
Previous Mext = Finish Cancel

Tutorial: Creating a Checkbook Register

The following tutorial walks you through creating an ASP.NET project in Visual Studio .NET using the Spread for
ASP.NET component. By creating a checkbook register, you will learn how to modify the appearance of a spreadsheet,
work with cell types, and add some formulas for performing calculations. In this tutorial, the major steps are

¢ Adding Spread to the Checkbook Project

¢ Adding Spread to a Project

e Setting Up the Rows and Columns of the Register

¢ Setting the Cell Types of the Register

¢ Adding Formulas to Calculate Balances

Adding Spread to the Checkbook Project

Start a new Visual Studio .NET project. Name the project checkbook. Name the form in the project register.aspx. Add
the FpSpread component to your project, and then place the component on the form.

If you do not know how to add the FpSpread component to the project, complete the steps in Adding Spread to a
Project.
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Adding Spread to a Project

This and all the tutorials assume that you have Visual Studio .NET installed on your system, and Internet Information
Services (IIS) installed and running on your system as the local host server.

Perform the steps in this tutorial to set up an ASP.NET Visual Studio .NET project that contains the Spread for ASP.NET
component.

1.

oo

10.
11.

12.
13.
14.

15.
16.

17.

Start Visual Studio .NET.

2. From the File menu, choose New, Project.
3.
4. In the Project Types list, choose either Visual Basic Projects or Visual C# Projects depending on the

In the New Project dialog,

language you are using.
In the Templates list, choose ASP.NET Web Application.

In the Location box, leave the location path as http://localhost/ unless you prefer to save this project to another
server. Change the project name from WebApplication1 to the name of your choice.

Click OK.

In the Solution Explorer, right-click on the form name, WebFormi.aspx. Choose Rename from the pop-up
menu, then type the new form name you prefer for the new form name.

If your project does not display the Solution Explorer, from the View menu, choose Solution Explorer.
If the Toolbox is not displayed, from the View menu choose Toolbox.

In the Toolbox, look in the Web Forms category (or in other categories if you have installed Spread and placed
the toolbox icon in a different category). If the Spread component is not in the Toolbox, perform steps 12
through 14. Otherwise, proceed to step 15.

Right-click in the Toolbox, and from the pop-up menu choose Customize Toolbox.
In the Customize Toolbox dialog, click the NET Framework Components tab.
In the .NET Framework Components tab,

a. Click Browse.

b. Browse to the installation path for the Spread for ASP.NET component. Once there, select
FarPoint.Web.Spread.dll and click Open.

c. The FpSpread component is now displayed in the list of components. Click OK.
In the Toolbox under Web Forms or another tab, select the FpSpread component.
On your form, draw an FpSpread component.
Save your project.

Your project should now look similar to the following image:
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You have added the Spread component to the project.

Setting Up the Rows and Columns of the Register

The Spread component on your form already has a sheet, ready for you to configure. In this step, you are going to set up
the columns and cells in the sheet to resemble a checkbook register.

1. Double-click on the form in your project to open the code window.
2. Select the line of code

C#

// Put user code to initialize the page here.

VB

'Put user code to initialize the page here.

and type the following code to replace it:
C#

if (this.IsPostBack) return;

// Set up component and rows and columns in sheet.
FpSpreadl.Height = Unit.Pixel (300);

FpSpreadl .Width = Unit.Pixel (763);
FpSpreadl.Sheets[0] .ColumnCount = 8;
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FpSpreadl.Sheets[0] .RowCount

100;

56

VB

If (IsPostBack) Then

Return

End If

' Set up component and rows and columns in sheet.
FpSpreadl.Height = Unit.Pixel (300)

FpSpreadl .Width = Unit.Pixel (763)
FpSpreadl.Sheets (0) .ColumnCount = 8
FpSpreadl.Sheets (0) .RowCount = 100

This code sets up the component to be 300 pixels high and 763 pixels wide, and the sheet to have 8 columns and

100 rows.

3. Now we need to set up the columns to have custom headings. Add the following code below the code you added in

Step 2:
C#

// Add text to column heading.

FpSpreadl.

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

VB

ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.

Cells

' Add text to column heading.

FpSpreadl

FpSpreadl.

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

.ColumnHeader.
ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.
.ColumnHeader.

Cells

.Text
.Text
.Text
. Text
. Text
.Text
.Text
.Text

o0l W N O

.Text
.Text
.Text
.Text
. Text
. Text
.Text
.Text

oUW NP O

"Check #";
"Date";
"Description";
"Tax?";
"Cleared?";
"Debit";
"Credit";
"Balance";

"Check #"
"Date"
"Description"
"Tax?"
"Cleared?"
"Debit"
"Credit"
"Balance"

4. Now set up the column widths to properly display our headings and the data you will add. Add the following code
below the code you added in Step 3:

C#

// Set column widths.

FpSpreadl
FpSpreadl
FpSpreadl

FpSpreadl.

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

VB

.Sheets[0] .Columns[0]
.Sheets[0] .Columns[1]
.Sheets[0] .Columns[2]
Sheets[0] .Columns[3]
.Sheets[0] .Columns[4]
.Sheets[0] .Columns[5]
.Sheets[0] .Columns[6]
.Sheets[0] .Columns[7]
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65;
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' Set column widths.

FpSpreadl.Sheets (0) .Columns (0)
FpSpreadl.Sheets (0) .Columns (1) .Width = 50
FpSpreadl.Sheets (0) .Columns (2) .Width = 200
FpSpreadl.Sheets (0) .Columns (3) .Width = 40
FpSpreadl.Sheets (0) .Columns (4) .Width = 65
(0) (5)
(0) (6)
(0) (7)

.Width = 50

FpSpreadl.Sheets .Columns .Width = 100
FpSpreadl.Sheets .Columns .Width = 100
FpSpreadl.Sheets .Columns .Width = 125

5. Save your project, then from the Debug menu choose Start to run your project.

Your ASP.NET page should look similar to the following picture.

Ch;"':k Date Description Tax? Cleared?|  Debit Credit Balance
1
2
3
4
5
6
7
g
9
10| . -
=i

Setting the Cell Types of the Register

To set cell types, for each custom cell type, you have to create a cell type object, set the properties for it, and then assign

that object to the CellType ('CellType Property' in the on-line documentation) property for a cell or range of
cells.

1. Set the cell type for the Check # column by adding the following code below the code you have already added:
C#

// Create Check # column of integer cells.
FarPoint.Web.Spread.IntegerCellType objIntCell = new
FarPoint.Web.Spread.IntegerCellType () ;
FpSpreadl.Sheets[0] .Columns[0].CellType = objIntCell;

VB

' Create Check # column of integer cells.
Dim objIntCell As New FarPoint.Web.Spread.IntegerCellType ()
FpSpreadl.Sheets (0) .Columns (0) .CellType = objIntCell

2. Set the cell type for the Date column by adding the following code below the code you have already added:
C#

// Create Date column of date-time cells.
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FarPoint.Web.Spread.DateTimeCellType objDateCell = new
FarPoint.Web.Spread.DateTimeCellType () ;
objDateCell.FormatString = "M/dd/yyyy";
FpSpreadl.Sheets[0] .Columns[1l].CellType = objDateCell;

VB

' Create Date column of date-time cells.

Dim objDateCell As New FarPoint.Web.Spread.DateTimeCellType ()
objDateCell.FormatString ="M/dd/yyyy"
FpSpreadl.Sheets (0) .Columns (1) .CellType = objDateCell

3. Set the cell type for the Description column by adding the following code below the code you have already added:
C#

// Create Description column of general cells.
FarPoint.Web.Spread.GeneralCellType objGenCell = new
FarPoint.Web.Spread.GeneralCellType () ;
FpSpreadl.Sheets[0] .Columns[2] .CellType = objGenCell;

VB

' Create Description column of general cells.
Dim objGenCell As New FarPoint.Web.Spread.GeneralCellType ()
FpSpreadl.Sheets (0) .Columns (2) .CellType = objGenCell

4. Set the cell type for the Tax? and Cleared? columns by adding the following code below the code you have already
added:

C#

/// Create Tax? and Cleared? columns of check box cells.
FarPoint.Web.Spread.CheckBoxCellType objCheckCell = new
FarPoint.Web.Spread.CheckBoxCellType () ;

FpSpreadl.Sheets[0] .Columns[3].CellType objCheckCell;
FpSpreadl.Sheets[0] .Columns[4] .CellType = objCheckCell;

VB

' Create Tax? and Cleared? columns of check box cells.
Dim objCheckCell As New FarPoint.Web.Spread.CheckBoxCellType ()
FpSpreadl.Sheets (0) .Columns (3) .CellType = objCheckCell
FpSpreadl.Sheets (0) .Columns (4) .CellType = objCheckCell

5. Set the cell type for the Debit, Credit, and Balance columns by adding the following code below the code you have
already added:

C#

// Create the Debit, Credit, and Balance columns of currency cells.
FarPoint.Web.Spread.CurrencyCellType objCurrCell = new
FarPoint.Web.Spread.CurrencyCellType () ;

FpSpreadl.Sheets[0] .Columns[5] .CellType = objCurrCell;
FpSpreadl.Sheets[0] .Columns[6] .CellType objCurrCell;
FpSpreadl.Sheets[0] .Columns[7] .CellType objCurrCell;

VB

' Create the Debit, Credit, and Balance columns of currency cells.
Dim objCurrCell As New FarPoint.Web.Spread.CurrencyCellType ()
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FpSpreadl.Sheets (0) .Columns (5) .CellType = objCurrCell
FpSpreadl.Sheets (0) .Columns (6) .CellType = objCurrCell
FpSpreadl.Sheets (0) .Columns (7) .CellType = objCurrCell

6. Save your project, then from the Debug menu choose Start to run your project.

Your ASP.NET page should look similar to the following picture.

Check

# Date Description Tax?|Cleared? Debit Credit
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Adding Formulas to Calculate Balances

Your checkbook register is now set up to look like a checkbook register; however, it does not balance the currency figures

you enter in the register. This step sets up the formula for balancing the figures.
1. Below the code you have already added, add the following code:
C#

// Set formula for calculating balance.
FpSpreadl.Sheets[0] .ReferenceStyle =
FarPoint.Web.Spread.Model.ReferenceStyle.R1C1;

FpSpreadl.Sheets[0].Cells [0, 7].Formula = "RC[-1]-RC[-2]1";
for (int 1 = 1; 1 < 99; 1i++)
{
FpSpreadl.Sheets[0].Cells[i, 7].Formula = "R[-1]C-RC[-2]+RC[-1]";
}
VB

' Set formula for calculating balance.

FpSpreadl.Sheets (0) .ReferenceStyle = FarPoint.Web.Spread.Model.ReferenceStyle.R1C1

FpSpreadl.Sheets (0) .Cells (0, 7).Formula = "RC[-1]-RC[-2]"
Dim i As Integer
For 1 = 1 To 99
FpSpreadl.Sheets (0) .Cells (i, 7).Formula = "R[-1]C-RC[-2]+RC[-1]"
Next

2. Save your project, then from the Debug menu choose Start to run your project.

Your ASP.NET page should look similar to the following picture. Type data into your checkbook register to test it and see
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how it operates. Click on the checkmark icon to save the changes or set the ClientAutoCalculation property for the
control to True.

Check
H
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Your checkbook register is complete! You have completed this tutorial.
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Understanding the Product

Spread for ASP.NET provides a completely new, object-oriented spreadsheet component for use in the Microsoft .NET
framework. The following topics provide an introduction to this unique and powerful product and explain some of the
underlying concepts.

Product Overview
Features Overview
Concepts Overview

e Namespaces Overview

Product Overview

Spread for ASP.NET is a comprehensive spreadsheet component for Web applications that combines grid capabilities,
spreadsheet functionality, and includes the ability to bind to data sources. A single component can contain many sheets,
columns, and rows. Cross-sheet referencing allows calculations to make use of data and formulas on a variety of sheets.
Spread for ASP.NET uses dot notation for object-oriented coding in .NET.

A Spread component may be dropped on a Web Form and customized for a range of applications. You can control the
appearance and the user interaction in a variety of ways. With a built-in Designer, you can quickly create a prototype or
customize your finished design. With most of the Spread’s appearance and functionality based on underlying models,
the advanced developer has complete control over the component.

The component resides on the server and generates HTML pages when it is accessed by end users on the client side. The
amount of interactivity of the Web page depends on the level of browser used on the client side. The view of the HTML
pages generated by the Spread component depends on the browser being used to view the page. Broadly, an uplevel
browser is one that can support client-side JavaScript, HTML version 4.0, the Microsoft Document Object Model, and
cascading stylesheets (CSS). For a more detailed definition of uplevel and downlevel browser and for a list of capabilities
of those browsers, refer to the browser capability information in the Microsoft .NET documentation. The component
also downloads some HTML component (HTC) files to the client side.

Import and export capabilities provide another source of flexibility when developing and exchanging designs. Spread for
ASP.NET can handle data from comma-delimited text files as well as multiple spreadsheets from Microsoft Excel files.

The following figure provides a conceptual overview of Spread for ASP.NET.
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In Spread, you can use the default models or extend them through inheritance. Refer to Underlying Models for more
information on models. Styles and named styles provide ways to save customized appearances that can be applied to
other sheets.

The Spread component contains toolbars and navigation aids, and a collection of sheets that contain row, column, cell,
and header objects. The contents of the component may be saved as a BIFF8 or XLSX file compatible with Microsoft
Excel or a text file or as a Spread XML file. For more information on exporting to (and importing from) a file, refer to the
Spread for ASP.NET Import and Export Reference.

For a list of many of the features, see Features Overview.
Features Overview

Spread for ASP.NET introduces some powerful features, as described in the following topics. Each topic refers to other
topics in the documentation that provide more information.

e AJAX Support
¢ ASP.NET AJAX Extenders
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¢ Built-In Functions

e Cell Types

e Chart Control

¢ Client-Side Scripting

¢ Conditional Formatting

¢ Context Menu

e Corner Customization

e Customized Appearance (Skins)
e Data Binding

¢ Floating Images (on-line documentation)
¢ Footers for Columns or Groups
¢ Formula Extender Control (on-line documentation)
¢ Frozen Rows and Columns

¢ Goal Seeking

¢ Grouping

¢ Headers with Multiple Columns and Rows
e Hierarchical Display

e Import and Export Capabilities
¢ Load on Demand

¢ Multiple-Line Columns

e Multiple Sheets

e PDF Support

e Printing

¢ Row Filtering

e Row Preview

e Row Template Editor

¢ Searching Features

¢ Sorting Capabilities

e Spannable Cells

e Sparklines

¢ Spread Designer

¢ Spread Wizard

e Theme Roller

e Title and Subtitle

¢ Touch Support

e Validation Controls

AJAX Support

You can allow support for AJAX (Asynchronous JavaScript and XML) to make your applications more responsive on the
client side.

For more information, refer to Enabling AJAX Support.

ASP.NET AJAX Extenders

You can use the many cell types in the FarPoint.Web.Spread.Extender assembly to provide controls that are available as
ASP.NET AJAX extenders.
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For more information, refer to Using ASP.NET AJAX Extenders.

Built-In Functions

You can use built-in functions and operators to develop formulas and perform calculations. Add calculations quickly to
your applications by using any of over 300 pre-defined algorithms or add your own custom functions.

For more information, refer to Managing Formulas and to the Formula Reference.

Cell Types

There are several different types of cells that can be set in a sheet to customize how the user interacts with the
information in that cell. You can specify the cell type for individual cells, columns, rows, a range of cells, or an entire
sheet. For each cell type there are properties of a cell that can be set. In general, working with cell types includes
defining the cell type, setting the properties, and applying that cell type to cells.

The following image displays many of the cell types that are available. You can also create multi-column combo, tag
cloud, and ajax extender cells.

Button Double List Box
Button | 45,65471 Fed
Check Box General Blue
This is a
Generic Cell Percent
Combo Box 69%
Hyperlink
www, fpoint. com Radio Button
8 One 8 Two 8 Three
Image
Currency FarPeint Regular Expression
$42,334.00 IS5 (ex, 123-45-6789 )]
123-45-6739
DateTime Integer IQ
o/14/2002 1243 Text
Label This is a i’
T abe] mmulti-line
abe Text cell, ;I

For a complete list of cell types, refer to Customizing with Cell Types.
Header Cells

While you can assign a cell type to the cells in the row header or column header, the cell type is only used for painting
purposes.

Details
In Spread, a cell has both an editor, which determines how the user interacts with the value in the cell, a formatter,
which determines how the value is displayed, and a renderer which does the painting of the cell. The editor is an actual

control instance that Spread creates and places in the location of the cell when you go into edit mode. The formatter
decides how the displayed text appears. The renderer is simply code that paints that control inside the cell rectangle
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when the editor is not there.

Cell

Editor (IEditor)
Renderer {(IRenderer)
Formatter {IFormatter)

CellType (ICellType)

For more detailed information on these objects, refer to the individual interfaces in the Assembly Reference (on-
line documentation). For more general information about cell types and applying them to cells, columns, rows, or
whole sheets, refer to Customizing with Cell Types.

Chart Control

You can add a chart control to the Spread control or use the chart control stand alone. The chart control supports many
types of charts as well as 2D or 3D views.

For more information, refer to Working with the Chart Control.
Client-Side Scripting

With scripting you can run small programs, or scripts, in your Web pages on the client after the pages are downloaded
from the server. Client-side scripting allows the user to interact with the page on the client without the page having to be
reloaded from the server. Scripts can be written in any scripting language supported by the browser on the client, such
as VBScript or JavaScript. Most often scripts are written in JavaScript (also referred to as ECMAScript).

Spread for ASP.NET gives you client-side scripting capabilities to enhance the power of your Web Forms. In addition,
you can also create your own HTC files for specific purposes.

Spread for ASP.NET client side features are enabled for IE 5.5 and above. For other browsers, there may be no client
side scripting support or it may be limited.

For more information, refer to the Spread for ASP.NET Client-Side Scripting Reference (on-line
documentation).

Conditional Formatting
You can set up conditional formats within cells that determine the formatting of the cell based on the outcome of a
conditional operation or rule.

For more information, refer to Using Conditional Formatting in Cells.

Context Menu

You can create a Spread context menu that is displayed when right-clicking on the Spread control. For more
information, see Adding a Context Menu.

Corner Customization

You can customize the sheet corner with text, colors, and various style settings.
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For more information, refer to Customizing the Sheet Corner.

Customized Appearance (Skins)

Easily and quickly configure the appearance of Spread using predefined skins or create and save your own custom skins.
Custom skins can be shared with everyone in your development team, allowing a consistent look of the component
across applications.

For more information about skins, refer to Applying a Skin to a Sheet and Creating a Skin for Sheets.
Data Binding

You can bind the spreadsheet to a data set to display and allow your users to edit information. Spread can automatically
update the data set with the changes. You can also bind a range of cells to a data source.

For more information about data binding, refer to Managing Data Binding.

Footers for Columns or Groups

You can display a footer at the bottom of the sheet that allows you to enter formulas or instructions with a footer cell for
each column. This feature also works with the grouping feature.

For more information, refer to Displaying a Footer for Columns or Groups.

Frozen Rows and Columns

You can freeze columns and rows (keep them non-scrollable) and keep them displayed regardless of where the user
navigates in the sheet.

For more information, refer to Freezing Rows and Columns.

Goal Seeking

You can use goal seeking capability to iterate toward a desired formula result. Use this if you know the result of a
formula but not the input value required to obtain the result.

For more information, refer to Finding a Value with Goal Seeking.
Grouping
You can set up the spreadsheet to group rows of data. This is useful for displaying large amounts of data in organized

groups.

For more information, refer to Customizing Grouping of Rows of User Data.

Headers with Multiple Columns and Rows

You can have multiple column headers and row headers. You can also span header cells. Use headers with multiple
columns or rows to organize your column and row data.

For more information, refer to Customizing the Appearance of Headers.
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Hierarchical Display

You can create a sheet within a row to display relational data hierarchically, with parent rows and child views of related
data.

For more information about hierarchical display of data, refer to Displaying Data as a Hierarchy.

Import and Export Capabilities

You can import data from and export data and formatting to Microsoft Excel, both individual spreadsheets and entire
workbooks. You can import and export entire spreadsheet(s) with data and formatting to and from XML.

For more information about opening and saving files, refer to Managing File Operations.

For more information about what happens during importing or exporting, refer to the Spread for ASP.NET Import and
Export Reference (on-line documentation).

Load on Demand

You can allow the Web page to load on demand. As the user scrolls further down the spreadsheet the Spread component
on the client loads another page of rows from the server as needed.

¢ FpSpread.AllowLoadOnDemand
e SheetView.AllowLoadOnDemand

For more information about this feature, refer to Allowing Load on Demand.

Multiple-Line Columns

For a more compressed format of displaying information, you may want to display columns with multiple lines of
information.

For more information on multiple-line columns, refer to Creating Row Templates (Multiple-Line Columns).

Multiple Sheets

Spread supports multiple sheets in a single component each uniquely named. Use multiple sheets to categorize your
information, similar to using worksheets in Microsoft Excel.

Sheets can have multiple rows and columns. You can define styles for sheets and apply those styles across multiple
sheets.

For more information about sheets, refer to Working with Multiple Sheets.

PDF Support

You can allow the user to save the spreadsheet to a PDF (Portable Document Format) file.

For more information, refer to Saving to a PDF File.
Printing

You can allow the user to print. You can also add headers and footers to the printed pages and customize the printed
page.

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 68

For more information, refer to Managing Printing.

Row Filtering

You can allow row filtering by hiding or changing the color of the filtered rows. You can also use a filter bar, simple
filtering, or enhanced filtering.

For more information, refer to Managing Filtering of Rows of User Data.

Row Preview

You can add a preview row that contains extra information about a row.

For more information, refer to Setting up Preview Rows.
Row Template Editor

You can use the row editor or template editor to type text.

For more information, refer to Setting up Row Edit Templates.

Searching Features

You can programmatically search the cell text, headers, notes, or tags. You can also specify the starting row and column
and the ending row and column.

Use the Search ('Search Method' in the on-line documentation) method or the SearchHeaders
('SearchHeaders Method' in the on-line documentation) method of the FpSpread ('FpSpread Class' in the
on-line documentation) object. For more information, refer to Searching for Data with Code.

Sorting Capabilities

You can sort rows or columns or a range of cells. You can programmatically sort data by rows or columns or allow your
users to sort rows automatically by clicking on the column header.

For more information, refer to Customizing Sorting of Rows of User Data

Spannable Cells

You can span cells. Create cell spans to join cells together, allowing one cell to span across multiple cells to include, for
example, your company logo. You can span data cells or headers.

For more information, refer to Spanning Cells.

Sparklines

You can add sparklines to a cell. A sparkline is a small graph that fits inside a cell and uses data from a range of cells.

For more information, refer to Using Sparklines.

Spread Designer
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You can use the Spread Designer to design your component and to create a prototype quickly. Use the Spread Designer
to reduce development time by allowing you to customize the look and feel of the component at design time using an
intuitive, easy-to-use interface.

For more information refer to Working with the Spread Designer.

Spread Wizard

You can use the Spread Wizard to design your component and to create a prototype quickly.

For more information refer to Using the Spread Wizard.

Theme Roller

Spread supports using a Theme Roller theme in the Spread control.

For more information, refer to Using the jQuery Theme Roller with Spread.

Title and Subtitle

You can add a title to the Spread component and subtitle to the sheet.

For more information refer to Adding a Title and Subtitle to a Sheet.

Touch Support

The Spread control supports touch gestures in many areas.

For more information, refer to Using Touch Support with the Component.

Validation Controls

You can prevent a user from entering invalid characters in a cell by using a validation control in the Spread cell.

For more information, refer to Using Validation Controls.

Concepts Overview

While those familiar with previous generations of Spread products understand the object oriented nature of Spread for
ASP.NET, there are several concepts that are worth reviewing for new users.

¢ Shortcut Objects

¢ Object Parentage

e Underlying Models

e Cell Types

¢ SheetView versus FpSpread

¢ Formatted versus Unformatted Data
e Zero-Based Indexing

¢ Client-Side Scripting

e Maintaining State

Shortcut Objects

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide /0

The spreadsheet objects in the Spread namespace, which represent various parts of the spreadsheet, can be accessed
through a set of built-in shortcut objects. The shortcut objects help you interact with the parts of the spreadsheet in a
way that is probably familiar to you from working with other components or applications. Cells, rows, columns and
others are wrappers to other objects, and make customization that much easier by allowing you to manipulate them.
There are objects that represent parts of a visible spreadsheet, such as columns, rows, and cells; and there are
conceptual representations of underlying pieces of the spreadsheet which are implemented in the underlying models. To
understand more about the objects in Spread, look at the simplified object model diagrams for the FpSpread
('FpSpread Class' in the on-line documentation) class and the SheetView ('SheetView Class' in the on-line
documentation) class as shown here.

FpSpread
Sheets {Sheet¥iewCollection) Sheet¥iew
Activesheet¥iew (Sheet¥iew)

Mamedstyles (NamedStyleCollection) Mamedstyle

Cells
Columns Column
Rows Row

SheetYiew
Columns Column
Rows Row
AlternatingRows AlternatingRow
Cells Cell
MamedsStyles (NamedStyleCollection) Mamedstyle

Defaultstyle {StyleInfo)

Activeskin (Sheetskin)

RowAxisModel (ISheetAxisModel)
ColumnAxisModel (ISheetAxisModel)
DataModel {ISheetDataModel)
Selection™odel {ISheetselection™odel)
SpanModel (ISheetspan™odel)

StyleModel (ISheetstyleModel)
Spread for ASP.NET provides the following shortcut objects in the Spread namespace:

Shortcut Corresponding Classes
Object

cell Cell ('Cell Class' in the on-line Cells ('Cells Class' in the on-line
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documentation) documentation)

column Column ('Column Class' in the on-line Columns ('Columns Class' in the on-line
documentation) documentation)

header ColumnHeader ('ColumnHeader Class'in RowHeader ('"RowHeader Class' in the on-
the on-line documentation) line documentation)

row Row ('Row Class' in the on-line Rows ('Rows Class' in the on-line
documentation) documentation)

alternating  AlternatingRow ('AlternatingRow Class' AlternatingRows ('AlternatingRows Class'

row in the on-line documentation) in the on-line documentation)

To use the shortcut objects, you will set their properties or call their methods. Many of the objects provide indexes for
specifying the row, column, or cell with which you want to work.

The shortcut objects help you interact with the Spread for ASP.NET component in a way that is probably familiar to you
from working with other components or applications. They are shortcuts for working with more conceptual objects, the
more abstract objects, that are referred to as "models." These models are responsible for managing the style information,
formatting, and data in the Spread component. They are what give the product its power and flexibility for
customization. For more information on the underlying models, refer to Underlying Models.

The shortcut objects call the model objects. However, the shortcut objects allow you to interact with the Spread
component without dealing too much with the underlying object models if you are doing routine development. If you are
new to working with Spread, or are new to developing in an object-oriented environment, you might want to use the
shortcut objects at first, as you become familiar with the features of Spread for ASP.NET. However, intensive use of the
shortcut objects can degrade your application’s performance. As you get familiar with the workings of the product and as
you want more control over the spreadsheet, you may begin to work more with the models.

For more information on the skins that can applied to a sheet, refer to Applying a Skin to a Sheet. For more
information on the styles refer to Creating and Applying a Custom Style for Cells.

Object Parentage

For the objects in a Spread component, such as the sheet, column, and cell, there are formatting and other properties
that each object inherits from what is called its "parent." A cell may inherit some formatting, for example the
background color, from the sheet. If you set the alignment of text for all the cells in a column, the cell inherits that as
well. Because of this object parentage, many properties and methods can be applied in different ways to different parts
of a spreadsheet.

Of course, you can override the formatting that an individual cell inherits. But by default, objects inherit properties from
their parents. So in a given context, the settings of any object are the composite of the settings of its parents that are
being applied to that object. For example, you may set the text color for a cell at the cell level, but it may inherit the
vertical alignment from the row and the border from its column, and the background color from the sheet. Since the
background color may be set at several of these levels, certain rules of precedence must apply.

The closer to the cell level, the higher the precedence. So if you set the background color of the cell, the settings inherited
from the parents are overridden. Refer to the list to see the order of precedence of these properties. The closer to the cell
(the lower the number) the higher the precedence.

Cell

Row

. Column

. Alternating Row

. Sheet

. component

For more information on the setting of properties of an object and how to use the Parent property of an object, refer to
Customizing the Appearance. For information on cell types, which is set in a different way than inheriting from a
parent, refer to Customizing with Cell Types.
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Underlying Models

Spread for ASP.NET provides the following underlying models for each sheet and each set of headers in the spreadsheet:

Sheet Classes and Interface Description

Model

Axis BaseSheetAxisModel ('BaseSheetAxisModel Class'in  Basis for how the sheet of cells is

model the on-line documentation) structured in terms of rows and columns.

DefaultSheetAxisModel ('DefaultSheetAxisModel
Class' in the on-line documentation)

ISheetAxisModel ('ISheetAxisModel Interface' in the
on-line documentation)

Data BaseSheetDataModel ('BaseSheetDataModel Class'in Basis for the manipulation of data in the
model the on-line documentation) cells in the sheet.

DefaultSheetDataModel ('DefaultSheetDataModel
Class' in the on-line documentation)

ISheetDataModel ('ISheetDataModel Interface' in the
on-line documentation)

Selection BaseSheetSelectionModel ('"BaseSheetSelectionModel Basis for the behavior of and interaction
model Class' in the on-line documentation) of selected cells in the sheet.

DefaultSheetSelectionModel
('DefaultSheetSelectionModel Class' in the on-line
documentation)

ISheetSelectionModel ('ISheetSelectionModel
Interface' in the on-line documentation)

Span BaseSheetSpanModel ('BaseSheetSpanModel Class' Basis for how cells in the sheet are
model in the on-line documentation) spanned.

DefaultSheetSpanModel ('DefaultSheetSpanModel
Class' in the on-line documentation)

ISheetSpanModel ('ISheetSpanModel Interface' in
the on-line documentation)

Style BaseSheetStyleModel ('BaseSheetStyleModel Class' in Basis for the appearance of the cells in
model the on-line documentation) the sheet.

DefaultSheetStyleModel ('DefaultSheetStyleModel
Class' in the on-line documentation)

ISheetStyleModel ('ISheetStyleModel Interface' in the

on-line documentation)
Each model object is provided as a base model and a default model. The base model is the base on which the default
model is created. The base model has the fewest built-in features, and the default model extends the base model.

The default models are provided as the models with which you will most likely want to work in Spread. They provide the
default features that the Spread component offers.

However, if you want to provide different features, you might want to extend the base models yourself, creating new
classes. One reason you might do this is if you want to create a "template" component for all the developers in your
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organization to use. By creating your own class based on one of the Spread base models, you could provide such a
template.

The shortcut objects access the interfaces in the model namespace. When you work with shortcut objects, you are
actually working with the interfaces of the models in the component. For example, if you change the background color of
a cell using the Cells shortcut object, the interface for the sheet style model is updated with that information. For more
information on the shortcut objects, refer to Shortcut Objects.

For more in-depth information on the models, refer to Using Sheet Models.

Cell Types

There are several different cell types that can be set for cells in a sheet. You can specify the cell type for individual cells,
columns, rows, a range of cells, or an entire sheet. For each cell type there are properties of a cell that can be set. In
general, working with cell types includes defining the cell type, setting the properties, and applying that cell type to cells.

While you can assign a cell type to the cells in the row header or column header, the cell type is only used for painting
purposes.

A cell has both an editor and a renderer. The editor is an actual control instance that we create and place in the location
of the cell when you go into edit mode. The formatter decides how the displayed text appears. The renderer is simply
code that paints that control inside the cell rectangle when the editor is not there.

Cell

Editor {IEditor)
Renderer (IRenderer)
Formatter {IFormatter)

CellType (ICellType)

For more detailed information on these objects, refer to the individual interfaces in the Assembly Reference (on-
line documentation). For more general information about cell types and applying them to cells, columns, rows, or
whole sheets, refer to Customizing with Cell Types.

SheetView versus FpSpread

In Spread, there are several objects that should not be confused. The sheet in a multiple-sheet workbook corresponds to
a SheetView object. In a hierarchical data display, each child (expanded) sheet of the parent sheet corresponds to a
separate SheetView object. The FpSpread object is somewhat like a workbook.

For more detailed information on these objects, refer to the FarPoint.Web.Spread.SheetView ('SheetView Class' in
the on-line documentation) object and the FarPoint.Web.Spread. FpSpread ('FpSpread Class' in the on-line
documentation) object in the API reference documentation.

Formatted versus Unformatted Data

Spread for ASP.NET provides both text (formatted data) and value (unformatted data) properties for a cell. For example,
in a currency cell, the formatted data could be $1,432.56, but the value would be 1432.56. The Text ("Text Property’
in the on-line documentation) property would return the entire formatted string with currency symbol and
thousand separator. The Value ("Value Property' in the on-line documentation) property could be used in
formulas or other calculations. Remember that each cell has both properties. For cell types that have buttons or check
boxes, the distinction is also important.

For more detailed information on the text and value data for specific cell types in Spread for ASP.NET, refer to the
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FarPoint.Web.Spread assembly and namespace, the Cell ('Cell Class' in the on-line documentation) class, the
Text ("Text Property' in the on-line documentation) and Value ("Value Property' in the on-line
documentation) properties, and Understanding How Cell Types Display Data. Refer to Placing and
Retrieving Data for more information about data in cells.

Zero-Based Indexing

For most objects in Spread, zero-based indexing is used. Rows and columns are numbered starting with zero (0, 1, 2, and
so on). Note that the default header labels are numbered starting with one (1, 2, 3, and so on).

Client-Side Scripting

Scripting refers to running small programs, or scripts, in your pages. Scripts are written in a scripting language, such as
VB Script or JavaScript. For more information on how to perform client-side scripting, refer to the Spread for ASP.NET
Client-Side Scripting Reference (on-line documentation).

Maintaining State

You can and should maintain the session state when the page is refreshed, so that user data remains in the page. You
have probably experienced pages that do not maintain state; when the page is refreshed, such as to remind you to
complete part of a form, your information is lost, and you must complete the entire page again. Understandably, users
prefer pages that maintain the state.

You need to set up your application’s state management to optimize performance while maintaining the state. For more
information about the best ways to optimize performance, refer to Maintaining State.
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Namespaces Overview

In Spread for ASP.NET, namespaces are organized to contain objects according to how they are used in the Spread
component. The Spread component comprises six namespaces. The objects in the component fall into these categories:

e objects that represent parts of the spreadsheet, like column, rows, and cells

¢ objects that represent parts of the component for editing cells in the spreadsheet

e objects that represent parts of the component for the underlying template or model of the spreadsheet

e objects that represent parts of the component for rendering or displaying the spreadsheet

e objects that represent the chart control

e objects that represent data binding

For each of these there is a specific namespace. The namespaces are organized as follows:

Namespace Description

FarPoint.Web.Spread Provides the base classes, interfaces, enumerations, and delegates for Spread.

FarPoint.Web.Spread.Chart Provides the base classes, interfaces, and enumerations for the Spread Chart
component.

FarPoint.Web.Spread.Data Provides the base classes and interfaces for data binding for the Spread spreadsheet
component.

FarPoint.Web.Spread.Editor Provides the base classes and interface for the controls used to edit cells.

FarPoint.Web.Spread.Model Provides the base classes, interfaces, and enumerations for the Spread models.

FarPoint.Web.Spread.Renderer Provides the base classes and interfaces for the controls used to render cells.

The spreadsheet objects and event arguments are in classes in the main Spread namespace. For a discussion of how to
work with these objects, refer to Shortcut Objects.

The conceptual objects, the more abstract objects, are referred to as "models." These models are responsible for
managing the style information, formatting, and data in the Spread component. These are found in the Model
namespace. In Spread, you can use the default models or extend them through inheritance. Refer to Underlying
Models for more information on models.

The spreadsheet and cell type objects call the model objects. If you are new to working with Spread, or are new to
developing in an object-oriented environment, you might want to use the spreadsheet and cell type objects at first, as
you become familiar with features of Spread. However, intensive use of these objects can degrade your application’s
performance.

If you are an experienced programmer, you might want to use the model objects directly, instead of accessing them
through the shortcut objects. If you want to extend Spread for ASP.NET, you must use the model objects to do so.
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Working with the Spread Designer

You can quickly customize a spreadsheet component using the Spread Designer. Whether you are prototyping a
complete spreadsheet component or simply customizing some aspect of your spreadsheet component, the dedicated
graphical interface offers many features to save time and effort. It also provides a way for you to add data to and set
properties for the component easily, including properties that are not available at design time in Visual Studio. You can
set both design-time and run-time properties. In most cases you can preview changes before applying them to the
spreadsheet.

The Spread Designer requires Microsoft Internet Explorer (IE) 77 or higher.

The Spread Designer creates a snapshot of the spreadsheet component. Once all the changes are made, you apply the
changes to the spreadsheet component on your form. You can also open files from within Spread Designer and save your
design as a file.

Throughout the rest of the documentation, where there is a procedure that could be done in code or in the Spread
Designer, a brief procedure for using Spread Designer is given. Because Spread Designer has so many features, a topic
dedicated to the designer is given here. This topic provides information about general tasks specific to the designer and
about the designer user interface in general. It is not a comprehensive explanation of all the dialogs within the Spread
Designer.

The following topics provide information about using Spread Designer:

¢ Starting the Spread Designer
¢ Understanding the Spread Designer Interface
e Using the Spread Designer

Starting the Spread Designer

You can start Spread Designer from inside your Visual Studio .NET project by performing either of these steps: right-
clicking on the control and selecting the context menu or selecting the designer verb area of the Smart Tags, both shown
below.

Description Picture
Context (right-click) menu of the FpSpread component selected on the
form in Visual Studio Show Smart Tag
Spread Designer %

Reset Spread Control

Edit Ternplate

Verb area of the Smart Tags (that shows up after clicking on the arrow to
the right) of the FpSpread component selected on the design form in Visual
Studio Spread Designer

Spread Cuicl '.'-t:n@l:mrl

Edit Sheets

Understanding the Spread Designer Interface

Use the Spread Designer as a way to quickly set properties of the FpSpread component in the Microsoft .NET framework
by accessing the properties in an organized and easy-to-use interface. There are several places where the Spread
Designer offers additional capabilities beyond the Properties window in the .NET framework. The parts of the user
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interface of the Spread Designer are shown in this figure.

menus —— @ 3 5 FarPoint Spread Designer{ Net 4 0 Framework Edion) Lo L0 (]
Home Inzert Data View  Settings
toolbars ¥ Cut - -
‘r'v
Bcm - A-[B I U = X
& Paste s = N
Clipboard Faont M Alignment CellType Editing
omistr—\[ 5 |x / £]
A B C D
: Selecked Ikem W
: ! |
4 Misc ~
spreadsheet ’ BackColor
preview area » Background  FarPoint.Web.Sp property
» Border Border T grid
CellType (naone)
ColumnSpan 1
Encodevalue  True v
BackColor
Gets ar sets the background color Faor a
v = cell,
status bar

[~ Fieady Cell: 00,11

To set the properties for a part of the spreadsheet, select the item in the Property Grid (Spread, Sheet, etc.) that
corresponds with that item. The figure above shows what appears when you click on the Spread item. The properties
related to this item are displayed in the Property Grid where you can set them as you would in Visual Studio. You can
also use the menus and toolbars to make changes to properties quickly and easily. The preview area offers a quick visual
indication of the results of your changes.

In this example, the Spread menu includes those properties of the overall component, including the border or outline of
the entire component, the command bar, the page navigation bar, the scroll bars, and many other design time
properties. You can also add styles (that apply to an entire Spread or an individual sheet) and you can add sheets. The
drop-down combo box allows you to select the Spread, Sheet, or Selected Item menus. You can then set properties
for the component, a specific sheet, or a selected item such as a column or a row.

The Spread Designer offers a quick and easy way to change appearance and functionality of an FpSpread component at
design time. Remember that this changes properties at design time in the component itself and no code is added for
these changes. Some properties cannot be seen at design time and the effect is not seen until you preview the
spreadsheet or until you run the spreadsheet.

The Spread Designer has several areas where you can change designer settings or change properties of the Spread
component. The following topics describe the different areas:

e Spread Designer Menus

e Spread Designer Toolbars

e Spread Designer Editors

e Spread Designer Context Menus

Spread Designer Menus

You can use the designer menus to save or load a designer file, show or hide toolbars, edit, set various formatting
properties for the component, or bring up the help.
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The following menus are available:

¢ File Menu

e Home Menu

¢ Insert Menu

e Data Menu

e View Menu

e Settings Menu

e Chart Tools Menu
¢ Sparklines Menu

For more tasks within Spread Designer, return to Understanding the Spread Designer Interface.
File Menu

The File menu or Spread button can be used to open and save files, apply changes to the designer or apply and exit,
reset the settings, print, preview the printing, various save options, or exit the Designer. The File menu is shown in the
following figure:

® L=H FarPoint Spread Designer(.MNe

Home Insert Diata View Settings
Clear Recent Files List

Apply Recent Documents

O

1 testxlsx

Apply and Exit

) [ R

Hew

Open

Save

Save As

W @

Brint b

7 Ahout X Exit

Home Menu
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The Home menu can be used to cut, copy, or paste cell data, select cells, set cell fonts and alignment, lock cells, set cell
types, find text or formatting, set conditional formatting, and clear or refresh the control. The Home menu is shown in
the following figure:

© U= H FarPoint Spread Designer( Net 4.0 Framework Edition) =EES
Home Insert Data View Settings
il

#‘ Cut M A A ERENE = Wrap Text |: MNone - o Lock [ Filter ~ :Ié;l

=3 Copy S Clear CellT x Clear All 84 Find

3 - - Lo == = = - ear Lell [y n iti

B Paste g én B 7 U == == & Ve = e ~/ Refresh Eg:ﬁﬁglﬁﬂzl'

Clipboard Faont r Alignment CellType Editing Style

Insert Menu

The Insert menu can be used to add or delete a chart control or a sparkline. The Insert menu is shown in the following
figure:

© 1= FarPoint Spread Designer{ et 4.0 Framewerk Editior) =N s 5

Home Insert Data Wiew Settings

aill x,.:!r_:: w ZI @ @ ~ 1l ne

Column Line Pie Bar Area Scatter Other Line  Column ‘Wwin/Loss
- - - - - - Charts ~
Chart r Delete Sparklines
Data Menu

The Data menu can be used to insert or delete rows, columns, or sheets. You can also use it to protect, move, or copy a
sheet. The Protect Workbook option allows you to protect the structure of the workbook (changes such as moving or
adding sheets). The Data menu is shown in the following figure:

Q 1= 4 -Point Spread Designer{.Net 4.0 Framework Edition) = ]

Home Insert Diata Wiew Settings
H _f" 4y Protect
Insert Delete L:J Mowve ar Copy...

- -

Spread Shest

&g Protect Workbook

View Menu

The View menu can be used to show or hide headers, grid lines, the formula bar, column footers, the group bar, group
footers, the header selection, scrolling content, Spread or sheet titles, or the preview row. The View menu can also be
used to freeze columns or rows. The View menu is shown in the following figure:

1

© U= FarPoint Spread Designer(Net 4.0 Framework Edition) (= Hc
Home Insert Data Wiew Settings
¥ FormulaBar Column Footer Sheet Title ¥ Command Bar E;:i
. - . . GroupBar
| Row Header | Vertical GridLine PreviewRow || HeaderSelection
) o . ) GroupFooter Freeze
| Column Header | HorizontalGridLine Spread Title ScrollingContent Panes ~
Show/Hide Window
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Settings Menu

The Settings menu can be used to format cells, the sheet, or the Spread component. The Settings menu has a Spread
Setting section that contains options for creating titles, setting the focus rectangle color, setting edit properties, paging,
command bar options, scrollbar options, and tab settings.

The Sheet Setting section can be used to set the column and row count, freeze columns and rows, set paging and
sorting options, set operation mode, set the locked and selection colors, set header and footer properties (including the
sheet corner), set grid lines (type and color), and set formula properties such as reference style.

The Appearance Settings section can be used to create sheet skins and named styles.

The Other Settings section has editors for the row template, header and groups, alternating rows, and cells, columns,
and rows.

The Designer Settings section allows you to make changes to the designer such as showing on start up and resizing.
The Settings menu is shown in the following figure:

FarPoint Spread Designen(.Net 4.0 Framework Edition) [oEE=

@ L=Hd
Home Insert Data View Settings
General HE Paging 15 General T GridLines 2% SheetSkin i .
o Edit Title 1 Tab 25 Colors ._ ) ' A Preferences ~
. 5 Caleulation @ Mamed Style Ep—
= ScrollBar $E Command Bar FHH Headers *i3
Spread Settings Shest Settings Appearance Settings Dther Settings Designer Settings

Chart Tools Menu

The Chart Tools menu can be used to make changes to a chart control. You can change the chart type, switch the
column and row data, move to the front or back, move the chart, or allow the user to move or resize the chart. The Chart

Tools menu is shown in the following figure:

1

© L=l FarPoint Spread Designer{ Net 4.0 Framework Edition) (=== Bol Fx3
Home Insert Data View Settings Chart Tools
[ @, [ H{‘ | Allow Resize
Change MeveChart 7| Allow Move
ChartType
Type Data Arrange Location Move & Resize

Sparklines Menu

The Sparklines menu can be used to make changes to a sparkline. This menu is displayed after you add a sparkline to a
cell. The Sparklines menu is shown in the following figure:

© L= d FarPoint Spread Designer{.Net 4.0 Framework Edition) =8 Eol=%=
Home Insert Data Wiew Settings Sparklines
e ' ot i I "Ii High Point FirstPoint . Sparkline Color - ,.,Nf
: Low Point LastPoint 38 Marker - .
Edit Line Column ‘wfin/Loss ) : e . Hadis
Data ~ Megative Points Markers = Weight . i Clear -
Sparkline Type Show Style Group

The Sparklines menu can be used to edit an existing sparkline, display markers and specific points, set colors and
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weights, show an axis, and group and ungroup sparklines.

Spread Designer Toolbars

You can use the toolbars to provide quick access to some features of the Spread Designer such as saving or loading a file
and creating formulas.

The following toolbars are available:
Formula Toolbar

The Formula toolbar allows you to enter formulas directly or open the Formula Editor to specify a formula for a cell
or range of cells. This toolbar is shown in the following figure.

|

General Toolbar

The General toolbar can be used to open and save files. This toolbar is shown in the following figure (next to the file
button icon):

J= 4

For more tasks within Spread Designer, return to Understanding the Spread Designer Interface.
Spread Designer Editors

You can use the collection editors to format specific areas of the component such as groups, sheet views, and named
styles. The following editors are available:

¢ Alternating Rows Editor

e Cells, Columns, and Rows Editor

e ContextMenu Collection Editor

e DataKey Names (String Collection) Editor

¢ Formula Editor

¢ Grouplnfo Collection Editor

e Header Editor

e NamedStyle Collection Editor

¢ Row Template Editor

¢ SheetSkin Editor

e SheetView Collection Editor

For more tasks within Spread Designer, return to Understanding the Spread Designer Interface.

Alternating Rows Editor

You can customize alternating rows. You can specify borders, colors, cell types, and other options with the Alternating
Rows editor in the Spread Designer. From the Settings menu, select the AlternatingRow icon under the Other
Settings section.
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Alternating Rows Editor
=] B3 |

AlER v O 4 Appearance L)
AltRovy 1 > Alignment: Alignment
> Background FarPoint.Web.Spre:
> Borders Border
» Color ForeBackColor
Encodevalue True
> Fonk
> Margins Inset
F] EE.l.lT'[ul'pE . . o
Alignment
Gets or sets the alignment of alternating row,
Presiew
1 (000 anao Qoo
> 111 111 111
3 222 222 222
4 (333 333 333

Cancel

Cells, Columns, and Rows Editor

You can customize the appearance of cells, columns or rows with the Cells, Columns, or Rows Editor of the Spread
Designer. This editor is launched from the Properties window by selecting sheet in the drop-down box on the right side
of the designer and then clicking on the button for the Cells, Columns, or Rows property.
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Cells, Columns and Rows Editor = B
Row: 3o o= =2 Column: T i #@ CelliD,0) Properties
A B C
Siz: | A

l +|= .&l |

2 4 Misc ~
BackColor

3 - Background  FarPoint.Web.Sp
Border Border

CelType (nong)
Column3pan 1
Encodevalue  True
Fonk

ForeColor

Formula
Horizonkaldlior MokSet
Imerode Auko

Locked False

Margin Inset

Mote W
BackColor

< > Gets or sets the background color For a

ﬂ | pagE‘S 1 cell,

For more information about customizing the appearance of cells, refer to Customizing the Appearance of a Cell.
For more information on rows and columns, refer to Customizing the Appearance of Rows and Columns.

ContextMenu Collection Editor

You can use the ContextMenu Collection Editor to create menus for the row header, column header, or viewport
area. You can also create menu items and set menu properties. From the Properties window, select ContextMenus to
see this editor.
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Contextldenu Collection Editor ?
b embers: Froperties:
+
+

&dd =

Use the Add button to add the type of menu (row header, column header, or viewport).

You can use the Menultem Collection Editor to add menu items after you add a menu type.
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Contextienu Collection Editor ?
b embiers: Yiewpart properties:
".,-'IiE'-"'-IF":lrt f E * |
4+ 4 Misc
[tems [Callection]
[ ShowDefaultCor Falze [
Menultem Collection Edlitor ?
b embiers: Froperties:
* |
+
Add
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After you add a menu item, you can specify menu properties such as visible or add submenu items with the ChildItems

collection. The CommandArgument and CommandName properties are used to separate which menu item is
clicked in code. The ImageUrl property is a small image displayed to the left of the menu item. Text is the title of the

menu item.
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Menultem Collection Editor ?

Menu item 1 properties:

+ B

4+ 4 Behavior

OnClientChick,
4 Misc

AutoPostBack  Tue
Childitems [Callection]
Cormmarddrgurm
Commandh arne
Enabled True
Irmagelrl
Text Menu item 1
Wizsible True

Add Remove

DataKey Names (String Collection) Editor

You can set the names of key fields for the data source. Select DataKeyNames under the Data section after selecting
Sheet in the drop-down box to the right side of the designer.
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acrollingContentvisible  False A
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String Collection Editor ?
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In the Formula bar, when you type an equals sign, (“=”) then the drop-down list displays all the built-in functions for

you to choose from. Or if you click on the Choose Formula button on the Formula bar, the Formula Editor is

displayed. The Formula Editor allows you to select any of the built-in functions.
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Function Categary

Formula Editor

Function Lisk

38

AES A
Math and Trig ACCRINT
Financial BCCRINTM
Lookup and Reference el
Loqgical BCOSH
Skatiskical ADDRESS
Engineering AMORDEGRC
Text AMORLIMNC
Inforrmation AMD
Date and Time ASIN
Database ASINH
ATAN
ATANZ
ATANH
ANEDEY b
ABS{A)

Returns the absaoluke value of the specified value.

Formula;

The Formula Editor gives you a list of the built-in functions that you can use and displays a brief description and
syntax of the selected function. To choose a function, double-click on the function name and it appears in the Formula
field. You may also type operators and constants to construct your formula.

For more information on formulas, refer to Managing Formulas and to the Formula Reference.

Grouplnfo Collection Editor

You can set basic formatting for group headers with the GroupInfo Collection Editor of the Spread Designer. You
can launch the GroupInfo Collection Editor from the Spread Designer by selecting the sheet from the drop down on
the right side of the designer and choosing GroupInfos under the Mise section.
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Grouplinfo Collection Edlitor
b embers: FarPoint/'eb.5 pread. Grouplnfo properties:
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4+ 4 Misc

BackColor " hite
> Background FarPoint. Web. 5preac

» Border Border
CzzClass

> Font
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TabStop Falze
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> BackColor
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information.

Add Remove

0k, Cancel

For more information on grouping and grouping headers, refer to Customizing Grouping of Rows of User Data.

Header Editor

You can customize column and row headers by selecting which headers display and by customizing the properties of the
headers. In the Spread Designer, from the Settings menu, select the Header Editor icon. An example of a header

dialog with customized header appearances is shown here.
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|
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|
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BackColor
» Background FarPoint.\Web.Sf
:»  Border Border
CelType (none)
Colurmn3pan 1
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Emvre =

BackColor

Gets or sets the background color For
acel,

First, select which headers these customizations apply to by choosing from the drop-down list at the top of the dialog.
Then select the formatting from the format bar at the top or the various properties listed in the Property window to the
right. The preview pane on the left displays how those customizations appear. When done, click Apply or OK.

For more information on customizing headers, refer to Customizing the Appearance of Headers.
NamedStyle Collection Editor

You can customize the appearance of cells by defining a named style. You can do this within the Spread Designer using
the Named Style Editor. This editor is launched from the Properties window by first selecting the Spread and then
clicking on the button in the NamedStyle property.
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Mam edStyle Collection Editor ?
Stylel properties:
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4+ 4 Misc
BackColor
> Background FarPoint. Web. 5preac
» Border Border
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Encodevalue  True
> Font
ForeColor
Harizontaldlign  MaotSet
ImeMode Auto
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Y E= Stylel
Parent
Add Remove Werticaldlign HotSet

0k, Cancel

For more information on named styles, refer to Creating and Applying a Custom Style for Cells.

Row Template Editor

The row template editor allows you to design the layout of the column headers and the data rows. From the Settings
menu, select the RowTemplate icon (Other Settings section).
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92

Design Row Template

[ ] Enable Fow Template Layout Mode

Layout Template
== | A
=121 |
4 WorksheetTemplate
ColumnCount 4

- ColumnHeade
- Fow

ColumnCount

Gets or sets the number of columns For
the layout template.

Cancel Apply

You can use the Span icon to span cells in the data row or column header. Select the cells to span and then select the

Span icon.

SheetSkin Editor

You can customize various sheet properties and save them as a set called a skin. That skin can be saved and used in other
projects. You can also use pre-defined built-in skins and apply a set of appearance settings at once.

Select the Settings menu in the Spread Designer, then select the SheetSkin menu under the Appearance Settings
section. The SheetSkin editor is shown here.
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SheetSkin Editor - O X
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& 8| %[ &| 8| &| 8] %] & &

Ik | | Cancel | | Apply

For information about using skins, refer to Applying a Skin to a Sheet and Creating a Skin for Sheets.

SheetView Collection Editor

You can customize the appearance of sheets with the Sheet View Collection Editor. Select Spread in the drop-down
box on the right side of the designer. Then click on the Sheets collection under the Data section.
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For more information on sheet appearance settings, refer to Customizing the Appearance of the Sheet.

Spread Designer Context Menus

In the spreadsheet preview area of the Spread Designer you right-click and bring up a context menu depending on
whether you are clicking on an individual cell or the entire sheet or component.

For more tasks within Spread Designer, return to Understanding the Spread Designer Interface.

Cell Context Menu

With the cell selected, you can display the cell context menu.
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Cell Types 3 m Button .
% cut [+ CheckBox
23 Capy _E ComboBox
L Paste % Currency
E Span DateTime
& Lock 1.0  Double
4 Borders.. Empty
all  General
=R &2  Hyperlink
Delete = Image
T 12 Integer
bt Lahel
=B ListBox
j FMultiCalumnComboBaox
% Percent
=3 RadioButtonlist
= [+] ReqularExpression
b TagCloud
0.0.1.1 ab| Text

Sheet Context Menu

You can select the sheet or component and right-click to display the sheet context menu. The Move or Copy menu

Clear Cell Type

option allows you to make a copy of a sheet.

Spread Settings...
Sheet Settings...

MamedStyle Editor,

Move or Copy...
Header Editor...
Cell, Row, Calumn Editar...
5‘ RowTemplate Editor...
HH  AlternatingRows Editor...
,wp SheetSkin Editor...

Using the Spread Designer

95

Spread Designer helps you design your FpSpread component by letting you see most of the settings you make at the time

you make them, and by letting you access settings that you cannot access in Visual Studio at design time. You can use
Spread Designer for many aspects of design, including customizing the appearance of your component. You can also
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load data into the sheets in your component, if you want to do so.

The tasks you can do using Spread Designer are described throughout this guide in the "how-to" instructions provided.
The following topics describe some specific tasks you need to do in Spread Designer to work with the component and the
Designer. Refer to these topics if you have questions while working through tasks described in other sections in this
guide.

The following sections describe working inside the Spread Designer:

¢ Customizing Sheets, Rows, and Columns in Spread Designer
¢ Customizing Cells in Spread Designer

¢ Adding Formulas to Cells

e Saving and Opening Design Files

e Applying Changes and Closing Spread Designer

For more information about Spread Designer, return to Working with the Spread Designer.
Customizing Sheets, Rows, and Columns in Spread Designer

Using the Spread Designer, you can set several types of properties to customize the sheet appearance. This includes the
following sheet properties:

e Colors

e Grid lines

e Sheet names

e Alternating rows

e Group bar colors

e Header starting numbers

e Automatic recalculation

For example, the grid lines properties are shown in the following figure.

Sheet Ly
=14 |
Colurns (Collection) -
- Defaultskyle
Defaulkstyleh.

FrozenColurn 0

FrozenRowCo O

GrayAreaurs

GravireaCurs Defaulk

aridlineColor - #DODTES

GridLines Eoth W |

GridLines

Gets of sets whether to display grid
lines in the sheet,

Besides the Sheet properties, you can also set several types of properties to customize the appearance of rows and
columns and headers using the Spread Designer. Use the Row menu for rows and row headers. Use the Column menu
for columns and column headers. The figure below shows the types of properties that are available for rows.
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For more information on setting cell types for a cell or range of cells, refer to Customizing Cells in Spread
Designer.

For more tasks within Spread Designer, return to Using the Spread Designer.

Customizing Cells in Spread Designer

Using the Spread Designer, you can set the cell types of cells in the data area of the spreadsheet.

Select the cells in the window of the Designer for which you want to set the cell type.
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If you are setting cell types for a given cell or range of cells, use the cell types right-click menu to quickly apply the cell
type. After making one or more settings, click Apply to apply the changes to Spread.

Several editable celltypes have a Format tab that can be used to set the NumberFormat property. The
NumberFormat property uses the NumberFormatInfo class. The NumberFormatInfo class may have properties
that the cell type does not support. Unsupported properties are ignored.

Style Editor

CellType Alignrment Fart Border Fill bizc
Cateqgary:

[I"ICII"IE] General Farmat
Button
CheckBox FumberFarmat Feset -
ComboB o
Currency Mone

DateTi ]
Invarnantinfo Culture

Empty Current Culture

General
HyperLink,
Image

Select the culture type and then set any of the number format properties.
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You can enter a formula into a cell or range of cells using the Formula property from the Formula tab of the Cell page
in the Spread Designer. For more information, refer to Adding Formulas to Cells. For more information on formulas

and functions, refer to the Formula Reference.

For more information on setting other properties for a cell or range of cells, refer to Customizing Sheets, Rows, and

Columns in Spread Designer.

For more tasks within Spread Designer, return to Using the Spread Designer.

Adding Formulas to Cells

You can enter a formula into a cell or range of cells using the Formula bar and the Formula Editor in the Spread

Designer.
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In the Formula bar, when you type an equals sign, (“=") then the drop-down list displays all the built-in functions for
you to choose from. Or if you click on the Choose Formula button on the Formula bar, the Formula Editor is
displayed. The Formula Editor allows you to select any of the built-in functions.
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Formula Editor

Function Categary Function List

STDEYP ~
Math and Trig STDEYPA
Financial STEY™
Lookup and Reference SIBSTITUTE
Loqgical SUBTOTAL
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Engineering SUMIF
Text SUMIFS
Inforrmation SUMPRODICT
Date and Time SIS0
Database SUMKZMYZ
SUMRZEPYZ
SLIMEMY 2
SyD
T W

SUM{valuel,valuez,..)

Sums walues, cells, ar blacks,

Formula: | ABS

The Formula Editor gives you a list of the built-in functions that you can use and displays a brief description and
syntax of the selected function. Functions are organized by category; you can select a category to show only functions of
a given category. To choose a function, double-click on the function name and it appears in the Formula field. You may
also type operators and constants to construct your formula.

You can enter the formula in the Formula field in the Formula Editor or in the formula box in the Formula bar.
When you are done entering the formula with the Formula Editor, click Apply or OK. When you are done typing the
formula in the formula box, click Enter (the check mark button). This applies the formula to the selected cell or range of
cells. When you click OK or Apply, the Formula Editor evaluates the formula to see if it is a valid formula. For more
information on formulas and functions, refer to the Formula Reference.

To display or hide the formula bar, from the View menu, select Formula Bar.

From the File menu choose Apply and Exit to apply your changes to the FpSpread component and exit Spread
Designer.

For more tasks within Spread Designer, return to Using the Spread Designer.
Saving and Opening Design Files

When you have finished working on a design, you can save the design to a file as any of several file types:
e Spread XML
e Excel (BIFF) XLS
e Excel 2007 XLSX
o Text file
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From the File menu, select Save or Save As New and specify a file name, the file type, and the location of the file.

To open an existing file, from the File menu, select Open and select the file from the File dialog, or Open Recent and
select the name from the recent files list.

For saving Spread Designer to an XML file, the Spread element contains these elements

e Data

e Presentation
o Settings

e Style

For more information on the save and open options from the File menu, refer to File Menu.

For details of what is exported to the BIFF-compatible file, refer to the Import and Export Reference (on-line
documentation).

For more tasks within Spread Designer, return to Using the Spread Designer.

Applying Changes and Closing Spread Designer

When you have finished setting the properties you want to set in Spread Designer, you can apply your changes to the
component, and then either continue to work in Spread Designer or close Spread Designer.

To apply your changes, do one of the following. From the Designer File menu,

e choose Apply
¢ choose Apply and Exit

For more tasks within Spread Designer, return to Using the Spread Designer.
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Customizing User Interaction

You can customize how the user interacts with the spreadsheet. The tasks that relate to customizing the way the user
interacts with the spreadsheet include:

¢ Customizing Interaction with the Overall Component

¢ Working with AJAX

e Customizing the Tool Bars

¢ Customizing Interaction with Rows and Columns

e Managing Filtering of Rows of User Data

¢ Customizing Grouping of Rows of User Data

¢ Customizing Sorting of Rows of User Data

¢ Customizing Interaction with Cells

¢ Customizing Selections of Cells

¢ Managing Printing

Customizing Interaction with the Overall Component

You can customize some aspects of the user interaction with the overall component. To customize user interaction, you
may perform the following tasks:

¢ Displaying Scroll Bars

¢ Displaying Scroll Bar Text Tips

e Customizing the Scroll Bar Colors

¢ Allowing Load on Demand

¢ Customizing Interaction Based on Events

e Handling the Tab Key

¢ Customizing the Graphical Interface

¢ Searching for Data with Code

¢ Adding a Context Menu

¢ Using the Formula Extender Control (on-line documentation)

For information about the appearance of the component, refer to Customizing the Appearance of the Overall
Component.

For information about displaying the sheet names, refer to Displaying the Sheet Names.

Displaying Scroll Bars

You can customize how and if to display the scroll bars in the component. You can display the individual scroll bars
(horizontal or vertical) only when needed, as shown in the figure.
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Using the Properties Window

1. Select the FpSpread component.
2. With the Properties window open, select the HorizontalScrollBarPolicy property and

104

VerticalScrollBarPolicy (under the Behavior category) and from the drop-down list, select a value for each.

3. The scroll bar policy is now set.

Using Code

Determine when to display the scroll bars by setting the HorizontalScrollBarPolicy ('"HorizontalScrollBarPolicy
Property' in the on-line documentation) property and VerticalScrollBarPolicy ('VerticalScrollBarPolicy

Property' in the on-line documentation) property for the FpSpread ('"FpSpread Class' in the on-line

documentation) component and the settings of the ScrollBarPolicy ('ScrollBarPolicy Enumeration' in the

on-line documentation) enumeration.
Example

The following example sets the horizontal and vertical scroll bar policies.

C#

FpSpreadl.HorizontalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.Always;
FpSpreadl.VerticalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.AsNeeded;

VB

FpSpreadl.HorizontalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.Always
FpSpreadl.VerticalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.AsNeeded

Using the Spread Designer

Select the Settings menu.

Select the Scrollbar icon under the Spread Settings section.
Set the policy options.

Click OK to apply the changes.

Click Apply and Exit to close the Spread Designer.

S e
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Displaying Scroll Bar Text Tips

You can display scroll bar text tips for the sheet when the user scrolls. The text tip displays information for the leftmost
column or the topmost row in the viewing area.

E G H I
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3

4

3 v
6

- < ] >
v J6 B I " =

Scroll bar text tip

You can also customize the scrolling text tip when using virtual paging with the VirtualScrollPagingFormatString
('VirtualScrollPagingFormatString Property' in the on-line documentation) property.

Using the Properties Window

1. Select the FpSpread component.
2. Select the Sheets collection in the properties window.
3. Select the ScrollingContentVisible property in the Sheets collection editor.

Using Code

Use the ScrollingContentVisible ('ScrollingContentVisible Property' in the on-line documentation)
property to enable tips for the scroll bar.

Example

The following example enables the tips for the scroll bar.

C#

FpSpreadl.Sheets[0].ScrollingContentVisible = true;

VB
FpSpreadl.Sheets (0) .ScrollingContentVisible

True

Using the Spread Designer

Select the Settings menu.

Select the Scrollbar icon under the Spread Settings section.
Select the Scrolling Content option.

Click OK to apply the changes.

Click Apply and Exit to close the Spread Designer.

S e
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FpSpreadl.ScrollBarFaceColor = Color.Orange;
FpSpreadl.ScrollBarHighlightColor = Color.White;
FpSpreadl.ScrollBarShadowColor = Color.Blue;
FpSpreadl.ScrollBarTrackColor = Color.Pink;

VB

FpSpreadl.VerticalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.AsNeeded
FpSpreadl.VerticalScrollBarPolicy = FarPoint.Web.Spread.ScrollBarPolicy.AsNeeded
FpSpreadl.Sheets (0) .ColumnCount = 10

FpSpreadl.Sheets (0) .RowCount = 10

FpSpreadl.ScrollBar3DLightColor = Color.Yellow

FpSpreadl.ScrollBarArrowColor = Color.Green

FpSpreadl.ScrollBarBaseColor = Color.Brown

FpSpreadl.ScrollBarDarkShadowColor = Color.Purple

FpSpreadl.ScrollBarFaceColor = Color.Orange

FpSpreadl.ScrollBarHighlightColor = Color.White

FpSpreadl.ScrollBarShadowColor = Color.Blue

FpSpreadl.ScrollBarTrackColor = Color.Pink

Allowing Load on Demand

You can allow the Web page to load on demand -- as the user scrolls further down the spreadsheet the Spread
component on the client loads another set of rows from the server as needed. The height of the component should be
smaller than the height needed for the initial number of rows to load (LoadInitRowCount ('LoadInitRowCount
Property' in the on-line documentation) property); otherwise, the scroll bar will not be visible and you will need to
use the next page icon instead of the scroll bar. The load on demand feature scrolls up to the maximum number of rows
you have set with the page size. If the row count is greater than the page size, you will need to use the next page icon to
display the rows beyond the page size setting.

The following properties are used to set the allow load on demand feature. They can be set at the control level or the
sheet level.

FpSpread class:

e FpSpread.AllowLoadOnDemand ('AllowLoadOnDemand Property' in the on-line
documentation)

¢ FpSpread.LoadInitRowCount ('LoadInitRowCount Property' in the on-line documentation)

e FpSpread.LoadRowIncrement ('LoadRowIncrement Property' in the on-line documentation)

SheetView class:

e SheetView.AllowLoadOnDemand ('AllowLoadOnDemand Property' in the on-line
documentation)

¢ SheetView.LoadInitRowCount ('LoadInitRowCount Property' in the on-line documentation)

¢ SheetView.LoadRowIncrement ('LoadRowIncrement Property' in the on-line documentation)

You can specify whether to use the standard or background load on demand options with the LoadOnDemandMode
('LoadOnDemandMode Property' in the on-line documentation) property.

The load on demand feature is not intended to work with a hierarchical display (parent sheet expanding into child
sheets) so it is disabled in a hierarchical Spread.

Standard Load on Demand

The standard mode only loads the next set of rows if there are rows that are hidden from the view. The default value for
the LoadOnDemandMode ('LoadOnDemandMode Property' in the on-line documentation) property is
standard.
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Background Load on Demand

You can load new rows in the background before the last row is displayed. For example, if 20 rows are loaded and the
user scrolls to row 15, the next set of rows is loaded. Set the LoadOnDemandMode ('LoadOnDemandMode
Property’' in the on-line documentation) property to Background to load the new rows before the last row is
displayed. You can also specify whether to load the new rows using a time interval or when the scrolling is a specified
number of rows from the bottom of the view. Use the LoadOnDemandTriggerMode
('LoadOnDemandTriggerMode Property' in the on-line documentation) property to specify whether to use a
time interval or an offset from the bottom of the view.

The background load on demand allows other pending AJAX requests while rows are being loaded (rows are loaded
without locking the Spread). The actions are put in a queue of pending requests to be processed later. When load on
demand is finished, pending requests in the queue are processed until there are no more requests in the queue.

Virtual Paging

Another option for loading pages as the user scrolls vertically is the AllowVirtualScrollPaging
("AllowVirtualScrollPaging Property' in the on-line documentation) property. This can be used instead of the
allow load on demand properties. The virtual paging feature will not work with load on demand. The
EnableClientScript ("EnableClientScript Property' in the on-line documentation) property must be true for
the virtual paging. For the best performance, you may also wish to set EnableAjaxCall ("EnableAjaxCall Property’
in the on-line documentation) to true since the virtual paging uses Ajax calls.

The virtual scrolling option scrolls from the first row to the last row of the page size. If the row count is greater than the
page size, then when you scroll past the maximum page size row, the next set of rows is loaded (a wait icon is displayed
while the next page is loading in this case).

You can also display rows from the previous page with the VirtualScrollPagingPrevRowCount
("VirtualScrollPagingPrevRowCount Property' in the on-line documentation) property.

The scroll bar button size reflects the total number of rows with virtual scrolling (rather than the number of currently
loaded rows).

Using the Properties Window

You can set several of the properties at design time using the Properties window of Visual Studio .NET or the Property
grid in the designer.

1. Select the sheet.

2. Set the AllowLoadOnDemand property to true to allow loading on demand.

3. Set the LoadInitRowCount property to specify the initial number of rows to load.

4. Set the LoadRowIncrement property to specify how many rows to load after the initial set of rows is loaded.

Using Code

Use the AllowLoadOnDemand ('AllowLoadOnDemand Property' in the on-line documentation) property
to allow load on demand. Set the LoadInitRowCount ('LoadInitRowCount Property' in the on-line
documentation) property to load the initial set of rows. Set the LoadRowIncrement ('LoadRowIncrement
Property' in the on-line documentation) property to specify the number of rows to load after the initial page is
loaded.

Example

The height of the component should be smaller than the height of ten rows (for this example).

C#
FpSpreadl.Sheets[0] .RowCount = 40;
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FpSpreadl.Sheets|
FpSpreadl.Sheets (
FpSpreadl.Sheets|[
FpSpreadl.Sheets|
long i;

for (1 = 1; 1 <= 20; i++)

{

FpSpreadl.Sheets[0].Cells[i, 0].Value = i;
}

] .AllowLoadOnDemand = True;
) .PageSize = 40;

] .LoadInitRowCount = 10;

] 10;

O O O O

.LoadRowIncrement

VB

FpSpreadl.Sheets (0) .RowCount = 40
FpSpreadl.Sheets (0) .AllowLoadOnDemand = True
FpSpreadl.Sheets (0) .PageSize = 40
FpSpreadl.Sheets (0) .LoadInitRowCount = 10
FpSpreadl.Sheets (0) 10
Dim i As Long

For i = 1 To 20

FpSpreadl.Sheets (0) .Cells (i, 0).Value = i
Next

.LoadRowIncrement

Customizing Interaction Based on Events

You can customize user interaction based on events in the FpSpread component. In the FpSpread ('"FpSpread Class'
in the on-line documentation) class there are several events, from ButtonCommand ('ButtonCommand
Event' in the on-line documentation) to InsertCommand ('InsertCommand Event' in the on-line
documentation) to SaveOrLoadSheetState ('SaveOrLoadSheetState Event' in the on-line
documentation). Use these events to initiate actions.

For a list of events with code samples, refer to the FpSpread ('"FpSpread Class' in the on-line documentation)
class in the Assembly Reference (on-line documentation).

Handling the Tab Key

You can customize the use of the Tab key. By default the user can press the Tab key to advance the focus to the next
active cell. You can turn off this behavior so that the component does not pay attention to the Tab key being pressed. To
control this behavior, set the ProcessTab ('ProcessTab Property' in the on-line documentation) property of
the FpSpread ('FpSpread Class' in the on-line documentation) class.

Using Code

Use the ProcessTab ('ProcessTab Property' in the on-line documentation) property.

Example

Set the ProcessTab ('ProcessTab Property' in the on-line documentation) property.

C#

FpSpreadl.ProcessTab = false;

VB

FpSpreadl.ProcessTab = False

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 109

Customizing the Graphical Interface

You can customize the graphical user interface of the component by using your own graphics for certain parts of the
interface. You can customize these aspects of the component:

e Sort indicator that is displayed in the column header
e Expand and collapse icons in the hierarchical display
¢ Icons in the filter bar

The following image displays custom icons in the hierarchical display.

LastName | FirstName 1D
Fielding William 0
12
Williams Arthur 1
2 B
City Crwner State
1 [Boston 1Mass.

To display or hide the sort indicator, use the SortIndicator ('SortIndicator Enumeration' in the on-line
documentation) enumeration settings and the SortIndicator ('SortIndicator Property' in the on-line
documentation) property of the Column ('Column Class' in the on-line documentation) class.

Use the GetImage ('GetImage Method' in the on-line documentation) method and SetImage ('SetImage
Method' in the on-line documentation) method in the FpSpread ('FpSpread Class' in the on-line
documentation) component to work with the image. Use the SpreadImages ('SpreadImages Enumeration' in
the on-line documentation) enumeration to specify the images to customize.

You can also manage whether users can expand rows to see child views. For more information, refer to Handling Row
Expansion.

For more information on sorting, refer to Customizing Sorting of Rows of User Data.
Using Code

You can use the SetImage ('SetImage Method' in the on-line documentation) method to add your own image to
the control. Specify which image to replace and the URL of the image with this method.

Example

The following example uses the SetImage ('SetImage Method' in the on-line documentation) method with a
control that has been bound to a hierarchical data set.

C#

System.Data.DataSet ds = new System.Data.DataSet();

DataTable name;

DataTable city;

name = ds.Tables.Add ("Customers");

name.Columns.AddRange (new DataColumn[] {new DataColumn ("LastName", typeof (string)), new
DataColumn ("FirstName", typeof (string)), new DataColumn ("ID", typeof (Int32))1});
name.Rows.Add (new object[] {"Fielding", "William", 01});

name.Rows.Add (new object[] {"Williams", "Arthur", 1});

name.Rows.Add (new object[] {"Zuchini", "Theodore", 21});

city = ds.Tables.Add("City/State");

city.Columns.AddRange (new DataColumn[] {new DataColumn ("City", typeof(string)), new

DataColumn ("Owner", typeof (Int32)), new DataColumn ("State", typeof(string))}):;
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city.Rows.Add (new object[] {"Atlanta", 0, "Georgia"});

city.Rows.Add (new object[] {"Boston", 1, "Mass."});

city.Rows.Add (new object[] {"Tampa", 2, "Fla."});
ds.Relations.Add("City/State", name.Columns["ID"], city.Columns["Owner"]);
FpSpreadl.DataSource = ds;

FpSpreadl.SetImage (FarPoint.Web.Spread.SpreadImages.Expand, "iconl.ico");
FpSpreadl.SetImage (FarPoint.Web.Spread.SpreadImages.Collapse, "icon2.ico");

VB

Dim ds As New System.Data.DataSet

Dim name As DataTable

Dim city As DataTable

name = ds.Tables.Add("Customers")

name.Columns.AddRange (New DataColumn () {New DataColumn ("LastName",
Type.GetType ("System.String")), New DataColumn ("FirstName",

Type.GetType ("System.String")), New DataColumn ("ID", Type.GetType ("System.Int32")) })
name.Rows.Add (New Object () {"Fielding", "William", 0})

name.Rows.Add (New Object () {"Williams", "Arthur", 1})

name.Rows.Add (New Object () {"Zuchini", "Theodore", 2})

city = ds.Tables.Add("City/State")

city.Columns.AddRange (New DataColumn () {New DataColumn ("City",
Type.GetType ("System.String")), New DataColumn ("Owner", Type.GetType ("System.Int32")),
New DataColumn ("State", Type.GetType ("System.String"))})

city.Rows.Add (New Object () {"Atlanta", 0, "Georgia"})

city.Rows.Add (New Object () {"Boston", 1, "Mass."})

city.Rows.Add (New Object () {"Tampa", 2, "Fla."})
ds.Relations.Add("City/State", name.Columns ("ID"), city.Columns ("Owner"))
FpSpreadl.DataSource = ds

FpSpreadl.SetImage (FarPoint.Web.Spread.SpreadImages.Expand, "iconl.ico")
FpSpreadl.SetImage (FarPoint.Web.Spread.SpreadImages.Collapse, "icon2.ico")

Searching for Data with Code

To search for data in any of the cells of a sheet, use either of these sets of methods in the FpSpread class:

e Search ('Search Method' in the on-line documentation) methods
e SearchHeaders ('SearchHeaders Method' in the on-line documentation) methods

The parameters of the various search methods allow you to specify the sheet to search, the string for which to search,
and the matching criteria. For a list of qualifications (restrictions) of the search, refer to the set of methods listed above
for more details.

Using Code

Use the Search ('Search Method' in the on-line documentation) method for the FpSpread component to
perform a search.

Example

Use the Search method to perform an exact-match search on the third sheet (Sheet 2) for the word "Total" and return
the values of the row index and column index of the found cell.

C#

fpSpreadl.Search (2, "Total", true, true, false, false,1,1,56,56,ref rowindx,ref colindx));
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VB

FpSpreadl.Search (2, "Total",True, True,False,False,1,1,56,56,ref rowindx,ref colindx))

Adding a Context Menu

You can display a Spread context menu when right-clicking on the Spread control. The context menu can be displayed
when the user right-clicks on the column header, row header, or viewport area (data area and empty area).

You can add menu items to the menu and set the height or other properties. Specify the type of menu with the
ContextMenuType ('ContextMenuType Enumeration' in the on-line documentation) enumeration. You can
create a menu using markup code, the ContextMenus ('ContextMenus Property' in the on-line
documentation) property in the Properties window, or server code.

The CommandArgument ('CommandArgument Property' in the on-line documentation) and
CommandName ('CommandName Property' in the on-line documentation) properties are used to separate
which menu item is clicked in code. So in the MenultemClicked ("M enultemClicked Event' in the on-line
documentation) event on the server side you could add code such as switch(eventArgs.Selectedltem.CommandName)
or switch(eventArgs.SelectedItem.CommandArgument).

A B C D
|
2
3 Test Itemn
Test Item2
Viewport item 1 Child item 1
Child item 2
< >
v 36 BB Iy =

Using the Properties Window

1. In the Properties windows select Spread.

2. Under the Behavior section select the ContextMenus property.

3. Use the ContextMenu Collection editor to add menus, menu items, and set any menu properties.
4. Click OK when finished.

Using Code
1. Create a viewport menu using markup or the ContextMenus ('ContextMenus Property' in the on-line

documentation) property in the property window at design time.
2. Set the EnableContextMenu ('"EnableContextMenu Property' in the on-line documentation)

property to true.
3. Create a row header menu with code.

Example

This example code creates one menu at design time and one menu at run time.

Code
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//Markup code

<ContextMenus>
<FarPoint:ContextMenu Type="Viewport">
<Items>
<FarPoint:Menultem Enabled="True" ImageUrl="http://linktoimagehere/abc.jpc"
Text="Menu item 1">
<ItemTemplate>
<asp:TextBox ID="bac" runat="server" />
</ItemTemplate>
</FarPoint:Menultem>
<FarPoint:Menultem Text="Sort" ImageUrl="http://linktoimagehere/abc.jpc">
<ChildItems >
<FarPoint:Menultem Text="Child Iteml"
ImageUrl="http://avc/abc.jpc"></FarPoint:Menultem>
<FarPoint:Menultem Text="Child Item2"></FarPoint:Menultem>
</ChildItems>
</FarPoint:Menultem>
<FarPoint:Menultem Enabled="True"
ImageUrl="http://linktoimagehere/abc.jpc">Menu item 3</FarPoint:Menultem>
</Items>
</FarPoint:ContextMenu>
</ContextMenus>

C#

protected void Page Load(object sender, System.EventArgs e)

{

if (this.IsPostBack) return;

FpSpreadl.EnableContextMenu = true;

//Create this viewport menu using markup or the ContextMenus property in the property
window

FarPoint.Web.Spread.ContextMenu viewportMenu =

FpSpreadl.ContextMenus [FarPoint.Web.Spread.ContextMenuType.Viewport];
FarPoint.Web.Spread.Menultem customViewportItem = new

FarPoint.Web.Spread.Menultem ("Viewport item 1");
customViewportItem.ChildItems.Add (new FarPoint.Web.Spread.Menultem("Child item 1"));
customViewportItem.ChildItems.Add (new FarPoint.Web.Spread.Menultem("Child item 2"));
viewportMenu.Items.Add (customViewportItem) ;

//This row header menu is created here (no markup or design properties)
FarPoint.Web.Spread.ContextMenu rowHeaderContextMenu = new
FarPoint.Web.Spread.ContextMenu () ;

rowHeaderContextMenu.Type = FarPoint.Web.Spread.ContextMenuType.RowHeader;
FarPoint.Web.Spread.Menultem rowHeaderItem = new

FarPoint.Web.Spread.Menultem ("RowHeader item 1");
rowHeaderItem.ChildItems.Add (new FarPoint.Web.Spread.Menultem("Child item 1"));
rowHeaderItem.ChildItems.Add (new FarPoint.Web.Spread.Menultem("Child item 2"));
rowHeaderContextMenu.Items.Add (rowHeaderItem) ;

FpSpreadl.ContextMenus.Add (rowHeaderContextMenu) ;

}

VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load
If (IsPostBack) Then
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Return
End If
FpSpreadl.EnableContextMenu = True
'Create this viewport menu using markup or the ContextMenus property in the property
window
Dim viewportMenu As FarPoint.Web.Spread.ContextMenu =
FpSpreadl.ContextMenus (FarPoint.Web.Spread.ContextMenuType.Viewport)
Dim customViewportItem As New FarPoint.Web.Spread.Menultem("Viewport item 1")
customViewportItem.ChildItems.Add (New FarPoint.Web.Spread.Menultem("Child item 1"))
customViewportItem.ChildItems.Add (New FarPoint.Web.Spread.Menultem("Child item 2"))
viewportMenu.Items.Add (customViewportItem)

'This row header menu is created here (no markup or design properties)
Dim rowHeaderContextMenu As New FarPoint.Web.Spread.ContextMenu ()
rowHeaderContextMenu.Type = FarPoint.Web.Spread.ContextMenuType.RowHeader
Dim rowHeaderItem As New FarPoint.Web.Spread.Menultem("RowHeader item 1")
rowHeaderItem.ChildItems.Add (New FarPoint.Web.Spread.Menultem("Child item 1
rowHeaderItem.ChildItems.Add (New FarPoint.Web.Spread.MenuItem("Child item 2"))
rowHeaderContextMenu.Items.Add (rowHeaderItem)

FpSpreadl.ContextMenus.Add (rowHeaderContextMenu)

End Sub

Working with AJAX

You can use AJAX and ASP.NET AJAX to extend the capability of Spread by providing additional cell types and page
refresh options. You may perform the following tasks:

¢ Enabling AJAX Support

e Using ASP.NET AJAX Extenders

Enabling AJAX Support

AJAX allows the component to refresh without refreshing the entire page. You can add AJAX support to the FpSpread
component by setting the EnableAjaxCall ('"EnableAjaxCall Property' in the on-line documentation)
property. Setting this property to True prevents Spread from doing a full page postback when implementing the
following features - expanding and collapsing child sheets in a hierarchical display, column sorting, inserting rows, or
paging.

If the ClientAutoCalculation ('ClientAutoCalculation Property’ in the on-line documentation) property is
true, then after a cell value is changed, an AJAX call is made to the FpSpread component. Then the component
calculates the formulas and sends the values to the client side. The component then updates the values at the client side.

Use the EnableAjaxCall ("EnableAjaxCall Property' in the on-line documentation) property to enable AJAX
support or use EnableAjaxCall and the ClientAutoCalculation ('ClientAutoCalculation Property' in the on-
line documentation) properties to enable AJAX support of formulas.

Using Code

You can set the EnableAjaxCall ("EnableAjaxCall Property' in the on-line documentation) property and the
ClientAutoCalculation ('ClientAutoCalculation Property' in the on-line documentation) property in code.

Example

The following code allows AJAX support and AJAX support of formulas.

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide

C#

FpSpreadl.EnableAjaxCall = true;
FpSpreadl.ClientAutoCalculation = true;

VB

FpSpreadl.EnableAjaxCall = True
FpSpreadl.ClientAutoCalculation = True<

Using the Spread Designer

Select the Settings menu.

Click OK.
Click Apply and Exit to close the Spread Designer.

Using ASP.NET AJAX Extenders

AN e N

Select the General icon under the Spread Settings section.
Select the General tab and check the Enable AJAX Call box.
Select the Edit tab in order to set the Client Auto Calculation check box.

114

You can use the many cell types in the FarPoint.Web.Spread.Extender assembly to provide controls that are available as

ASP.NET AJAX extender controls. The extender controls enhance the client capabilities of other controls.
For more information about extender cell types, refer to Working with ASP.NET AJAX Extender Cell Types.
The various cell types that use ASP.NET AJAX extender controls include:

e Setting an Automatic-Completion Cell

¢ Setting a Calendar Cell

e Setting a Filtered Text Cell

e Setting a Masked Edit Cell

e Setting a Mutually Exclusive Check Box Cell
¢ Setting a Numeric Spin Cell

¢ Setting a Rating Cell

e Setting a Slider Cell

e Setting a Slide Show Cell

¢ Setting a Text Box with Watermark Cell

Using the AJAX Extenders

1. The current AJAX toolkit and setup is available at https://ajaxcontroltoolkit.codeplex.com/.

2. After installing the setup, add references to the new AjaxControlToolkit.dll files.

& Ifyou are using Ajax Control Toolkit 15.1.2, check http://www.nuget.org/packages/AjaxControlToolkit/ for

information about adding the references to the project.

& Check the https://ajaxcontroltoolkit.codeplex.com/ web site for the current location of the dll if you are

using Ajax Control Toolkit 15.1 or older.

&1 Earlier versions of the AJAX toolkit are available at the Microsoft ASP.NET AJAX Controls page

(http://ajax.asp.net/ajaxtoolkit/) and require downloading the zip file with the AJAX Control extenders

and adding the references.
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3. To use the AJAX Extender CellType, add a Script Manager to the page. From the Toolbox, under the AJAX
Extenders category select Script Manager and drag it to the ASPX page (Web Form) where you have the Spread
component.

& The AJAX Control Toolkit 15.1 stopped supporting ToolkitScriptManager and now supports the standard
ScriptManager. For more information, refer to https://ajaxcontroltoolkit.codeplex.com.

Spread supports multiple versions of AJAX so the oldest version is used in the development environment. If you use
AJAX Control Toolkit 15.1 when deploying to a server, the following configuration information about assembly binding
must be added so that the web server loads the correct version.

Web.config

<configuration>
<system.web>
</system.web>
<runtime>
<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>
<assemblyIdentity name="AjaxControlToolkit" publicKeyToken="28f01b0e84b6d53e"
culture="neutral"/>
<bindingRedirect oldVersion="3.0.30930.28736" newVersion="15.1.2.0" />
</dependentAssembly>
</assemblyBinding>
</runtime>
</configuration>

Customizing the Tool Bars

There are a set of tasks that allow you to customize how the user can interact with the spreadsheet, namely the parts of
the component that involve navigation and buttons in the tool bars that FpSpread displays above and below any sheet of
data. Not all of the tool bars are displayed automatically; some are optional. The tasks involved in customizing the
various tool bars include:

¢ Customizing the Command Bar on the Component

¢ Customizing the Command Buttons

¢ Changing the Command Button Images

¢ Hiding a Specific Command Button

¢ Working with the SaveExcel button on the CommandBar (on-line documentation)

¢ Displaying the Sheet Names

¢ Customizing Page Navigation

¢ Customizing Page Navigation Buttons on the Client

¢ Customizing the Hierarchy Bar

For information about the scroll bars, refer to Displaying Scroll Bars. For information about the graphical user
interface, refer to Customizing the Graphical Interface.

Customizing the Command Bar on the Component

The command bar is a tool bar that is displayed at the top or bottom of the component. This bar includes the sheet name
tabs (if there is more than one sheet) and the command buttons. By default, page navigation aids are also displayed on
the command bar but can be repositioned or not displayed on the command bar.
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Command buttons

Customizations

The customizations are made possible with the CommandBarInfo ('CommandBarInfo Class' in the on-line
documentation) object. You can do the following customizations:

e Customize the color of the command bar

¢ Customize the font style of the text in the sheet name tabs and buttons

e Hide the command bar if there is only one sheet

o Set the position of the command bar to be either at the top or bottom of the component
To set the color of the command bar, use the BackColor ('BackColor Property' in the on-line documentation)

property. To change the font of the text that appears in the buttons, use the Font ("Font Property' in the on-line
documentation) property.

To hide the command bar when there is only one sheet (and thus no sheet name tabs to display), use the Visible
('Visible Property' in the on-line documentation) property.

By default, the command bar is displayed at the bottom of the component. You can display it at the top by setting the
CommandBarOnBottom ('CommandBarOnBottom Property' in the on-line documentation) property in
the FpSpread ('FpSpread Class' in the on-line documentation) class.

Command Bar Position Example Spread

On Top Sheet? Sheets 36 BB Iy =
A B C D

On Bottom A B C D

Sheet? Sheet3 + 36 Em Iy =

Postbacks

Several, but not all, of the buttons in the command bar trigger a postback to the server. These include:
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¢ Delete button (AJAX postback)

e Print button

e Pager buttons (AJAX postback)

e Sheet buttons (AJAX postback)

e Update button (AJAX postback)

For information on other aspects of the appearance of the command bar buttons, refer to Customizing the
Command Buttons.

Using the Properties Window

1. Select the FpSpread component.

2. With the Properties window open, select the CommandBar property drop-down list, and set any of the
command bar properties. In order to set the BackColor setting for the command bar, set the Enable property to
False in the Background section.

Using Code

Use the properties of the FpSpread ('FpSpread Class' in the on-line documentation) class to define the position
of the command bar and use the command bar properties to customize the look of the command bar.

Example

In this example, set the command bar to display at the top of the component and set the color to yellow.

C#

FpSpreadl.CommandBarOnBottom = false;
FpSpreadl.CommandBar.Background = null;
FpSpreadl.CommandBar.BackColor = Color.Yellow;

VB

FpSpreadl.CommandBarOnBottom = False
FpSpreadl.CommandBar.Background = Nothing
FpSpreadl.CommandBar.BackColor = Color.Yellow

Using the Spread Designer

1. Select the Settings menu.

2. Select the Command Bar icon under the Spread Settings section (the property grid has additional settings
that are not available in the designer).

3. Select the various options.
4. Click Apply and OK.
5. Click Apply and Exit to close the Spread Designer.

Customizing the Command Buttons

You can customize how (and if) the command buttons are shown in the command bar. The figure below shows the
default display of the command buttons using the images (or icon) type of display.
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The various settings of the command bar are handled using the CommandBarInfo ('CommandBarInfo Class' in
the on-line documentation) class.

¢ You can display the command buttons as images (also called icons), push buttons (with text), or links (with
text). The default is to display them as images. This is the type of buttons displayed. You can also specify
themes for the button images.

¢ You can change the appearance of the text of the command buttons (if you are using the button type) using the
Font ('Font Property' in the on-line documentation) property.

¢ You can change the appearance of the command buttons using various button properties.

e You can display or not display the buttons on the command bar using the Visible ('Visible Property' in
the on-line documentation) property.

e You can change the images (as described in Changing the Command Button Images)

e You can hide or show the Save Excel button on the CommandBar to quickly export your spreadsheets to Excel

(using the ShowExcelButton ('ShowExcelButton Property' in the on-line documentation) property
in the CommandBarInfo ('CommandBarInfo Class' in the on-line documentation) class).

v 6 3 h =

Save Excel button

For more information, please refer to Working with the SaveExcel button on the CommandBar (on-line
documentation).

e You can hide or show a PDF button for printing to PDF (using the ShowPDFButton ('ShowPDFButton
Property’' in the on-line documentation) property in the CommandBarInfo ('CommandBarInfo
Class' in the on-line documentation) class).

v X En = 5

Which command buttons appear in the command bar change if you set the EnableClientScript
("EnableClientScript Property' in the on-line documentation) property to false for the component. Fewer
buttons are displayed, due to the limitations of not providing scripting on the client.

Print PDF button

Command Bar Button Types
The type of buttons displayed in the command bar can be any of these types:

Button Enumeration Typical Default Display
Type Setting

Images ImageButton R 3.5 Egy iD =
(or icons)

Text links LinkButton Update | Cancel | Cut | Copy | Paste | [= | << | == | =| | Print
lI)’lllltstl:)—ns PushButton Update | Cancel | Cut | Copy | Paste | < | = | Print |

Refer to the ButtonType ('ButtonType Enumeration' in the on-line documentation) enumeration and the
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ButtonType ('ButtonType Property' in the on-line documentation) property. Note that the buttons appear
grayed out or inactive until they can be used. The figures shown above show all the buttons active. The link type
command button option requires that the client-side scripting be disabled (FpSpread ('FpSpread Class' in the on-
line documentation) class, EnableClientScript ("EnableClientScript Property' in the on-line
documentation) property set to false). Client-side operations such as cut, copy, and paste are not available when
scripting is disabled so buttons for those operations do not appear on the command bar.

The properties that affect the appearance of the buttons include these:

CommandBarInfo Property Appearance Description
ButtonFaceColor ('ButtonFaceColor Property' in the on-line the background color of the buttons
documentation)

ButtonHighlightColor ('ButtonHighlightColor Property' in the the color of the top and left outline of
on-line documentation) the buttons

ButtonShadowColor ('ButtonShadowColor Property' in the on-  the color of the bottom and right outline
line documentation) of the buttons

Font ('"Font Property' in the on-line documentation) the color of text in the buttons

Remember that to update the data on the server, changes must be saved from the client. Changes from the client can be
saved either by using the SaveChanges ('SaveChanges Method' in the on-line documentation) method in code
or by having the user click the Update button on the command bar.

For other ways to customize parts of the command bar, refer to Customizing the Command Bar on the
Component.

Using the Properties Window

1. Select the FpSpread component.

2. With the Properties window open, select the CommandBar property drop-down list, and set any of the button
properties.

Using Code

Use the properties of the CommandBarInfo ('CommandBarInfo Class' in the on-line documentation) class
to define the appearance of the buttons.

Example

In this example, some of the button properties of the command bar are set. The result is shown in this figure.
Update | Cancel | Cut | Copy | Paste | < | 'z | > | | | Print |

C#

FpSpreadl.CommandBar.Background = null;

FpSpreadl.CommandBar.BackColor = Color.Yellow;
FpSpreadl.CommandBar.ButtonFaceColor = Color.YellowGreen;
FpSpreadl.CommandBar.ButtonTextColor = Color.RoyalBlue;
FpSpreadl.CommandBar.ButtonType = FarPoint.Web.Spread.ButtonType.PushButton;
FpSpreadl.CommandBar.Font.Bold = true;

FpSpreadl.CommandBar.Font.Name = "Comic Sans MS";
FpSpreadl.CommandBar.Visible = true;

VB

FpSpreadl.CommandBar.Background = Nothing
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FpSpreadl.CommandBar.BackColor = Color.Yellow
FpSpreadl.CommandBar.ButtonFaceColor = Color.YellowGreen
FpSpreadl.CommandBar.ButtonTextColor = Color.RoyalBlue
FpSpreadl.CommandBar.ButtonType = FarPoint.Web.Spread.ButtonType.PushButton
FpSpreadl.CommandBar.Font.Bold = True

FpSpreadl.CommandBar.Font.Name = "Comic Sans MS"
FpSpreadl.CommandBar.Visible = True

Using the Spread Designer

1. Select Spread in the Property grid.

2. Select the CommandBar property drop-down list, and set any of the button properties.
3. Click Apply and OK.

4. Click Apply and Exit to close the Spread Designer.

] Note: While you set any of the button properties above, make sure that the UseSheetSkin ('UseSheetSkin
Property' in the on-line documentation) property of the CommandBarInfo Class (on-line
documentation) is set to false.

Changing the Command Button Images

You can change the images used for the buttons in the command bar. By default, the command buttons are displayed as
images (or icons) since the ButtonType ('ButtonType Property' in the on-line documentation) property in the
CommandBarInfo ('CommandBarInfo Class' in the on-line documentation) class is set to ImageButton by
default. You can change the images by providing replacement images or by adding your own buttons in code. In
addition, you can change the buttons by setting the Theme ('Theme Property' in the on-line documentation)

property.

You can put images of any size in the command bar; the only limit to the size is the size of the command bar.
You can change the existing images by replacing them in the images subdirectory of the fp_client folder.

For information on other aspects of the appearance of the command bar buttons, refer to Customizing the
Command Buttons.

Using Code

Use the properties of the CommandBarInfo ('CommandBarInfo Class' in the on-line documentation) class
to define the appearance of the buttons.

Example

In this example, the default images are changed to XP theme images.

C#

FpSpreadl.Sheets[0] .RowCount = 20;
FpSpreadl.CommandBar.ButtonType = FarPoint.Web.Spread.ButtonType.ImageButton;
FpSpreadl.CommandBar.Theme = FarPoint.Web.Spread.ImageButtonTheme.Xp;

VB

FpSpreadl.Sheets (0) .RowCount = 20
FpSpreadl.CommandBar.ButtonType = FarPoint.Web.Spread.ButtonType.ImageButton
FpSpreadl.CommandBar.Theme = FarPoint.Web.Spread.ImageButtonTheme.Xp
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Using Code

Change the image for the Print button using the CreateButton ('CreateButton Event' in the on-line
documentation) event.

Example

In this example, the print button image is changed.

C#

private void FpSpreadl CreateButton(object sender,
FarPoint.Web.Spread.CreateButtonEventArgs e)
{

if (e.Command == "Print")

{

e.EnabledImgUrl = "happy.bmp";
}

}

VB

Protected Sub FpSpreadl CreateButton(ByVal sender As Object, ByVal e As
FarPoint.Web.Spread.CreateButtonEventArgs) Handles FpSpreadl.CreateButton
If e.Command = "Print" Then

e.EnabledImgUrl = "happy.bmp"

End If

End Sub

Using Code

=
You can also create your own buttons with code as displayed by the above image.
Override the Render event.
Create a new table cell.

Create a button control and set the button properties.
Add the button to the table cell.

S e A

Example

In this example, add the My Button button.
C#

protected override void Render (System.Web.UI.HtmlTextWriter writer)

{
Control updateBtn = FpSpreadl.FindControl ("Update") ;

if ((updateBtn != null))

{

TableCell tc = (TableCell)updateBtn.Parent;
TableRow tr = (TableRow)tc.Parent;

TableCell tcl = new TableCell();
tr.Cells.Add (tcl);

Button btn = new Button();
btn.CausesValidation = false;
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btn.Text = "My Button";
btn.Attributes.Add ("onclick", "Jjavascript:" +
this.Page.GetPostBackEventReference (FpSpreadl, "my command") + "; return false;");

tcl.Controls.Add (btn);
}

base.Render (writer) ;

}

VB

Protected Overrides Sub Render (ByVal writer As System.Web.UI.HtmlTextWriter)
Dim updateBtn As Control = FpSpreadl.FindControl ("Update")
If Not updateBtn Is Nothing Then

Dim tc As TableCell = updateBtn.Parent
Dim tr As TableRow = tc.Parent

Dim tcl As New TableCell ()
tr.Cells.Add (tcl)

Dim btn As New Button ()
btn.CausesValidation = False

btn.Text = "My Button"
btn.Attributes.Add ("onclick", "javascript:" +
Me.Page.GetPostBackEventReference (FpSpreadl, "my command") + "; return false;")
tcl.Controls.Add (btn)
End If

MyBase.Render (writer)
End Sub

You can process the button command by adding an event handler to the ButtonCommand ('ButtonCommand
Event' in the on-line documentation) event.

C#

private void FpSpreadlButtonCommand (object sender,
FarPoint.Web.Spread.SpreadCommandEventArgs e)

{
}

VB

Private Sub FpSpreadl ButtonCommand(ByVal sender As Object, ByVal e As
FarPoint.Web.Spread.SpreadCommandEventArgs) HandlesFpSpreadl.ButtonCommand
End Sub

Hiding a Specific Command Button

You can customize the display of the command buttons in the command bar by hiding any or all of the command
buttons.

122

To hide a command button, set the Visible ('Visible Property' in the on-line documentation) property to false in

the event that creates the button.

Using Code
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Use the CreateButton ('CreateButton Event' in the on-line documentation) event to hide certain buttons.

Example

This example uses code to hide the print icon by adding the Visible ('Visible Property' in the on-line
documentation) property to the CreateButton ('CreateButton Event' in the on-line documentation) event.
The result is shown in this figure.

v a6 BB Iy

C#

private void FpSpreadl CreateButton(object sender,
FarPoint.Web.Spread.CreateButtonEventArgs e)
{
if (e.Command == "Print")
{
e.Visible = false;

}

VB

Private Sub FpSpreadlCreateButton (ByVal sender As Object, ByVal e As
FarPoint.Web.Spread.CreateButtonEventArgs) Handles FpSpreadl.CreateButton
If e.Command = "Print" Then

e.Visible = False

End If

End Sub

Displaying the Sheet Names

You can customize how and if to display the sheet names in the bar at the bottom of the component. Since a component
may have more than one sheet, the tabs (or buttons) in the command bar contain the sheet names and provide a way to
navigate to different sheets. These are called sheet name tabs. The default sheet names are Sheeto, Sheet1, etc. You can
specify other names for the sheets and these appear in the sheet name tabs. By default, the component has only one
sheet and so no sheet name tabs are displayed. When you add a sheet, as described in Adding a Sheet, the sheet name
tabs are added to the command bar for display.

You can set how many sheet name tabs are displayed. If the number of tabs exceeds the value specified, an ellipses is
displayed. Click the ellipses to display the next (or previous) set of sheet names. You can also set the increment for
advancing the sheet names. Be sure not to set the increment bigger than the number displayed if you want to be able to
see all the sheet name tabs. You can set which sheet number displays first. These are all properties of the TabInfo
('TablInfo Class' in the on-line documentation) class.

Z] Note: The sheet changes when you click a different sheet name tab or when you click on the ellipses. When you
click on the ellipses, the lowest number sheet in the set of sheet names is displayed.
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1. To define when the sheet name tabs are displayed, use the TabControlPolicy ('TabControlPolicy Property’
in the on-line documentation) property of the TabInfo ("TabInfo Class' in the on-line
documentation) class and the settings of the TabControlPolicy ('TabControlPolicy Enumeration' in
the on-line documentation) enumeration.

Determine the various settings using the Tab ('Tab Property' in the on-line documentation) property of

the FpSpread ('"FpSpread Class' in the on-line documentation) component. Determine how many sheet
name tabs to display using the VisibleCount ('VisibleCount Property' in the on-line documentation)
property, how many to increment with the ScrollIncrement ('ScrollIncrement Property' in the on-line
documentation) property, and which is the first visible sheet name with the FirstVisibleTab
('FirstVisibleTab Property’ in the on-line documentation) property of the TabInfo ('TabInfo Class'
in the on-line documentation) class.

Determine the appearance of the sheet name tabs, such as the background color, the text color, and the text of the

sheet name using the properties of the TabInfo ("TabInfo Class' in the on-line documentation) class for
the Tab ('Tab Property’ in the on-line documentation) property of the component.

Example

In this example, set the sheet name tabs to always appear below the sheet at the bottom of the component and show only
two sheet names (two tabs) and set the background color of the active tab to green.

C#
FpSpreadl

FpSpreadl.
.Tab
.Tab.
.Tab.
.Tab.
.Tab
.Tab[0]
.Tab[1]
.Tab[2]

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

VB

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

FpSpreadl.
.Tab.

FpSpreadl

FpSpreadl.
FpSpreadl.
FpSpreadl.

.Tab.TabControlPolicy
.Sheets.Count
.Tab
.Tab.
.Tab.

Sheets.Count
Tab.

3;
TabControlPolicy
.VisibleCount = 2
ScrollIncrement
FirstVisibleTab = 1;

TextColor Color.Yellow;
.ActiveTabBackColor Color.Green;
"First";

"Second";

"Third";

|~

2;

FarPoint.Web.Spread
= 3
.VisibleCount = 2
ScrollIncrement = 2
FirstVisibleTab = 1
.ActiveTabBackColor
TextColor
Tab (0) "First"
Tab (1) "Second"
Tab (2) = "Third"

Tab Color.Green

Color.Yellow
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Using the Spread Designer

Select the Settings menu.

Select the General icon under the Spread Settings section.
Select Tab and specify the policy settings.

Click OK.

Click Apply and Exit to close the Spread Designer.

[ e

Customizing Page Navigation

A page is the amount of data in a sheet that can be displayed at one time. This is not the same as an HTML page. When
the sheet contains more rows than can be displayed in the component, Spread automatically creates pages that group
the rows and allows you to navigate between the pages of the sheet. For sheets that have more rows than fit in the
display area, the sheet has multiple pages. For example, for a sheet that has 50 rows, you may want to display only 10
rows at a time, so each page would be a set of 10 rows.

You can advance through these pages using the page navigation buttons that are available at the edge of the component.
These include next (right arrow) and previous (left arrow) buttons as well as page numbers. You can determine which of
these buttons are displayed by the component and where on the component they are displayed. Customizing these page
navigation aids is done with the properties of the PagerInfo ('PagerInfo Class' in the on-line documentation)
class and the Pager ('Pager Property' in the on-line documentation) property of the FpSpread ('FpSpread
Class' in the on-line documentation) class.

You can customize the page navigation in the following ways:

e Appearance (mode) of the navigation aids
e Type of buttons (image, link, or push) and image button themes
e Position of the navigation aids on the component; in which tool bars they appear
e Count of how many page numbers are displayed as part of the navigation aids
¢ Alignment of the navigation aids on the top or bottom bars
e Color of the background and color of the text in the bars with the navigation aids
e Font of the navigation aids in the bars
e Labels (text) of the navigation aids in the command bar
Mode: You can display either next (>>) and previous (<<) arrows, page numbers, or both as page navigation aids.

Clicking on the next and previous arrows has the same effect as clicking on the corresponding page number: advancing
through the pages to see the set of rows for that page.

Position: You can display these page navigation aids at the top of the sheet, the bottom of the sheet, on the command
bar, or some combination of these. The page numbers do not appear in the command bar, only the next and previous
arrows.

This figure illustrates the various optional placements of page navigation buttons with the default font and alignment:
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Note that you cannot display the page navigation in all these positions at once, but you can display them at the top and
bottom or top and command bar at the same time. The illustration serves to show the possible placements in one
diagram.

Numbers: For sheets that consist of many pages, you can set how many page numbers are displayed. If the number of
pages for a sheet exceeds the value specified by the PageCount property, an ellipses (...) is displayed. The user clicks the
ellipses to display the next (or previous) set of page numbers.

Alignment: You can set the alignment of the navigation aids when they appear in the top or bottom bar or both. When
right aligned, for example, the navigation aids appear on the right side of the bar(s). This does not affect the display in
the command bar.

Colors: You can set both the background color of the page navigation aids and the text color (foreground color) for
display in the top or bottom bar or both. This does not affect the display in the command bar.

Font: You can set the font, when the navigation aids are displayed in the top or bottom bar or both. This does not affect
the display in the command bar.

Labels: You can customize the labels of these buttons on the client using the CreateButton event. For more information,
refer to Customizing Page Navigation Buttons on the Client.

For more information on setting the size of the page, refer to Customizing the Page Size (Rows to Display).
Using the Properties Window

1. Select the FpSpread component.
2. Select the Pager object and set properties as needed.
3. Select the Sheets collection and set properties such as PageSize and RowCount.

Using Code

1. Use the PagerInfo ('PagerInfo Class' in the on-line documentation) class to set the properties of the
Pager ('Pager Property' in the on-line documentation) property for the FpSpread ('FpSpread Class'
in the on-line documentation) component.

2. Specify what part of the page navigation to display by setting the Mode ("Mode Property' in the on-line
documentation) property of the PagerInfo ('PagerInfo Class' in the on-line documentation) class with
the settings of the PagerMode ('PagerMode Enumeration' in the on-line documentation) enumeration.

3. Specify where to display the page navigation aids by setting the Position ('Position Property' in the on-line
documentation) property with the settings of the PagerPosition ('PagerPosition Enumeration' in the
on-line documentation) enumeration and how many page numbers to display by setting the PageCount
('PageCount Property' in the on-line documentation) property.

4. Specify the appearance of the page navigation aids by setting the font and color.
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Example

In this example, set the page navigation buttons to appear at the top of the component on a separate tool bar above the
sheet (and not on the tool bars below the sheet). Display both the page numbers and the page arrows with the specified
font and colors and display them on the right side of that top bar, as shown in the figure.

M« _5678...0 M
A B C D
53 n
54 o
55
Sheet? Sheet3 .. v © 6 p &

C#

// Set the number of sheets.
FpSpreadl.Sheets.Count 5;
// Set the number of rows on the first sheet

FpSpreadl.Sheets[0] .RowCount =

FpSpreadl.Sheets[0] .PageSize

// Display the pager only at
FpSpreadl.Pager.Position F

136;// Set the number of rows per page in this sheet.
= 13;

the top of the component.
arPoint.Web.Spread.PagerPosition.Top;

// Display both numbers and arrows by setting mode.
// Set the mode after the position, otherwise an error.
FpSpreadl.Pager.Mode FarPoint.Web.Spread.PagerMode.Both;

// Format

the text in the pager at the top.

FpSpreadl.Pager.Align = HorizontalAlign.Right;
FpSpreadl.Pager.Font.Bold = true;
FpSpreadl.Pager.Font.Name = "Trebuchet MS";
FpSpreadl.Pager.ForeColor = Color.Brown;
FpSpreadl.Pager.BackColor = Color.Orange;

// Display at most four page numbers at a time.
FpSpreadl.Pager.PageCount = 4;

VB

' Set the
FpSpreadl
' Set the
FpSpreadl
FpSpreadl

of sheets.

.Sheets.Count 5

number of rows on the first sheet.

.Sheets (0) .RowCount 136' Set the number of rows per page in this sheet.
.Sheets (0) .PageSize 13

number

' Display
FpSpreadl
' Display

the pager only at the top of the component.
.Pager.Position FarPoint.Web.Spread.PagerPosition.Top
both numbers and arrows by setting mode.

' Set the mode after the position, otherwise an error.
FpSpreadl.Pager.Mode FarPoint.Web.Spread.PagerMode.Both

' Format the text in the pager at the top.

FpSpreadl.Pager.Align = HorizontalAlign.Right
FpSpreadl.Pager.Font.Bold = True
FpSpreadl.Pager.Font.Name = "Trebuchet MS"

FpSpreadl.Pager.ForeColor Color.Brown
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FpSpreadl.Pager.BackColor = Color.Orange
' Display at most four page numbers at a time.
FpSpreadl.Pager.PageCount = 4

Using the Spread Designer

Select the Settings menu.

Select the Paging icon under the Spread Settings section.
Select the various options.

Click Apply and OK.

Click Apply and Exit to close the Spread Designer.

LI e

Customizing Page Navigation Buttons on the Client

If the command bar is displayed, you can customize the labels of the page navigation buttons, as well as other aspects of
the button appearance by using the CreateButton ('CreateButton Event' in the on-line documentation) event.
Refer to the CreateButtonEventArgs ('CreateButtonEventArgs Class' in the on-line documentation) class
members for more details.

If the command bar is not displayed, there are no buttons being created so you cannot use the CreateButton
('CreateButton Event' in the on-line documentation) event. But you can still customize the appearance using
client code to achieve the same results. On the client side, the page navigation links are drawn in a table cell on the
resulting HTML page. You can get access to that table cell and draw your own label instead.

Using Code

Here is the client code to display a version of the links to the next and previous pages by manipulating the table cells and
creating buttons for these.

Client Code

function window.onload ()
{
var pager=document.all ("FpSpreadl Pagerl");
for(var i=0;i&lt;pager.childNodes.length;i++) {
switch (pager.childNodes (i) .nodeType) {
case 1:
switch (pager.childNodes (i) .innerText) {
case "&lt;&lt;":

pager.childNodes (i) .innerText = "&lt;&lt;Prev ";
break;
case "&gt;&gt;":
pager.childNodes (i) .innerText = " Nexté&gt;&gt;";
break;
}
case 3:

switch (pager.childNodes (i) .data) {
case "&lt;&lt;":
pager.childNodes (i) .data = "&lt;&lt; Prev";
break;
case "&gt;&gt;":
pager.childNodes (i) .data
break;

" Next &gt;é&gt;";
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Customizing the Hierarchy Bar

When you nest an entire sheet in a cell, you have a hierarchy. As an alternative to displaying the entire hierarchy of
sheets, you can display only one sheet at a time with its hierarchy information displayed in the tool bars above the sheet.
This hierarchy information displays the names of the different sheet levels (the whole path) on one line and lets you click
on any of those levels, and it displays the information about the parent row (the row above the displayed sheet) on
another line. You can decide whether to display one or both of these with the HierBar ("HierBar Property' in the
on-line documentation) property.

Hierarchy Bar

| 1] Subject:Music | owner:( | owner-subject:0-Idusic |
| Students | Class | Grades |

|?5 50 85 a§\ 90 93 99\ |

\\‘ Parent Row

Links to Whole Path
Cther Levels to this
in Hierarchy Child Sheet

v X EBER WP

You can customize how the hierarchy information is displayed for cells that have sheets within them. You can display the
parent row information, the whole path information, or both.

For more information on the hierarchical display of data, typically with a component bound to a data set, refer to
Displaying Data as a Hierarchy.

For more information on Outlook-style grouping for hierarchical display of data, refer to Customizing Grouping of
Rows of User Data.

For information about how to customize the expand and collapse icons, refer to the Customizing the Graphical
Interface.

Using Code

1. Bind the Spread control to a hierarchical dataset (refer to the HierBar ("HierBar Property' in the on-line
documentation) property to see an example of how to bind the control to a hierarchical dataset).

2. Add code that sets the specific property for the hierarchy bar using either the HierBarInfo ('HierBarInfo
Class' in the on-line documentation) class or the HierBar ('"HierBar Property' in the on-line
documentation) property of the FpSpread ('"FpSpread Class' in the on-line documentation)
component.
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Example

In this example, turn on the hierarchy bar and display it above the sheet (and thereby not display the entire hierarchy of
sheets) and show both pieces of information: the parent row information and the whole path to this child sheet.

C#

FpSpreadl .HierarchicalView = false;
FpSpreadl.HierBar.ShowParentRow = true;
FpSpreadl.HierBar.ShowWholePath = true;

VB

FpSpreadl.HierarchicalView = False
FpSpreadl.HierBar.ShowParentRow = True
FpSpreadl.HierBar.ShowWholePath = True

Customizing Interaction with Rows and Columns

You can customize these aspects of user interaction with rows and columns:

e Allowing the User to Move Columns

¢ Allowing the User to Move Rows (on-line documentation)
¢ Allowing the User to Resize Rows or Columns

¢ Freezing Rows and Columns

e Setting up Row Edit Templates

e Setting up Preview Rows

For more information related to rows and columns, refer to these topics:

¢ Customizing Simple Filtering of Rows of User Data
¢ Customizing Grouping of Rows of User Data
¢ Customizing Sorting of Rows of User Data

For more information related to ranges of cells, refer to these topics:

¢ Customizing Selections of Cells
¢ Customizing the Appearance of a Cell
¢ Customizing with Cell Types

Allowing the User to Move Columns

You can allow the user to drag and move columns. Set the AllowColumnMove ('AllowColumnMove Property' in
the on-line documentation) property in the SheetView ('SheetView Class' in the on-line documentation)
class to allow the user to move columns.

For the user to move columns, they simply left click on the header of the column to move and drag the header back or
forth over the header area and release the mouse over the header of the desired destination.

Moving columns is not supported in child sheets in hierarchical displays.
Using the Properties Window

1. At design time, in the Properties window, select the FpSpread component.
2. Select the Sheets property.
3. Click the button to display the SheetView Collection Editor.
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4. In the Behavior section, set the AllowColumnMove property.
5. Click OK to close the SheetView Collection Editor.

Using a Shortcut
Set the AllowColumnMove ('AllowColumnMove Property' in the on-line documentation) property.
Example

This example code sets the AllowColumnMove ('AllowColumnMove Property' in the on-line
documentation) property.

C#

FpSpreadl.ActiveSheetView.AllowColumnMove = true;

VB

FpSpreadl .ActiveSheetView.AllowColumnMove = True

Allowing the User to Resize Rows or Columns

You can allow the user to readjust the size of a row or column in the sheet. Set the Resizable ('Resizable Property'
in the on-line documentation) property for the row to allow the user to resize rows and the Resizable ('Resizable
Property' in the on-line documentation) property for the column to allow the user to resize columns.

For users to resize rows or columns, they simply left click on the edge of the header of the row or column to resize and
drag the side of the header and release the mouse at the desired size. While the left mouse button is down, a bar is
displayed along with the resize pointer as shown in the figure below. Be sure to click on the right edge of the column and
bottom edge of the row.

A & B
1

By default, user resizing of rows or columns is allowed for rows and columns in the data area and not allowed for the
header area. In code, you can resize row and column headers, not just data area rows and columns. You can override the
default behavior using the Resizable property and prevent the user from resizing.

You can determine if a row or column can be resized by the user with these methods in the SheetView ('SheetView
Class' in the on-line documentation) class:

¢ GetColumnSizeable ('GetColumnSizeable Method' in the on-line documentation)
¢ SetColumnSizeable ('SetColumnSizeable Method' in the on-line documentation)
¢ GetRowsSizeable ('GetRowSizeable Method' in the on-line documentation)
¢ SetRowSizeable ('SetRowSizeable Method' in the on-line documentation)

Using Code
Set the Resizable ('Resizable Property' in the on-line documentation) property.
Example

This example code sets the Resizable ('Resizable Property' in the on-line documentation) property.

C#
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FpSpreadl.Sheets[0].Columns[0] .Resizable = true;
FpSpreadl.Sheets[0] .Rows[0] .Resizable = true;
FpSpreadl.Sheets[0].Columns[1l] .Resizable = false;
FpSpreadl.Sheets[0] .Rows[1l] .Resizable = false;
VB

FpSpreadl.Sheets (0) .Columns (0) .Resizable = True
FpSpreadl.Sheets (0) .Rows (0) .Resizable = True
FpSpreadl.Sheets (0) .Columns (1) .Resizable = False
FpSpreadl.Sheets (0) .Rows (1) .Resizable = False

Using the Spread Designer

1. Select a column or row.
2. Set the Resizable property in the Property Grid.
3. Click Apply and Exit to close the Spread Designer.

Freezing Rows and Columns

Frozen rows and frozen columns do not scroll when the user uses the scroll bar or navigation keys in the component.
This is useful if you need information in non-header rows or columns to stay visible regardless of where in the sheet the
user navigates. Frozen rows and frozen columns are supported with Microsoft Internet Explorer (IE) and Mozilla Firefox
when the FpSpread EnableClientScript ('"EnableClientScript Property' in the on-line documentation)
property is true.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.
. Click the button to display the SheetView Collection Editor.

. In the Appearance section, set the number of frozen rows or columns using FrozenRowCount or
FrozenColumnCount.

5. Click OK to close the SheetView Collection Editor.

A W N R

Using a Shortcut

Set the FrozenColumnCount ('"FrozenColumnCount Property’ in the on-line documentation) or
FrozenRowCount ('FrozenRowCount Property' in the on-line documentation) property in the sheet of the
component.

Example

This example code sets FrozenColumnCount ('FrozenColumnCount Property' in the on-line
documentation) and FrozenRowCount ('FrozenRowCount Property' in the on-line documentation).

C#

FpSpreadl.Sheets[0] .FrozenColumnCount = 2;
FpSpreadl.Sheets[0] .FrozenRowCount = 1;

VB

FpSpreadl.Sheets (0) .FrozenColumnCount = 2
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FpSpreadl.Sheets (0) .FrozenRowCount = 1

Using the Spread Designer

1. Select Sheet from the drop-down combo box to the right of the designer.
2. In the Appearance section, set the number for FrozenColumnCount or FrozenRowCount.
3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Setting up Row Edit Templates

You can allow a row edit template to be displayed so the user can edit the contents of an entire row using a specified
template or form. In the example shown here, the entire row of data is presented to the user as a vertical form with an
Update and Cancel button at the bottom of the form.

Book Mo. Book Mame Price | InHouse | Owner
1 MNOO01 Dynarmic HTML 20 Owen
2 MNoo2 C55 Mastery £30 ] Winnoy
3 |NOO3 JavaScript Ref £40 ¥ enture
4 NOo4 ASP.MET 2.0 525 Lucky
Book Information Management
Book Mo MO05
Book Mame FPrograming Windows
g  [Price 5'—?-'391
InHouse
Owner Owen w
Update Cancel
6 NOOB Thinking C++ £16 Chwen
7 Mooz Mational Geographic £10 Owen
AN e L =

The API members that are involved with this feature include:

¢ FpSpread.RowEditTemplate ('RowEditTemplate Property' in the on-line documentation)
property

o SheetView.RowEditTemplate ('RowEditTemplate Property' in the on-line documentation)
property

¢ RowEditTemplateContainer ('RowEditTemplateContainer Class' in the on-line documentation)
class and its members

In most cases, you can use RowEditTemplateContainer ('RowEditTemplateContainer Class' in the on-line
documentation) for the template control. But the editing template can contain other kinds of controls. In these cases,
you must develop code to update the data of these controls.

When users double click a row, the row edit template appears. Then users can edit the data of the row, and press the
Update link button to commit changes or press the Cancel link button to discard the changes.

The row edit template supports XML serialization so custom editing template can be saved and loaded along with
Spread.

You can create the row edit template at design time or run time.
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Using Code

Set the EnableRowEditTemplate ("EnableRowEditTemplate Property' in the on-line documentation),
EnableClientScript ('"EnableClientScript Property' in the on-line documentation), and OperationMode
('OperationMode Property' in the on-line documentation) properties.

Example

This example code sets the EnableRowEditTemplate ("EnableRowEditTemplate Property' in the on-line
documentation) property.

C#

FpSpreadl .ActiveSheetView.EnableRowEditTemplate = true;
FpSpreadl.EnableClientScript = true;
FpSpreadl.ActiveSheetView.OperationMode = FarPoint.Web.Spread.OperationMode.RowMode;

VB

FpSpreadl.ActiveSheetView.EnableRowEditTemplate = True
FpSpreadl.EnableClientScript = True
FpSpreadl.ActiveSheetView.OperationMode = FarPoint.Web.Spread.OperationMode.RowMode

Using Design Settings

. Select Edit Templates from the Spread smart tag.

. Select Editing Template from the drop-down.

. Drag the FpSpreadTemplateReplacement control from the Visual Studio toolbox to the edit template area.
. Select a task (such as CellType) and specify the column index.

. Add code to set EnableRowEditTemplate to true and OperationMode to row mode (see above code).
. Run the project and double-click a cell in column o to edit it.

N A W DN =

Setting up Preview Rows

You can display a preview row to provide more information about a record. The preview row is displayed below the row
it provides information for. You can specify colors and other formatting for the preview row as well. The gray rows in the
following picture are preview rows.

] Photo
1 FarFigint
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1 Web Forms

~fimages/Columns. gif
ahe def ghl kI moo par sty v vz al

2 FarPgint
Spre

Web Forms

~fimages/Columns. gif
ghed efgh kI maop grat W vz ab

Use the Edit Template verb at design time to create a preview template.

Set the PreviewRowVisible ('"PreviewRowVisible Property' in the on-line documentation) property to true
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in order to see the preview row. Use the PreviewRowColumnIndex ('PreviewRowColumnIndex Property' in
the on-line documentation) property to specify which column’s text you wish to see in the preview row. You can use
the PreviewRowStyle ('"PreviewRowStyle Property' in the on-line documentation) property to provide
additional formatting using a style element. Or you can set various properties for the PreviewRowStyle
('PreviewRowStyle Property' in the on-line documentation) such as BackColor, Border, Font, and so on.

The API members involved in this feature include:

¢ PreviewRowInfo ('PreviewRowInfo Class' in the on-line documentation) class

¢ PreviewRowTemplateContainer ('PreviewRowTemplateContainer Class' in the on-line
documentation) class

e SheetView.PreviewRowColumnIndex ('PreviewRowColumnIndex Property' in the on-line
documentation) property

o SheetView.PreviewRowStyle ('PreviewRowStyle Property' in the on-line documentation) property

e SheetView.PreviewRowTemplate ('"PreviewRowTemplate Property' in the on-line
documentation) property

¢ SheetView.PreviewRowVisible ('"PreviewRowVisible Property' in the on-line documentation)
property

Using Design Settings

Click on Edit Templates from the Spread smart tag.

Select Preview Row Template from the drop-down.

Drag the a control from the Visual Studio toolbox to the edit template area or use a default template.
Set colors or other properties.

Select End Template Editing when you are done editing the template.

[ e

Managing Filtering of Rows of User Data

You can create filters for data. The basic steps are to create a filter and then assign the filter to a column. You can specify
certain details for the filter such as creating a background color for filtered and non-filtered rows with a style filter or
creating a hide row filter that hides the rows.

Spread provides several types of filtering, simple and enhanced. The simple filtering is the style of filtering provided in
this and previous releases of Spread. The enhanced filtering is similar to Excel's filter feature. Spread also provides a
filter bar that uses the enhanced filtering options.

Each type of filtering provides a way for users to change data's appearance or temporarily hide data based on conditions
that they specity, as shown in the following figures. This figure illustrates the simple filter.

(Al hd Al hd D
3
1 4
2 5
(MonBlanks)
3
v © 3 B in =

The following figure illustrates the enhanced filter.
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A - B - C - D
1 |
2 Mumber Filters k|
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o ] (Select All
OK Cancel

The filter bar provides a text box, a list of enhanced filter choices, and a filter icon. This figure illustrates a filter bar.

A B C D

EqualTo
MotEqualTe

£

GreaterThan |

] LessThan
GreaterThanOrEqualTo
LessThanOrEqualTo
Eetween...
MotBetween..

IsMull
MotlsMull
Custom...

You can customize many features for each type of filtering, as well as the display of filtered rows, as described in the
following sections.

¢ Creating Filtered Rows and Setting the Appearance
¢ Customizing Simple Filtering of Rows of User Data
¢ Using Enhanced Filtering

e Using the Filter Bar
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Creating Filtered Rows and Setting the Appearance

You can customize the appearance of filtered rows to allow you to see which rows are filtered in and which ones are
filtered out. Rows that meet the criteria for the row filter are said to be "filtered in"; rows that do not meet the criteria
are said to be "filtered out." Filtering may either hide the rows that are filtered out, or change the styles such as the
background color for both filtered-in and filtered-out rows. If you want the styles to change, so that you can continue to
display all the data but highlight rows that match some criteria, then you must define a filtered-in style and a filtered-out

style.

Hidden rows are not displayed even if they match the filter criteria.

A row filter uses a style row filter or a hide row filter. The style row filter changes the appearance of the filtered row. The
hide row filter hides the rows that do not meet the filter criteria.

You define styles by creating NamedStyle objects that contain all the style settings. Then when the row filtering is
applied to a column, you specify those defined style settings by referring to the NamedStyle object for that filtered
state. For more information about the row filter that uses styles, refer to the StyleRowFilter ('StyleRowFilter Class'
in the on-line documentation) class.

You can create a hide or style row filter using the Spread Designer. Select the Spread control in the property grid drop-
down of the designer, then select the Sheets Collection (under Data), and then select the Row Filter option in the
SheetView Collection editor.

In addition to creating row filters for the user to select the item; you can also programmatically filter a row.

You can specify simple filtering, enhanced filtering, or the filter bar with the AutoFilterMode ('AutoFilterMode
Property’' in the on-line documentation) property.

For detailed information on the objects involved, refer to these classes.

¢ BaseFilterItem ('BaseFilterItem Class' in the on-line documentation) Class

¢ DefaultFilterItem ('DefaultFilterItem Class' in the on-line documentation) Class

¢ DefaultRowFilter ('DefaultRowFilter Class' in the on-line documentation) Class

¢ FilterColumnDefinition ('FilterColumnDefinition Class' in the on-line documentation) Class

¢ FilterColumnDefinitionCollection ('FilterColumnDefinitionCollection Class' in the on-line
documentation) Class

¢ FilterItemCollection ('FilterItemCollection Class' in the on-line documentation) Class

¢ TFilterListBehavior ('FilterListBehavior Enumeration' in the on-line documentation)
Enumeration

¢ HideRowtFilter ("HideRowFilter Class' in the on-line documentation) Class
¢ StyleRowgFilter ('StyleRowFilter Class' in the on-line documentation) Class

Using Code
Create a named style and then set the style row filter.
Example

This example code sets a style row filter.

C#

FarPoint.Web.Spread.NamedStyle instyle = new FarPoint.Web.Spread.NamedStyle();
FarPoint.Web.Spread.NamedStyle outstyle = new FarPoint.Web.Spread.NamedStyle();
instyle.BackColor = Color.Yellow;

outstyle.BackColor = Color.Aquamarine;
FarPoint.Web.Spread.FilterColumnDefinition fcd = new
FarPoint.Web.Spread.FilterColumnDefinition (1,
FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences |
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FarPoint

FarPoint.

FarPoint

FarPoint.
FarPoint.
FarPoint.
FarPoint.

.Web.
Web.
.Web.

Web

Web.
Web.

Web

Spread.
Spread.
Spread.
. Spread.
Spread.
Spread.
.Spread.

sf.AddColumn (fcd) ;
sf.AddColumn (fcdl)
sf.AddColumn (fcd2) ;
FpSpreadl.Sheets[0]

VB

FilterListBehavior.Default);

FilterColumnDefinition fcdl = new
FilterColumnDefinition(2);
FilterColumnDefinition fcd2 = new

FilterColumnDefinition () ;
StyleRowFilter sf = new

StyleRowFilter (FpSpreadl.Sheets[0], instyle,

.RowFilter = sf;

Dim instyle As New FarPoint.Web.Spread.NamedStyle ()
Dim outstyle As New FarPoint.Web.Spread.NamedStyle ()
instyle.BackColor =
outstyle.BackColor
Dim fcd As New FarPoint.Web.Spread.FilterColumnDefinition (1,

FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences Or

Color.Yellow
Color.Aquamarine

FarPoint.Web.Spread.FilterListBehavior.Default)

Dim fcdl As New FarPoint.Web.Spread.FilterColumnDefinition (2)

Dim fcd2 As New FarPoint.Web.Spread.FilterColumnDefinition ()

Dim sf As New FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets (0),

outstyle)

sf.AddColumn(fcd

sf.AddColumn (

sf.AddColumn (f
FpSpreadl.Sheets

Using Code

)

fcdl)

cd2)
(0)

.RowFilter = sf

Create a column filter definition and set a hide row filter.

Example

This example code uses the hide row filter.

C#

FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.
FarPoint.

Web.
Web.
Web.
Web.
Web.
Web.

Web

Web.
Web.
Web.
Web.

Spread.
Spread.
Spread.
Spread.
Spread.
Spread.
.Spread.
Spread.
Spread.
Spread.
Spread.

hf.AddColumn (fcd) ;
hf.AddColumn (fcdl

)
hf.AddColumn (fcd2) ;
FpSpreadl.Sheets [0

VB

].

FilterColumnDefinition fcd = new
FilterColumnDefinition (1,
FilterListBehavior.SortByMostOccurrences
FilterListBehavior.Default);

FilterColumnDefinition fcdl = new
FilterColumnDefinition (2,
FilterListBehavior.Default);
FilterColumnDefinition fcd2 = new

FilterColumnDefinition (3);
HideRowFilter hf = new
HideRowFilter (FpSpreadl.Sheets[0]);

RowFilter = hf;
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Dim fcd As New FarPoint.Web.Spread.FilterColumnDefinition (1,

FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences Or

FarPoint.Web.Spread.FilterListBehavior.Default)

Dim fcdl As New FarPoint.Web.Spread.FilterColumnDefinition (2)

Dim fcd2 As New FarPoint.Web.Spread.FilterColumnDefinition (3)

Dim hf As New FarPoint.Web.Spread.HideRowFilter (FpSpreadl.Sheets (0))

hf.AddColumn (fcd)

hf.AddColumn (fcdl)

hf.AddColumn (fcd?2)
0

FpSpreadl.Sheets (0) .RowFilter = hf

Using Code
Create a column filter definition and set a row filter.
Example

This example applies a filter programmatically with the AutoFilterColumn ('AutoFilterColumn Method' in the
on-line documentation) method.

C#

FpSpreadl.Sheets[0] .Cells [0, 2].Text = "test";

FarPoint.Web.Spread.NamedStyle instyle = new FarPoint.Web.Spread.NamedStyle () ;
FarPoint.Web.Spread.NamedStyle outstyle = new FarPoint.Web.Spread.NamedStyle();
instyle.BackColor = Color.Yellow;

outstyle.BackColor = Color.Aquamarine;
FarPoint.Web.Spread.FilterColumnDefinition fcd = new
FarPoint.Web.Spread.FilterColumnDefinition (1,
FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences |
FarPoint.Web.Spread.FilterListBehavior.Default);

FarPoint.Web.Spread.FilterColumnDefinition fcdl = new
FarPoint.Web.Spread.FilterColumnDefinition (2);
FarPoint.Web.Spread.FilterColumnDefinition fcd2 = new

FarPoint.Web.Spread.FilterColumnDefinition () ;
FarPoint.Web.Spread.StyleRowFilter sf = new
FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets[0], instyle, outstyle);
sf.AddColumn (fcd) ;

sf.AddColumn (fcdl) ;

sf.AddColumn (fcd2) ;

FpSpreadl.Sheets[0] .RowFilter = sf;

FpSpreadl.Sheets[0] .AutoFilterColumn (2, "test");

VB

FpSpreadl.Sheets (0) .Cells (0, 2).Text = "test"

Dim instyle As New FarPoint.Web.Spread.NamedStyle ()

Dim outstyle As New FarPoint.Web.Spread.NamedStyle ()
instyle.BackColor = Color.Yellow

outstyle.BackColor = Color.Aquamarine

Dim fcd As New FarPoint.Web.Spread.FilterColumnDefinition (1,
FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences Or
FarPoint.Web.Spread.FilterListBehavior.Default)

Dim fcdl As New FarPoint.Web.Spread.FilterColumnDefinition (2)
Dim fcd2 As New FarPoint.Web.Spread.FilterColumnDefinition ()
Dim sf As New FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets (0), instyle,
outstyle)
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sf.AddColumn (fcd)

sf.AddColumn (fcdl)

sf.AddColumn (fcd2)

FpSpreadl.Sheets (0) .RowFilter = sf
FpSpreadl.Sheets (0) .AutoFilterColumn (2, "test")

Customizing Simple Filtering of Rows of User Data

You can customize certain details for simple filtering as well as create a custom filter. The following topics provide more
information about using and customizing simple filters:

¢ Using Row Filtering
e Customizing the List of Filter Items
¢ Creating a Completely Custom Filter

For information on selections of cells, refer to Customizing Selections of Cells.

For information on how to change the appearance of cells, refer to Customizing the Appearance of a Cell. For
information on setting the cell type, refer to Customizing with Cell Types.

Using Row Filtering

This topic summarizes how the end user can interact with the simple row filtering feature.

Once you have row filtering applied to a column, an indicator appears in the column header as in the following figure:
(Al b

If you want to display a label for the header, you must add another row of column headers and put the label in that row.

The column header displays the row filtering indicator, a drop-down arrow symbol. Clicking on this indicator provides a
drop-down list of the filter choices. Picking an item from this list causes that filter to be applied and all the rows meeting
that condition (in this column) are filtered. The default drop-down list contains all the unique text values in cells in this
column. The figure below shows an example of a drop-down list of filters:

(Al v

(Blanks)
(NonBlanks)

The table below summarizes the entries in the drop-down list.

Filter List Description

Item

(AID Include or allow all the rows in this column regardless of content

[contents] Include or allow only those rows with this particular cell content in this column

(Blanks) Include or allow only rows that have blanks (empty cells) in this column

(NonBlanks) Include or allow only rows that have non-blanks (non-empty cells) in this column, in other words

any cell that has any content

You can customize the filter list. For more information, see Customizing the List of Filter Items.

Using Code
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Create a named style and then set the style row filter.
Example

This example code sets a style row filter.

C#

FpSpreadl.ActiveSheetView.AutoFilterMode =
FarPoint.Web.Spread.AutoFilterMode.FilterGadget;

FarPoint.Web.Spread.NamedStyle instyle = new FarPoint.Web.Spread.NamedStyle () ;
FarPoint.Web.Spread.NamedStyle outstyle = new FarPoint.Web.Spread.NamedStyle()
instyle.BackColor = Color.Yellow;

outstyle.BackColor = Color.Aquamarine;
FarPoint.Web.Spread.FilterColumnDefinition fcd = new
FarPoint.Web.Spread.FilterColumnDefinition (1,
FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences |
FarPoint.Web.Spread.FilterListBehavior.Default);
FarPoint.Web.Spread.FilterColumnDefinition fcdl = new
FarPoint.Web.Spread.FilterColumnDefinition (2) ;
FarPoint.Web.Spread.FilterColumnDefinition fcd2 = new
FarPoint.Web.Spread.FilterColumnDefinition () ;
FarPoint.Web.Spread.StyleRowFilter sf = new

FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets[0], instyle, outstyle);
sf.AddColumn (fcd) ;
sf.AddColumn (fcdl)
sf.AddColumn (fcd2) ;
FpSpreadl.Sheets[0] .RowFilter = sf;

VB

FpSpreadl.ActiveSheetView.AutoFilterMode =
FarPoint.Web.Spread.AutoFilterMode.FilterGadget

Dim instyle As New FarPoint.Web.Spread.NamedStyle ()

Dim outstyle As New FarPoint.Web.Spread.NamedStyle ()

instyle.BackColor = Color.Yellow

outstyle.BackColor = Color.Aquamarine

Dim fcd As New FarPoint.Web.Spread.FilterColumnDefinition (1,

FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences Or

FarPoint.Web.Spread.FilterListBehavior.Default)

Dim fcdl As New FarPoint.Web.Spread.FilterColumnDefinition (2)

Dim fcd2 As New FarPoint.Web.Spread.FilterColumnDefinition ()

Dim sf As New FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets (0), instyle,

outstyle)

sf.AddColumn (fcd)

sf.AddColumn (fcdl)

sf.AddColumn (fcd2)
(0

FpSpreadl.Sheets (0) .RowFilter = sf

Customizing the List of Filter Items

You can customize the text of the default filter items in the drop-down filter list. The items that are displayed in the
drop-down filter list are column filter definitions. You can customize the text of those by changing the value of the
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AllString ('AllString Property’' in the on-line documentation), BlanksString ('BlanksString Property' in
the on-line documentation), and NonBlanksString ('NonBlanksString Property' in the on-line
documentation) properties.

Using Code
Create a row filter and set the filter strings.
Example

This example creates custom filter items for the drop-down list.

C#

FarPoint.Web.Spread.NamedStyle instyle = new FarPoint.Web.Spread.NamedStyle();
FarPoint.Web.Spread.NamedStyle outstyle = new FarPoint.Web.Spread.NamedStyle();
instyle.BackColor = Color.Yellow;
outstyle.BackColor = Color.Gray;

FarPoint.Web.Spread.StyleRowFilter rf = new

FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets[0], instyle, outstyle);
FpSpreadl.Sheets[0] .RowFilter = rf;

// Assign filter and customize filter options.

FpSpreadl.Sheets[0] .RowFilter.AddColumn (1) ;

FpSpreadl.Sheets[0] .RowFilter.ShowFilterIndicator = true;
FpSpreadl.Sheets[0] .RowFilter.AllString = "Show All";

FpSpreadl.Sheets[0] .RowFilter.BlanksString = "Show The Blanks";
FpSpreadl.Sheets[0] .RowFilter.NonBlanksString = "Show The Non-Blanks";

VB

Dim instyle As New FarPoint.Web.Spread.NamedStyle ()

Dim outstyle As New FarPoint.Web.Spread.NamedStyle ()
instyle.BackColor = Color.Yellow

outstyle.BackColor = Color.Gray

Dim rf As New FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets (0),
outstyle)
FpSpreadl.Sheets (0)
' Assign filter and

instyle,

.RowFilter = rf
customize filter options.

FpSpreadl.Sheets (0) .RowFilter.AddColumn (1)
FpSpreadl.Sheets (0) .RowFilter.ShowFilterIndicator = True
FpSpreadl.Sheets (0) .RowFilter.AllString = "Show All"
FpSpreadl.Sheets (0) .RowFilter.BlanksString = "Show The Blanks"
FpSpreadl.Sheets (0) .RowFilter.NonBlanksString = "Show The Non-Blanks"

Creating a Completely Custom Filter

You can create a custom filter that you can then include in the filter column definition collection. In order to create a
custom filter, follow these steps:
1. Create a class that inherits from FarPoint.Web.Spread.BaseFilterItem or FarPoint.Web.Spread.DefaultFilterItem.
2. Override DisplayName property to return the name to be displayed in the drop-down list of filter items.

3. Override the ShowInDropDown method to specify if this filter item should be displayed in the drop-down list
given the current filtered in rows. If the custom filter does not contain this item then the filter is not applied.

4. Override the Filter method to perform the filter action on the specified column.

5. Override the Serialize and Deserialize methods. Make calls to the base.Serialize and base.Deserialize methods
unless your methods handle persisting the default properties.
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6. Create a HideRowFilter or StyleRowFilter object.

7. Add the custom filter to the custom filter’s list of the column filter definition in the row filtering object from the
previous step.

If you are creating a custom filter item and you display a modal dialog inside the Filter method of the filter item, then
after the dialog goes away, call the IRowFilter interface ResetCachedIntersectedFilteredInRowIndexes method.

C#

FpSpreadl.Sheets (0) .RowFilter.ResetCachedIntersectedFilteredInRowIndexes

More information about creating custom filters is available on our online technical support forum (see the Read Me for
more information).

Using Enhanced Filtering

When the control has enhanced filtering turned on, the user can drop-down a list of available filters to apply to the data.

The default filter that is displayed depends on the data in the column. The filter can be a number, text, date, or color
filter.

The filters are described in the following table.

Filter Type Description

Number Filters

Equals Values in rows are equal to condition

Does Not Equal Values in rows do not equal condition

Greater Than Values in rows are greater than condition

Greater Than Or Equal To Values in rows are greater than or equal to condition

Less Than Values in rows are less than condition

Less Than Or Equal To Values in rows are less than or equal to condition

Between Values in rows are greater than one condition and less than another condition
Top 10 Values in the rows with the ten highest values

Above Average Values in the rows that are above the average of the values in all the rows
Below Average Values in the rows that are below the average of the values in all the rows
Custom Filter Values in rows that meet the conditions of a custom filter

Text Filters

Equals Values in rows equal the condition

Does Not Equal Values in rows do not equal the condition

Begins With Values in rows begin with the specified characters

Ends With Values in rows end with the specified characters

Contains Values in rows contain the specified characters

Does Not Contain Values in rows do not contain the specified characters

Custom Filter Values in rows that meet the conditions of a custom filter

Date Filters

Equals Values in rows equal the condition
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Before Values in rows are dates before the condition
After Values in rows are dates after the condition
Between Values in rows are dates between two specified dates for the condition
Tomorrow Values in rows are tomorrow's date

Today Values in rows are today's date

Yesterday Values in rows are yesterday's date

Next Week Values in rows are during next week

This Week Values in rows are during current week

Last Week Values in rows are during last week

Next Month Values in rows are during next month

This Month Values in rows are during current month
Last Month Values in rows are during last month

Next Quarter Values in rows are during next quarter

This Quarter Values in rows are during current quarter
Last Quarter Values in rows are during last quarter

Next Year Values in rows are during next year

This Year Values in rows are during current year

Last Year Values in rows are during last year

Year to Date

All Dates in the Period

Custom Filter

Values in rows are during current year to present date
Values in rows are within a specified period

Values in rows that meet the conditions of a custom filter

Users can specify wildcards in conditions. The "?" character represents any single character. The "*" character
represents any series of characters.

When the user chooses a filter, the control either filters the data to display only the items that match the filter criteria, or
the control displays the rows that meet the criteria with one appearance, and the rows that do not meet the criteria with
another appearance. For information about setting the styles for rows, see Creating Filtered Rows and Setting the
Appearance.

Using Code

Set the AutoFilterMode ('AutoFilterMode Property' in the on-line documentation) property to Enhanced,
create a filter style, and then apply the filter to the sheet.

Example

The following example creates an enhanced filter in the first three columns. Add different types of data to see the various
filter options.

C#

FpSpreadl.Sheets[0] .AutoFilterMode = FarPoint.Web.Spread.AutoFilterMode.Enhanced;
FarPoint.Web.Spread.NamedStyle instyle = new FarPoint.Web.Spread.NamedStyle () ;
FarPoint.Web.Spread.NamedStyle outstyle = new FarPoint.Web.Spread.NamedStyle()
instyle.BackColor = Color.Yellow;

outstyle.BackColor = Color.Aquamarine;

FarPoint.Web.Spread.FilterColumnDefinition fcd = new
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FarPoint.Web.Spread.FilterColumnDefinition (1,
FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences |
FarPoint.Web.Spread.FilterListBehavior.Default);
FarPoint.Web.Spread.FilterColumnDefinition fcdl
FarPoint.Web.Spread.FilterColumnDefinition (2) ;
FarPoint.Web.Spread.FilterColumnDefinition fcd2 = new
FarPoint.Web.Spread.FilterColumnDefinition () ;
FarPoint.Web.Spread.StyleRowFilter sf = new
FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets[0], instyle, outstyle);
sf.AddColumn (fcd) ;

sf.AddColumn (fcdl) ;

sf.AddColumn (fcd2) ;

FpSpreadl.Sheets[0] .RowFilter = sf;

new

VB

FpSpreadl.Sheets (0) .AutoFilterMode = FarPoint.Web.Spread.AutoFilterMode.Enhanced

Dim instyle As New FarPoint.Web.Spread.NamedStyle ()

Dim outstyle As New FarPoint.Web.Spread.NamedStyle ()

instyle.BackColor = Drawing.Color.Yellow

outstyle.BackColor = Drawing.Color.Aquamarine

Dim fcd As New FarPoint.Web.Spread.FilterColumnDefinition (1,

FarPoint.Web.Spread.FilterListBehavior.SortByMostOccurrences Or

FarPoint.Web.Spread.FilterListBehavior.Default)

Dim fcdl As New FarPoint.Web.Spread.FilterColumnDefinition (2)

Dim fcd2 As New FarPoint.Web.Spread.FilterColumnDefinition ()

Dim sf As New FarPoint.Web.Spread.StyleRowFilter (FpSpreadl.Sheets (0), instyle,

outstyle)

sf.AddColumn (fcd)

sf.AddColumn (fcdl)

sf.AddColumn (fcd?2)
0

FpSpreadl.Sheets (0) .RowFilter = sf

Using the Filter Bar

The filter bar allows filtering in all columns by displaying a filter bar below the column header area. The filter icon
appears in the filter bar instead of the column header. The filter bar displays filter information and allows users to edit
the condition criteria for each filter column.

The filter bar contains a text box, a menu of choices, and the filter icon. The user can enter a filter item in the text box,
select a menu option, and then click on the filter icon to apply the filter.

The MenuType ('MenuType Property' in the on-line documentation) property specifies the type of menu
options that are displayed for the filter (number, date time, enhanced, or text). If the menu type is date, a date time
picker is also available in the filter bar. The automatic option displays the menu options based on the type of data in the
column.

The following image displays a date picker in the filter bar for column B.
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The following table lists the menu options for text, number, and date:

Filter Menu Options

Text Contains
DoesNotContain
StartsWith
EndsWin
EqualTo
NotEqualTo
Between
NotBetween
IsEmpty
NotIsEmpty
IsNull
NotIsNull

Number and Date EqualTo
NotEqualTo
GreaterThan
LessThan
GreaterThanOrEqualTo
LessThanOrEqualTo
Between
NotBetween
IsNull
NotIsNull

146

The FilterBarMode ('FilterBarMode Property’ in the on-line documentation) property specifies whether the
filter context menu data is requested from the server after the page is loaded or loaded in the server before the page is

rendered.

Set the DateTimeFormat ('DateTimeFormat Property' in the on-line documentation) or FormatString
('FormatString Property' in the on-line documentation) property to format the value from the date picker in the
filter bar. Set these properties if the format of the data in the cell is different from the format in the filter. The EqualTo

menu option requires that the cell format and the filter bar format be the same. A ScriptManager is required for the
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DateTimeFormat ('DateTimeFormat Property' in the on-line documentation) and FormatString
('FormatString Property' in the on-line documentation) properties.

=l &A% Extensions
R Pointer

o} ScriptManager

'2:} acriptManagerProsy
iﬁ Tirner

51 UpdatePanel

HE] JpdateProgress

Using Code

1. Create a filter bar cell if you wish to customize the default options in the filter bar.

2. Set the AutoFilterMode ('AutoFilterMode Property' in the on-line documentation) property to
FilterBar.

Example

This example code customizes the filter bar and using a filter bar for filtering.

C#

protected void Page Load(object sender, EventArgs e)
{

if (IsPostBack) return;

for (int i = 0; 1 < FpSpreadl.ActiveSheetView.RowCount; i++)
for (int j = 0; j < FpSpreadl.ActiveSheetView.ColumnCount; Jj++)
{

FpSpreadl.ActiveSheetView.Cells[i, j].Value = i + 7j;

}

FarPoint.Web.Spread.FilterBarCellType fbc = new
FarPoint.Web.Spread.FilterBarCellType () ;
fbc.MenuType = FarPoint.Web.Spread.FilterMenuType.Auto;
FpSpreadl.ActiveSheetView.FilterBar.DefaultStyle.CellType = fbc;
FpSpreadl.ActiveSheetView.AutoFilterMode =
FarPoint.Web.Spread.AutoFilterMode.FilterBar;
}

VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load
If (IsPostBack) Then
Return
End If
For 1 As Integer = 0 To FpSpreadl.ActiveSheetView.RowCount - 1
For j As Integer = 0 To FpSpreadl.ActiveSheetView.ColumnCount - 1
FpSpreadl.ActiveSheetView.Cells (i, Jj).Value = i + j
Next
Next

Dim fbc As New FarPoint.Web.Spread.FilterBarCellType ()
fbc.MenuType = FarPoint.Web.Spread.FilterMenuType.Auto
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FpSpreadl.ActiveSheetView.FilterBar.DefaultStyle.CellType = fbc
FpSpreadl.ActiveSheetView.AutoFilterMode = FarPoint.Web.Spread.AutoFilterMode.FilterBar
End Sub

Customizing Grouping of Rows of User Data

You can set the display of the spreadsheet component to allow rows to be grouped according to the column headers. You
can customize the user experience for grouping data on a sheet. With grouping, you can allow the user to group rows of
data according to the column headers that are dragged into the group bar. Special group headings are displayed above
the grouped rows. Grouping of rows includes the following tasks.

¢ Using Grouping

¢ Allowing the User to Group Rows

e Setting the Appearance of Grouped Rows
¢ Customizing the Group Bar

¢ Creating a Custom Group

e Compatibility with Other Features

For information about the GroupInfo editor in the Spread Designer, refer to GroupInfo Collection Editor.

Using Grouping

You can set up the display to allow Outlook-style grouping of rows. For large amounts of data, this is helpful to display the data in the
order the user needs. The user selects columns by which to sort and the component then organizes and displays the data in a hierarchy
with rows organized accordingly. To select a column by which to group and display that data, either double-click on the header of that
column or click and drag that column into the grouping bar at the top of the page. See the figure below for an example of the terms used
with grouping.

primary secondary

group name group name order indicator .
| {ascending-descending)

1
EmployeelD = == FrstName =

group bar

expand -
CpD”-EI[JSE EmploveelD LastName FirstiName column names
indicator T‘:::E' Employeell: |
=
ol Nancy .
- : .._1 Davolio — formatting and order
[ Empk i group determined by grouping
= heading
2 Fuller Andrew

You can provide grouping to allow users to sort the data with multiple levels of groups by dragging additional column headers into the
grouping area. An example of the process of setting up two levels of grouping is shown in the following figure.

You can expand or collapse groups by clicking the expand (+) or collapse (-) indicators.
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EmployeelD =~ EmploveelD &= == FirstName ~
Employee]lD) | LastName | FirstName Title 1 EmployeeID = LastName | FirstName Title
EmployeelD: 1 E] EmploveelD: 1
1 Davolio Nancy Sales 1 =
EmploveelD: 2 1 Dawvolio Nancy Sales
2 Fuller Andrew WVice I | & EmployeelD: 2
EmployeelD: 3 =]
3 Levetling Janet Sales 1 2 Fauller Andrew Vice
[l EmployeelD: 3
=]
3 Lewverling Janet Sales
Before secondary grouping: dragging the column header into After secondary grouping: now a second level of hierarchy is shown.
the grouping bar.

When more than one level is chosen, the higher level is called the parent group and the lower level is called the child group. In the
picture above with secondary grouping, the Employee ID is the parent group and the First Name is the child group.

Allowing the User to Group Rows

By default, the spreadsheet does not allow the user to group the rows of a spreadsheet. You can turn on this feature and
allow grouping of rows for an entire sheet. Besides allowing grouping, you also need to allow columns to move, since the
user performs grouping by clicking and dragging a column header into the group bar, which is similar to the act of
moving a column. Also, the group bar must be visible and the column headers (at least one row) should be visible.

Use the AllowGroup ('AllowGroup Property' in the on-line documentation) property of the sheet to turn on
grouping. Use the GroupBarVisible ('GroupBarVisible Property' in the on-line documentation) property of
the sheet to display the group bar (the area at the top of the sheet into which the user can drag column headers.
Remember to set the AllowColumnMove ('AllowColumnMove Property' in the on-line documentation)
property of the sheet to true to allow the user to click and drag column headers. Unless you are using the default value,
set the ColumnHeaderVisible ('ColumnHeaderVisible Property' in the on-line documentation) property of
the sheet to true to ensure that the column headers are displayed. The following image shows the control before the user
drags the column header:

[Drag a column to group by that column_
A B C D
1
2
3
=

You can turn on or off the row headers; these have no effect on the display of grouping.

You can set the maximum number of levels of grouping that the end user can set. This limits the number of column
headers that can be dragged consecutively to the group bar.

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 150

To understand how grouping works for the end user, refer to Using Grouping.
Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Set AllowColumnMove, GroupBarVisible, and AllowGroup.

. Click OK to close the SheetView Collection Editor.

g WN R

Using Code

Set the AllowGroup ('AllowGroup Property’ in the on-line documentation), AllowColumnMove
('AllowColumnMove Property' in the on-line documentation), and the GroupBarVisible
('GroupBarVisible Property' in the on-line documentation) properties to allow user grouping.

Example

This example allows the user to group rows.

C#

FpSpreadl.ActiveSheetView.AllowColumnMove = true;
FpSpreadl.ActiveSheetView.GroupBarVisible true;
FpSpreadl.ActiveSheetView.AllowGroup = true;

VB

FpSpreadl.ActiveSheetView.AllowColumnMove = True
FpSpreadl.ActiveSheetView.GroupBarVisible = True
FpSpreadl.ActiveSheetView.AllowGroup = True

Using the Spread Designer

Select the Settings menu.

Select the Group icon in the Other Settings section.

Set the various properties.

Select Sheet in the Property Grid and set AllowColumnMove.
Click OK to close the dialog.

Use the View menu to show or hide the group bar.

Click Apply and Exit to close the Spread Designer.

N oo A ® DN

Setting the Appearance of Grouped Rows

You can customize the appearance of the group headers and the grouped rows. For an introduction to the user interface
for grouping, refer to Using Grouping.

You can set up the display so that the items are shown initially all expanded or all collapsed when grouping is performed
with the GroupingPolicy ('GroupingPolicy Property' in the on-line documentation) property.

You can set the colors and other formatting of both the hierarchy names and the data in the rows when grouping is
performed with the GroupInfo ('GrouplInfo Class' in the on-line documentation) class.

For more information on other hierarchical displays of data, refer to Displaying Data as a Hierarchy.
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You can also define a set of properties in an array list called GroupInfo. Set the appearance of grouped rows by adding
styles to the array list of appearance properties for grouping. A collection of GroupInfo ('GroupInfo Class' in the
on-line documentation) objects is in the GroupInfoCollection. To set the appearance settings in a GroupInfo
('Grouplnfo Class' in the on-line documentation) to a particular sheet, set the GroupInfos ('GroupInfos
Property' in the on-line documentation) property on that sheet. Appearance settings for grouping include:

e Background color

e Border

e CSSclass

e Font

e Foreground (text) color
e HorizontalAlignment
e VerticalAlignment

Only column and sheet appearance settings remain when grouping is turned on. For more information about the group
data model and the effect on the sheet data model, refer to Creating a Custom Group. Since rows and cells are moved
when the grouping feature is turned on, any style or span settings are ignored. You can use the IsGroup ('IsGroup
Method' in the on-line documentation) method, which determines whether a requested row is a data row or a
group header row.

For information about the GroupInfo editor in the Spread Designer, for customizing the appearance settings of the
group headers, refer to GroupInfo Collection Editor.

Using Code

1. Set the AllowColumnMove ('AllowColumnMove Property' in the on-line documentation),
GroupBarVisible ('GroupBarVisible Property' in the on-line documentation), and AllowGroup
('AllowGroup Property' in the on-line documentation) properties.

2. Specify the main group bar color with the GroupBarBackColor ('GroupBarBackColor Property' in the
on-line documentation) property.

3. Specify colors for subgroups with the GroupInfo ('GroupInfo Class' in the on-line documentation) class.
Example

This example sets the appearance for the group bar and the grouped rows.

C#

FpSpreadl.ActiveSheetView.AllowColumnMove = true;
FpSpreadl.ActiveSheetView.GroupBarVisible = true;
FpSpreadl.ActiveSheetView.GroupBarBackColor = Color.Salmon;
FpSpreadl.ActiveSheetView.GroupBarHeight = 50;
FpSpreadl.ActiveSheetView.GroupMaximumLevel = 5;
FpSpreadl.ActiveSheetView.AllowGroup = true;
FarPoint.Web.Spread.GroupInfo gi = new FarPoint.Web.Spread.GroupInfo();
gi.BackColor = Color.Yellow;

FarPoint.Web.Spread.GroupInfo gi2 = new FarPoint.Web.Spread.GroupInfol();
gi2.BackColor = Color.Green;

FarPoint.Web.Spread.GroupInfoCollection gic = new
FarPoint.Web.Spread.GroupInfoCollection () ;

gic.AddRange (new FarPoint.Web.Spread.GroupInfol] {gi, gi2});
FpSpreadl.ActiveSheetView.GroupInfos.Add (gic[0]);

VB

FpSpreadl.ActiveSheetView.AllowColumnMove = True
FpSpreadl .ActiveSheetView.GroupBarVisible True
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FpSpreadl.ActiveSheetView.GroupBarBackColor =
FpSpreadl.ActiveSheetView.GroupBarHeight = 50
FpSpreadl.ActiveSheetView.GroupMaximumLevel =
FpSpreadl.ActiveSheetView.AllowGroup = True
Dim gi As New FarPoint.Web.Spread.GroupInfo
gi.BackColor = Color.Yellow

Dim gi2 As New FarPoint.Web.Spread.GroupInfo
gi2.BackColor = Color.Green

5

Dim gic As New FarPoint.Web.Spread.GroupInfoCollection ()

gic.Add (gi)
FpSpreadl.ActiveSheetView.GroupInfos.Add (gic (0))

Using the Spread Designer

Select the Settings menu.

Select the Group icon in the Other Settings section.
Set the various properties.

Click OK to close the dialog.

Use the View menu to show or hide the group bar.
Click Apply and Exit to close the Spread Designer.
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Customizing the Group Bar

Color.Salmon

You can customize the appearance of the group bar at the top of the grouping display and you can hide or display the
grouping bar at the top of the sheet. The properties on the sheet (SheetView ('SheetView Class' in the on-line

documentation) object) include:

SheetView Property

GroupBarBackColor ('GroupBarBackColor Property' in the on-
line documentation)

GroupBarHeight ('GroupBarHeight Property' in the on-line
documentation)

GroupBarVisible ('GroupBarVisible Property' in the on-line
documentation)

GroupMaximumLevel ('GroupMaximumLevel Property' in the
on-line documentation)

Using Code

Description

Set the background color of the grouping
bar

Set the height of the grouping bar

Set whether to display the grouping bar

Set the maximum number of levels of
grouping allowed

1. Set the AllowColumnMove ('AllowColumnMove Property' in the on-line documentation),
GroupBarVisible ('GroupBarVisible Property' in the on-line documentation), and AllowGroup
('AllowGroup Property' in the on-line documentation) properties.

2. Specify the main group bar color with the GroupBarBackColor ('GroupBarBackColor Property' in the

on-line documentation) property.

3. Specify colors for subgroups with the GroupInfo ('GrouplInfo Class' in the on-line documentation) class.

Example

This example sets the appearance for the group bar and the grouped rows.

C#
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FpSpreadl.ActiveSheetView.AllowColumnMove = true;
FpSpreadl.ActiveSheetView.GroupBarVisible true;
FpSpreadl.ActiveSheetView.GroupBarBackColor = Color.Salmon;
FpSpreadl.ActiveSheetView.GroupBarHeight = 50;
FpSpreadl.ActiveSheetView.GroupMaximumLevel = 5;
FpSpreadl.ActiveSheetView.AllowGroup = true;
FarPoint.Web.Spread.GroupInfo gi = new FarPoint.Web.Spread.GroupInfo();
gi.BackColor = Color.Yellow;

FarPoint.Web.Spread.GroupInfo gi2 = new FarPoint.Web.Spread.GroupInfo();
gi2.BackColor = Color.Green;

FarPoint.Web.Spread.GroupInfoCollection gic = new
FarPoint.Web.Spread.GroupInfoCollection() ;

gic.AddRange (new FarPoint.Web.Spread.GroupInfol] {gi, gi2});

FpSpreadl .ActiveSheetView.GroupInfos.Add (gic[0]);

VB

FpSpreadl .ActiveSheetView.AllowColumnMove = True

FpSpreadl .ActiveSheetView.GroupBarVisible = True

FpSpreadl .ActiveSheetView.GroupBarBackColor = Color.Salmon
FpSpreadl.ActiveSheetView.GroupBarHeight = 50
FpSpreadl.ActiveSheetView.GroupMaximumLevel = 5
FpSpreadl.ActiveSheetView.AllowGroup = True

Dim gi As New FarPoint.Web.Spread.GroupInfo

gi.BackColor = Color.Yellow

Dim gi2 As New FarPoint.Web.Spread.GroupInfo

gi2.BackColor = Color.Green
Dim gic As New FarPoint.Web.Spread.GroupInfoCollection ()
gic.Add (gi)

FpSpreadl.ActiveSheetView.GroupInfos.Add (gic (0))

Using the Spread Designer

Select the Settings menu.

Select the Group icon in the Other Settings section.
Set the various properties.

Click OK to close the dialog.

Use the View menu to show or hide the group bar.
Click Apply and Exit to close the Spread Designer.
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Creating a Custom Group

When grouping is turned on for a sheet, a separate target group data model is available to the sheet (or spreadsheet
component) and this group data model is flat, completely without a hierarchy. This contains the group headers and
other grouping-specific display data. Underneath that model is a target data model where the row data resides.

You can customize grouping by specifying your own comparer. For example, you can create a custom group that is by
decade if the column has year information. As the Grouping ('Grouping Event' in the on-line documentation)
event is raised, you can pass in your own IComparer (call it MyComparer, for example). You can determine what is
displayed in the group header by setting the Text property for that group.

More information about creating a custom group is available on our online technical support forum (see the Read Me for
more information).

Compatibility with Other Features
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The grouping feature affects the visual display and is not intended to work with some other features of Spread that also
work with the display of the spreadsheet. When grouping happens, the data model is changed and a new model (the
GroupDataModel) is used. Many features are not affected by grouping at all, but some features, listed below, are not
intended to operate with grouping. In general, if the feature involves the appearance or interactivity of the sheet or
column, check the list to see if it is affected by grouping.

Some formatting features can work with grouping, but need to be applied after grouping occurs. If you need to format
cells (colors, locked, etc.), you must apply the formatting after grouping.

Features Influenced by Grouping

These features do not interoperate with grouping in Spread.

e Filtering: Grouping and filtering do not work together. If you want to use grouping, you should not use
filtering and you should clear the filter under the Grouping event.

e Conditional Formatting: Grouping and conditional formatting do not work together. Conditional formatting
requires the default data model. Thus, these features do not work together.

e Formulas: Grouping and formulas do not work together. Formulas requires the default data model. Thus,
these features do not work with grouping.

¢ Sorting: Grouping and sorting do not work together. Grouping is a type of sorting. When grouping is on,
clicking on column headers will cause grouping, not sorting. Thus, these features do not work together.

e Count: After grouping rows, you should not change the column count and row count. The GroupDataModel
does not support changing the column or row count. To add or remove columns or rows, you need to call the
original data model methods. You can access the original data model using TargetModel ('TargetModel
Property' in the on-line documentation) property of the GroupDataModel ('GroupDataModel
Class' in the on-line documentation) class.

These features work with grouping in Spread.

e Grouping and hidden columns work together.
¢ Printing and exporting work with grouping.

Customizing Sorting of Rows of User Data

You can sort the data displayed in the sheet either by column or by row. Typically, all the rows of a sheet are sorted by
the values in a particular column. But Spread allows various ways of performing a sort with various properties and
methods for each type of sorting. In general, sorting data can be done by any of these ways:

There are various properties of sorting. The order of the sort can be in ascending order (A to Z, zero to 9) or descending
order (Z to A, 9 to zero). The method of comparison can be customized. You can select which values to use as a key when
comparing in order to sort the values. The sort indicator, an arrow typically, can be displayed in the header for the
column being used as a sort key. For more information on customizing the sorting, refer to the SortInfo ('SortInfo
Class' in the on-line documentation) object. With this object, you can set the parameters for sorting and then
specify this object in the particular sort method you choose.

The cell type does not matter for sorting. The sorting is done depending on the data type of the values in the cells. If you
sort cells with data of the DateTime type, then it sorts those cells by date, and if you sort cells with data of the string
type, it sorts those cells alphabetically.

You can sort entire rows or columns in a sheet. To sort all the rows of an entire sheet based on the values of a given
column is the most common case, but Spread allows you to sort either rows or columns and to specify which column or
row to use as a key for sorting. The sort applies to the entire sheet.

Use the SortColumns ('SortColumns Method' in the on-line documentation) (or SortRows ('SortRows
Method' in the on-line documentation)) method to sort the arrangement of columns (or rows) in a sheet using one
or more rows (or columns) as the key. This does not affect the data model, only how the data is displayed. Several
overloads provide different ways to sort the columns (or rows). To further customize the way sorting is performed, use
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the SortInfo ('SortInfo Class' in the on-line documentation) object in conjunction with these methods.

Be aware of how sorting works with the data in the models. If you use the automatic sorting by clicking the column
header or you call the SortRows ('SortRows Method' in the on-line documentation) method of the sheet, then
the data model is not sorted, just the data that is displayed to the user. In this case, any data that is hidden before the
sort is hidden after the sort, since Spread moves any hidden rows automatically. When you sort data, only the data
model is getting sorted. The SelectionModel does not get sorted. For more information on the models, refer to Using
Sheet Models.

Sorting executed by clicking column headers sorts only the displayed data and does not affect the order of actual data in
the data model. So you can reset the sorted data being displayed to the order of actual data by calling either the
ResetViewRowIndexes ('ResetViewRowIndexes Method' in the on-line documentation) method or the
ResetViewColumnIndexes ('ResetViewColumnIndexes Method' in the on-line documentation) method.

Also, sorting is not intended to be used when Outlook-style grouping is turned on. For more information about grouping
(which is its own way a type of sorting), refer to Customizing Grouping of Rows of User Data.

< Note: Cell spans become invisible when sorting a sheet.

You can allow the user to sort with the AllowSort ('AllowSort Property’' in the on-line documentation)
property. See the following topic for more information:

¢ Allowing User Sorting

Allowing User Sorting

You can allow the user to sort with the AllowSort ('AllowSort Property' in the on-line documentation)
property. The following image shows the column after the user has double-clicked on the header.

A B
1 5
2 |7
3 9

Using Code
Use the AllowSort ('AllowSort Property' in the on-line documentation) property to allow user sorting.
Example

The following example sets the AllowSort ('AllowSort Property' in the on-line documentation) property.
C#

FarPoint.Web.Spread.SheetView sv = new FarPoint.Web.Spread.SheetView();
FpSpreadl.ActiveSheetView.SetValue (0, 0, 9);
FpSpreadl.ActiveSheetView.SetValue (1, 0, 5);
FpSpreadl.ActiveSheetView.SetValue (2, 0, 7);

sv = FpSpreadl.ActiveSheetView) ;

sv.AllowSort = true;

VB

Dim sv As FarPoint.Web.Spread.SheetView
FpSpreadl .ActiveSheetView.SetValue (0, 0, 9)
FpSpreadl.ActiveSheetView.SetValue (1, 0, 5)
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FpSpreadl.ActiveSheetView.SetValue (2, 0, 7)
sv = FpSpreadl.ActiveSheetView
sv.AllowSort = True

Using the Spread Designer

Select the Settings menu in the Sheet Settings section.
Select the General icon.

Set the AllowSort check box.

Click OK to close the dialog.

Click Apply and Exit to close the Spread Designer.

LI e

Customizing Interaction with Cells

You can customize the user interaction with individual cells (or a range of cells). To customize this aspect of user
interaction, you may perform the following tasks.

Adding a Note to a Cell

Adding a Tag to a Cell

Locking a Cell

¢ Using Conditional Formatting in Cells

For information on selections of cells, refer to Customizing Selections of Cells.

For information on how to change the appearance of cells, refer to Customizing the Appearance of a Cell. For
information on setting the cell type, refer to Customizing with Cell Types.

Adding a Note to a Cell

You can add a note to a cell or range of cells. The note may contain text such as a comment, a question, or
documentation describing the origin of the cell's value. When the pointer is over a cell that has a note, the note text
displays in a box next to the cell. Notes cannot be placed in cells in the column or row headers.

A B C

]

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Select the Cells drop-down.

. Select the cells for which you want to set the note.

. Set the Note property.

. Select OK.

N O A WON R

Using a Shortcut

156

Set the Note ('Note Property' in the on-line documentation) property for the cells in the sheet of the component.
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Example

This example code sets the Note ('"Note Property' in the on-line documentation) property for a range of Cell
objects.

C#

FpSpreadl.Sheets[0] .ColumnCount = 4;

FpSpreadl.Sheets[0] .RowCount = 4;

FpSpreadl.Sheets[0].Cells[1l, 1, 3, 3].Note = "This is the note that describes the
value.";

FpSpreadl.Sheets[0] .Cells[1l, 1, 3, 3].Value = "Value Here";

VB

FpSpreadl.Sheets (0) .ColumnCount = 4
FpSpreadl.Sheets (0) .RowCount = 4

FpSpreadl.Sheets (0) .Cells (1, 1, 3, 3).Note = "This is the note that describes the
value."

FpSpreadl.Sheets (0) .Cells (1, 1, 3, 3).Value = "Value Here"

Using Code

Set the Note ('Note Property' in the on-line documentation) property for the Cell ('Cell Class' in the on-line
documentation) object for a range of cells.

Example

This example code sets the Note ("Note Property' in the on-line documentation) property for a range of Cell
objects.

C#

FarPoint.Web.Spread.Cell rangel;
rangel = fpSpreadl.ActiveSheetView.Cells[1l, 1, 3, 31;

rangel.Value = "Value Here";
rangel.Note = "This is the note that describes the value.";
VB

Dim rangel As FarPoint.Web.Spread.Cell

rangel = fpSpreadl.ActiveSheetView.Cells (1, 1, 3, 3)
rangel.Value = "Value Here"

rangel.Note = "This is the note that describes the value."

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the notes to display.

2. In the properties list (in the Misc group), select the Note property and type in the text of the note.
Another way is to select the Cells property and click on the button to call up the Cell, Column, and Row editor
and select the cells in that editor.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Adding a Tag to a Cell
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You can add a tag to a cell or range of cells. If you prefer, you can associate data with any cell in the spreadsheet, or the
cells in a column, a row, or the entire spreadsheet. The string data can be used to interact with a cell or to provide
information to the application you create. The cell data, or cell tag, is similar to item data you can provide for the
spreadsheet, columns, or rows.

For more information on tags, refer to the Tag ("Tag Property' in the on-line documentation) property in the
Cell ('Cell Class' in the on-line documentation) class.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Select the Cells drop-down.

. Select the cells for which you want to set the tag.

. Set the Tag property.

. Select OK.

N OO, WO N

Using a Shortcut
Set the Tag ('Tag Property' in the on-line documentation) property for the cells in the sheet of the component.
Example

This example code sets the Tag ('Tag Property' in the on-line documentation) property for a range of Cell ('Cell
Class' in the on-line documentation) objects.

C#

FpSpreadl.Sheets[0].Cells[1l, 1, 3, 3].Tag = "This is the tag that describes the
value.";

FpSpreadl.Sheets[0].Cells[1l, 1, 3, 3].Value = "Value Here";

VB

FpSpreadl.Sheets(0) .Cells (1, 1, 3, 3).Tag = "This is the tag that describes the value."
FpSpreadl.Sheets (0) .Cells (1, 1, 3, 3).Value = "Value Here"

Using Code

Set the Tag ('Tag Property' in the on-line documentation) property for the Cell ('Cell Class' in the on-line
documentation) object for a range of cells.

Example

This example code sets the Tag ("Tag Property' in the on-line documentation) property for a range of Cell ('Cell
Class' in the on-line documentation) objects.

C#

FarPoint.Web.Spread.Cell rangel;
rangel = fpSpreadl.ActiveSheetView.Cells[1l, 1, 3, 3];

rangel.Value = "Value Here";
rangel.Tag = "This is the tag.";
VB
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Dim rangel As FarPoint.Web.Spread.Cell

rangel = fpSpreadl.ActiveSheetView.Cells (1, 1, 3, 3)
rangel.Value = "Value Here"

rangel.Tag = "This is the tag."

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the tag to display.

2. In the properties list (in the Misc group), select the Tag property and type in the text.
Another way is to select the Cells property and click on the button to display the Cell, Column, and Row
editor and select the cells in that editor.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
Locking a Cell

You can lock a cell or range of cells and make it unavailable for editing by the end user.

You can lock cells using the Locked property in the Cell ('Cell Class' in the on-line documentation), Column
('Column Class' in the on-line documentation), Row ('Row Class' in the on-line documentation),
AlternatingRow ('AlternatingRow Class' in the on-line documentation), or SheetView ('‘SheetView Class'
in the on-line documentation) objects.

For cells marked as locked to be locked from user input, the Protect ('Protect Property' in the on-line
documentation) property of the sheet must be set to True, which is its default value. If it is set to False, the user can
still interact with the cells.

Using the Properties Window

At design time, in the Properties window, select the FpSpread component.
Select the Sheets property.

Click the button to display the SheetView Collection Editor.

Select the Cells drop-down.

Select the cells that you wish to lock.

Set the Locked property.

Select OK.

N o s @D

Using a Shortcut

Using the Locked property for the Cell ('Cell Class' in the on-line documentation), Column ('Column Class'
in the on-line documentation), or Row ('Row Class' in the on-line documentation) object, you can mark
some cells as locked. The Protect ('Protect Property' in the on-line documentation) property, for the sheet,
must be set to true if you want the cells to be locked from user input.

Example

Making sure that the Protect ('"Protect Property' in the on-line documentation) property is True for the sheet,
you can lock some columns of cells and then unlock some of the cells in one row.

C#

FpSpreadl.ActiveSheetView.Protect = true;
FpSpreadl.ActiveSheetView.Columns [0, 3].Locked = true;
FpSpreadl.ActiveSheetView.Cells[1,1,1,2].Locked = false;
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VB

FpSpreadl.ActiveSheetView.Protect = True
FpSpreadl.ActiveSheetView.Columns [0, 3].Locked = True
FpSpreadl.ActiveSheetView.Cells[1,1,1,2].Locked = False

Using Code

Using the Locked property for the Cell ("Cell Class' in the on-line documentation), Column ('Column Class'
in the on-line documentation), or Row ('Row Class' in the on-line documentation) object, you can mark
some cells as locked. The Protect ('"Protect Property' in the on-line documentation) property, for the sheet,
must be set to True if you want the cells to be locked from user input.

Example

Making sure that the Protect ('Protect Property' in the on-line documentation) property is True for the sheet,
you can lock some columns of cells and then unlock some of the cells in one row.

C#

FpSpreadl .ActiveSheetView.Protect = true;
FpSpreadl .ActiveSheetView.LockBackColor = Color.LightCyan;
FpSpreadl .ActiveSheetView.LockForeColor Color.Green;

FarPoint.Web.Spread.Column columnobj;

columnobj = fpSpreadl.ActiveSheetView.Columns[0, 3];
columnobj.Locked = true;

FarPoint.Web.Spread.Cell cellobj;

cellobj = fpSpreadl.ActiveSheetView.Cells[1,1,1,2];
cellobj.Locked = false;

FpSpreadl.ActiveSheetView.Cells[1,0,1,4].Text = "First Five";

VB

FpSpreadl.ActiveSheetView.Protect = True
FpSpreadl.ActiveSheetView.LockBackColor = Color.LightCyan
FpSpreadl.ActiveSheetView.LockForeColor = Color.Green

Dim columnobj As FarPoint.Web.Spread.Column
columnobj = fpSpreadl.ActiveSheetView.Columns (0, 3)
columnobj.Locked = True

Dim cellobj As FarPoint.Web.Spread.Cell

cellobj = fpSpreadl.ActiveSheetView.Cells(1l,1,1,2)
cellobj.Locked = False

FpSpreadl.ActiveSheetView.Cells(1,0,1,4) .Text = "First Five"

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to lock the cells either by dragging over a range of cells
or selecting row or column headers (for entire rows or columns).

2. In the Misc section, select the Locked property and choose True.
(Another way of doing that is to select the Cells property, click on the button to call up the Cell, Column, and
Row editor, and select the cells in that editor.)

3. Choose the sheet from the drop-down combo to the right of the designer. From the properties list (in the Misc
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section), set the Protect property.

4. In the Properties window in the SheetView Collection Editor, in the Misc section, select the Protect
property and set it to True if you want the cells to be locked from user input.

5. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
Using the Spread Designer

The following steps list a different way to lock cells in the designer.

1. In the work area, select the cell or cells that you want to lock.

2. Select the Home menu.

3. Select the Lock icon from the Editing section.

4. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Using Conditional Formatting in Cells

You can customize the user interaction with individual cells (or a range of cells). You can use rules or conditional
operators in the conditional format.

To customize this aspect of user interaction, you may perform the following tasks:

e Creating Conditional Formatting with Rules
¢ Conditional Formatting of Cells

Creating Conditional Formatting with Rules

You can set the visual appearance of cells using rules. The following classes are available when creating conditional
formatting with rules:

¢ AverageConditionalFormattingRule Class (on-line documentation)

¢ BetweenValuesConditionalFormattingRule Class (on-line documentation)

¢ BlankConditionalFormattingRule Class (on-line documentation)

¢ DatabarConditionalFormattingRule Class (on-line documentation)

¢ ErrorConditionalFormattingRule Class (on-line documentation)

¢ FormulaConditionalFormattingRule Class (on-line documentation)

¢ IconSetConditionalFormattingRule Class (on-line documentation)

¢ PrePaintConditionalFormattingRule Class (on-line documentation)

¢ PrePaintTextConditionalFormattingRule Class (on-line documentation)

¢ TextConditionalFormattingRule Class (on-line documentation)

e ThreeColorScaleConditionalFormattingRule Class (on-line documentation)

¢ TimePeriodConditionalFormattingRule Class (on-line documentation)

e TopRankedValuesConditionalFormattingRule Class (on-line documentation)

e TwoColorScaleConditionalFormattingRule Class (on-line documentation)

e UnaryComparisonConditionalFormattingRule Class (on-line documentation)

¢ UniqueOrDuplicatedConditionalFormattingRule Class (on-line documentation)
The average rule checks for values above or under the average. The cell value rule compares values. The date rule
compares dates. The formula rule allows you to use formulas when checking the condition. The scale rule uses a sliding
color scale. For example if 1 is yellow and 50 is green, then 25 would be light green. The specific text rule searches for

text strings. The top 10 rule checks for values in the top or bottom of the range. The unique rule checks to see if the value
is the only one of that value in the range (if the duplicate option is false). The duplicate rule checks for duplicate values.

The data bar rule displays a bar in the cell based on the cell value in the range. The icon set rule displays icons based on
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the values.
The following topics provide additional information about specific conditional formatting rules.

e Color Scale Rules

e Data Bar Rule

e Highlighting Rules

e Icon Set Rule

e Top or Average Rules

Color Scale Rules

Color scales are visual guides that help you understand data distribution and variation. A two-color scale compares a
range of cells by using a gradation of two colors. The shade of the color represents higher or lower values. For example,
in a green and red color scale, you can specify that higher value cells are closer to a green color and lower value cells are
closer to a red color. You can specify the value type, value, and color for the minimum and maximum properties.

A three-color scale compares a range of cells by using a gradation of three colors. The shade of the color represents
higher, middle, or lower values. For example, in a green, yellow, and red color scale, you can specify that higher value
cells have a green color, middle value cells have a yellow color, and lower value cells have a red color. You can specify the
value type, value, and color for the minimum, middle, and maximum properties.

The following image uses the three color rule:

A B C D
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Using Code

Set the properties of the TwoColorScaleConditionalFormattingRule
("TwoColorScaleConditionalFormattingRule Class' in the on-line documentation) class or the
ThreeColorScaleConditionalFormattingRule ('ThreeColorScaleConditionalFormattingRule Class' in the
on-line documentation) class and then apply the formatting.

Example

This example code creates a three color rule and uses the SetConditionalFormatting
('SetConditionalFormatting Method' in the on-line documentation) method to apply the rule.

C#

protected void Page Load(object sender, System.EventArgs e)
{

FpSpreadl.Sheets[0].Cells [0, 0].Value = 3;
FpSpreadl.Sheets[0].Cells[1l, 0].Value = 2;
FpSpreadl.Sheets[0].Cells[1l, 1].Value = 10;
FpSpreadl.Sheets[0].Cells [0, 2].Value = 1;

}

protected void Buttonl Click(object sender, EventArgs e)

{

FarPoint.Web.Spread.Model.CellRange celRangel = new
FarPoint.Web.Spread.Model.CellRange (0, 0, 3, 3);
FarPoint.Web.Spread.ThreeColorScaleConditionalFormattingRule rule = new
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FarPoint.Web.Spread.ThreeColorScaleConditionalFormattingRule (Color.Aqua, Color.Bisque,
Color.BlueViolet);

FpSpreadl.Sheets[0].SetConditionalFormatting (new FarPoint.Web.Spread.Model.CellRange][]
{ celRangel }, rule);

}

VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load

FpSpreadl.Sheets (0) .Cells (0, 0).Value = 3
FpSpreadl.Sheets (0) .Cells (1, 0).Value = 2
FpSpreadl.Sheets (0) .Cells (1, 1).Value = 10
FpSpreadl.Sheets (0) .Cells (0, 2).Value =1

End Sub

Protected Sub Buttonl Click(sender As Object, e As EventArgs) Handles Buttonl.Click
Dim celRangel As New FarPoint.Web.Spread.Model.CellRange (0, 0, 3, 3)

Dim rule As New
FarPoint.Web.Spread.ThreeColorScaleConditionalFormattingRule (Drawing.Color.Aqua,
Drawing.Color.Bisque, Drawing.Color.BlueViolet)
FpSpreadl.Sheets (0) .SetConditionalFormatting (New FarPoint.Web.Spread.Model.CellRange ()
{celRangel}, rule)

End Sub

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the conditional format.

2. Under the Home menu, select the Conditional Formatting icon in the Style section, then select the Color
Scales option, and then choose the color set.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
Data Bar Rule

The data bar rule uses a bar that is displayed as the background for each cell. The length of the bar corresponds to the
size of the data relative to the other data in the worksheet. The longer the bar, the greater the value in the cell.

You can specify the value type and the value to compare in the conditional format.

Value Description
Type

Percent The minimum value in the range of cells that the conditional formatting rule applies to plus X percent of
the difference between the maximum and minimum values in the range of cells that the conditional
formatting rule applies to. For example, if the minimum and maximum values in the range are 1 and 10
respectively, and X is 10, then the value is 1.9.

Highest The maximum value in the range of cells that the conditional formatting rule applies to.
Value

Lowest The minimum value in the range of cells that the conditional formatting rule applies to.
Value

Formula  The result of the formula determines the minimum or maximum value of the cell range that the rule
applies to. If the result is not numeric, it is treated as zero.

Percentile The result of the function percentile applied to the range with X.
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Automatic The smaller or larger or the minimum or maximum value in the range of cells that the conditional format
applies to.

Number  Number, date, or time value in the range of cells that the conditional formatting rule applies to.

Valid percentiles are from 0 (zero) to 100. A percentile cannot be used if the range of cells contains more than 8,191 data
points. Use a percentile when you want to visualize a group of high values (such as the top 20th percentile) in one data
bar and low values (such as the bottom 20th percentile) in another data bar. This is useful if you have extreme values
that might skew the visualization of your data.

Valid percent values are from 0 (zero) to 100. Percent values should not use a percent sign. Use a percentage when you
want to visualize all values proportionally because the distribution of values is proportional.

Start formulas with an equal sign (=). Invalid formulas result in no formatting applied.

The minimum and maximum types can be different. The Maximum ('Maximum Property’' in the on-line
documentation) property should not be set to a ConditionalFormattingValue value such as
ConditionalFormattingValueType.Min or ConditionalFormattingValueType.AutoMin. An exception will occur in this
case. The Minimum ("Minimum Property' in the on-line documentation) property should not be set to a
ConditionalFormattingValue value such as ConditionalFormattingValueType.Max or
ConditionalFormattingValueType.AutoMax. An exception will occur in this case.

You can also specify borders, colors, and an axis.

The following image displays data bars in a cell range:
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Using Code

Set the properties of the data bar rule class and then apply the formatting.
Example

This example code creates a data bar rule and uses the SetConditionalFormatting ('SetConditionalFormatting
Method' in the on-line documentation) method to apply the rule.

C#

protected void Page Load(object sender, System.EventArgs e)

{

FpSpreadl.Sheets[0] .RowCount = 5;

FpSpreadl.Sheets[0] .Cells [0, 0].Value = 3;
FpSpreadl.Sheets[0] .Cells[1l, 0].Value = 2;
FpSpreadl.Sheets[0].Cells[2, 0].Value = 10;
FpSpreadl.Sheets[0] .Cells[3, 0].Value = 1;

}

protected void Buttonl Click(object sender, EventArgs e)

{

FarPoint.Web.Spread.DatabarConditionalFormattingRule d = new
FarPoint.Web.Spread.DatabarConditionalFormattingRule () ;
d.BorderColor = Color.Red;
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d.ShowBorder = true;

d.Minimum = new FarPoint.Web.Spread.ConditionalFormattingValue (0,
FarPoint.Web.Spread.ConditionalFormattingValueType.Number) ;
d.Maximum = new FarPoint.Web.Spread.ConditionalFormattingValue (15,
FarPoint.Web.Spread.ConditionalFormattingValueType.Max) ;

FpSpreadl .ActiveSheetView.SetConditionalFormatting (0, 0, 4, 1, d);
}

VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load

FpSpreadl.Sheets (0) .RowCount = 5
FpSpreadl.Sheets (0) .Cells (0, 0).Value = 3
FpSpreadl.Sheets (0) .Cells (1, 0).Value = 2
FpSpreadl.Sheets (0) .Cells (2, 0).Value = 10
FpSpreadl.Sheets (0) .Cells (3, 0).Value =1

End Sub

Protected Sub Buttonl Click(sender As Object, e As EventArgs) Handles Buttonl.Click
Dim d As New FarPoint.Web.Spread.DatabarConditionalFormattingRule ()

d.BorderColor = Drawing.Color.Red

d.ShowBorder = True

d.Minimum = New FarPoint.Web.Spread.ConditionalFormattingValue (0,
FarPoint.Web.Spread.ConditionalFormattingValueType.Number)

d.Maximum = New FarPoint.Web.Spread.ConditionalFormattingValue (15,
FarPoint.Web.Spread.ConditionalFormattingValueType.Max)

FpSpreadl .ActiveSheetView.SetConditionalFormatting (0, 0, 4, 1, d)

End Sub

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the conditional format.

2. Under the Home menu, select the Conditional Formatting icon in the Style section, then select the Data
Bars option, and then choose the color set.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
Highlighting Rules

You can use this rule to highlight data that meets one of the following conditions:

e is greater than a value

e islessthan a value

e isbetween a high and low value

e isequal to a value

e contains a value

e is a date that occurs in a particular range

e is either unique or duplicated elsewhere in the worksheet

After you choose one of the options above, enter a value or formula against which each cell is compared. If the cell data
satisfies that criteria, then the formatting is applied.

You can select a predefined highlight style or create a custom highlight style. The following rules are highlight style
rules:
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e BetweenValuesConditionalFormattingRule ('BetweenValuesConditionalFormattingRule Class'
in the on-line documentation)

¢ BlankConditionalFormattingRule ('BlankConditionalFormattingRule Class' in the on-line
documentation)

¢ ErrorConditionalFormattingRule ('ErrorConditionalFormattingRule Class' in the on-line
documentation)

¢ FormulaConditionalFormattingRule ('"FormulaConditionalFormattingRule Class' in the on-
line documentation)

¢ TextConditionalFormattingRule ('TextConditionalFormattingRule Class' in the on-line
documentation)

¢ TimePeriodConditionalFormattingRule ('TimePeriodConditionalFormattingRule Class' in the
on-line documentation)

¢ UnaryComparisonConditionalFormattingRule ('UnaryComparisonConditionalFormattingRule
Class' in the on-line documentation)

¢ UniqueOrDuplicatedConditionalFormattingRule
('UniqueOrDuplicatedConditionalFormattingRule Class' in the on-line documentation)

Using Code
Set the properties of the rule class and then apply the formatting.
Example

This example code creates the between values rule and uses the SetConditionalFormatting
('SetConditionalFormatting Method' in the on-line documentation) method to apply the rule.

C#

protected void Page Load(object sender,

{

System.EventArgs e)

FpSpreadl.Sheets[0].Cells[0, 0].Value = 3;
FpSpreadl.Sheets[0] .Cells[1l, 0].Value = 2;
FpSpreadl.Sheets[0] .Cells[1l, 1].Value = 5;
FpSpreadl.Sheets[0] .Cells [0, 2].Value = 1;
}
protected void Buttonl Click(object sender, EventArgs e)

{
FarPoint.Web.Spread.BetweenValuesConditionalFormattingRule between =
FarPoint.Web.Spread.BetweenValuesConditionalFormattingRule (false) ;

new

between.FirstValue = 10;
between.SecondValue = 20;
between.IsNotBetween = true;

between.BackColor = Color.Bisque;

FpSpreadl.ActiveSheetView.SetConditionalFormatting(l, 1, between);

VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load

FpSpreadl.Sheets (0) .Cells (0, 0).Value = 3

FpSpreadl.Sheets (0) .Cells (1, 0).Value = 2

FpSpreadl.Sheets (0) .Cells (1, 1).Value = 5

FpSpreadl.Sheets (0) .Cells (0, 2).Value =1
End Sub
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Protected Sub Buttonl Click(sender As Object, e As EventArgs) Handles Buttonl.Click
Dim between As New
FarPoint.Web.Spread.BetweenValuesConditionalFormattingRule (False)

between.FirstValue = 10

between.SecondValue = 20

between.IsNotBetween = True

between.BackColor = Drawing.Color.Bisque

FpSpreadl.ActiveSheetView.SetConditionalFormatting(l, 1, between)
End Sub

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the conditional format.

2. Under the Home menu, select the Conditional Formatting icon in the Style section, then select the
Highlight Cells Rules option, and then choose the condition.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Icon Set Rule

You can set rules that display certain icons when a cell value is greater than, equal to, or less than a value.

You can use built-in icon sets for the rule. You can also specify individual icons to use in the icon set with the IconRuleSet ('IconRuleSet Property' in the on-line
documentation) property.
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Using Code

Set the properties of the IconSetConditionalFormattingRule ('IconSetConditionalFormattingRule Class' in the on-line documentation) class and then apply the
formatting.

Example

This example code creates an icon set rule and uses the SetConditionalFormatting ('SetConditionalFormatting Method' in the on-line documentation) method to
apply the rule.

C#

protected void Page_Load(object sender, System.EventArgs e)
{
FpSpreadl.Sheets[0] .RowCount = 5;
FpSpreadl.Sheets[0] .Cells [0, 0].Value 8;
FpSpreadl.Sheets[0].Cells[1, 0].Value 5;
[07].
[0].

FpSpreadl.Sheets Cells[2, 0].Value 10;
FpSpreadl.Sheets Cells[3, 0].Value = 1;
}
protected void Buttonl_ Click(object sender, EventArgs e)
{
FarPoint.Web.Spread.Model.CellRange celRangel = new FarPoint.Web.Spread.Model.CellRange (0, 0, 4, 1);
FarPoint.Web.Spread.IconSetConditionalFormattingRule rule = new
FarPoint.Web.Spread.IconSetConditionalFormattingRule (FarPoint.Web.Spread.ConditionalFormattingIconSetStyle.ThreeRimmedTrafficLights);
FpSpreadl.Sheets[0] .SetConditionalFormatting (new FarPoint.Web.Spread.Model.CellRange[] { celRangel }, rule);
}

VB

Private Sub Page_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles MyBase.Load
FpSpreadl.Sheets (0) .RowCount = 5

FpSpreadl.Sheets (0) .Cells (0, 0).Value = 8
FpSpreadl.Sheets (0) .Cells (1, 0).Value = 5
FpSpreadl.Sheets (0) .Cells (2, 0).Value = 10
FpSpreadl.Sheets (0) .Cells (3, 0).Value = 1

End Sub
Protected Sub Buttonl Click(sender As Object, e As EventArgs) Handles Buttonl.Click
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Dim celRangel As New FarPoint.Web.Spread.Model.CellRange (0, 0, 4, 1)

Dim rule As New

FarPoint.Web.Spread.IconSetConditionalFormattingRule (FarPoint.Web.Spread.ConditionalFormattingIconSetStyle.ThreeRimmedTrafficLights)
FpSpreadl.Sheets (0) .SetConditionalFormatting (New FarPoint.Web.Spread.Model.CellRange () {celRangel}, rule)

End Sub

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the conditional format.
2. Under the Home menu, select the Conditional Formatting icon in the Style section, then select the Icon Sets option, and then choose the icon set.
3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Top or Average Rules

The top or bottom rules apply formatting to cells whose values fall in the top or bottom percent. The top ranked rule
specifies the top or bottom values. The average rule applies to the greater or lesser average value of the entire range.

The following options are available:

e top10

e top10%

e bottom 10

e bottom 10%

e above average
e below average

Using Code
Set the properties of the rule class and then apply the formatting.
Example

This example code creates an average rule and uses the SetConditionalFormatting ('SetConditionalFormatting
Method' in the on-line documentation) method to apply the rule.

C#

protected void Page Load(object sender, System.EventArgs e)

{

FpSpreadl.Sheets[0] .Cells [0, 0].Value = 3;
FpSpreadl.Sheets[0] .Cells[1l, 0].Value = 2;
FpSpreadl.Sheets[0] .Cells[1l, 1].Value = 10;
FpSpreadl.Sheets[0] .Cells [0, 2].Value = 1;

}

protected void Buttonl Click(object sender, EventArgs e)

{
//Average CF

FarPoint.Web.Spread.AverageConditionalFormattingRule average = new
FarPoint.Web.Spread.AverageConditionalFormattingRule (true, true);
average.IsAbove = true;

average.IsIncludeEquals = true;

average.StandardDeviation = 5;

average.FontStyle = new

FarPoint.Web.Spread.SpreadFontStyle (FarPoint.Web.Spread.UnderlineFontStyle.None) ;
average.FontStyle.RegularBoldItalic =
FarPoint.Web.Spread.RegularBoldItalicFontStyle.Bold;

FpSpreadl .ActiveSheetView.SetConditionalFormatting (1, 1, average);

}
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VB

Private Sub Page Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.Load

FpSpreadl.Sheets (0) .Cells (0, 0).Value = 3
FpSpreadl.Sheets (0) .Cells (1, 0).Value = 2
FpSpreadl.Sheets (0) .Cells (1, 1).Value = 10
FpSpreadl.Sheets (0) .Cells (0, 2).Value =1

End Sub

Protected Sub Buttonl Click(sender As Object, e As EventArgs) Handles Buttonl.Click
'Average CF

Dim average As New FarPoint.Web.Spread.AverageConditionalFormattingRule (True, True)
average.IsAbove = True

average.IsIncludeEquals = True

average.StandardDeviation = 5

average.FontStyle = New

FarPoint.Web.Spread.SpreadFontStyle (FarPoint.Web.Spread.UnderlineFontStyle.None)
average.FontStyle.RegularBoldItalic =
FarPoint.Web.Spread.RegularBoldItalicFontStyle.Bold
FpSpreadl.ActiveSheetView.SetConditionalFormatting(l, 1, average)

End Sub

Using the Spread Designer

1. In the work area, select the cell or cells for which you want to set the conditional format.

2. Under the Home menu, select the Conditional Formatting icon in the Style section, then select the Top
Bottom Rules option, and then choose the condition.

3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Conditional Formatting of Cells

You can set up conditional formats within cells that determine the formatting of the cell based on the outcome of a
conditional statement. You can use a named style to specify various formatting options such as borders and colors to
apply if the condition statement is valid, that is, if the operation is satisfied.

For example, you may want to change the background color of a cell based on the value of the cell. If the value is below
100 then the background color would be changed to red. The condition statement is "less than 100" and consists of a
comparison operator "less than" and a condition, in this case a single constant "100". The condition can be a constant
(expressed as a string) or an expression. Some condition statements have two conditions and an operator: for instance, if
the cell value is between 0 and 100, then change the background color. In this case, the comparison operator is
“between” and the first condition is 0 and the last condition is 100. For a complete list of operations, refer to the
ComparisonOperator ('ComparisonOperator Enumeration' in the on-line documentation) enumeration.
For a list of the types of expressions, refer to the CalcEngine.Expression object. For more information about the possible
style settings, refer to Creating and Applying a Custom Style for Cells.

If two conditional formats are set to the same cell, the second conditional format takes effect.
Using Code

Use the SetConditionalFormat ('SetConditionalFormat Method' in the on-line documentation) method to
create a conditional format.

Example
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The following example changes the color of the cell if the value is greater than 14.

C#

FarPoint.Web.Spread.NamedStyle ns = new FarPoint.Web.Spread.NamedStyle();
ns.BackColor = Color.Crimson;

ns.Name = "mystyle";

FpSpreadl.NamedStyles.Add (ns) ;
FpSpreadl.Sheets[0].SetConditionalFormat (0, 0, ns,
FarPoint.Web.Spread.ComparisonOperator.GreaterThan, "14");

VB

Dim ns As New FarPoint.Web.Spread.NamedStyle
ns.BackColor = Drawing.Color.Azure

ns.Name = "mystyle"

FpSpreadl .NamedStyles.Add (ns)
FpSpreadl.Sheets (0) .SetConditionalFormat (0, 0, ns,
FarPoint.Web.Spread.ComparisonOperator.GreaterThan, "14")

Customizing Selections of Cells

You can customize what the user can select and how it appears. To customize aspects of selections, you can perform the
following tasks:

¢ Specifying What the User Can Select
e Working with Selections of Cells
¢ Customizing the Appearance of Selections

For more information about the underlying selection model, refer to Understanding the Selection Model.

Specifying What the User Can Select

By default, the component allows users to select a cell, a column, a row, a range of cells, or the entire sheet. You can
customize what the user can select by working with the operation mode of the sheet (OperationMode
('OperationMode Property' in the on-line documentation) property). The settings are based on the
OperationMode ('OperationMode Enumeration’' in the on-line documentation) enumeration. You can
specify what the user is allowed to select in normal operation mode with the SelectionBlockOptions
('SelectionBlockOptions Property' in the on-line documentation) property. You can allow the user to select
multiple blocks in normal operation mode with the SelectionPolicy ('SelectionPolicy Property' in the on-line
documentation) property.

The settings of the OperationMode ('OperationMode Property' in the on-line documentation) property affect
user interaction with the sheet, that is, what the user can select, but not necessarily what the application can select.
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Editable active cell Entire row selected
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The following table summarizes the options available for specifying what users can select and edit on the sheet:

User can select User can edit OperationMode Setting
Cell, row, column, any range of cells, entire sheet Active cell Normal

Only one row Active Cell RowMode

Only one row Nothing SingleSelect

Nothing Nothing ReadOnly

Multiple contiguous rows Nothing MultiSelect

Multiple discontiguous rows Nothing ExtendedSelect

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.

. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. In the Members list, select the sheet for which to set the operation mode.

. Select the OperationMode property, then select one of the values from the drop-down list of values.
. Click OK to close the editor.
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Using a Shortcut

1. To set the overall user interaction mode of the sheet, set the Sheet’s OperationMode ('OperationMode
Property' in the on-line documentation) property.

Example

This example code sets the sheet to allow users to select only rows and only edit the active cell.

C#

// Set the operation mode and let users select only rows.
fpSpreadl.Sheets[0] .OperationMode = FarPoint.Web.Spread.OperationMode.RowMode;

VB

' Set the operation mode and let users select only rows.
FpSpreadl.Sheets (0) .OperationMode = FarPoint.Web.Spread.OperationMode.RowMode
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Using Code

1. To set the overall user interaction mode of the sheet, set the OperationMode ('OperationMode Property'
in the on-line documentation) property for a SheetView ('SheetView Class' in the on-line
documentation) object.

2. Assign the SheetView ('SheetView Class' in the on-line documentation) object you have created to one
of the sheets in the component.

Example

This example code sets the sheet to allow users to select only cells or ranges of cells, including multiple ranges of cells.
They cannot select columns, rows, or the entire sheet.

C#

// Set operation mode and let users select only a row.
FarPoint.Web.Spread.SheetView newsheet = new FarPoint.Web.Spread.SheetView();
newsheet.OperationMode = FarPoint.Web.Spread.OperationMode.RowMode;

// Assign the SheetView object to a sheet.

fpSpreadl.Sheets[0] = newsheet;

VB

' Set operation mode and let users select only a row.

Dim newsheet As New FarPoint.Web.Spread.SheetView ()
newsheet.OperationMode = FarPoint.Web.Spread.OperationMode.RowMode
' Assign the SheetView object to a sheet.

FpSpreadl.Sheets (0) = newsheet

Using the Spread Designer

1. Select the sheet tab for the sheet for which you want to set the selection operation mode.

2. From the Settings menu, select the General icon, then select one of the choices from the Operation Mode
area.

3. Click OK to close the Sheet Settings dialog.
4. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Working with Selections of Cells

Besides selections that can be allowed by the end user, you can work with selections to the sheet using code. With code,
you can add a selection or remove one or all of the existing selections. Use the AddSelection ('AddSelection
Method' in the on-line documentation) and ClearSelection ('ClearSelection Method' in the on-line
documentation) methods to add and remove selections using code in the selection model.

For more information on working with the models, refer to Understanding the Selection Model.

For information on changing the appearance of selected cells, refer to Customizing the Appearance of Selections.
Using Code
You can get a selection on the server side with the following code.

Example
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The following code gets the first selection.

C#

FarPoint.Web.Spread.Model.CellRange cr = FarPoint.Web.Spread.Model.CellRange;
cr = FpSpreadl.Sheets[0].SelectionModel (0);

VB

Dim cr as FarPoint.Web.Spread.Model.CellRange
cr = FpSpreadl.Sheets (0).SelectionModel (0)

Customizing the Appearance of Selections

Selections have a default appearance provided by the component and the selection renderer. You can change that
appearance, including the background and text colors as well as the border. By default, when you click on a row header,
the entire row is selected and when you click on a column header, the entire column is selected. The active cell retains a
different appearance to show you which cell is active. You can change the selection behavior by setting the
OperationMode ('OperationMode Property' in the on-line documentation) for the sheet.

Set the SheetView ('SheetView Class' in the on-line documentation) object’s SelectionBackColor
('SelectionBackColor Property' in the on-line documentation) and SelectionForeColor
('SelectionForeColor Property' in the on-line documentation) to specify the colors to use for the background
and for the text (SelectionForeColor ('SelectionForeColor Property' in the on-line documentation) only
applies to downlevel browsers). Set the SheetView object’s SelectionBorder ('SelectionBorder Property' in the
on-line documentation) to specify the border for selections (downlevel browser only). Assign the SheetView object
you have created to one of the sheets in the component.

You can also change the appearance by setting the selection colors in a custom skin and applying that skin to the sheet.
For more information about skins, refer to Creating a Skin for Sheets and Applying a Skin to a Sheet.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Set the various selection properties.

. Click OK to close the editor.
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Using a Shortcut

1. Set the SelectionBackColorStyle ('SelectionBackColorStyle Property' in the on-line
documentation) property.

2. Set the SelectionBackColor ('SelectionBackColor Property' in the on-line documentation) property.
3. Set the SelectionPolicy ('SelectionPolicy Property' in the on-line documentation) property.

Example

This example code sets the selection backcolor and policies.

C#

FpSpreadl.Sheets[0] .SelectionBackColorStyle =
FarPoint.Web.Spread.SelectionBackColorStyles.SelectionBackColor;
FpSpreadl.Sheets[0].SelectionBackColor = Color.SaddleBrown;
FpSpreadl.Sheets[0].SelectionPolicy =
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FarPoint.Web.Spread.Model.SelectionPolicy.MultiRange;

VB

FpSpreadl.Sheets (0) .SelectionBackColorStyle =
FarPoint.Web.Spread.SelectionBackColorStyles.SelectionBackColor
FpSpreadl.Sheets (0) .SelectionBackColor = Color.SaddleBrown
FpSpreadl.Sheets (0) .SelectionPolicy =
FarPoint.Web.Spread.Model.SelectionPolicy.MultiRange

Using the Spread Designer

. Select the Settings menu.

. Select the Colors icon from the Sheet Settings section.

. Set the various selection options. Click OK to close the dialog.

. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
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Managing Printing

You can print the data area of the spreadsheet. This includes the headers and the cells, but not the tool bars or scroll bars
of the component. You can also specify headers and footers for the printed pages.

¢ Printing a Spreadsheet
¢ Adding Headers and Footers to Printed Pages

You can also print to a PDF file. For more information, see Saving to a PDF File.

Printing a Spreadsheet

You can print the data area of a spreadsheet by clicking Print (or the Print icon) in the command bar of the
component. The appearance of the print button depends on the setting in the command bar and the type of buttons. For
more information refer to Customizing the Command Buttons.

At run time, when you click Print, the standard print dialog for your machine appears and you can choose various
printer settings before clicking OK to print. You can specify page breaks with the column PageBreak ('"PageBreak
Property’' in the on-line documentation) property or the row PageBreak ('PageBreak Property' in the on-
line documentation) property when printing to the client.

In addition to the print button, there is an IsPrint ('IsPrint Property' in the on-line documentation) property.
Setting this to true brings up a preview of what is to be printed.

&) The ShowColumnHeader ('ShowColumnHeader Property' in the on-line documentation) and
ShowRowHeader ('ShowRowHeader Property' in the on-line documentation) properties in the
PrintInfo ('"PrintInfo Class' in the on-line documentation) class apply when printing or saving to PDF.

You can also use the client-side Print (on-line documentation) method. For more information, refer to the Client-
Side Scripting Reference (on-line documentation).

Using Code

You can set the FpSpread ('FpSpread Class' in the on-line documentation) component IsPrint ('IsPrint
Property' in the on-line documentation) property in code.

Example
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The following code sets the IsPrint ('IsPrint Property' in the on-line documentation) property.

C#

FpSpreadl.IsPrint = true;

VB
FpSpreadl.IsPrint

True

Using the Spread Designer

1. Select the File menu.
2. Select Print, SaveToPDF, or Print Preview from the Print menu.
3. Click Apply and Exit to close the Spread Designer.

Adding Headers and Footers to Printed Pages

You can add headers and footers to the printed pages by using the Content property in the PrintSheet event. You can use
HTML characters in the header or footer string. An example of this would be the line break tag, <BR>, for breaking to a
new line.

Using Code
Set the Content property in the PrintSheet ('PrintSheet Event' in the on-line documentation) event.
Example

The following code adds a header and footer to the printed page.
C#

private void FpSpreadl PrintSheet (object sender, FarPoint.Web.Spread.PrintEventArgs e)
{

if (e.Header == true)
{
e.Content = "Header<BR>Test";
}
if (e.Header == false)
{
e.Content = "Footer";

}
}

VB

Private Sub FpSpreadl PrintSheet (ByVal sender As Object, ByVal e As
FarPoint.Web.Spread.PrintEventArgs) Handles FpSpreadl.PrintSheet
If e.Header = True Then

e.Content = "Header<BR>Test"
End If
If e.Header = False Then
e.Content = "Footer"
End If
End Sub
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Customizing the Appearance

You can customize the appearance of various parts of the FpSpread component.
The tasks that relate to setting the appearance of parts of the component include:

¢ Customizing the Appearance of the Overall Component
¢ Customizing the Appearance of the Sheet

¢ Customizing the Appearance of Rows and Columns

¢ Customizing the Appearance of Headers

¢ Customizing the Appearance of a Cell

For information on customizing the appearance of selections, refer to Customizing the Appearance of Selections
For information on customizing the interaction with parts of the component, refer to Customizing User Interaction.
For information on the hierarchical display of data, refer to Displaying Data as a Hierarchy.

For information on the underlying style model, refer to Understanding the Style Model.

Customizing the Appearance of the Overall Component

You can set several aspects that determine the appearance of the component on the HTML page. These include:

¢ Customizing the Dimensions of the Component
¢ Customizing the Outline of the Component

¢ Customizing the Default Initial Appearance

¢ Resetting Parts of the Interface

Using the jQuery Theme Roller with Spread

Other tasks that are related to the appearance of the overall component include:

Setting the Background Color of the Sheet
Displaying Grid Lines on the Sheet
Displaying the Sheet Names

Adding a Title and Subtitle to a Sheet

For more information on the FpSpread component properties, refer to the FpSpread ('"FpSpread Class' in the on-
line documentation) class.

Customizing the Dimensions of the Component

You can set the overall dimensions of the component and these remain the same regardless of the size of the sheet or the
amount of navigation bars. If there are more rows in a sheet than can be displayed, then the component creates pages
inside the component to allow you access to those rows. Refer to Customizing Page Navigation for more
information. If you display hierarchy information and page navigation bars, then the amount of space dedicated to the
sheet is smaller. All the tool bars, scroll bars, and sheet appear inside the overall dimensions of the component. Refer to
Customizing the Tool Bars for more information.

The following figure shows the dimensions that you can set by setting the number of pixels for each.
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Height
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Using the Properties Window

Set the dimensions at design time with the Properties window of Visual Studio .NET.

1. Select the component.

2. With the Properties window open, in the Layout category, select the Height property or the Width property
and type in a new value. The unit is pixels. Press Enter. The new dimension is now set.
Refer to the Microsoft .NET Framework documentation for setting the units of measurement for height to
something other than the default, which is pixels.

Using Code

Add a line of code that sets the specific dimension using the Height or Width properties of FpSpread ('FpSpread
Class' in the on-line documentation) class or both. The default for the unit of measurement is pixels.

Example

This example shows how to set the height of the component to 200 pixels and the width to 400 pixels.

C#

FpSpreadl.Height = 200;
FpSpreadl.Width = 400;

VB

FpSpreadl.Height = System.Web.UI.WebControls.Unit.Pixel (200)
FpSpreadl.Width = System.Web.UI.WebControls.Unit.Pixel (400)

Customizing the Outline of the Component

You can set several aspects of the outline (or border) of the component. These aspects include:

o the color of the outline
o the line style of the outline
¢ the width (or thickness) of the outline

Here is a picture of an example of the outline of the component changed to be a thick dashed green outline. The example
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below shows the code for these customizations.
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Using the Properties Window

Set the border at design time with the Properties window of Visual Studio .NET.

1. Select the component.

2. With the Properties window open, in the Appearance category, select the BorderColor property, the
BorderStyle property, or the BorderWidth property. For the BorderColor and BorderStyle properties,
select a value from the drop-down list. For the BorderWidth, type in a value; the unit is pixels. Press Enter.
The new property is now set.

Refer to the Microsoft .NET Framework documentation for setting the units to something other than the default,
which is pixels.

Using Code

Add a line of code that sets the specific border property. The default for the unit of thickness is pixels. For more
information, refer to the BorderColor ('BorderColor Property' in the on-line documentation), BorderStyle
('BorderStyle Property' in the on-line documentation), and BorderWidth properties in the Border ('Border
Class' in the on-line documentation) class.

Example

This example shows how to create a green dashed outline that is four pixels thick around the entire component. To see
the results, see the figure above.

C#

FpSpreadl.BorderColor = Drawing.Color.Green;
FpSpreadl.BorderStyle BorderStyle.Dashed;
FpSpreadl.BorderWidth = System.Web.UI.WebControls.Unit.Pixel (4);

VB

FpSpreadl.BorderColor = Drawing.Color.Green
FpSpreadl.BorderStyle BorderStyle.Dashed
FpSpreadl.BorderWidth = System.Web.UI.WebControls.Unit.Pixel (4)

Customizing the Default Initial Appearance

You can set the default initial appearance.
The following API members are involved in the default appearance.

¢ CommandBarInfo ('CommandBarInfo Class' in the on-line documentation) Background Property
¢ DefaultSkins ('DefaultSkins Class' in the on-line documentation) Classic Property
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e DefaultSkins ('DefaultSkins Class' in the on-line documentation) Default Property

e FpSpread ScrollBar Properties (ScrollBargDLightColor ('ScrollBargDLightColor Property' in the
on-line documentation), ScrollBarArrowColor ('ScrollBarArrowColor Property' in the on-line
documentation), ScrollBarBaseColor ('ScrollBarBaseColor Property' in the on-line
documentation), and so on)

¢ GrouplInfo ('GroupInfo Class' in the on-line documentation) Background Property and Reset method

You can change the font size for the entire component using the underlying Web controls properties. For example, you
can set the font size to 14 point using this command in code:

VB

FpSpreadl.ActiveSheetView.DefaultStyle.Font.Size =
System.Web.UI.WebControls.FontUnit.Point (14)

You can set the default appearance to the version 3 appearance with the following code:

Using Code

Set the BackgroundImageUrl ('BackgroundImageUrl Property' in the on-line documentation),
SelectionBackColor ('SelectionBackColor Property' in the on-line documentation), and default header and
corner styles.

Example

This example shows how to set the control to the version 3 appearance.

C#

FpSpreadl.CommandBar.Background.BackgroundImageUrl = NULL;
FpSpreadl.Sheets[0].SelectionBackColor = Color.Empty;

FpSpreadl.Sheets[0] .ColumnHeader.DefaultStyleName = "HeaderDefault";
FpSpreadl.Sheets[0] .RowHeader.DefaultStyleName = "HeaderDefault";
FpSpreadl.Sheets[0].SheetCorner.DefaultStyleName = "HeaderDefault";

VB

FpSpreadl.CommandBar.Background.BackgroundImageUrl = Nothing
FpSpreadl.Sheets (0) .SelectionBackColor = Color.Empty

FpSpreadl.Sheets (0) .ColumnHeader.DefaultStyleName = "HeaderDefault"
FpSpreadl.Sheets (0) .RowHeader.DefaultStyleName = "HeaderDefault"
FpSpreadl.Sheets (0) .SheetCorner.DefaultStyleName = "HeaderDefault"

Resetting Parts of the Interface

You can reset various settings on various parts of the Spread component interface back to default or original values. You
can also clear parts of the data area of various items, both data and formatting.

The ways in which parts of the component can be reset include:
e Reset the component to its original state using the FpSpread ('FpSpread Class' in the on-line

documentation) class Reset ('Reset Method' in the on-line documentation) method.

e Reset the sheet to its original state using the SheetView ('SheetView Class' in the on-line
documentation) class Reset ('Reset Method' in the on-line documentation) method.

o Reset the skin properties for a sheet or sheets using the DefaultSkins ('DefaultSkins Class' in the on-
line documentation) class Reset ('Reset Method' in the on-line documentation) method.

o Reset the value of a cell or the text in a cell to empty using the Cell ('Cell Class' in the on-line
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documentation) class, ResetText ('ResetText Method' in the on-line documentation) or
ResetValue ('ResetValue Method' in the on-line documentation) method.

e Reset all the named style properties to their default values using the NamedStyle ('NamedStyle Class' in
the on-line documentation) class Reset ('Reset Method' in the on-line documentation) method.
There are also individual reset methods for each of the settings in a style:

e Reset all the style settings in the StyleInfo object to the default settings using the StyleInfo ('StyleInfo
Class' in the on-line documentation) class Reset ('"Reset Method' in the on-line documentation)
method.

Reset the settings for cells, rows, or columns using the individual reset methods for each setting in the Cell ('Cell
Class' in the on-line documentation) or Row ('Row Class' in the on-line documentation) or Column
("Column Class' in the on-line documentation) or StyleInfo ('StyleInfo Class' in the on-line
documentation) class.

e ResetBackColor Method

e ResetBackground Method

e ResetBorder Method

e ResetCellType Method

e ResetFont Method

e ResetForeColor Method

e ResetHorizontalAlignment Method

e ResetLocked Method

e ResetTabStop Method

e ResetText Method

e ResetValue Method

e ResetVerticalAlignment Method
Reset all the named style properties to their default values using the NamedStyle ('NamedStyle Class' in the on-
line documentation) class Reset ('Reset Method' in the on-line documentation) method. There are also
individual reset methods for each of the settings in a style.

¢ StyleInfo ResetEditor ('ResetEditor Method' in the on-line documentation) Method

¢ StyleInfo ResetFormatter ('ResetFormatter Method' in the on-line documentation) Method

¢ StyleInfo ResetRenderer ('ResetRenderer Method' in the on-line documentation) Method
Resetting the component or a sheet to its default settings returns the component or the sheet to its initial state prior to

any design-time or run-time changes. It clears data, resets colors, and returns cells to the default cell type. Resetting the
component resets everything in the component to the state when the component is first drawn on the form.

Resetting the component or a sheet clears the data in the sheet(s) as well as the formatting. If you provide a way for
users to reset their sheet(s), be sure to have them confirm the action before resetting the sheet(s).

Using the jQuery Theme Roller with Spread

You can apply a Theme Roller theme to the Spread control.
The theme is applied to the following areas.

e Column Header

e Row Header

e Corner

e Footer and Footer Corner
e Command Bar

e Title Bar

e Group Bar
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Gray Header
e Hierarchy Bar
e Pager

Sheet Tab

The following styles are applied from the jQuery theme.

e Background-Color
e Background-Image
e ForeColor
e Font family
e Font weight
e Font size
If the jQuery theme is enabled, the jQuery theme style has a higher priority than the default style but a lower priority

than the custom style. If the sheet skin is DefaultSkins.Default or it is not specified, the jQuery theme takes effect. If the
sheet view active skin is a built-in skin (not DefaultSkins.Default) or a custom skin then the jQuery theme has no effect.

The viewport, context menu, filter menu, touch strip, dialogs, group headers, and group footers are not supported. If the
SheetView.SelectionBackColor ('SelectionBackColor Property' in the on-line documentation) property is
set, then the theme highlight is not applied.

For more information about themes, refer to the Theme Roller web site, http://jqueryui.com/themeroller/.

Using Code

e Add a reference to the theme.

¢ Set the EnablejQueryTheme ('"EnablejQueryTheme Property' in the on-line documentation)
property.

Example

This example displays a theme.

Script

<head runat="server">

<title>Demo page</title>

<link href="jquery-ui-themes-1.10.4/themes/ui-darkness/jquery-ui.min.css"
rel="stylesheet" />

<link href="jquery-ui-themes-1.10.4/themes/ui-darkness/jquery.ui.theme.css"
rel="stylesheet" />
</head>

C#

FpSpreadl .EnablejQueryTheme = true;

VB

FpSpreadl.EnablejQueryTheme = True

Customizing the Appearance of the Sheet

You can set many different properties for the appearance of the data area of the spreadsheet.

You can have multiple sheets within a workbook. Each sheet is a separate spreadsheet and can have its own appearance
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and settings for user interaction. Each sheet has a unique name and sheet name tab for easy navigation between sheets.
These tasks relate to setting the appearance of the entire sheet inside the component:

¢ Working with the Active Sheet

e Working with Multiple Sheets

¢ Adding a Sheet

¢ Removing a Sheet

¢ Showing or Hiding a Sheet

¢ Setting the Background Color of the Sheet

¢ Adding a Title and Subtitle to a Sheet

¢ Customizing the Page Size (Rows to Display)
¢ Displaying Grid Lines on the Sheet

¢ Customizing the Sheet Corner

e Displaying a Footer for Columns or Groups
¢ Adding an Image to the Sheet (on-line documentation)

You can quickly customize the appearance of a sheet by applying a "skin" to it. Skins are provided with Spread to create
common formats. You can also create your own skin and save it, to use again, similar to a template.

£ Note: Be aware that some settings for skins are affected by the setting of the EnableClientScript
("EnableClientScript Property' in the on-line documentation) property of the component.

The tasks you can perform when working with skins include:

e Creating a Skin for Sheets
e Applying a Skin to a Sheet

When you work with sheets, you can manipulate the objects using the short cuts in code, (SheetView ('SheetView
Class' in the on-line documentation) and SheetViewCollection ('SheetViewCollection Class' in the on-
line documentation) classes) or you can directly manipulate the model. Most developers who are not changing
anything drastically find it easy to manipulate the short cut objects.

For more information on the sheet properties, refer to the SheetView ('SheetView Class' in the on-line
documentation) class.

For more information on the SheetView Collection editor, refer to SheetView Collection Editor.

For information on displaying the sheet names, refer to Displaying the Sheet Names.

Working with the Active Sheet

The active sheet is the sheet that currently receives any user interaction. You can specify the active sheet
programmatically. Use the ActiveSheetView ('ActiveSheetView Property' in the on-line documentation)
property of the FpSpread ('FpSpread Class' in the on-line documentation) object.

Usually, the active sheet is displayed on top of the other sheets in the component.
For information about adding a sheet, refer to Adding a Sheet.

For information on working with multiple sheets, refer to Working with Multiple Sheets.

Working with Multiple Sheets

The component allows multiple sheets. Set the Count ("Count Property' in the on-line documentation) property
to specify the number of sheets. For information on adding sheets with the designer, see the SheetView Collection
Editor.
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Multiple sheets

For information about the display of the sheet names in the sheet name buttons, refer to Displaying the Sheet
Names.

Formulas in a cell on one sheet can refer to a value or a cell on another sheet. For more information about formulas,
refer to Managing Formulas.

You can name the sheets. Use the SheetName ('SheetName Property' in the on-line documentation) property
in the SheetView ('SheetView Class' in the on-line documentation) class to name the sheet programmatically.

For information about adding a sheet, refer to Adding a Sheet.
Using Code

This example sets the number of sheets.

C#

FpSpreadl.Sheets.Count = 2;
VB
FpSpreadl.Sheets.Count = 2

Adding a Sheet

You can add a sheet or add several sheets to the component. By default, the component has one sheet, named Sheet 1
and referenced as sheet index 0. The sheet index is zero-based. If you are using custom sheet names be sure to specify
the name of the sheet.

In code, you can simply change the number of sheets by changing the Count ("Count Property' in the on-line
documentation) property or you can explicitly add the sheet(s) by defining new sheets or by using the Add ("Add
Method' in the on-line documentation) method. The following instructions describe how to add a sheet.

For information on removing a sheet, refer to Removing a Sheet.
Using the Properties Window

1. At design time, in the Properties window, select the Sheets property for the FpSpread component.
2. Click the button to display the SheetView Collection Editor.

3. Click the Add button to add a sheet to the collection.
A new sheet named Sheetn (where n is an integer) is added to the component.

4. If you want to change the name of the new sheet, click the SheetName property in the property list, and then
type the new name for the sheet.
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5. Click OK to close the editor.
Using Code

1. Create a new SheetView ('SheetView Class' in the on-line documentation) object.

2. If you want to do so, set properties for the sheet, such as its name.

3. Use the Add ('Add Method' in the on-line documentation) method with the FpSpread ('"FpSpread
Class' in the on-line documentation) component Sheets ('Sheets Property' in the on-line
documentation) shortcut to add the new SheetView ('SheetView Class' in the on-line documentation)
object to the collection of sheets (SheetViewCollection ('SheetViewCollection Class' in the on-line
documentation)) for the component.

Example

This example code adds a new sheet to the component, then names the sheet "North" and sets it to have 10 columns and
100 rows.

C#

// Create a new sheet.

FarPoint.Web.Spread.SheetView newsheet = new FarPoint.Web.Spread.SheetView();
newsheet.SheetName = "North";

newsheet.ColumnCount = 10;

newsheet .RowCount = 100;

// Add the new sheet to the component.
FpSpreadl.Sheets.Add (newsheet) ;

VB

' Create a new sheet.

Dim newsheet As New FarPoint.Web.Spread.SheetView()
newsheet.SheetName = "North"

newsheet.ColumnCount = 10

newsheet.RowCount = 100

' Add the new sheet to the component.
FpSpreadl.Sheets.Add (newsheet)

Using the Spread Designer

1. Select the Data menu. Click on the Insert icon.

2. Click the Insert Sheet option.
A new sheet named Sheetn (where n is an integer) is added to the component.

3. If you want to change the name of the new sheet, click the new sheet in the Properties for Sheetn list, and change
the SheetName property in the property list.

4. Click Apply and Exit to close the Spread Designer.

Removing a Sheet

You can remove a sheet or several sheets from the component. The sheet index is zero-based. In code, you can simply
change the number of sheets using the Count ('Count Property' in the on-line documentation) property or you
can explicitly remove the sheet(s) using the Remove ('Remove Method' in the on-line documentation) method.

Removing an existing sheet does not change the default sheet names provided to the other sheets. For example, a
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component with three sheets would by default name them Sheet1, Sheet2, and Sheet3. If you remove the second sheet,
the names for the remaining sheets are Sheet1 and Sheet3. The indexes for the sheets are 0 and 1, because the sheet
index is zero-based. You can also hide a sheet. For more information, refer to Showing or Hiding a Sheet.

To remove an existing sheet, complete the following instructions.

For information on adding a sheet, refer to Adding a Sheet.
Using the Properties Window

. At design time, in the Properties window, select the Sheets property for the FpSpread component.
. Click the button to display the SheetView Collection Editor.

. In the Members list, select the sheet to remove.

. Click the Remove button to remove the sheet from the collection.

. Click OK to close the editor.

g WN R

Using a Shortcut

Use the Remove ('Remove Method' in the on-line documentation) method with the FpSpread ('"FpSpread
Class' in the on-line documentation) component Sheets ('Sheets Property' in the on-line documentation)
shortcut to remove the SheetView ('SheetView Class' in the on-line documentation) object from the collection
of sheets (SheetViewCollection ('SheetViewCollection Class' in the on-line documentation)).

Example

This example code removes the second sheet from a component that has two or more sheets.

C#

// Remove the second sheet.
FpSpreadl.Sheets.Remove (FpSpreadl.Sheets[1]);

VB

' Remove the second sheet.
FpSpreadl.Sheets.Remove (FpSpreadl.Sheets (1))

Using the Spread Designer

1. Select the Data menu. Select the sheet you wish to delete (click on the sheet name at the bottom of the designer
window).

Select the Delete icon.

Click Delete Sheet.

The Spread Designer asks you if you are sure you want to remove the sheet. Click Yes to remove the sheet.
Click Apply and Exit to close the Spread Designer.

CUEE S S

Showing or Hiding a Sheet

You can hide a sheet so that it is not displayed to the user while still keeping it in the component.

Hiding a sheet does not change the default sheet names provided to the other sheets. For example, a component with
three sheets would by default name them Sheet1, Sheet2, and Sheet3. If you hide the second sheet, the names for the
remaining sheets are Sheet1 and Sheet3s.

Hiding a sheet does not remove it and does not affect formulas on that sheet or references to that sheet. For more
information on removing the sheet completely, refer to Removing a Sheet. Use the Visible ("Visible Property' in
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the on-line documentation) property of the FpSpread ('FpSpread Class' in the on-line documentation)
component to show or hide the sheet.

Using the Properties Window

At design time, in the Properties window, select the Sheets property for the FpSpread component.
Click the button to display the SheetView Collection Editor.

In the Members list, select the sheet to hide.

Select the Visible property in the property list and set to false.

Click OK to close the editor.

S e

Using a Shortcut

Set the Visible ("Visible Property' in the on-line documentation) property of the FpSpread ('FpSpread
Class' in the on-line documentation) component Sheets ('Sheets Property’ in the on-line documentation)
shortcut.

Example

This example code hides the second sheet from a component that has two or more sheets.

C#

// Hide the second sheet.
FpSpreadl.Sheets[1l].Visible = false;

VB

' Hide the second sheet.
FpSpreadl.Sheets[1l] .Visible = False

Setting the Background Color of the Sheet

You can customize the background color of the data area of the sheet. The sheet background color is displayed as the cell
background color, unless you set specific cell colors (as explained in Customizing the Colors of a Cell). It is also the
color in the rest of the sheet where cells are not displayed (empty area), as shown in the following figure, where the
background color is set to light yellow.
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The background color for the sheet can be set either with the BackColor ('BackColor Property' in the on-line
documentation) property of the sheet (SheetView ('SheetView Class' in the on-line documentation) class) or
the BackColor ('BackColor Property' in the on-line documentation) property of the SheetSkin ('SheetSkin
Class' in the on-line documentation) class and the skin applied to the sheet.

Using the Properties Window
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. At design time, in the Properties window, select the Sheets property for the FpSpread component.
. Click the button to display the SheetView Collection Editor.
. In the Members list, select the sheet for which to set the background color.

. Select the BackColor property in the property list, and then click the drop-down button to display the color
picker.

5. Select a color in the color picker.
6. Click OK to close the editor.

A W N R

Using a Shortcut

Set the BackColor ('BackColor Property' in the on-line documentation) property of the FpSpread
('FpSpread Class' in the on-line documentation) component Sheets ('Sheets Property' in the on-line
documentation) shortcut.

Example

This example code sets the background color of the first sheet to light yellow.

C#

// Set the first sheet's background color to light yellow.
FpSpreadl.Sheets[0] .BackColor = Color.LightYellow;

VB

' Set the first sheet's background color to light yellow.
FpSpreadl.Sheets (0) .BackColor = Color.LightYellow

Using the Spread Designer

From the sheets displayed at the bottom, select the sheet for which you want to set the background color.
Select the BackColor property in the property list.

Click the drop-down arrow to display the color picker.

Select a color from the color picker.

Click Apply and Exit to close the Spread Designer.

Adding a Title and Subtitle to a Sheet

S e

You can add a specially formatted area at the top of the spreadsheet that includes either a title or a subtitle or both. An
example is shown here of a spreadsheet that has a title and a subtitle.

FarPoint Spread Title
Sheet Only Subtitle
A B C D
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=
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The title is set using the TitleInfo property at the FpSpread level. The subtitle is set using the TitleInfo ('TitleInfo
Property' in the on-line documentation) property at the sheet level. So titles apply to the overall Spread
component, while subtitles can be different for each sheet.

The API members that are involved include:

¢ TitleInfo ('TitleInfo Class' in the on-line documentation) Class and all members
¢ SheetView TitleInfo ('TitleInfo Property' in the on-line documentation) Property
e FpSpread TitleInfo ('TitleInfo Property’ in the on-line documentation) Property

Using the Properties Window

1. At design time, in the Properties window, select the FpSpread component or the sheet.
2. Select TitleInfo.

3. Set the Visible property to true and other properties as needed.

4. Click OK to close the editor.

Using a Shortcut

Set the properties of the TitleInfo ('TitleInfo Class' in the on-line documentation) class at the FpSpread and
Sheet level.

Example

This example code sets and displays a title for the component and subtitle for the sheet.

C#

// Show the title for the entire spreadsheet component.
FpSpreadl.TitleInfo.Visible = true;

FpSpreadl.TitleInfo.Text = "FarPoint Spread Title";

// Show the subtitle for the individual sheet.

FpSpreadl.Sheets[0] .TitleInfo.Visible = true;
FpSpreadl.Sheets[0].TitleInfo.Text = "Sheet Only Subtitle";
FpSpreadl.Sheets[0].TitleInfo.HorizontalAlign = HorizontalAlign.Center;
FpSpreadl.Sheets[0].TitleInfo.BackColor = System.Drawing.Color.Aqua;

VB

' Show the title for the entire spreadsheet component.
FpSpreadl.TitleInfo.Visible = True

FpSpreadl.TitleInfo.Text = "FarPoint Spread Title"

' Show the subtitle for the individual sheet.
FpSpreadl.Sheets (0) .TitleInfo.Visible = True
FpSpreadl.Sheets (0) .TitleInfo.Text = "Sheet Only Subtitle"
FpSpreadl.Sheets (0) .TitleInfo.HorizontalAlign = HorizontalAlign.Center
FpSpreadl.Sheets (0) .TitleInfo.BackColor = System.Drawing.Color.Aqua

Using the Spread Designer

1. Select the Settings menu.

2. Select the Title icon under the Spread Settings section.
3. Set the title and/or subtitle.

4. Click Apply and Exit to close the Spread Designer.
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Customizing the Page Size (Rows to Display)

In this Web Form version of Spread, a page is the amount of data of a sheet that can be displayed at one time. When the
sheet contains more rows than can be displayed in the component, Spread automatically creates pages that contain the
other rows. (These are not to be confused with HTML pages.) For sheets that have more rows than fit in the display area,
the sheet has multiple pages.

The page size is the number or rows that are displayed at one time. By default, the page size is ten, so ten rows are
displayed. If you would like to display more than ten rows (or ten records for a bound spreadsheet), set the PageSize
property to the number of records you want to display on every page.

For more information on setting the page navigation, refer to Customizing Page Navigation.

Using Shortcut Object

Set the PageSize ('PageSize Property' in the on-line documentation) property for the sheet using the
ActiveSheetView ('ActiveSheetView Property' in the on-line documentation) shortcut of the FpSpread
component.

Example

The following code shows how to set the page size to display 15 rows.

C#

FpSpreadl.ActiveSheetView.PageSize = 15;
VB
FpSpreadl.ActiveSheetView.PageSize = 15

Using Code

Set the PageSize ('PageSize Property' in the on-line documentation) property for the SheetView
('SheetView Class' in the on-line documentation) class.

Example

The following code shows how to set the page size to display 15 rows.

C#

FarPoint.Web.Spread.SheetView sv = FpSpreadl.ActiveSheetView;
sv.PageSize = 15;

VB

Dim sv As FarPoint.Web.Spread.SheetView
sv = FpSpreadl.ActiveSheetView
sv.PageSize = 15

Using the Spread Designer

1. Select the Settings tab.
2. Select the General icon under the Sheet Settings section.
3. Check the AllowPage check box and specify the number of rows in the Page Size edit box.
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4. Click Apply and Exit to close the Spread Designer.

Displaying Grid Lines on the Sheet

You can display grid lines on the sheet that distinguish rows or columns (or both). You can set the grid lines to display
using the GridLines ('GridLines Property' in the on-line documentation) property for the sheet (which uses
the settings of the GridLines enumeration in the underlying Microsoft .NET framework).

e To show only the grid lines for the rows (horizontal lines), set the property to GridLines.Horizontal.

e To show only the grid lines for the columns (vertical lines), set the property to GridLines.Vertical.

e To show the grid lines for both the rows and the columns (both the vertical and horizontal lines), set the
property to GridLines.Both.

e To turn off (or hide) the grid lines, set the property to GridLines.None.

You can set the color of the grid lines. In the following figure, where both the horizontal and vertical lines are displayed,
the grid lines are red.
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You can also set the grid lines and the grid lines color by defining these properties in the SheetSkin ('SheetSkin
Class' in the on-line documentation) class and then applying the skin to the sheet. For more information creating
and applying skins, refer to Applying a Skin to a Sheet and Creating a Skin for Sheets.

To set borders around individual cells, refer to Customizing Cell Borders.
Using the Properties Window

. At design time, in the Properties window, select the Sheets property for the FpSpread component.
. Click the button to display the SheetView Collection Editor.
. In the Members list, select the sheet for which you want to set the grid line color.

. Select the GridLineColor property in the property list, and then click the drop-down button to display the color
picker.

5. Select a color in the color picker.
6. Click OK to close the editor.

A WO N R

Using a Shortcut

Set the GridLines ('GridLines Property' in the on-line documentation) and GridLineColor
('GridLineColor Property' in the on-line documentation) properties of the FpSpread ('FpSpread Class' in
the on-line documentation) component Sheets ('Sheets Property' in the on-line documentation) shortcut.

Example

This example code sets the grid line color to red and displays the row grid lines.

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 191

C#

// Set the grid line color to red.
FpSpreadl.Sheets[0].GridLineColor = System.Drawing.Color.Red;
FpSpreadl.Sheets[0] .GridLines = GridLines.Horizontal;

VB

' Set the grid line color to red.
FpSpreadl.Sheets (0) .GridLineColor = System.Drawing.Color.Red
FpSpreadl.Sheets (0) .GridLines = GridLines.Horizontal

Using the Spread Designer

Select the Settings menu.

From the sheets displayed at the bottom, select the sheet for which you want to set the grid line color.
Select the GridLines icon in the Sheet Setting section.

Set the color or any other grid properties.

Click OK to close the dialog.

Click Apply and Exit to close the Spread Designer.

g h @R

Customizing the Sheet Corner

You can customize the appearance of the sheet corner, the header cell in the upper left corner of the sheet, for each
sheet. Sheet corners can display grid lines, have a different background color from the rest of the headers, and more. You
can set the style of the sheet corner. You can set the style of the sheet corner as you would any cell in the spreadsheet and
you can set the text that appears in the corner. Any of the properties of the StyleInfo ('StyleInfo Class' in the on-
line documentation) object can be set for the cells in the corner of the sheet. In the following figure, the sheet corner
uses default values (the sheet corner row and column count have been set to three).

L1
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Sheet corners can display grid lines, have a different background color from the rest of the headers, and more. There are
several different ways to set properties in the sheet corner. One way is with the SheetCorner ('SheetCorner Class'
in the on-line documentation) class. Another option is to set the sheet corner properties for the SheetView
('SheetView Class' in the on-line documentation) class.

The parts of the API that affect the sheet corner include:

e FpSpread SheetCorner ('SheetCorner Property' in the on-line documentation) Property

o SheetView AllowTableCorner ('AllowTableCorner Property' in the on-line documentation)
Property

e SheetView SheetCorner ('SheetCorner Property' in the on-line documentation) Property

e SheetView SheetCornerStyle ('SheetCornerStyle Property' in the on-line documentation)
Property
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e SheetView SheetCornerStyleName ('SheetCornerStyleName Property' in the on-line
documentation) Property

¢ SheetCorner ('SheetCorner Class' in the on-line documentation) Class - all members
Several of the StyleInfo object properties can be set for the sheet corner cell. These properties include:

e background color - the background color of the cell

e border - the border around the cell

o cell type - the type of cell (see

o font - the font settings of the cell

e text color - the color of text color in the cell

e alignment - the alignment of text in the cell (horizontal and vertical)

The figure below shows an example (see the example code below) that specifies a sheet corner with alternating row
colors and a column border.

Using Shortcut Object

1. Set the given property of the sheet corner style (SheetCornerStyle ('SheetCornerStyle Property' in the
on-line documentation) property) of the FpSpread ('"FpSpread Class' in the on-line documentation)
component Sheets ('Sheets Property' in the on-line documentation) shortcut.

Example

This example code sets the text, border colors, text colors, and row colors.

C#

FarPoint.Web.Spread.StyleInfo altrowstyle = new FarPoint.Web.Spread.StyleInfo();
altrowstyle.BackColor = System.Drawing.Color.LemonChiffon;

altrowstyle.ForeColor = System.Drawing.Color.Navy;

altrowstyle.Font.Bold = true;
FpSpreadl.Sheets[0] .AllowTableCorner = true;
FpSpreadl.Sheets[0].SheetCorner.RowCount = 3;
FpSpreadl.Sheets[0].SheetCorner.ColumnCount =
FpSpreadl.Sheets[0] .SheetCorner.AlternatingRow
System.Drawing.Color.Crimson;
FpSpreadl.Sheets[0].SheetCorner.Cells[0, 0].Text = "Test";
FpSpreadl.Sheets[0].SheetCorner.Columns[0] .Border = new

FarPoint.Web.Spread.Border (System.Web.UI.WebControls.BorderStyle.Double,
System.Drawing.Color.DarkBlue, 2);

FpSpreadl.Sheets[0].SheetCorner.Rows|[0] .Border = new

FarPoint.Web.Spread.Border (System.Drawing.Color.Green) ;

FpSpreadl.Sheets[0] .SheetCornerStyle = new FarPoint.Web.Spread.StyleInfo(altrowstyle);

3;
s[0] .BackColor =
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VB

Dim altrowstyle As New FarPoint.Web.Spread.StyleInfo()
altrowstyle.BackColor = Drawing.Color.LemonChiffon
altrowstyle.ForeColor = Drawing.Color.Navy

altrowstyle.Font.Bold = True

FpSpreadl.Sheets (0) .AllowTableCorner = True

FpSpreadl.Sheets (0) .SheetCorner.RowCount = 3

FpSpreadl.Sheets (0) .SheetCorner.ColumnCount = 3

FpSpreadl.Sheets (0) .SheetCorner.AlternatingRows (0) .BackColor = Drawing.Color.Crimson
FpSpreadl.Sheets ( .SheetCorner.Cells (0, 0).Text = "Test"
FpSpreadl.Sheets (0) .SheetCorner.Columnns (0) .Border = New

FarPoint.Web.Spread.Border (System.Web.UI.WebControls.BorderStyle.Double,
Drawing.Color.DarkBlue, 2)

FpSpreadl.Sheets (0) .SheetCorner.Rows (0) .Border = New

FarPoint.Web.Spread.Border (Drawing.Color.Green)

FpSpreadl.Sheets (0) .SheetCornerStyle = New FarPoint.Web.Spread.StyleInfo(altrowstyle)

0)
0)
0)
0)

Using the Spread Designer

Select the sheet tab for the sheet for which you want to display the sheet corner.

Select the Settings menu.

Select the Header Editor icon in the Other Settings section.

Select Sheet Corner in the Selected Header drop-down box.

Set the various formatting properties in the property grid.

From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

oSG h ®N R

Displaying a Footer for Columns or Groups

You can show a column footer or a group footer or both for the sheet and put information in the footer such as formulas
or text. The column footer is an area at the bottom of the sheet. The group footer is an extra row of footer cells under
each group when grouping, if you are using the grouping feature.

For details on the API, refer to the ColumnFooter ('ColumnFooter Property' in the on-line documentation)
property of the SheetView ('SheetView Class' in the on-line documentation) class and the various members of
the ColumnFooter ('ColumnFooter Class' in the on-line documentation) class.

In order to calculate the column footer or group footer result with a formula, set the AggregationType
('AggregationType Property' in the on-line documentation) property of the Column ('Column Class' in the
on-line documentation) object to the correct formula type for that column. The Aggregate ('Aggregate Event' in
the on-line documentation) event is raised after setting this property and can be used to add information to column
and group footers. The following figure displays a column footer with a formula in the first column:
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Drag a column to group by that column.

A B C D E

1 0 1 2 3 4 5

2 15 16 17 18 19 20 ~
3 30 31 32 33 34 35

4 45 46 7 48 49 50

5 |60 61 62 63 64 65

6 |75 76 17 78 79 80 v
7 " na A ~n na o

Sum
Sum:[420]

=}

=

The group footer is an extra row that is displayed below the group after grouping by a column header. The following
figure shows the result of a sum formula in column A for each row below a group. The rows are grouped by the data in
column A.

A Y
A B C D E
1 |=0:-0 A
200 1 2 3 4 3
3 o
4 |E0-15
5 |15 16 17 18 19 20 ¥
6 < >
Sum
Sum:[420]
Eg W S

The Grouped ('Grouped Event' in the on-line documentation) or Grouping ('Grouping Event' in the on-
line documentation) events can be used to set style information in the group footer after a user has created the group.

For more information on column appearance, refer to Customizing the Appearance of Rows and Columns.

For more information on grouping, refer to Customizing Grouping of Rows of User Data.
Using the Properties Window

1. At design time, in the Properties window, select the Sheets property for the FpSpread component.
2. Click the button to display the SheetView Collection Editor.
3. Select the ColumnFooter property or the GroupFooter property or both in the Property list and set visible
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to true.
4. Select DefaultStyle under ColumnFooter in order to set additional column footer properties such as color.
5. Select GroupInfoFooter in order to set additional group footer properties such as color.
6. Click OK to close the editor.

Using a Shortcut
Set the Visible ('Visible Property' in the on-line documentation) property of the ColumnFooter for the sheet.
Example

This example code displays a column footer with a span, puts text in a cell, and sets the text color.

C#

FpSpreadl.Sheets[0] .RowCount = 10;

FpSpreadl.Sheets[0].ColumnCount = 15;

// Show the column footer.

FpSpreadl .ActiveSheetView.ColumnFooter.Visible = true;
FpSpreadl.ActiveSheetView.ColumnFooter.RowCount = 2;
FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.ForeColor = Color.Purple;
FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.Border.BorderStyle =
BorderStyle.Double;
FpSpreadl.ActiveSheetView.ColumnFooter.Columns[12] .HorizontalAlign =
HorizontalAlign.Left;

FpSpreadl.ActiveSheetView.ColumnFooter.Cells[0, 12].RowSpan = 2;
FpSpreadl .ActiveSheetView.ColumnFooter.Cells [0, 0].Value = "test";

VB

FpSpreadl.Sheets (0) .RowCount = 10

FpSpreadl.Sheets (0) .ColumnCount = 15

' Show the footer.

FpSpreadl.ActiveSheetView.ColumnFooter.Visible = true
FpSpreadl.ActiveSheetView.ColumnFooter.RowCount = 2
FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.ForeColor = Color.Purple
FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.Border.BorderStyle =
BorderStyle.Double
FpSpreadl.ActiveSheetView.ColumnFooter.Columns (12) .HorizontalAlign =
HorizontalAlign.Left

FpSpreadl .ActiveSheetView.ColumnFooter.Cells (0, 12) .RowSpan = 2
FpSpreadl.ActiveSheetView.ColumnFooter.Cells (0, 0).Value = "test

Using a Shortcut

Set the AggregationType ('AggregationType Property' in the on-line documentation) property for the
column.

Example

This example sums the values in the first column and displays them in the column and group footers.

C#

FpSpreadl.Sheets[0] .RowCount=8;
FpSpreadl.Sheets[0].ColumnCount = 15;
this.FpSpreadl.ActiveSheetView.GroupBarVisible = true;
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this.FpSpreadl.ActiveSheetView.AllowGroup = true;
this.FpSpreadl.ActiveSheetView.GroupFooterVisible = true;
this.FpSpreadl.ActiveSheetView.ColumnFooter.Visible = true;
this.FpSpreadl.ActiveSheetView.ColumnFooter.RowCount = 2;
this.FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.Border.BorderStyle =
BorderStyle.Double;
this.FpSpreadl.ActiveSheetView.ColumnFooter.Columns[12].HorizontalAlign =
HorizontalAlign.Left;
this.FpSpreadl.ActiveSheetView.ColumnFooter.Cells[0, 12].RowSpan = 2;
//Value

for (int r = 0; r < this.FpSpreadl.ActiveSheetView.RowCount; r++)

{

for (int j 0; j < this.FpSpreadl.ActiveSheetView.ColumnCount; J++) {
FpSpreadl.ActiveSheetView.DataModel.SetValue(r, j, J + r *
FpSpreadl.ActiveSheetView.ColumnCount) ;

}

}

int 1 = 0;

this.FpSpreadl.ActiveSheetView.Columns|[i].AggregationType =
FarPoint.Web.Spread.Model.AggregationType.Sum;
this.FpSpreadl.ActiveSheetView.ColumnFooter.Cells [0, i].Value "Sum";
this.FpSpreadl.ActiveSheetView.ColumnFooter.Cells[1l, i].Value = "Sum:[{0}]";
//Use the Grouped event to set style information

protected void FpSpreadl Grouped(object sender, EventArgs e)

{

FarPoint.Web.Spread.Model.GroupFooter gf =

default (FarPoint.Web.Spread.Model.GroupFooter) ;
FarPoint.Web.Spread.GroupInfo gi = default (FarPoint.Web.Spread.GroupInfo);
gf = ((FarPoint.Web.Spread.Model.GroupDataModel

) FpSpreadl .ActiveSheetView.DataModel) .GetGroupFooter (2) ;

gi = FpSpreadl.ActiveSheetView.GetGroupFooterInfo (gf);

gi.Font.Name = "Verdana";

gi.Font.Size = 8;

gl.ForeColor = System.Drawing.Color.Red;

}

VB

FpSpreadl.Sheets (0) .RowCount = 8
FpSpreadl.Sheets (0) .ColumnCount = 15

FpSpreadl .ActiveSheetView.GroupBarVisible = True
FpSpreadl.ActiveSheetView.AllowGroup = True

FpSpreadl .ActiveSheetView.GroupFooterVisible = True
FpSpreadl .ActiveSheetView.ColumnFooter.Visible = True
FpSpreadl.ActiveSheetView.ColumnFooter.RowCount = 2
FpSpreadl.ActiveSheetView.ColumnFooter.DefaultStyle.Border.BorderStyle =
BorderStyle.Double

'Value

Dim r As Integer

Dim j As Integer

For r = 0 To FpSpreadl.Sheets (0).RowCount

For j = 0 To FpSpreadl.Sheets (0).ColumnCount
FpSpreadl.ActiveSheetView.DataModel.SetValue(r, j, J + r *
FpSpreadl.ActiveSheetView.ColumnCount)

Next j

Next r

Dim i As Integer
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i=0

FpSpreadl.ActiveSheetView.Columns (0) .AggregationType =
FarPoint.Web.Spread.Model.AggregationType.Sum
FpSpreadl.ActiveSheetView.ColumnFooter.Cells (0, i) .Value = "Sum"
FpSpreadl .ActiveSheetView.ColumnFooter.Cells (1, i) .Value = "Sum:[{O0}]"
'Use the Grouped event to set style information

Protected Sub FpSpreadl Grouped(ByVal sender As Object, ByVal e As System.EventArgs)
Handles FpSpreadl.Grouped

Dim gf As FarPoint.Web.Spread.Model.GroupFooter

Dim gi As FarPoint.Web.Spread.GroupInfo

gf = CType (FpSpreadl.ActiveSheetView.DataModel,
FarPoint.Web.Spread.Model.GroupDataModel) .GetGroupFooter (2)

gi = FpSpreadl.ActiveSheetView.GetGroupFooterInfo (gf)

gi.Font.Name = "Verdana"

gi.Font.Size = 8

gi.ForeColor = System.Drawing.Color.Red

End Sub

Using the Spread Designer

Select the sheet tab for the sheet for which you want to display the column footer.

Select the Settings menu.

Select the Header Editor icon in the Other Settings section (Group Footer Editor icon for group footers).
Select Column Footer in the Selected Header drop-down box.

Set the various formatting properties in the property grid.

Set the Visible property for the column or group footer under Sheet Settings, Headers, and the Column or
Group Footer tab.

7. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

AN e N

Creating a Skin for Sheets

You can quickly customize the appearance of a sheet by applying a "skin" to it. Some built-in (default) skins are provided
with Spread to create common formats. You can create your own custom skin and save it to use again or share it, similar
to a template. A skin, whether built-in or custom, can be applied to any number of sheets in a Spread component. Just as
a style can be applied to cells, so a skin can be applied to an entire sheet. Because a skin can be saved to a file, you can
use it across projects and share it with other developers.

A skin includes the following appearance settings:

e cell colors
e header colors
¢ headers displayed or not
e header text bold
e row colors
e selection colors
e Spread background color
e grid lines
e cell spacing
You can save several appearance properties of a sheet as a custom skin, which can be used in other projects or shared

with other developers. Any custom skins that you create can be saved to a file in the Spread Designer using the Sheet
Skin editor.

Use the Custom tab to create your own skin. From here you can create a custom skin by altering the properties in the
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Property window. When you are ready, click Save. The Skin Repository dialog is displayed and you can enter a
name for your skin.

Pre-Defined | Saved | Custom Preview:

H== | A
3= | Z 1

B cell »
CellBadkColor #CCFF99
CellForeCaolor

E Headers
Appearance Three

ColumnHeaderBar FarPoi
DisplayColHeader False

-,

Skin Repository

) Flease enter a name for the skin to be saved as.
DisplayRowHeade True NOTE: The Spread control spedfic information,

HeaderBold False such as borders, etc., will not be saved off
HeaderColors ForeBai

HeaderGrayhreal #7999(
RowHeaderBackg FarPoi:J

SheetCornerBack FarPoi
El Misc W

DisplayColHeaders

Gets or sets whether the column headers
are visible,

Sawve

(0]4 ] [ Cancel ] [ Apply

After you select OK, the file name is displayed in the list of saved custom skins in the Saved tab. You can use the custom
skin again later by selecting the Saved tab and then applying the appropriate custom skin.

For more information on SheetSkin object, refer to SheetSkin ('SheetSkin Class' in the on-line documentation)
in the API reference documentation.

For information on the SheetSkin editor in the Spread Designer, refer to SheetSkin Editor.
For instructions for applying the built-in sheet skins, see Applying a Skin to a Sheet.

For instructions on creating and applying your own cell-level styles, see Creating and Applying a Custom Style for
Cells.

Using Code

Use the SheetSkin ('SheetSkin Class' in the on-line documentation) object constructor, and set its parameters
to specify the settings for the skin.

Example

This example code sets the sheet to use a custom skin.

C#

FarPoint.Web.Spread.SheetSkin myskin = new FarPoint.Web.Spread.SheetSkin ("MySkin",
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Color.BlanchedAlmond, Color.Bisque, Color.Navy, 2, Color.Blue, GridLines.Both,
Color.Beige, Color.BurlyWood, Color.AntiqueWhite, Color.Brown, Color.Bisque,
Color.Bisque, true, true, true, true, false);

myskin.Apply (FpSpreadl.Sheets[0]) ;

VB

Dim myskin As New FarPoint.Web.Spread.SheetSkin ("MySkin", Color.BlanchedAlmond,
Color.Bisque, Color.Navy, 2, Color.Blue, GridLines.Both, Color.Beige, Color.BurlyWood,
Color.AntiqueWhite, Color.Brown, Color.Bisque, Color.Bisque, True, True, True, True,
False)

myskin.Apply (FpSpreadl.Sheets (0))

Using the Spread Designer

Select the Settings menu.

Select the SheetSkin icon.

Select the Custom tab to create a custom skin.

Set the properties.

Click Save and type in a name for the custom skin.
Click OK.

Click Apply and Exit to close the Spread Designer.

N o DR

Applying a Skin to a Sheet

You can quickly customize the appearance of a sheet by applying a "skin" to it. Built-in (default) skins are provided with
Spread to create common formats. You can also create your own custom skin and save it to use again, similar to a
template.

For an overview and illustrations of sheet skins, see Creating a Skin for Sheets.
Using Code

1. If you want to create your own sheet skin, follow the instructions provided in Creating a Skin for Sheets to
create a sheet skin and apply it. To apply a default sheet skin, follow the rest of these directions.

2. Use the GetAt ('GetAt Method' in the on-line documentation) method of the DefaultSkins
('DefaultSkins Class' in the on-line documentation) object to specify the index of the default skin to
return, then the default skin Apply ('Apply Method' in the on-line documentation) method to assign it to
a specific FpSpread component, collection of sheets, or sheet.

Example

This example code sets the first sheet to use the Colorful2 predefined skin.

C#
FarPoint.Web.Spread.DefaultSkins.Colorful2.Apply (FpSpreadl.Sheets[0]);

VB
FarPoint.Web.Spread.DefaultSkins.Colorful2.Apply (FpSpreadl.Sheets (0))

Using the Spread Designer
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Select the Settings menu.

Select the SheetSkin icon.

In the Pre-Defined tab or the Custom tab, choose the skin to use for the sheet.
Click OK.

Click Apply and Exit to close the Spread Designer.

[ e

Customizing the Appearance of Rows and Columns

These tasks relate to setting the appearance of rows or columns in the sheet:

e Customizing the Number of Rows or Columns

¢ Adding a Row or Column

¢ Removing a Row or Column

¢ Showing or Hiding Rows or Columns

¢ Setting the Row Height or Column Width

¢ Setting the Top Row to Display

¢ Creating Alternating Rows

e Creating Row Templates (Multiple-Line Columns)
When you work with rows and columns, you can manipulate the objects using the shortcuts in code (Row ('Row Class'
in the on-line documentation), Rows ("Rows Class' in the on-line documentation), Column ('Column
Class' in the on-line documentation), Columns ('Columns Class' in the on-line documentation),

AlternatingRow ('AlternatingRow Class' in the on-line documentation), etc.) or you can directly manipulate
the model. Most developers who are not changing anything drastically find it easy to manipulate the shortcut objects.

Remember that settings applied to a particular row or column override the settings that are set at the sheet level and
settings applied at a cell level override the row or column settings. Refer to Object Parentage.

For information on headers, refer to Customizing the Appearance of Headers.

For more information, refer to the Row ("Row Class' in the on-line documentation) class or Column ('Column
Class' in the on-line documentation) class.

For more information about the underlying axis model, refer to Understanding the Axis Model.

Customizing the Number of Rows or Columns

When you create a sheet, it is automatically created with three rows and four columns. You can change the number to up
to two billion rows and columns.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Set RowCount and ColumnCount under the Layout section.

. Click OK to close the editor.

g~ WN R

Using a Shortcut
Set the RowCount ('"RowCount Property' in the on-line documentation) or ColumnCount ('ColumnCount

Property' in the on-line documentation) property for the Sheets ('Sheets Property' in the on-line
documentation) shortcut.
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Example

This example code sets the first sheet to have 10 columns and 100 rows.

C#

FpSpreadl.Sheets[0] .RowCount = 100;
FpSpreadl.Sheets[0].ColumnCount = 10;

VB

FpSpreadl.Sheets (0) .RowCount = 100
FpSpreadl.Sheets (0) .ColumnCount = 10

Using Code

201

Set the RowCount ('"RowCount Property' in the on-line documentation) or ColumnCount ('ColumnCount

Property’' in the on-line documentation) property for a SheetView ('SheetView Class' in the on-line

documentation) class.

Example

This example code sets the first sheet to have 100 rows and 10 columns.

C#

FarPoint.Web.Spread.SheetView SheetO;
Sheet0 = FpSpreadl.Sheets[0];
Sheet0.RowCount = 100;
Sheet0.ColumnCount = 10;

VB

Dim Sheet0 As FarPoint.Web.Spread.SheetView
Sheet0 = FpSpreadl.Sheets (0)
Sheet0.RowCount = 100

Sheet0.ColumnCount = 10

Using the Spread Designer

1. Select the Settings menu.

2. At the bottom, select the sheet for which you want to set the number of rows or columns.
3. Select the General icon under the Sheet Settings section and change the RowCount or ColumnCount

setting.
4. Click OK.
5. Click Apply and Exit to close the Spread Designer.

Adding a Row or Column

You can add one or more rows or columns to a sheet, and specify where the row or column is added. You can use the

methods in the SheetView ('SheetView Class' in the on-line documentation) class or the methods in the
DefaultSheetDataModel ('DefaultSheetDataModel Class' in the on-line documentation) class.

For adding an unbound row to a sheet in a component that is bound to a data source, refer to Adding an Unbound

Row.
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Using a Shortcut

1. Use the AddRows ('AddRows Method' in the on-line documentation) method or AddColumns
("AddColumns Method' in the on-line documentation) method for the Sheets ('Sheets Property' in
the on-line documentation) shortcut.

2. Set the row or column parameter to specify the row or column before which to add the rows or columns.
3. Set the count parameter to specify the number of rows or columns to add.

Example

This example code adds two columns before column 6.

C#
FpSpreadl.Sheets[0] .AddColumns (6, 2) ;

VB
FpSpreadl.Sheets (0) .AddColumns (6, 2)

Using Code

1. Use the AddRows ('AddRows Method' in the on-line documentation) method or AddColumns
('AddColumns Method' in the on-line documentation) method for a SheetView ('SheetView Class' in
the on-line documentation) object.

2. Set the row or column parameter to specify the row or column before which to add the rows or columns.
3. Set the count parameter to specify the number of rows or columns to add.

Example

This example code adds two columns before column 6.

C#

FarPoint.Web.Spread.SheetView SheetO;
Sheet0 = FpSpreadl.Sheets[0];
Sheet0.AddColumns (6,2) ;

VB

Dim Sheet0 As FarPoint.Web.Spread.SheetView
Sheet0 = FpSpreadl.Sheets (0)
Sheet0.AddColumns (6, 2)

Using the Spread Designer

. Select the Data menu.

. At the bottom, select the sheet for which you want to add rows or columns.

. Select an existing row or column (the new row or column is inserted before this row or column).
. Click the Insert icon and then select Insert Row or Insert Column.

. Click OK.

. Click Apply and Exit to close the Spread Designer.

Do P W DN R

Removing a Row or Column
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You can remove one or more rows or columns from a sheet and you can allow the end user to remove rows or prohibit
them from removing rows.

If you simply want to hide the row or column from the end user, but not remove it from the sheet, refer to Showing or
Hiding Rows or Columns.

Using a Shortcut

1. Use the RemoveRows ('RemoveRows Method' in the on-line documentation) or RemoveColumns
('RemoveColumns Method' in the on-line documentation) method for the Sheets ('Sheets Property'
in the on-line documentation) shortcut.

2. Set the row or column parameter to specify the first row or column to remove.
3. Set the count parameter to specify the number of rows or columns to remove.

Example

This example code removes two rows.

C#

FpSpreadl.Sheets[0] .RemoveRows (6, 2) ;

VB
FpSpreadl.Sheets (0) .RemoveRows (6, 2)

Using Code

1. Use the RemoveRows ('RemoveRows Method' in the on-line documentation) or RemoveColumns
('RemoveColumns Method' in the on-line documentation) method for a SheetView ('SheetView
Class' in the on-line documentation) object.

2. Set the row or column parameter to specify the first row or column to remove.
3. Set the count parameter to specify the number of rows or columns to remove.

Example

This example code removes two rows.

C#

FarPoint.Web.Spread.SheetView SheetO;
Sheet0 = FpSpreadl.Sheets[0];
Sheet0.RemoveRows (6, 2) ;

VB

Dim SheetO As FarPoint.Web.Spread.SheetView
Sheet0 = FpSpreadl.Sheets (0)
Sheet0.RemoveRows (6, 2)

Using the Spread Designer

1. Select the Data menu.
2. At the bottom, select the sheet for which you want to remove rows or columns.
3. In the Rows or Columns area, select an existing row or column in the list.
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4. Click the Delete icon. Select Delete Row or Delete Column to remove a row or column.
5. Click OK.
6. Click Apply and Exit to close the Spread Designer.

Showing or Hiding Rows or Columns

You can hide a row or column so that it is not visible to the user. You can also hide only the row headers or column
headers; follow the procedures in Showing or Hiding Headers.

When you hide a row or column, the value of the row height or column width is kept by the fpSpread component. If you
display the row or column again, it is displayed at the value it was before it was hidden. The data is still available to other
parts of the sheet; the only change is that the row or column is not displayed.

If you want to remove the row or column, refer to Removing a Row or Column.
Using a Shortcut

Set the Visible ('Visible Property' in the on-line documentation) property for the Row ('"Row Class' in the
on-line documentation) shortcut object or the Visible ('Visible Property' in the on-line documentation)
property for the Column ('Column Class' in the on-line documentation) shortcut object, or use the
SetRowVisible ('SetRowVisible Method' in the on-line documentation) or SetColumnVisible
('SetColumnVisible Method' in the on-line documentation) method in the SheetView ('SheetView Class' in
the on-line documentation) object.

Example

This example code hides the second row and hides the third column.

C#

FpSpreadl.Sheets[0].SetRowVisible (1, false);
FpSpreadl.Sheets[0].SetColumnVisible (2, false);

VB

FpSpreadl.Sheets[0].SetRowVisible (1, false)
FpSpreadl.Sheets[0].SetColumnVisible (2, false)

Using Code
Set the SetRowVisible ('SetRowVisible Method' in the on-line documentation) or SetColumnVisible

('SetColumnVisible Method' in the on-line documentation) method in the SheetView ('SheetView Class' in
the on-line documentation) object.

Example

This example code sets the first sheet to have 100 rows and 10 columns.

C#

FarPoint.Web.Spread.SheetView sv;
sv = FpSpreadl.ActiveSheetView;
sv.SetRowVisible (1, false);
sv.SetColumnVisible (2, false);

VB
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Dim sv As FarPoint.Web.Spread.SheetView
sv = FpSpreadl.ActiveSheetView
sv.SetRowVisible (1, False)
sv.SetColumnVisible (2, false)

Using the Spread Designer

1. In Spread Designer, select the row or column.
2. In the properties window, set the Visible property to false.
3. Click Apply and Exit to close the Spread Designer.

Setting the Row Height or Column Width

You can set the row height or column width as a specified number of pixels. Each sheet uses and lets you set a default
size, making all rows or columns in the sheet the same size. You can override that setting by setting the value for
individual rows or columns.

You can set the column width with the Width ("Width Property' in the on-line documentation) property of the
FpSpread ('"FpSpread Class' in the on-line documentation) component Columns ('Columns Property' in
the on-line documentation) object. You can set the row height with the Height ('"Height Property' in the on-
line documentation) property of the FpSpread ('FpSpread Class' in the on-line documentation) component
Rows ('Rows Property’' in the on-line documentation) object.

You can also use the DefaultColumnWidth ('DefaultColumnWidth Property' in the on-line documentation)
property for the sheet to set the width for all columns in the sheet; use the SetColumnWidth ('SetColumnWidth
Method' in the on-line documentation) method or use the Column Width ("Width Property' in the on-line
documentation) property to set the width for a specific column. For row heights, set the DefaultRowHeight
('DefaultRowHeight Property' in the on-line documentation) property for the sheet to set the height for all the
rows in the sheet; use the SetRowHeight ('SetRowHeight Method' in the on-line documentation) method or
use the Row Height ("Height Property' in the on-line documentation) property to set the height for a specific
TOW.

Users can change the row height or column width by dragging the header lines between rows or columns.
Using the Properties Window

1. To change the default column width setting or row height, at design time, in the Properties window, select the
Sheets property for the FpSpread component.

2. Click the button to display the SheetView Collection Editor.

In the Members list, select the sheet for which to set the default column width or row height.

4. Select the DefaultColumnWidth property in the property list or the DefaultRowHeight, and specify the

width or height in pixels.

Click OK to close the editor.

6. To change the width or height for a specific column or row, select the Columns or Rows collection after
selecting the sheet. Then select a column or row and set the width or height properties.

7. Click OK to close the editor.

w

@

Using Code

Typically, set the default column width for the sheet and set the width of individual columns on that sheet as needed.
Similarly, set the default row height for the sheet and set the height of individual rows on that sheet as needed.

Example
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This example code changes the default width of all columns for the first sheet to 50 pixels, but makes the width of the
second column 100 pixels.

C#

// Set default width to 50, but second column 100.
FpSpreadl.Sheets[0] .DefaultColumnWidth = 50;
FpSpreadl.Sheets[0].Columns[1l].Width = 100;

VB

' Set default width to 50, but second column 100.
FpSpreadl.Sheets (0) .DefaultColumnWidth = 50
FpSpreadl.Sheets (0) .Columns (1) .Width = 100

Using Code

Set the Width ("Width Property' in the on-line documentation) property for a Column ('Column Class' in
the on-line documentation) object.

Example

This example code sets the width of the second column to 100 pixels.

C#

FarPoint.Web.Spread.Column Coll;
Coll = fpSpreadl.Sheets[0].Columns([1];
Coll.Width = 100;

VB

Dim Coll As FarPoint.Web.Spread.Column
Coll = FpSpreadl.Sheets (0).Columns (1)
Coll.Width = 100

Using the Spread Designer

1. To set the default column width or row height,
a. Select the sheet for which you want to set the default column width or row height.
b. Select DefaultColumnWidth or DefaultRowHeight and set the width or height properties.

c¢. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread
Designer.

2. To set a specific column width or row height,
a. Select the column or row for which you want to change the width or height.
b. In the properties list for that column or row, change the Width property or the Height property.

c. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread
Designer.

Setting the Top Row to Display

You can set the display of a sheet to display a particular row as the top row with the SheetView.TopRow ('TopRow
Property’' in the on-line documentation) property. Rows above that top row are not rendered in the client. Use the
ScrollTo (on-line documentation) method to move the specified cell.
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If the AllowPage ('AllowPage Property' in the on-line documentation) property is False, the TopRow property
takes effect. If AllowPage ('AllowPage Property' in the on-line documentation) is True; then TopRow only
takes effect the first time the page is loaded.

Using Code

1. Set the AllowPage ('AllowPage Property' in the on-line documentation) property.
2. Set the TopRow ('TopRow Property' in the on-line documentation) property.

Example

This example code sets the top row.

C#

FpSpreadl.ActiveSheetView.RowCount = 20;
FpSpreadl.ActiveSheetView.ColumnCount = 7;
FpSpreadl.ActiveSheetView.AllowPage = false;
FpSpreadl.ActiveSheetView.TopRow = 4;
FpSpreadl.ActiveSheetView.IgnoreHiddenRowsWhenPaging = false;
VB

FpSpreadl.ActiveSheetView.AllowPage = False
FpSpreadl.ActiveSheetView.ColumnCount = 7

FpSpreadl .ActiveSheetView.RowCount = 20

FpSpreadl .ActiveSheetView.IgnoreHiddenRowsWhenPaging = False
FpSpreadl.ActiveSheetView.TopRow = 4

Creating Alternating Rows

You might want to set up your sheet so that alternating rows have different appearance. For example, in a ledger,
alternating rows often have a green background. In Spread, you can set up multiple alternating row appearances, which
are applied in sequence, starting with the first row. The following image displays alternating row colors:

A B C D

2

3

Set up the alternating rows using an index into the alternating row appearances. It might help to think of the default row
appearance as the first alternating row style (or style zero, because the index is zero-based). Set the other alternating row
appearances to subsequent indexes. Refer to the AlternatingRow ('AlternatingRow Class' in the on-line
documentation) class.

Using a Shortcut

1. Set the Count ('Count Property' in the on-line documentation) property for the AlternatingRows
(‘AlternatingRows Class' in the on-line documentation) shortcut object.

2. Set the various appearance and other properties of the AlternatingRows ('AlternatingRows Class' in the
on-line documentation) shortcut object, such as the BackColor ('BackColor Property' in the on-line
documentation) and ForeColor ('ForeColor Property' in the on-line documentation) properties.

3. Create additional alternating row appearances by setting properties for additional AlternatingRows
('AlternatingRows Class' in the on-line documentation) shortcut objects, increasing the index for each
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appearance you create.

Example

208

This example code creates a sheet that has three different appearance settings for rows. The first row uses the default
appearance. The second row has a light blue background with dark blue text, and the third row has an orange
background with dark red text. This pattern repeats for all subsequent rows.

C#

FpSpreadl
FpSpreadl
FpSpreadl

FpSpreadl.
.Sheets

FpSpreadl

VB

FpSpreadl. (0)
.Sheets (0)
.Sheets (0)
(0)
(0)

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

.Sheets[0]
.Sheets[0]
.Sheets[0]
[0]
[0]

Sheets

Sheets

.Sheets
.Sheets

1]

— — — —

17.
27.
27.

Using the Spread Designer

.AlternatingRows.Count = 3;
.AlternatingRows
.AlternatingRows
.AlternatingRows
.AlternatingRows

.BackColor =

ForeColor
BackColor

ForeColor =

.AlternatingRows.Count = 3
.AlternatingRows (1) .
.AlternatingRows (1) .
.AlternatingRows (2) .
.AlternatingRows (2) .

BackColor =

ForeColor
BackColor

ForeColor =

Color.
Color.

Color

Color.
Color.
Color.
Color.

LightBlue;
DarkBlue;

.Orange;
Color.

DarkRed;

LightBlue
DarkBlue
Orange
DarkRed

1. From the Settings menu, select the AlternatingRow editor icon located under the Other Settings section.

N

AltRow section.

N OGP W

. In the AlternatingRow editor, add the number of alternating row objects you want to provide, using the

. Select the alternating row object for which you want to set properties from the list of row objects.
. Set the properties for the alternating row object in the list of properties.

. Repeat steps 3 and 4 for each alternating row object you want to customize.

. Click OK to close the editor.
. Click Apply and Exit to close the Spread Designer.

Creating Row Templates (Multiple-Line Columns)

You can create row templates, also called aggregation subtotals or multiple-line columns. You can display multiple lines
within a column, such as to display address information together in one column that involves multiple fields of

information.
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In this figure, the ID and name information appear staggered in a single column and the street address and city

information appear in the same column.

The parts of the API that are involved with this feature include:

D Title Country HireData
Address :
Photo Region Phone
Marme - -
BirthData City PostalCod Extens
Far[int ] 1 Spread Web Team |32 Elm Street |USA 1/9/2002
1 p‘l.‘n'ﬂ: Forms | Harold Albright M ::EQQ::EE}}]_:EE
Burlington 21005 383
S“m‘im ] 2 Spread Web Team |15 Main Street USA 22/3/2007 A
2 p'l.‘l'rh Forms | John Simon [ A (029)8833198¢
Princeton 11054 284
FarFgint ] 3 Spread Web Team 4 Maple Lane  Canada o/4/2007
12 p‘l.‘l'i*h Forms |Julia Fende BC (029)8833198¢
Vancouver 354 343 383
Farfigint ] 4 | Spread Web Team 101 Southport USA 22/3/2007
4 p-"n'i*h Forms | John L. Hancoc MC (029)8833108¢
f/23/1985 Maorrisville 27360 384
qh:ﬁ*int 5 Spread Web Team 40 Purpura Mexico 28/3/2007 al
NTEA =
Vo M B M S

SheetView.LayoutMode ('LayoutMode Property' in the on-line documentation) property
SheetView.WorksheetTemplate ("WorksheetTemplate Property’' in the on-line documentation)
Worksheet. RowTemplate ('RowTemplate Property' in the on-line documentation) property
LayoutTemplate ('LayoutTemplate Class' in the on-line documentation) class

LayoutCell ('LayoutCell Class' in the on-line documentation) class

LayoutCells ('LayoutCells Class' in the on-line documentation) class

LayoutColumn ('LayoutColumn Class' in the on-line documentation) class

LayoutColumns ('LayoutColumns Class' in the on-line documentation) class

LayoutRow ('LayoutRow Class' in the on-line documentation) class

LayoutRows ('LayoutRows Class' in the on-line documentation) class

SheetView.LayoutModeType ('SheetView.LayoutModeType Enumeration' in the on-line
documentation) enumeration

The worksheet template contains a column header template and a row template. Layout information such as cell spans,
column count, and row count is stored in the worksheet template.

This feature has the following effects on other features:

The row count of the column header and the column count of the row header are limited.

This does not support changing the row height by the drag and drop operation, but it does support changing
the column width by the drag and drop operation.

The frozen columns feature is not supported, but the frozen rows feature is supported.The selection operation
only supports the single selection policy of a sheet (SheetView object).

The Axis model of Spread is limited: you cannot set row height or column width for the viewport, the row
header, or the column header.

The Span model of Spread is limited: you cannot set spans in the viewport, row header, column header, or
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column footer. You can get similar effects by spanning cells in the row template.
e This does not support the operation of moving a column by dragging and dropping.
e Automatic merging is no longer supported.

The following code example creates this image.

Region Date
ProductID —
Description
21 China 2010/11 ~
1 Computer  Using newest display adapter
36 Vietnam 2010/6/1
2 Notebook  Dell v
12 il | Tt
2 <
v 36 Em Iy =
Using Code

1. Set the LayoutMode ('LayoutMode Property' in the on-line documentation) property for the sheet.

2. Set the template to the WorksheetTemplate ("WorksheetTemplate Property' in the on-line
documentation) property for the sheet.

Set the ColumnCount ('ColumnCount Property' in the on-line documentation) property for the
template.

Set the row count for the column header template and the row template.

Set the cell spans for the column header and row templates.

Create data for the cells.

Use the DataIndex ('Datalndex Property' in the on-line documentation) property to put data in the cell.

w

N oo b

Example

This example assigns a layout mode for the column headers.

C#

protected void Page Load(object sender, System.EventArgs e)

{

if (this.IsPostBack) return;

FpSpreadl.ActiveSheetView.LayoutMode =
FarPoint.Web.Spread.SheetView.LayoutModeType.RowTemplateLayoutMode;
FarPoint.Web.Spread.WorksheetTemplate templatel =
FpSpreadl.Sheets[0] .WorksheetTemplate;

templatel.ColumnCount = 3;
templatel.ColumnHeaderTemplate.RowCount = 2;
templatel.RowTemplate.RowCount = 2;
templatel.LayoutColumns[1].Width = 250;

//Set row template's layout
templatel.RowTemplate.LayoutCells[1l, 1].ColumnSpan = 2;

//set column header template's layout
templatel.ColumnHeaderTemplate.LayoutCells [0, 0].RowSpan = 2;
templatel.ColumnHeaderTemplate.LayoutCells[1l, 1].ColumnSpan =
DataTable dt = new DataTable();

dt.Columns.Add ("ProductID") ;

dt.Columns.Add ("ProductName") ;

2;
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dt.Columns.Add ("Region") ;

dt.Columns.Add ("Date") ;

dt.Columns.Add ("Description");

dt.Rows.Add (new object[] { 21, "Computer", "China", "2010/1/1", "Using newest display
adapter" 1});

dt.Rows.Add (new object[] { 36, "Notebook", "Vietnam", "2010/6/1", "Dell" });
dt.Rows.Add (new object[] { 13, "Hard disk", "Taiwan", "2011/1/1", "Speed is 7200™ });
FpSpreadl.Sheets[0] .DataSource = dt;

templatel.LayoutCells [0, 0] .DatalIndex = 0;

templatel.LayoutCells[1l, 0O].DataIndex = 1;

templatel.LayoutCells[0, 1].DatalIndex = 2;

templatel.LayoutCells [0, 2].Datalndex = 3;

templatel.LayoutCells[1l, 1].DatalIndex = 4;

}

VB

Private Sub Page Load(ByVal
Handles MyBase.Load

sender As System.Object, ByVal e As System.EventArgs)

If (IsPostBack) Then
Return
End If

FpSpreadl.ActiveSheetView.LayoutMode
FarPoint.Web.Spread.SheetView.LayoutModeType.RowTemplateLayoutMode

Dim templatel As FarPoint.Web.Spread.WorksheetTemplate
.Sheet (0) .WorksheetTemplate

.ColumnCount
.ColumnHeaderTemplate.RowCount
.RowTemplate.RowCount
.LayoutColumns (1) .Width

FpSpreadl
templatel
templatel
templatel
templatel
'Set row t
templatel.

3

2

2

250

emplate's layout
RowTemplate.LayoutCells (1,

2

1) .ColumnSpan

'set column header template's layout

templatel.
templatel.
Dim dt As
dt.Columns
dt.Columns
dt.Columns
dt.Columns
dt.Columns
dt.
adapter"})

dt.Rows.Add (New Object ()
dt .Rows.Add (New Object ()
.Sheets (0) .DataSource
.LayoutCells (0,
.LayoutCells
.LayoutCells
.LayoutCells
.LayoutCells

FpSpreadl
templatel
templatel
templatel
templatel
templatel
End Sub

Rows .Add (New Object ()

2

ColumnHeaderTemplate.LayoutCells (0,
ColumnHeaderTemplate.LayoutCells (1,
New DataTable ()
.Add ("ProductID")
.Add ("ProductName")
.Add ("Region")

.Add ("Date")

.Add ("Description")
{21,

0) .RowSpan
1) .ColumnSpan

2

"Computer", "China", "2010/1/1", "Using newest display

{36,
{13,

"Notebook",
"Hard disk",
dt

.DataIndex
.DataIndex
.DataIndex
.DataIndex
.DataIndex

"2010/6/1",
"2011/1/1",

"Vietnam",
"Taiwan",

"Dell"})
"Speed is 7200"})

1,

4

DS w N e O

(
(0
(0,
(1

4

Using the Spread Designer

1. Select the Settings menu.
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2. Select the Row Template icon under the Other Settings section.
3. Set the various template properties.

4. Click OK.

5. Click Apply and Exit to close the Spread Designer.

Customizing the Appearance of Headers

You can customize the appearance of header cells. These tasks relate to customizing the appearance of header cells for
rows or columns in the sheet:

¢ Customizing the Style of Header Cells

¢ Showing or Hiding Headers

¢ Customizing the Default Header Labels

e Customizing Header Label Text
e Setting the Size of Header Cells

¢ Customizing the Header Empty Areas

¢ Creating a Header with Multiple Rows or Columns
¢ Creating a Span in a Header

Headers provide labels to identify the columns and rows. They appear at the top (for columns) and to the left (for rows)
of the data cells and are formatted differently to be clearly seen. You may customize the appearance of header cells as
you would any of the cells in the spreadsheet component. When you work with row headers and column headers, you
can manipulate the objects using the short cuts in code (RowHeader ('"RowHeader Class' in the on-line
documentation) and ColumnHeader ('ColumnHeader Class' in the on-line documentation) classes), or you
can directly manipulate the model. Most developers who are not changing anything drastically find it easy to manipulate

the short cut objects.
The figure below shows the parts of the headers and the coordinates of cells in headers that have multiple rows and
columns.
sheet column
corner headers
Ty
(0,0) (0,1} {0,2)
(1,0 {1,1) (1,2) s s @
(2,0] (2,1) (2,2)
A B C
row
headers data
\{U,UJ (1) 1(02) /area
(1,00 (1,1) | 2(1,2)
" s
(2,00 (21} 3(2,2)
L ] L
. .
L ] L ]
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For more information on the Cell and Cells objects, refer to the Assembly Reference (on-line documentation).
For more information on models, refer to Using Sheet Models.

For information on footers, refer to Displaying a Footer for Columns or Groups.

Customizing the Style of Header Cells

You can customize the style of header cells if you want to change the default appearance. Set the default style of the
header cells by setting the DefaultStyle property in the RowHeader ('RowHeader Class' in the on-line
documentation) or ColumnHeader ('ColumnHeader Class' in the on-line documentation) class. For more
information on what can be set, refer to the StyleInfo object and the RowHeader and ColumnHeader objects in the
Assembly Reference (on-line documentation).

You can also change some of the properties of the SheetSkin ('SheetSkin Class' in the on-line documentation)
class that customize the appearance of header cells and apply the skin the sheet. These properties include
FlatRowHeader ('FlatRowHeader Property' in the on-line documentation) and FlatColumnHeader
('FlatColumnHeader Property' in the on-line documentation). For more information creating and applying
skins, refer to Applying a Skin to a Sheet and Creating a Skin for Sheets.

When defining and applying a custom style to header cells, be sure to set the text alignment. The default renderer
(without any style applied) centers the text; if you apply a style, and do not set the alignment, the text is left-aligned not
centered.

You can also set the grid lines around the header cells with the Border ('Border Class' in the on-line
documentation) property.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.

. Select the NamedStyles Collection drop-down button.

. Add a style and set the properties.

. Click OK. Select the cells you want to apply the style to and set the StyleName property.

. Use the SheetView Collection Editor to set the DefaultStyleName for a column header, row header,
column footer, or sheet corner.

6. Click OK to close the editor.

g A WN R

Using a Shortcut

1. To change the style for the column header, define a style and then set the ColumnHeader ('ColumnHeader
Class' in the on-line documentation) DefaultStyle ('DefaultStyle Property' in the on-line
documentation) property.

2. To change the settings for the row header, define a style and then set the RowHeader ('"RowHeader Class' in
the on-line documentation) DefaultStyle ('DefaultStyle Property' in the on-line documentation)
property.

Example

This example code defines a style with new colors and applies it to the column header.

C#

// Define a new style.

FarPoint.Web.Spread.StyleInfo darkstyle = new FarPoint.Web.Spread.StyleInfo();
darkstyle.BackColor = Color.Teal;

darkstyle.ForeColor = Color.Yellow;

darkstyle.Border = new FarPoint.Web.Spread.Border (Color.Crimson) ;
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// RApply the new style.
FpSpreadl.ActiveSheetView.ColumnHeader.DefaultStyle = darkstyle;

VB

' Define a new style.

Dim darkstyle As New FarPoint.Web.Spread.StyleInfo ()
darkstyle.BackColor = Color.Teal

darkstyle.ForeColor Color.Yellow

darkstyle.Border = New FarPoint.Web.Spread.Border (Color.Crimson)
' Apply the new style.
FpSpreadl.ActiveSheetView.ColumnHeader.DefaultStyle = darkstyle

Using the Spread Designer

Select the Settings menu.

Select the Named Style icon under the Appearance Settings section.

Use the new style icon to create a style name. Use the edit style icon to set properties for the style.
Click OK. Close the NamedStyle dialog.

In order to apply the style to a header, select the Header Editor icon under Other Settings. Use the Selected
Header option to specify column header, row header, column footer, or sheet corner.

Set the DefaultStyleName. Click Apply and OK.

For cells, select the Cells, Columns, and Rows Editor.
Select the cells you want to apply the style to.

Set the StyleName.

10. Choose Apply and OK to apply your changes to the component.
11. Click Apply and Exit to close the Spread Designer.

S e

© o3 o

Showing or Hiding Headers

By default, the row headers and column headers are displayed in the component. You can hide the row headers, the
column headers, or both. The following figure shows a sheet that displays only column headers and hides the row
headers.

A B C D

=

=

If the sheet has multiple headers, using the property window instructions to hide the headers, hides all header rows or
header columns or both. If you want to hide specific rows or columns within a header, you must specify the row or
column. For more details on hiding specific rows or columns, refer to Showing or Hiding Rows or Columns.

The display of headers is done by simply setting the row header Visible ('Visible Property' in the on-line
documentation) property or column header Visible ('Visible Property' in the on-line documentation)
property.
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Alternatively, if you prefer you can customize the headers by providing custom text or headers with multiple columns or
rows, as explained in Customizing Header Label Text and Creating a Header with Multiple Rows or
Columns.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Click the sheet for which you want to change the header display.

. Set the Visible property for the ColumnHeader object or the Visible property for the RowHeader object to false
to turn off the display of the header.

. Click OK to close the editor.

g A WN R
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Using a Shortcut

Set the ColumnHeader ('ColumnHeader Class' in the on-line documentation) Visible ('Visible Property'
in the on-line documentation) (or SheetView ('SheetView Class' in the on-line documentation)
ColumnHeaderVisible ('ColumnHeaderVisible Property' in the on-line documentation)) property or
RowHeader ('RowHeader Class' in the on-line documentation) Visible ('Visible Property' in the on-line
documentation) (or SheetView ('SheetView Class' in the on-line documentation) RowHeaderVisible
('RowHeaderVisible Property' in the on-line documentation)) property for a sheet.

Example

This example turns off the display of the row header.
C#

// Turn off the display of row headers.
FpSpreadl.Sheets[0] .RowHeader.Visible = false;
FpSpreadl.Sheets[0] .ColumnCount = 4;

VB

' Turn off the display of row headers.
FpSpreadl.Sheets (0) .RowHeader.Visible = False
FpSpreadl.Sheets[0] .ColumnCount = 4

Using Code

1. Create a new SheetView object.

2. Set the SheetView object ColumnHeaderVisible ('ColumnHeaderVisible Property' in the on-line
documentation) or RowHeaderVisible ('RowHeaderVisible Property' in the on-line
documentation) property to false.

3. Set an FpSpread component’s sheet equal to the SheetView object you just created.
Example

This example code sets the first sheet to not display column headers.

C#

// Create a new sheet.
FarPoint.Web.Spread.SheetView newsheet = new FarPoint.Web.Spread.SheetView()

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 216

newsheet.ColumnHeaderVisible = false;
// Set first sheet equal to SheetView object.
FpSpreadl.Sheets[0] = newsheet;

VB

' Create a new sheet.

Dim newsheet As New FarPoint.Web.Spread.SheetView()
newsheet.ColumnHeaderVisible = False

' Set first sheet equal to SheetView object.
FpSpreadl.Sheets (0) = newsheet

Using the Spread Designer

1. Select the sheet tab for the sheet for which you want to turn off header display.
2. In the View menu select or deselect the Row Header or Column Header check box.
3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Customizing the Default Header Labels

By default the component displays sequential letters in the bottom row of the column header and sequentially increasing
numbers in the right-most column of the row header. If your sheet displays multiple column header rows or row header
columns, you can specify which column or row displays these default labels. In the following figure, the column headers
show numbers instead of letters and the labels are shown in the second row instead of the bottom row. You can also
display no default labels.

1 2 3 4
A
B
C
=

You can also set the number (or letter) at which to start the sequential numbering (or lettering) of the labels using a
property of the sheet. Use the StartingColumnNumber ('StartingColumnNumber Property’' in the on-line
documentation) property or StartingRowNumber ('StartingRowNumber Property' in the on-line
documentation) property of the SheetView ('SheetView Class' in the on-line documentation) object to set
the number or letter displayed in the first column header or first row header respectively on the sheet. The starting
number or letter is used only for display purposes and has no effect on the actual row and column coordinates.

] Note: The value of a starting number or letter is an integer, so if the header displays letters and set the starting
letter to 10, the first header cell contains the letter J.

You can also choose to display custom text in the headers instead of or in addition to the automatic label text. For
instructions, see Customizing Header Label Text.

Using the Properties Window
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. At design time, in the Properties window, select the FpSpread component.

. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Click the sheet for which you want to change the header labels.

. To change the header labels displayed, change the setting of the ColumnHeader AutoText or RowHeader
AutoText property.

. To change the row or column in the header in which the label is displayed, change the setting of the
ColumnHeader AutoTextIndex or RowHeader AutoTextIndex property (the index is zero-based).

7. Click OK to close the editor.

g A WN R
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Using a Shortcut

1. To change the settings for the column header, set the ColumnHeaderAutoText ('ColumnHeaderAutoText
Property' in the on-line documentation) property for the sheet (or the AutoText ('AutoText Property'
in the on-line documentation) property of the ColumnHeader ('ColumnHeader Class' in the on-line
documentation) object) and the ColumnHeaderAutoTextIndex ('ColumnHeaderAutoTextIndex
Property' in the on-line documentation) property of the sheet (or the AutoTextIndex ('AutoTextIndex
Property' in the on-line documentation) property of the ColumnHeader ('ColumnHeader Class' in
the on-line documentation) object). Use the HeaderAutoText ("HeaderAutoText Enumeration' in
the on-line documentation) enumeration with the auto text properties.

2. To change the settings for the row header, set the RowHeaderAutoText ('RowHeaderAutoText Property’
in the on-line documentation) property for the sheet (or the AutoText ('AutoText Property' in the on-
line documentation) property of the RowHeader ('RowHeader Class' in the on-line documentation)
object) and the RowHeaderAutoTextIndex ('"RowHeaderAutoTextIndex Property' in the on-line
documentation) property for the sheet (or the AutoTextIndex ('AutoTextIndex Property' in the on-line
documentation) property of the RowHeader ('"RowHeader Class' in the on-line documentation)
object).

Example

This example code sets the column header to display numbers instead of letters and changes the row header to letters.

C#

// Set the column header to display numbers instead of letters.

FpSpreadl.Sheets[0] .ColumnHeaderAutoTextIndex = 1;

FpSpreadl.Sheets[0] .ColumnHeaderAutoText = FarPoint.Web.Spread.HeaderAutoText.Numbers;
// Change row headers to letters

FpSpreadl.Sheets[0] .RowHeaderAutoText = FarPoint.Web.Spread.HeaderAutoText.Letters;

VB

' Set the column header to display numbers instead of letters.
FpSpreadl.Sheets (0) .ColumnHeaderAutoTextIndex = 1
FpSpreadl.Sheets (0) .ColumnHeaderAutoText = FarPoint.Web.Spread.HeaderAutoText.Numbers
' Change row headers to letters

FpSpreadl.Sheets (0) .RowHeaderAutoText = FarPoint.Web.Spread.HeaderAutoText.Letters

Using the Spread Designer

1. Select the sheet for which you want to modify the header label (automatic text) settings.

2. Select the Settings menu. Select the Headers icon in the Sheet Settings section. Select the Column or Row
Header tab.

3. Change the settings of the AutoText and AutoTextIndex properties to specify the header label to display and
which column or row in the header should display the automatic text. You can also specify other header
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properties such as the starting column or row number.
4. Click OK to close the dialog.
5. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Customizing Header Label Text

By default the component displays letters in the column headers and numbers in the row headers. Besides this
automatic text, you can add labels to any or all of the header cells. You can customize the header label text, as shown in
the following figure where the first four columns have custom labels.

North South East West
2
3
5

To specify the custom text for a header label, you can use the Column ('Column Class' in the on-line
documentation) Label ('Label Property' in the on-line documentation) property or the Row ('"Row Class'
in the on-line documentation) Label ('Label Property' in the on-line documentation) property or you can
use the Cell ('Cell Class' in the on-line documentation) Text ('Text Property' in the on-line
documentation) property. For headers with multiple columns and multiple rows, you use the Text ("Text Property’
in the on-line documentation) property of the Cells shortcut objects. Refer to the example in Creating a Header
with Multiple Rows or Columns.

To customize the sequential letters in column headers and sequential numbers in row headers that are displayed by
default, refer to Customizing the Default Header Labels.

Cells in the headers are separate from the cells in the data area, so the coordinates for cells in the headers start at 0,0
and count up from upper left to lower right within the header. The sheet corner cell is separate and is not counted when
figuring header cell coordinates.

Using the Properties Window

At design time, in the Properties window, select the FpSpread component.
Select the Sheets property.
Click the button to display the SheetView Collection Editor.

Click the sheet for which you want to change the header labels.
You cannot add or change custom text in cells other than the labels displayed when using the Properties
window.

Sl

In the property list, select the Cells property and click the button to display the Cell, Column, and Row
Editor.

Select the column for which you want to change the labels displayed to custom text.
Set the Label property to set the custom text.

Click OK to close the Cell, Column, and Row Editor.

Click OK to close the SheetView Collection Editor.

@

© o3 o

Using a Shortcut
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e If you want to change the text in a header cell or display text in a cell, set the Text property for the Cells
('Cells Class' in the on-line documentation) object of the ColumnHeader ('ColumnHeader Class'
in the on-line documentation) to the custom text you want to display. If you want to set the text for
multiple header cells, call the SetClip ('SetClip Method' in the on-line documentation) or
SetClipValue ('SetClipValue Method' in the on-line documentation) methods for the
ColumnHeader ('ColumnHeader Class' in the on-line documentation). The same applies to a
RowHeader ('RowHeader Class' in the on-line documentation) object.

¢ If you want to change the labels displayed, set the Label ('Label Property' in the on-line
documentation) property for the Columns ('Columns Class' in the on-line documentation) object
to the custom text you want to display.

Example

This example code sets custom text for the labels in the first four column headers.

C#

// Set custom text for columns A through D.
FpSpreadl.Sheets[0] .ColumnCount = 4;

1.
FpSpreadl.Sheets[0] .ColumnHeader.Columns[0] .Label = "North";
FpSpreadl.Sheets[0] .ColumnHeader.Columns[1l] .Label = "South";
FpSpreadl.Sheets[0] .ColumnHeader.Columns[2] .Label = "East";
FpSpreadl.Sheets[0].ColumnHeader.Columns[3].Label = "West";
VB
' Set custom text for columns A through D.
FpSpreadl.Sheets (0) .ColumnCount = 4
FpSpreadl.Sheets (0) .ColumnHeader.Columns (0) .Label = "North"
FpSpreadl.Sheets (0) .ColumnHeader.Columns (1) .Label = "South"
FpSpreadl.Sheets (0) .ColumnHeader.Colunns (2) .Label = "East"
FpSpreadl.Sheets (0) .ColumnHeader.Columns (3) .Label = "West"

Using the Spread Designer

Select the sheet at the bottom of the designer.

Select the Settings menu.

Select the Header editor in the Other Settings section.

Select the header you wish to edit.

Set the Label property in the property grid.

Choose Apply and OK to apply your changes to the component.
Click Apply and Exit to close the Spread Designer.

N oG h @R

Setting the Size of Header Cells

You can customize the appearance of header cells by changing the row height or column width, or both, for any of the
rows or columns of headers. You can change the size by setting properties in the RowHeader ('RowHeader Class' in
the on-line documentation) class for the row header or the ColumnHeader ('ColumnHeader Class' in the on-
line documentation) class for the column header or both, or use the respective SheetView ('SheetView Class' in
the on-line documentation) class properties. Use these properties:

e ColumnHeader.Height ("Height Property' in the on-line documentation)
e RowHeader.Width ("Width Property' in the on-line documentation)
e SheetView.ColumnHeaderHeight ('ColumnHeaderHeight Property' in the on-line
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documentation)
e SheetView.RowHeaderWidth ('RowHeaderWidth Property' in the on-line documentation)

You can also use the Spread Designer to set the width and height of header cells.

For information on setting the size of cells in the data area, refer to Setting the Row Height or Column Width.
Using Code

Set the height or width for the headers.

Example

This example code sets the height and width of the headers.
C#

// Set the height and width for the headers.
FpSpreadl.Sheets[0].ColumnHeader.Height = 60;
FpSpreadl.Sheets[0] .RowHeader.Width = 60;

VB

' Set the height and width for the headers.
FpSpreadl.Sheets (0) .ColumnHeader.Height = 60
FpSpreadl.Sheets (0) .RowHeader.Width = 60

Using the Spread Designer

Select the Settings menu.

Select the Header Editor icon in the Other Settings section.
Select the header you wish to edit.

Set the height or width properties.

Choose Apply and OK to apply your changes to the component.
Click Apply and Exit to close the Spread Designer.

g h @R

Customizing the Header Empty Areas

By default the component displays a color in the empty areas not filled in with column or row headers. These are the
header empty areas as illustrated in the figure.

A B C D

H‘*« Header empty areas

L1

=

To customize the color of the header empty area, you can use the SheetView ('SheetView Class' in the on-line
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documentation) HeaderGrayAreaColor ('HeaderGrayAreaColor Property' in the on-line
documentation) property. You can add images to the empty area with the
HeaderGrayAreaBackgroundImageUrl ("HeaderGrayAreaBackgroundImageUrl Property' in the on-line
documentation) property.

Using the Properties Window

. At design time, in the Properties window, select the Sheets property for the FpSpread component.
. Click the button to display the SheetView Collection Editor.
. In the Members list, select the sheet for which you want to set the color of the header empty area.

. Select the HeaderGrayAreaColor property (or HeaderGrayAreaBackgroundImageUrl and select an
image) in the property list, and then click the drop-down button to display the color picker.

5. Select a color in the color picker.
6. Click OK to close the editor.

AW N R

Using Code

Set the HeaderGrayAreaBackgroundImageUrl ('"HeaderGrayAreaBackgroundImageUrl Property' in the
on-line documentation) property.

Example

This example code sets the color or image properties for the gray area.

C#
// Set a color or an image for the gray area.
FpSpreadl.Sheets[0] .HeaderGrayAreaBackgroundImageUrl = "happy.bmp";

//FpSpreadl.Sheets[0] .HeaderGrayAreaColor = Color.BurlyWood;

VB
' Set a color or an image for the gray area.
FpSpreadl.Sheets (0) .HeaderGrayAreaBackgroundImageUrl = "happy.bmp

'FpSpreadl.Sheets (0) .HeaderGrayAreaColor = Color.BurlyWood

Creating a Header with Multiple Rows or Columns

You can provide multiple rows in the column header and multiple columns in the row header. As shown in the following
figure, the headers may have different numbers of columns and rows.
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Fiscal Year 2005
15t Quarter 2nd Quarter 3rd Quarter 4th Quarter
East West East West East West East West

1

2

3
Branc] 4
# 3
6

7

8

The rows or columns in the header can also contain spans, for example, if you want to have a header cell that explains
two header cells beneath it (or subheaders). For instructions for creating a span in a header, see Creating a Span in a
Header.

You can customize the labels in these headers. For instructions for customizing the labels, see Customizing Header
Label Text.

Using the Properties Window

. At design time, in the Properties window, select the FpSpread component.
. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Click the sheet for which you want to change the header display.

. Set the ColumnHeader RowCount property to the number or rows you want in the column header or the
RowHeader ColumnCount property to the number of columns you want in the row header.

6. Click OK to close the editor.

g WN R

Using a Shortcut

Set the RowCount ('RowCount Property' in the on-line documentation) property for the ColumnHeader
('ColumnHeader Class' in the on-line documentation) object and the ColumnCount ('ColumnCount
Property' in the on-line documentation) property for the RowHeader ('RowHeader Class' in the on-line
documentation) object.

Example

This example code creates a spreadsheet shown in the figure above, with two columns in the row header and three rows
in the column header.

C#

FpSpreadl.Sheets[0] .ColumnCount = 8;
FpSpreadl.Sheets[0] .RowCount = 8;

// Set the number or rows and columns in the headers.
FpSpreadl.Sheets[0].ColumnHeader.RowCount = 3;
FpSpreadl.Sheets[0] .RowHeader.ColumnCount = 2;

// Span the header cells as needed.

FpSpreadl.Sheets[0] .ColumnHeaderSpanModel.Add (0, 0, 1, 8);
FpSpreadl.Sheets[0] .RowHeaderSpanModel .Add (0,0,12,1);

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl.
FpSpreadl

.Sheets[0].ColumnHeaderSpanModel.
.Sheets[0] .ColumnHeaderSpanModel.
.Sheets[0] .ColumnHeaderSpanModel.
Sheets[0] .ColumnHeaderSpanModel.
.Sheets[0] .ColumnHeaderSpanModel.

// Set the labels as needed --
// using the Label property or the cell Text property.

FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.

FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.

VB

FpSpreadl.
FpSpreadl.
! Set the
FpSpreadl.
FpSpreadl.

'Span the
FpSpreadl.
FpSpreadl.

FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
FpSpreadl.
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Add(1, 0, 1, 2);
Add (1, 2, 1, 2);:
Add (1, 4, 1, 2);:
Add (1, 6, 1, 2);:
Add (1, 8, 1, 2);:

~
~

Sheets[0] .ColumnHeader.Cells [0, 0].Text = "Fiscal Year 2005";
Sheets[0] .RowHeader.Cells[0, 0].Text = "Branch #";
Sheets[0] .ColumnHeader.Cells[1l, 0].Text = "lst Quarter";
Sheets[0] .ColumnHeader.Cells[1l, 2].Text = "2nd Quarter";
Sheets[0] .ColumnHeader.Cells[1l, 4].Text = "3rd Quarter";
Sheets[0] .ColumnHeader.Cells[1l, 6].Text = "4th Quarter";
Sheets[0] .ColumnHeader.Cells[2, 0].Text = "East";
Sheets[0] .ColumnHeader.Cells[2, 1].Text = "West";
Sheets[0] .ColumnHeader.Cells[2, 2].Text = "East";
Sheets[0] .ColumnHeader.Cells[2, 3].Text = "West";
Sheets[0] .ColumnHeader.Cells[2, 4].Text = "East";
Sheets[0] .ColumnHeader.Cells[2, 5].Text = "West";
Sheets[0] .ColumnHeader.Cells[2, 6].Text = "East";
Sheets[0] .ColumnHeader.Cells[2, 7].Text = "West";
Sheets (0) .RowCount = 8

Sheets (0) .ColumnCount = 8

number or rows and columns in the headers.

Sheets (0) .ColumnHeader.RowCount = 3

Sheets (0) .RowHeader.ColumnCount = 2

header cells as needed.

Sheets (0) .ColumnHeaderSpanModel .Add (0, 0, 1, 8)

Sheets (0) .RowHeaderSpanModel .Add (0,0,12,1)

Sheets (0) .ColumnHeaderSpanModel .Add (1, 0, 1, 2)

Sheets (0) .ColumnHeaderSpanModel .Add (1, 2, 1, 2)

Sheets (0) .ColumnHeaderSpanModel .Add (1, 4, 1, 2)

Sheets (0) .ColumnHeaderSpanModel.Add (1, 6, 1, 2)

Sheets (0) .ColumnHeaderSpanModel .Add (1, 8, 1, 2)

'Set the labels as needed --
'using the Label property or the cell Text property.

FpSpreadl
FpSpreadl

FpSpreadl
FpSpreadl.
FpSpreadl
FpSpreadl

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl.

.Sheets (0) .ColumnHeader.Cells (0,

.Sheets (0) .RowHeader.Cells (0, 0)
.Sheets (0) .ColumnHeader.Cells (1,
Sheets (0) .ColumnHeader.Cells (1,
.Sheets (0) .ColumnHeader.Cells (1,
.Sheets (0) .ColumnHeader.Cells (1,
.Sheets (0) .ColumnHeader.Cells (2,
.Sheets (0) .ColumnHeader.Cells (2,
.Sheets (0) .ColumnHeader.Cells (2,
.Sheets (0) .ColumnHeader.Cells (2,
Sheets (0) .ColumnHeader.Cells (2
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FpSpreadl.Sheets (0) .ColumnHeader.Cells (2, 5).Text = "West"
FpSpreadl.Sheets (0) .ColumnHeader.Cells (2, 6).Text = "East"
FpSpreadl.Sheets (0) .ColumnHeader.Cells (2, 7).Text = "West"

Using the Spread Designer

Select the sheet tab for the sheet for which you want to display multiple header rows or columns.
Select the Settings menu.

Select the Header Editor icon in the Other Settings section.

Select Column Header or Row Header in the Selected Header drop-down box.

Set the RowCount property to the number or rows you want in the column header or the ColumnCount
property to the number of columns you want in the row header in the property grid.

6. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

LI e

Creating a Span in a Header

You can create cell spans in a header, for example, to make a header for multiple columns of data, as shown in the
following figure.

Fiscal Year 2005
1st Quarter 2nd Quarter 3rd Quarter 4th Quarter
East West East West East West East West

1

2

3
Brancl 4
# 5
6

7

8

For information on creating multiple rows in the column headers or multiple columns in the row headers, refer to
Creating a Header with Multiple Rows or Columns.

You can create cell spans in either the column or row headers or both. For more background about creating cell spans,
refer to Spanning Cells.

You can customize the labels in these headers. For instructions for customizing the labels, see Customizing Header
Label Text.

Using a Shortcut

Define the number of rows in the column header (and columns in the rows header) and then set the header cells to span
using the Add ('Add Method' in the on-line documentation) property in the span model.

Example

This example creates multiple headers and adds cell spans.

C#

// Set the number or rows and columns in the headers.
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FpSpreadl.Sheets[0] .ColumnHeader.RowCount = 3;

FpSpreadl.Sheets[0] .RowHeader.ColumnCount

2;

// Span the header cells as needed.

FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

VB

.Sheets [0
.Sheets|
.Sheets|
.Sheets|
.Sheets|
.Sheets|
.Sheets|

]
0]
0]
0]
0]
0]
0]

.ColumnHeaderSpanModel .Add (0, 0, 1,
.RowHeaderSpanModel .Add (0,0,12,1);
.ColumnHeaderSpanModel.Add (1, O,
.ColumnHeaderSpanModel . Add (
.ColumnHeaderSpanModel . Add (
.ColumnHeaderSpanModel . Add (
.ColumnHeaderSpanModel . Add (

~

4

~

4

4

~

B e
N

@ o N

e
~

4

~

'Set the number or rows and columns in the headers.

FpSpreadl
FpSpreadl
'Span the
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl
FpSpreadl

.Sheets(
.Sheets(
.Sheets (
.Sheets (
.Sheets (
.Sheets (
.Sheets (

.Sheets (0)
.Sheets (0)

.ColumnHeader.RowCount = 3
.RowHeader.ColumnCount = 2

header cells as needed.

0)

0)
0)
0)
0)
0)
0)

.ColumnHeaderSpanModel .Add
.ColumnHeaderSpanModel .Add

.ColumnHeaderSpanModel .Add (0, 0, 1,
.RowHeaderSpanModel .Add (0,0,12,1)
.ColumnHeaderSpanModel.Add (1, O,
.ColumnHeaderSpanModel . Add (
.ColumnHeaderSpanModel . Add (

(

(

~

4

~

4

4

~

B e
N

® oy N

e
~

4

~

Using the Spread Designer

1. Select the Settings menu, and then the Header Editor icon.

2. Select a cell (the cells represent the header cells in this editor). Set the number of columns or rows to span with
the ColumnSpan or RowSpan property.

3. When done, choose Apply and OK to apply your changes.
4. Click Apply and Exit to close the Spread Designer.

Customizing the Appearance of a Cell

You can set the appearance of individual cells in the data area of the spreadsheet. These tasks relate to setting the

appearance of individual cells:

¢ Working with the Active Cell

¢ Customizing the Colors of a Cell

¢ Aligning Cell Contents

¢ Customizing Cell Borders

¢ Customizing the Margins and Spacing of the Cell
¢ Creating and Applying a Custom Style for Cells

e Assigning a Cascading Style Sheet to a Cell

e Creating a Range of Cells

¢ Spanning Cells

¢ Allowing Cells to Merge Automatically
e Using Sparklines

DN NN

DN NN

Ne Ne Ne N

~.

225

When you work with cells, you can manipulate the objects using the short cuts in code (Cell ('Cell Class' in the on-

line documentation) and Cells ('Cells Class' in the on-line documentation) classes) or you can directly
manipulate the model. Most developers who are not changing anything drastically find it easy to manipulate the

shortcut objects.
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2] Note: We use the word "appearance" in the general sense of the look and feel of the cell, not simply the settings in
the Appearance ('Appearance Class' in the on-line documentation) class, which contains only a few
settings and is used for the appearance of several parts of the interface. Most of the appearance settings for a cell
are in the StyleInfo ('StyleInfo Class' in the on-line documentation) class.

Remember that settings applied to a particular cell override the settings that are set at the column or row level. Refer to
Object Parentage.

Other cell-level appearance settings are set by the cell type. For more information on settings related to cell types, refer
to Customizing with Cell Types.

For information on header cells, refer to Customizing the Appearance of Headers.
For tasks that relate to setting the user interaction at the cell level, refer to Customizing Interaction with Cells.

For more information, refer to the Cell ("Cell Class' in the on-line documentation) class.

Working with the Active Cell

The active cell is the cell that currently receives any user interaction. Typically, the active cell appears with some form of
highlighting to distinguish it from the other cells in the data area and to indicate that it is the active cell.

You can change what can be selected by the user. For more information, refer to Specifying What the User Can
Select. You can also customize how the selection appears. For more information, refer to Customizing the
Appearance of Selections.

Customizing the Colors of a Cell

You can set the background and foreground (text) colors for a cell or for a group of cells. The following figure shows the
background and text colors of the data area changed from the default values with light blue text on a dark background.

This text is light blue.
The background is dark cyan.

To change the text and background colors, use the BackColor ('BackColor Property' in the on-line
documentation) and ForeColor ('ForeColor Property' in the on-line documentation) properties of the Cell
('Cell Class' in the on-line documentation) class or the BackColor ('BackColor Property' in the on-line
documentation) and ForeColor ('ForeColor Property' in the on-line documentation) properties of the
StyleInfo ('StyleInfo Class' in the on-line documentation) class and apply the style to the cells. Alternatively,
you can set the CellBackColor ('CellBackColor Property' in the on-line documentation) and CellForeColor
('CellForeColor Property' in the on-line documentation) properties of the SheetSkin ('SheetSkin Class' in
the on-line documentation) class and apply the skin to the sheet. For more information on styles for cells, refer to
Creating and Applying a Custom Style for Cells. For more information on skins to apply to sheets, refer to
Creating a Skin for Sheets and Applying a Skin to a Sheet.

You can also set the color for cells to change when they are selected. You can set the SelectionBackColor
('SelectionBackColor Property' in the on-line documentation) and SelectionForeColor
('SelectionForeColor Property' in the on-line documentation) to change the background color and text color of
selected cells. This is done either to the sheet directly with the SheetView ('SheetView Class' in the on-line
documentation) class or with the skin that is applied to a sheet with the SheetSkin ('SheetSkin Class' in the on-
line documentation) class. For more information refer to Customizing the Appearance of Selections.

For information about cascading style sheets, refer to Assigning a Cascading Style Sheet to a Cell.

Using the Properties Window
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. At design time, in the Properties window, select the FpSpread component.

. Select the Sheets property.

. Click the button to display the SheetView Collection Editor.

. Select the Cells collection and then select BackColor under the Mise. section.

. Click the BackColor drop-down button to display the color picker and choose the color from the available
colors.

. Click OK.
7. Click Apply and OK to apply the changes.

g WN R
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Using a Shortcut

Set the BackColor ('BackColor Property' in the on-line documentation) property or ForeColor ("ForeColor
Property’' in the on-line documentation) property for the FpSpread ('FpSpread Class' in the on-line
documentation) Cells ('Cells Class' in the on-line documentation) object.

Example

This example code sets the background color for cell A1 to Azure, then sets the background color for cells C3 through D4
to Bisque.

C#

FpSpreadl.Sheets[0] .RowCount = 4;

FpSpreadl.Sheets[0] .ColumnCount = 4;

FpSpreadl.Sheets[0] .Cells[0,0] .BackColor = Color.Azure;
FpSpreadl.Sheets[0] .Cells[2,2,3,3].BackColor = Color.Bisque;
VB

FpSpreadl.Sheets (0) .RowCount = 4
FpSpreadl.Sheets (0) .ColumnCount = 4
FpSpreadl.Sheets (0) .Cells (0, 0).BackColor = Color.Azure
FpSpreadl.Sheets (0) .Cells (2, 2, 3, 3).BackColor = Color.Bisque

Using Code

Set the BackColor ('BackColor Property' in the on-line documentation) property or ForeColor ('ForeColor
Property' in the on-line documentation) property for a Cell ('Cell Class' in the on-line documentation)
object.

Example

This example code sets the background color for cell A1 to Azure and the foreground color to Navy, then sets the
background color for cells C3 through D4 to Bisque.

C#

FarPoint.Web.Spread.SheetView count;
count = FpSpreadl.Sheets[0];
count.RowCount = 4;
count.ColumnCount = 4;
FarPoint.Web.Spread.Cell cellAl;
cellAl = FpSpreadl.Cells[0, 0];
cellAl.BackColor = Color.Azure;
cellAl.ForeColor = Color.Navy;
FarPoint.Web.Spread.Cell cellrange;
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cellrange = FpSpreadl.Cells[2,2,3,3];
cellrange.BackColor = Color.Bisque;

VB

Dim count as FarPoint.Web.Spread.SheetView
count = FpSpreadl.Sheets (0)
count.RowCount = 4

count.ColumnCount = 4

Dim cellAl As FarPoint.Web.Spread.Cell
cellAl = FpSpreadl.Cells (0, 0)
cellAl.BackColor = Color.Azure
cellAl.ForeColor = Color.Navy

Dim cellrange As FarPoint.Web.Spread.Cell
cellrange = FpSpreadl.Cells (2, 2, 3, 3)
cellrange.BackColor = Color.Bisque

Using the Spread Designer

1. Select the cells to apply the changes to.

2. Select the Home menu and then select the Fill Color icon under the Font section.
You can also select the Settings menu and then select the Cells, Columns, and Rows icon under the Other
Settings section.

3. Click the BackColor drop-down button to display the color picker and choose the color from the available
colors.

4. Click OK to apply the changes.
5. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Aligning Cell Contents

You can set the horizontal or vertical alignment for the contents of a cell or a group of cells.
A B C D

1 Thisis a test
2 This 15 a test

Using the Properties Window

At design time, in the Properties window, select the FpSpread component.

Select the Sheets property.

Click the button to display the SheetView Collection Editor.

Select the Cells collection and then select HorizontalAlign or VerticalAlign under the Misc. section (select

the cells or cells).

5. You can also select a cell or cells and select HorizontalAlign or VerticalAlign (Selected Item drop-down
option).

6. Click Apply and OK.

S S

Using a Shortcut

Set the HorizontalAlign ('"HorizontalAlign Property' in the on-line documentation) and VerticalAlign
("VerticalAlign Property' in the on-line documentation) properties for the FpSpread ('FpSpread Class' in
the on-line documentation) object’s Cells ('Cells Class' in the on-line documentation) property.
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Example

This example code sets the horizontal alignment of the first cell (A1) to be right-aligned, the vertical alignment of that
cell to be top-aligned, and the horizontal alignment of cells from B2 to C3 to be centered.

C#

FpSpreadl.Sheets[0].Cells[0,0] .HorizontalAlign = HorizontalAlign.Right;
FpSpreadl.Sheets[0].Cells[0,0].VerticalAlign = VerticalAlign.Top;
FpSpreadl.Sheets[0].Cells[1,1,2,2].HorizontalAlign = HorizontalAlign.Center;

VB

FpSpreadl.Sheets (0) .Cells (0,0) .HorizontalAlign = HorizontalAlign.Right
FpSpreadl.Sheets (0) .Cells (0,0) .VerticalAlign = VerticalAlign.Top
FpSpreadl.Sheets (0) .Cells(1,1,2,2) .HorizontalAlign = HorizontalAlign.Center

Using the Spread Designer

Select the Home menu.

Select the cells you wish to change.

Select the appropriate icon in the Alignment section.

Click Apply to apply the changes.

From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

S e A

Customizing Cell Borders

You can customize the appearance of borders of the cell. You can specify whether a cell or range of cells has a border.
Borders can be displayed on the left, right, top, or bottom, or around all four sides of the cell or cell range.

A B C
1
2
3

Cell borders follow the precedence used by the sheet. For more information on precedence, refer to the list in Object
Parentage.

If you import cell border information from an Excel file, the width of the cell border may be changed. If the
EnableClientScript ('"EnableClientScript Property' in the on-line documentation) property of the FpSpread
component is set to True, then BorderCollapse is set to True. This helps the appearance of most borders and grid lines
together. However, if a cell border is set to a size equal to 1, the left and top borders are overwritten by the grid lines due
to the behavior of HTML tables. So the solid, dash, dot, etc. borders are set to a width of 2 so that they are displayed
when loaded into Spread from Excel. The "hair" border is not set to a size of 1.

Set border color, style, and size with strict compliance mode to get the best results.

Borders are different from grid lines in that they create a border around a cell or group of cells rather than
distinguishing rows and columns. For more information about grid lines, which are set for an entire sheet, refer to
Displaying Grid Lines on the Sheet.

For information about cascading style sheets, refer to Assigning a Cascading Style Sheet to a Cell.

Using a Shortcut
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Set the Border ('Border Property' in the on-line documentation) property to the new border that you specify.
Example

This example code creates a bevel border and then sets a cell border to be the bevel border.

C#

// Set cell border to the bevel border.

fpSpreadl.Sheets[0].Cells[2, 2].Border = new

FarPoint.Web.Spread.Border (System.Web.UI.WebControls.BorderStyle. Double,
Color.DarkBlue, 2);

VB

' Set cell border to the bevel border.

FpSpreadl.Sheets (0) .Cells (2, 2).Border = New

FarPoint.Web.Spread.Border (System.Web.UI.WebControls.BorderStyle. Double,
Color.DarkBlue, 2)

Using the Spread Designer

There are several ways to set cell borders in the Spread Designer. The first method is the following:

1. Select the cells to apply the changes to.

2. Select the Home menu and then select the Cell Border icon under the Font section.
3. Select a border type or select more borders to set colors and other border properties.
4. Click OK to apply the changes.

Using the Spread Designer

This is the second method:

1. Select the cells to apply the changes to.

2. Select the Settings menu and then select the Cells, Columns, and Rows icon under the Other Settings
section.

3. Click the Border property in the property grid to set the border options.
4. Click OK to apply the changes.
5. Click Apply and Exit to close the Spread Designer.

Customizing the Margins and Spacing of the Cell

You can customize the margins within a cell and the spacing between cells in a sheet. The cell margin is the distance
between the cell border and the cell contents and is specified for all four sides of a cell (or table cell in the displayed
HTML). The cell spacing is the distance between the cells and is specified for the entire sheet (or table in the displayed
HTML).
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To set the cell margin (or padding) use the Margin ('Margin Property’ in the on-line documentation) property
in the Cell ('Cell Class' in the on-line documentation) (or Column ('Column Class' in the on-line
documentation) or Row ('Row Class' in the on-line documentation)) class, or set the Margin ('Margin
Property' in the on-line documentation) property in the StyleInfo ('StyleInfo Class' in the on-line
documentation) class and apply the style to the cell or cells.

To set the cell spacing for the entire sheet, use the CellSpacing ('CellSpacing Property' in the on-line
documentation) property in the Sheet or set the CellSpacing ('CellSpacing Property' in the on-line
documentation) property in the SheetSkin ('SheetSkin Class' in the on-line documentation) class and apply
the skin to the sheet or sheets.

To set the border, use the Border ('Border Property' in the on-line documentation) property as described in
Customizing Cell Borders.

Using a Shortcut

1. Set the Cell shortcut object Margin ('Margin Property' in the on-line documentation) property to the
new margins.

2. Set the Sheet CellSpacing ('CellSpacing Property’ in the on-line documentation) property to the new
cell spacing value.

Example

This example code creates a cell margin and sets cell spacing for the sheet.

C#

FarPoint.Web.Spread.Cell mycell;

FarPoint.Web.Spread.Inset margin = new FarPoint.Web.Spread.Inset (20, 40, 50, 20);
mycell = FpSpreadl.Cells[0, 0];

mycell.Value = "Margin";

mycell.Locked = true;

mycell .Margin = margin;
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FpSpreadl.ActiveSheetView.Rows[0] .Height = 80;
FpSpreadl.Sheets[0].CellSpacing = 5;

VB

Dim mycell As FarPoint.Web.Spread.Cell

Dim margin As New FarPoint.Web.Spread.Inset (20, 40,
mycell = FpSpreadl.Cells (0, 0)

mycell.Value = "Margin"

mycell.Locked = True

mycell .Margin = margin
FpSpreadl.ActiveSheetView.Rows (0) .Height = 80
FpSpreadl.Sheets (0) .CellSpacing = 5

Using the Spread Designer

1. Select the Settings menu.
2. Select the cells to apply the changes to.
3. Use the following to set the margin:

Select the Cells, Columns, and Rows icon under the Other Settings section.

Click on the Margin property in the property grid to create an inset for the cell in pixel units.

Click OK to apply the changes.

4. To apply the cell spacing, do the following:
Select the Settings menu.

50, 20)

Select the SheetSkin icon in the Appearance Settings section.

Select the custom tab in the SheetSkin editor.
Set CellSpacing in the Misec. section.
Click OK to apply the changes.
5. Click Apply and Exit to close the Spread Designer.

Creating and Applying a Custom Style for Cells

232

You can quickly customize the appearance of a cell or range of cells (or rows or columns) by applying a style, which is a
set of appearance settings defined in a single StyleInfo ('StyleInfo Class' in the on-line documentation) object.
You can create your own style and save it to use again, similar to a template. The style includes appearance settings that

apply to cells, such as background color, text color, font, borders, and cell type. For more information, refer to the
StyleInfo ('StyleInfo Class' in the on-line documentation) object in the Assembly Reference (on-line

documentation).

Z] Note: The word "appearance" is used to refer to the general look and feel of the cell, not the Appearance class,

which is used for the appearance of several parts of the interface.

A cell style includes the following appearance settings:

e text alignment of cell contents

e border colors, border style, border width and which sides have them

e cell colors

o font for text in cell
e margins

o cell type
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You can specify the style for a cell by setting the StyleName ('StyleName Property' in the on-line
documentation) property for the Cell ('Cell Class' in the on-line documentation) object.

A style can be applied to any number of cells. Just as a skin can be applied to a sheet, so a style can be applied to cells.
You typically set the style for the cell by using the StyleName ('StyleName Property' in the on-line
documentation) property to define which StyleInfo ('StyleInfo Class' in the on-line documentation) object is
used by that cell. When you set the style (StyleName ('StyleName Property' in the on-line documentation)),
you set the entire StyleInfo ('StyleInfo Class' in the on-line documentation) object in the style model for each
cell in the range to the one in the NamedStyleCollection with the specified name.

You can also use the ParentStyleName ('ParentStyleName Property' in the on-line documentation) property
to set a style for a range of cells that may individually have different StyleName ('StyleName Property' in the on-
line documentation) values set but which all inherit a common set of appearance settings from a parent style. A cell
inherits all the style information from the parent style (ParentStyleName ('"ParentStyleName Property' in the
on-line documentation)). When you set the parent style, you are setting the Parent property of the StyleInfo object
assigned to each cell in the range. The parent for a named style can also be set by the Parent ("Parent Property' in
the on-line documentation) property of the NamedStyle ('NamedStyle Class' in the on-line
documentation) object. So different cells (cells in different rows or columns) may have different named styles but
have the same parent style. For example, the cells may have different text colors (set in the named style) but inherit the
same background color (set in the parent style). The default parent style is set in the DataAreaDefault
('DataAreaDefault Field' in the on-line documentation) field in the DefaultStyleCollection
('DefaultStyleCollection Class' in the on-line documentation) class. For more information on the order of
inheritance, refer to Object Parentage.

You can also create and apply appearance settings to an entire sheet by using sheet skins. For instructions on creating
sheet skins, see Creating a Skin for Sheets.

Using the Property Window

1. In the Form window, click the FpSpread component for which you want to create the style in the
NamedStyleCollection. For the FpSpread component, in the Appearance category, select the NamedStyles
property.

Click on the button to launch the NamedStyleCollection Editor.

In the NamedStyleCollection Editor, click the Add button.

Set the properties in the Named Style Properties list to create the style you want.

Set the Name property to specify the name for your custom style.

Click OK to close the editor.

Select the cells (or rows or columns) to apply the style to.

In the property window, set the StyleName to the custom named style previously added.

©®N g p WD

Using Code

1. Create the style using the NamedStyle ('NamedStyle Class' in the on-line documentation) object
constructor and set the style properties.

2. Add the styles.

3. Set the StyleName ('StyleName Property' in the on-line documentation) property to assign the style to
the cells.

Example

This example code creates several styles and sets a parent style. This causes the cells to display the same background
color but, different text colors.

C#

\\ Create a style with a blue background color.
FarPoint.Web.Spread.NamedStyle backstyle = new
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FarPoint.Web.Spread.NamedStyle ("BlueBack") ;

backstyle.BackColor = Color.Blue;

\\ Create a style with an orange text color and assign it a parent style.
FarPoint.Web.Spread.NamedStyle textlstyle = new
FarPoint.Web.Spread.NamedStyle ("OrangeText", "BlueBack");
textlstyle.ForeColor = Color.Orange;

\\ Create a style with a yellow text color and assign it a parent style.
FarPoint.Web.Spread.NamedStyle text2style = new
FarPoint.Web.Spread.NamedStyle ("YellowText", "BlueBack");
text2style.ForeColor = Color.Yellow;

FpSpreadl.NamedStyles.Add (backstyle);

FpSpreadl .NamedStyles.Add (textlstyle);

FpSpreadl .NamedStyles.Add (text2style) ;

FpSpreadl .ActiveSheetView.Cells[0,0,2,0].StyleName = "OrangeText";
FpSpreadl .ActiveSheetView.Cells[0,1,2,1].StyleName = "YellowText";
VB

' Create a style with a blue background color.

Dim backstyle As New FarPoint.Web.Spread.NamedStyle ("BlueBack")
backstyle.BackColor = Color.Blue

' Create a style with an orange text color and assign it a parent style.

Dim textlstyle As New FarPoint.Web.Spread.NamedStyle ("OrangeText", "BlueBack")
textlstyle.ForeColor = Color.Orange

' Create a style with a yellow text color and assign it a parent style.

Dim text2style As New FarPoint.Web.Spread.NamedStyle ("YellowText", "BlueBack")
text2style.ForeColor = Color.Yellow

FpSpreadl.NamedStyles.Add (backstyle)

FpSpreadl.NamedStyles.Add (textlstyle)

FpSpreadl .NamedStyles.Add (text2style)

FpSpreadl.ActiveSheetView.Cells (0,0,2,0).StyleName = "OrangeText"
fpSpreadl.ActiveSheetView.Cells (0,1,2,1).StyleName = "YellowText"

Using the Spread Designer

Select the Settings menu.

Select the Named Style icon under the Appearance Settings section.

Use the New style icon to create a new style and use the Edit style icon to set properties for the style.

Select Apply and OK.

Select the cell or cells and set the StyleName property.

From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

g h @R

Assigning a Cascading Style Sheet to a Cell

You can assign a cascading style sheet (CSS) to a cell or group of cells as a way of conveniently defining the appearance
settings of the cell or cells. The CSS class name is a property of the cell type.

This assumes that the RenderCSSClass ('RenderCSSClass Property' in the on-line documentation) property
in the FpSpread ('FpSpread Class' in the on-line documentation) class is set to True, which is the default. If it is
set to False, the component uses the in-line style attributes instead of the cascading style sheet.

The CSS Class should be outside the head tag and after the Spread HTML code for best results with strict compliance.

Using Code

Copyright © GrapeCity, Inc. All rights reserved.



Spread for ASP.NET Developer’s Guide 235

1. Define the CSSClass ('CssClass Property' in the on-line documentation) property for a given cell type.
2. Assign that cell type to the cell or cells.

Example

The following attaches a style sheet named myCssClass to be used for the specified column header and cells:

C#

FarPoint.Web.Spread.GeneralCellType mycelltype = new
FarPoint.Web.Spread.GeneralCellType () ;
myCellType.CssClass = "myCssClass";
FpSpreadl.ColumnHeader.Cells [0, 0].CellType = myCellType;
FpSpreadl.Cells[0, 1].CellType = myCellType;

VB
Dim myCellType As New FarPoint.Web.Spread.GeneralCellType
myCellType.CssClass = "myCssClass"

FpSpreadl.ColumnHeader.Cells (0, 0).CellType = myCellType
FpSpreadl.Cells (0, 1) .CellType = myCellType

Example

When the pointer is over data in the Spread, the mouse cursor turns into an I-beam shape indicating that the user is
allowed to edit the information. This happens even if the columns are locked. To have the pointer remain an arrow when
hovering over data in the row, or to change the cursor to whatever you want, you can use the CSSClass object, which
assigns a cascading style sheet class to a cell. For example, you can use the following code to use a style for the cursor
over a locked column.

C#

FpSpreadl.Sheets[0] .Columns[0] .Locked = true;
CType (FpSpreadl.Sheets[0].StyleModel.GetCompositeInfo (-1, 0, -1, Nothing) .CellType,
FarPoint.Web.Spread.GeneralCellType) .CssClass = "myCell";

VB

FpSpreadl.Sheets (0) .Columns (0) .Locked = True
CType (FpSpreadl.Sheets (0) .StyleModel.GetCompositeInfo(-1, 0, -1, Nothing) .CellType,
FarPoint.Web.Spread.GeneralCellType) .CssClass = "myCell"

Then in HTML code you can add the myCell style:

HTML
<style>.myCell { CURSOR: default } </style>

Creating a Range of Cells

You can create a range of cells to allow you to define properties and behaviors for those cells. A range may be any set of
cells.

Using the Properties Window

1. At design time, in the Properties window, select the FpSpread component.
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Select the Sheets property.

Click the button to display the SheetView Collection Editor.

Select the sheet.

Select the button for the Cells object (or Columns or Rows collections).
Select a block of cells.

Set properties as needed.

Click OK to close each editor.
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Using Code

1. Specify the range of cells.

2. Set the Note ('Note Property' in the on-line documentation) property for the Cell ('Cell Class' in the
on-line documentation) object for that range.

Example

This example code sets the Note property for a range of Cell objects.
C#

FarPoint.Web.Spread.Cell rangel;
rangel = fpSpreadl.ActiveSheetView.Cells[0, 0, 2, 2];

rangel.Value = "Value Here";
rangel.Note = "This is the note that describes the value.";
VB

Dim rangel As FarPoint.Web.Spread.Cell

rangel = fpSpreadl.ActiveSheetView.Cells (0, 0, 2, 2)
rangel.Value = "Value Here"

rangel.Note = "This is the note that describes the value."

Using the Spread Designer

1. Select a block of cells.
2. Set properties as needed.
3. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.

Spanning Cells

You can group cells together to form one large cell. This is called a spanning cells and the large cell that is created is
called a cell span. You can add spans in headers or in data cells. Creating a span of cells creates one large cell where there
had previously been several. For example, if you create a span of cells from cell B2 to cell D3, cell B2 then appears to
occupy the space from cell B2 through cell D3.

A B C D E

These six cells are spanned.

Lad | b | =

The component is divided into four parts: sheet corner, column headers, rows headers, and data area. You can create
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spans within a part, but you cannot create a span that goes across parts. For example, you cannot span cells in the data
area with cells in the row headers and you cannot span cells in the column header with the sheet corner. This topic
discusses spanning cells in the data area. For more information on creating a span of header cells, refer to Creating a
Span in a Header.

When you create a span of cells, the data in the first cell in the span (called the anchor cell) occupies all the space in the
span. When you create a span, the data that was in each of the cells in the span is still in each cell, but not displayed. The
data is simply hidden by the span range. If you remove the span from a group of cells, the content of the spanned cells,
which previously was hidden, is displayed as appropriate.

The cell types of the cells combined in the span are not changed. The spanned cell takes the type of the left-most cell in
the span.

You can return whether a specified cell is in a span of cells by calling the GetSpanCell ('GetSpanCell Method' in
the on-line documentation) method.

You can remove a span from a range of cells by calling the RemoveSpanCell ('RemoveSpanCell Method' in the
on-line documentation) method. You can remove a span range by calling this method, specifying the anchor cell of
the span range to remove the range. When you remove a span range, the data that was previously in each of the cells in
the span is re-displayed in the cell. The data was never removed from the cell, but simply hidden by the span range.

] Note: You cannot sort a spreadsheet that has spanned cells.

For more information on allowing automatic merging of cells with identical content, refer to Allowing Cells to Merge
Automatically.

For more information about the underlying span model, refer to Understanding the Span Model.
Using the Properties Window

At design time, in the Properties window, select the FpSpread component.

Select the Sheets property.

Click the button to display the SheetView Collection Editor.

Select the sheet.

In the Properties window on the right side of the SheetView Collection Editor, select the Cells property for
the sheet.

Select the cell from which to start the span.

Click the button to display the Cell, Column, and Row Editor.

8. In the editor, select either the RowSpan or ColumnSpan property and set the number to the number of cells to
span starting from the selected cell. To remove a span, set the value back to 1.

The preview on the left side of the editor shows the cells spanned.

I e
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9. If you want to apply this change, click Apply.
10. Click OK to close each editor.

Using a Shortcut

To span cells (or remove spanning) use any of the following methods of the FpSpread ('"FpSpread Class' in the on-
line documentation) component Sheets ('Sheets Property’' in the on-line documentation) shortcut:

¢ AddSpanCell ('AddSpanCell Method' in the on-line documentation)
¢ GetSpanCell ('GetSpanCell Method' in the on-line documentation)
¢ RemoveSpanCell ('RemoveSpanCell Method' in the on-line documentation)

Example

This example code defines some content then spans six adjoining cells.
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C#

// Create some content in two cells.
FpSpreadl.ActiveSheetView.Cells[1l,1].Text = "These six cells are spanned.";
FpSpreadl.ActiveSheetView.Cells[2,2] .Text = "This is text in 2,2.";

// Span six cells including the ones with different content.
FpSpreadl.ActiveSheetView.AddSpanCell (1, 1, 2, 3);

VB

' Create some content in two cells.
FpSpreadl.ActiveSheetView.Cells(1l,1) .Text = "These six cells are spanned."
FpSpreadl .ActiveSheetView.Cells (2,2) .Text = "This is text in 2,2."

1

Span six cells including the ones with different content.
FpSpreadl .ActiveSheetView.AddSpanCell (1, 1, 2, 3)

Using the Spread Designer

1. Select the sheet.
2. Select the cells to span.
3. Do one of the following:
From the Home menu, select the merge icon.

Another way is to right-click and select Span or in the property list (in the Misc category), select either the
RowSpan or ColumnSpan property and set the number to a value greater than one to span cells. To remove a
span, set the value back to 1.

The Designer shows the cells spanned.

4. From the File menu choose Apply and Exit to apply your changes to the component and exit Spread Designer.
Allowing Cells to Merge Automatically

You can have Spread automatically merge cells between columns or between rows if the cells have the same value based
on the policy that you set. The component can automatically combine cells that have the same contents. You might want
to do this, for example, when bound to a database.

Unlike spanning cells, merging is an automatic feature. You tell the component which columns and rows allow cells to be
combined automatically, and any cells within that set that have the same contents are combined for you.

For more information on spanning cells, refer to Spanning Cells.
If the merge policy is set to None, cells within a row or column are not merged.
If the merge policy is set to Always, cells within a row or column are merged when the cells have the same values.

If the merge policy is set to Restricted, cells within a row or column are merged when the cells have the same values and
the corresponding cells in the previous row or column also have the same value. For example, suppose cells A1:A8
contain {a; a; b; b; b; b; c; ¢} and cells B1:B8 contain {1; 1; 1; 1; 2; 2; 2; 2}. If the merge policy for column B is Always, the
cells in column B are merged into two blocks B1:B4 and B5:B8. If the merge policy for column A is Always and the merge
policy for column B is Restricted then the cells in column B are merged into four blocks B1:B2, B3:B4, B5:B6, and B7:B8.
For example:
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A B C
1 la 1
2
3 b 1
4
5 2
)
7 Ic 2
8

You can have the cells in the specified row or column combine the cells automatically, or only combine them if the cells
to their left (in columns) or above them (in rows) are merged. Typically, if you set the merge policy on several adjacent
rows or columns, then you would use Always on the first row or column and Restricted on the remaining rows or
columns.

Merged cells take on the properties of the top-left merged cell. For example, if the top-left merged cell has a blue
background color, the cells that merge with it display the same background color.

Merged cells do not lose their data; it is simply hidden by the merge. If you remove the merge, the data appears in each
cell that was in the merge. You can edit the top-left merged cell; when you leave edit mode, if the contents of that cell are
no longer identical to the cell or cells with which it was previously merged, the cells are no longer displayed as merged
when the Spread is updated. How cells are merged is only changed when the Spread is updated.

Cells that are different cell types but have the same contents can merge. For example, a date cell might contain the
contents "01/31/02" and the adjacent edit cell might contain the same contents; if the column containing the cells is set
to merge, the cells will merge. If the contents change or the merge is removed, the cells maintain their cell types as well
as their data.

To set cells to be merged if they have the same value, use the following members:
¢ GetColumnMerge ('GetColumnMerge Method' in the on-line documentation) and

SetColumnMerge ('SetColumnMerge Method' in the on-line documentation)

¢ GetRowMerge ('GetRowMerge Method' in the on-line documentation) and SetRowMerge
('SetRowMerge Method' in the on-line documentation)

¢ GetMergePolicy ('GetMergePolicy Method' in the on-line documentation) and SetMergePolicy
('SetMergePolicy Method' in the on-line documentation)

e MergePolicy ('MergePolicy Enumeration' in the on-line documentation) enumeration settings

For more information on these members, refer to the SheetView ('SheetView Class' in the on-line
documentation) class (or the Row ("Row Class' in the on-line documentation) or Column ('Column Class'
in the on-line documentation) class) or the DefaultSheetAxisModel ('DefaultSheetAxisModel Class' in the
on-line documentation) of the Model namespace in the Assembly Reference (on-line documentation).

For more information on creating spans of cells with identical content, refer to Spanning Cells.
Using a Shortcut

Use the SetColumnMerge ('SetColumnMerge Method' in the on-line documentation) or SetRowMerge
('SetRowMerge Method' in the on-line documentation) method for the FpSpread ('FpSpread Class' in the
on-line documentation) component Sheets ('Sheets Property' in the on-line documentation) shortcut.

Example

This example code sets the row and column merge policies for all rows and all columns.
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C#

FpSpreadl.Sheets[0].SetRowMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always);
FpSpreadl.Sheets[0].SetColumnMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always);

VB

FpSpreadl.Sheets (0) .SetRowMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always)
FpSpreadl.Sheets (0) .SetColumnMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always)

Using Code

Set the SetColumnMerge ('SetColumnMerge Method' in the on-line documentation) or SetRowMerge
('SetRowMerge Method' in the on-line documentation) method for a SheetView ('SheetView Class' in the
on-line documentation) object.

Example

This example code sets the row and column merge policies for all rows and all columns.

C#

FarPoint.Web.Spread.SheetView SheetO;

Sheet0 = fpSpreadl.Sheets[0];

Sheet0.SetRowMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always):;
Sheet0.SetColumnMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always);

VB

Dim SheetO As FarPoint.Web.Spread.SheetView

Sheet0 = fpSpreadl.Sheets (0)

Sheet0.SetRowMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always)
Sheet0.SetColumnMerge (-1, FarPoint.Web.Spread.Model.MergePolicy.Always)

Using Sparklines

You can create a small graph in a cell that uses data from a range of cells. The data for the sparkline is limited to one
column or row of values. You can set the sparkline type to column, line, or winloss, as shown in the following figure. The
images were created using a minimum axis of -9 and a maximum axis of 15.

A A A 15
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Data for sparkline

Column sparkline  Line sparkline Winloss sparkline

The column sparkline draws the values as a column chart. The line sparkline draws the values as a line chart. The
winloss sparkline shows the points with the same size. Negative points extend down from the axis and positive points
extend up.

The graphs can display colors for the marker points. You can set colors for the high, low, negative, first, and last points.
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The graphs have horizontal and vertical axes.
Sparklines are stored as groups. A group contains at least one sparkline.

The Sparkline graph requires the following information in the web.config file. This example is based on IIS7.

Code

<system.webServer>
<validation validateIntegratedModeConfiguration="false"/>
<handlers>

<add name="chart" path="FpChart.axd" verb="*"
type="FarPoint.Web.Chart.ChartImageHttpHandler" />
</handlers>

// If you are using integrated managed pipeline mode,
//set validateIntegratedModeConfiguration to false.
<validation validateIntegratedModeConfiguration="false"/>

This example is based on IIS8.
Code

<system.webServer>
<handlers>
<add name="FpChart" verb="*" path="FpChart.axd" preCondition="integratedMode"
type="FarPoint.Web.Chart.ChartImageHttpHandler" />
</handlers>
<validation validateIntegratedModeConfiguration="false"/>
</system.webServer>

For more information, see the following topics:

¢ Adding a Sparkline to a Cell

¢ Customizing Markers and Pointers

e Specifying Horizontal and Vertical Axes
¢ Working with Sparklines

Adding a Sparkline to a Cell

You can add a sparkline to a cell using code or the designer.
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Using Code

1. Specify a cell to create the sparkline in.
2. Specify a range of cells for the data.
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3. Set any properties for the sparkline (such as points and colors).

4. Add the sparkline to the cell with the AddSparkline ('AddSparkline Method' in the on-line
documentation) method.

Example

This example creates a column sparkline in a cell and shows negative and series colors.

C#

FarPoint.Web.Spread.SheetView sv = new FarPoint.Web.Spread.SheetView() ;
FarPoint.Web.Spread.Chart.SheetCellRange data = new
FarPoint.Web.Spread.Chart.SheetCellRange(sv, 0,0,1, 5);
FarPoint.Web.Spread.Chart.SheetCellRange data2 = new
FarPoint.Web.Spread.Chart.SheetCellRange(sv, 5,0,1,1);
FarPoint.Web.Spread.ExcelSparklineSetting ex = new
FarPoint.Web.Spread.ExcelSparklineSetting() ;
ex.ShowMarkers = true;

ex.ShowNegative = true;

ex.NegativeColor = Color.Red;

// Use with a Column or Winloss type

ex.SeriesColor = Color.Olive;

fpSpreadl.Sheets[0] = sv;
